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Welcome 
@RISK for Microsoft Excel 

Welcome to @RISK, the revolutionary software system for the 
analysis of business and technical situations impacted by risk!  The 
techniques of Risk Analysis have long been recognized as powerful 
tools to help decision-makers  successfully manage situations subject 
to uncertainty.  Their use has been limited because they have been 
expensive, cumbersome to use, and have substantial computational 
requirements.  However, the growing use of computers in business 
and science has offered the promise that these techniques can be 
commonly available to all decision-makers. 

That promise has been finally realized with @RISK (pronounced "at 
risk") — a system which brings these techniques to the industry 
standard spreadsheet package, Microsoft Excel.  With @RISK and 
Excel any risky situation can be modeled, from business to science 
and engineering.  You are the best judge of what your analysis needs 
require, and @RISK, combined with the modeling capabilities of 
Excel, allows you to design a model which best satisfies those needs.  
Anytime you face a decision or analysis under uncertainty, you can 
use @RISK to improve your picture of what the future could hold. 

Why You Need Risk Analysis and @RISK 
Traditionally, analyses combine single "point" estimates of a model's 
variables to predict a single result.  This is the standard Excel model 
— a spreadsheet with a single estimate of results.  Estimates of model 
variables must be used because the values which actually will occur 
are not known with certainty.  In reality, however, many things just 
don't turn out the way that you have planned.  Maybe you were too 
conservative with some estimates and too optimistic with others.  The 
combined errors in each estimate often lead to a real-life result that is 
significantly different from the estimated result.  The decision you 
made based on your "expected" result might be the wrong decision, 
and a decision you never would have made if you had a more 
complete picture of all possible outcomes.  Business decisions, 
technical decisions, scientific decisions ... all use estimates and 
assumptions.  With @RISK, you can explicitly include the uncertainty 
present in your estimates to generate results that show all possible 
outcomes.   
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@RISK uses a technique called "simulation" to combine all the 
uncertainties you identify in your modeling situation.  You no longer 
are forced to reduce what you know about a variable to a single 
number.  Instead, you include all you know about the variable, 
including its full range of possible values and some measure of 
likelihood of occurrence for each possible value.  @RISK uses all this 
information, along with your Excel model, to analyze every possible 
outcome.  It's just as if you ran hundreds or thousands of "what-if" 
scenarios all at once!  In effect, @RISK lets you see the full range of 
what could happen in your situation.  It's as if you could "live" 
through your situation over and over again, each time under a 
different set of conditions, with a different set of results occurring. 

All this added information sounds like it might complicate your 
decisions, but in fact, one of simulation's greatest strengths is its 
power of communication.  @RISK gives you results that graphically 
illustrate the risks you face.  This graphical presentation is easily 
understood by you, and easily explained to others. 

So when should you use @RISK?  Anytime you make an analysis in 
Excel that could be affected by uncertainty, you can and should use 
@RISK.  The applications in business, science and engineering are 
practically unlimited and you can use your existing base of Excel 
models.  An @RISK analysis can stand alone, or be used to supply 
results to other analyses.  Consider the decisions and analyses you 
make every day!  If you've ever been concerned with the impact of 
risk in these situations, you've just found a good use for @RISK! 

Modeling Features 
As an "add-in" to Microsoft Excel, @RISK "links" directly to Excel to 
add Risk Analysis capabilities.  The @RISK system provides all the 
necessary tools for setting up, executing and viewing the results of 
Risk Analyses.  And @RISK works in a style you are familiar with — 
Excel style menus and functions. 

@RISK allows you to define uncertain cell values in Excel as 
probability distributions using functions.  @RISK adds a set of new 
functions to the Excel function set, each of which allows you to 
specify a different distribution type for cell values.  Distribution 
functions can be added to any number of cells and formulas 
throughout your worksheets and can include arguments which are 
cell references and expressions — allowing extremely sophisticated 
specification of uncertainty.  To help you assign distributions to 
uncertain values, @RISK includes a graphical pop-up window where 
distributions can be previewed and added to formulas.   

@RISK 
Functions 
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The probability distributions provided by @RISK allow the 
specification of nearly any type of uncertainty in cell values in your 
spreadsheet.  A cell containing the distribution function 
NORMAL(10,10), for example, would return samples during a 
simulation drawn from a normal distribution (mean = 10, standard 
deviation = 10).  Distribution functions are only invoked during a 
simulation — in normal Excel operations, they show a single cell 
value — just the same as Excel before @RISK.  Available distribution 
types include: 

Beta 
BetaGeneral 
Beta-Subjective 
Binomial 
Chi-Square 
Cumulative 
Discrete 
Discrete Uniform 
Error Function 
Erlang 
Exponential 
Extreme Value 
Gamma 

General 
Geometric 
Histogram 
Hypergeometric 
Inverse Gaussian 
IntUniform 
Logistic 
Log-Logistic 
Lognormal 
Lognormal2 
Negative Binomial 
Normal 
Pareto 

Pareto2 
Pearson V 
Pearson VI 
PERT 
Poisson 
Rayleigh 
Student's t 
Triangular 
Trigen 
Uniform 
Weibull 

All distributions may be truncated to allow only samples within a 
given ranges of values within the distribution.  Also, many 
distributions can also use alternate percentile parameters.  This allows 
you to specify values for specific percentile locations of an input 
distribution as opposed to the traditional arguments used by the 
distribution. 

@RISK has sophisticated capabilities for specifying and executing 
simulations of Excel models.  Both Monte Carlo and Latin Hypercube 
sampling techniques are supported, and distributions of possible 
results may be generated for any cell or range of cells in your 
spreadsheet model.  Both simulation options and the selection of 
model outputs are entered with Windows style menus, dialog boxes 
and use of the mouse. 

High resolution graphics are used to present the output distributions 
from your @RISK simulations.  Histograms, cumulative curves,  and 
summary graphs for cell ranges all lead to a powerful presentation of 
results.  And all graphs may be displayed in Excel for further 
enhancement and hard copy.  An essentially unlimited number of 
output distributions may be generated from a single simulation — 
allowing for the analysis of even the largest and most complex 
spreadsheets! 

Available 
Distribution 
Types 

@RISK 
Simulation 
Analysis 

Graphics 
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The options available for controlling and executing a simulation in 
@RISK are among the most powerful ever available.  They include: 
•  Latin Hypercube or Monte Carlo sampling 
•  Any number of iterations per simulation 
•  Any number of simulations in a single analysis 
•  Animation of sampling and recalculation of the spreadsheet 
•  Seeding the random number generator 
•  Real time results and statistics during a simulation 

@RISK graphs a probability distribution of possible results for each 
output cell selected in @RISK.  @RISK graphics include: 
•  Relative frequency distributions and cumulative probability curves 
•  Summary graphs for multiple distributions across cell ranges (for 

example, a worksheet row or column) 
•  Statistical reports on generated distributions 
•  Probability of occurrence for target values in a distribution 
•  Export of graphics as Windows metafiles for further enhancement 

Execution time is of critical importance because simulation is 
extremely calculation intensive.  @RISK is designed for the fastest 
possible simulations through the use of advanced sampling 
techniques.  

Advanced  
Simulation 
Capabilities 

High Resolution 
Graphic 
Displays 

Product 
Execution 
Speed 
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Introduction 
This introduction describes the contents of your @RISK package and 
shows you how to install @RISK and attach it to your copy of 
Microsoft Excel 97 for Windows or higher. 

Checking Your Package 
Your @RISK package should contain: 

The @RISK User’s Guide (this book) with: 
•  Getting Started 
•  Overview to Risk Analysis and @RISK 
•  Upgrade Guide 
•  Getting to Know @RISK 
•  @RISK Modeling Techniques 
•  Distribution Fitting 
•  @RISK Reference Guide 
•  Technical Appendices 

The @RISK CD-ROM including: 
•  @RISK Program  
•  @RISK Tutorial  

The @RISK Licensing Agreement 

A complete listing of all files contained on the @RISK CD is contained 
in the file INSTALL.LOG found in the DTOOLS\RISK45 directory on 
your hard disk. 

If your package is not complete, please call your @RISK dealer or 
supplier or contact Palisade Corporation directly at (607) 277-8000.  If 
you want to install @RISK from diskettes, please contact Palisade 
Corporation. 

About This Version 
 
This version of @RISK can be installed as a 32-bit program for 
Microsoft Excel 97 or higher.   
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Working with your Operating Environment 
This User’s Guide assumes that you have a general knowledge of the 
Windows operating system and Excel.  In particular: 
•  You are familiar with your computer and using the mouse. 
•  You are familiar with terms such as icons, click, double-click, menu, 

window, command and object. 
•  You understand basic concepts such as directory structures and file 

naming. 

If You Need Help 
Technical support is provided free of charge for all registered users of 
@RISK with a current maintenance plan, or is available on a per 
incident charge.  To ensure that you are a registered user of @RISK, 
please register online at www.palisade.com/html/register.html. 

If you contact us by telephone, please have your serial number and 
User’s Guide ready.  We can offer better technical support if you are 
in front of your computer and ready to work. 

Before contacting technical support, please review the following 
checklist: 
•  Have you referred to the on-line help?  
•  Have you checked this User's Guide and reviewed the on-line 

multimedia tutorial? 
•  Have you read the README.WRI file? It contains current information 

on @RISK that may not be included in the manual. 
•  Can you duplicate the problem consistently? Can you duplicate the 

problem on a different computer or with a different model? 
•  Have you looked at our site on the World Wide Web? It can be found at 

http://www.palisade.com. Our Web site also contains the latest FAQ 
(a searchable database of tech support questions and answers) and 
@RISK patches in our Technical Support section.  We recommend 
visiting our Web site regularly for all the latest information on @RISK 
and other Palisade software. 

Before Calling 
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Palisade Corporation welcomes your questions, comments or 
suggestions regarding @RISK.  Contact our technical support staff 
using any of the following methods: 
•  E-mail us at tech-support@palisade.com. 
•  Telephone us at (607) 277-8000 any weekday from 9:00 AM to 5:00 PM, 

EST.  Press 2 on a touch-tone phone to reach technical support. 
•  Fax us at (607) 277-8001. 
•  Mail us a letter at: 

Technical Support 
Palisade Corporation  
31 Decker Road 
Newfield, NY  14867  USA 

If you want to contact Palisade Europe: 
•  E-mail us at tech-support@palisade-europe.com. 
•  Telephone us at +44 (0)207 426 9950 (UK). 
•  Fax us at +44 (0)207 375 1229 (UK). 
•  Mail us a letter at: 

Palisade Europe 
Technical Support 
The Blue House, Unit 1 
30 Calvin Street 
London E1 6NW UK 

Regardless of how you contact us, please include the product name, 
exact version and serial number.  The exact version can be found by 
by selecting the Help About command on the @RISK menu in Excel. 

Contacting 
Palisade 
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Telephone support is not available with the student version of @RISK.  
If you need help, we recommend the following alternatives: 
•  Consult with your professor or teaching assistant. 
•  Log-on to our site on the World Wide Web for answers to frequently 

asked questions. 
•  Contact our technical support department via e-mail or fax. 

@RISK System Requirements   
System requirements for @RISK 4.5 for Microsoft Excel for Windows 
include: 
•  Pentium PC or faster with a hard disk. 
•  Microsoft Windows 95 or higher or Windows NT 4.0 or higher. 
•  32 MB installed memory. 
•  Microsoft Excel Version 97 or higher. 

Student 
Versions 
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Installation Instructions 

General Installation Instructions 
The Setup program copies the @RISK system files into a directory you 
specify on your hard disk.  Setup asks you for the location of the Excel 
directory on your hard disk, so please note this information before 
running Setup.  Setup and @RISK require Microsoft Windows to run, 
so be sure to start Windows before running these programs.   

To run the Setup program in Windows 95 or higher: 

1) Insert the @RISK CD-ROM in your CD-ROM drive 

2) Click the Start button, click Settings and then click Control Panel 

3) Double-click the Add/Remove Programs icon 

4) On the Install/Uninstall tab, click the Install button 

5) Follow the Setup instructions on the screen 

If you encounter problems while installing @RISK, verify that there is 
adequate space on the drive to which you’re trying to install.  After 
you’ve freed up adequate space, try rerunning the installation. 

Within 30 days of installing @RISK you need to authorize your copy 
of @RISK. 

 
Authorization can be done over the Internet by clicking the Authorize 
Now button and following the prompts on the screen.  Alternatively, 
you can contact Palisade or Palisade Europe during normal business 
hours and authorize your copy of @RISK over the phone. 

An authorized copy of @RISK is licensed for use on a single computer 
only.  If you wish to move your copy of @RISK to a different 
computer, please contact Palisade for instructions.

Authorizing 
Your Copy of 
@RISK 
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Setup creates the file INSTALL.LOG in your @RISK directory.  This 
file lists the names and locations of all installed files.  If you wish to 
remove @RISK from your computer, use the Control Panel’s 
Add/Remove Programs utility and select the entry for @RISK.   

The DecisionTools Suite  
@RISK for Excel is a member of the DecisionTools Suite, a set of 
products for risk and decision analysis described in Appendix D:  
Using @RISK With Other DecisionTools.  The default installation 
procedure of @RISK puts @RISK in a subdirectory of a main 
“DTOOLS” directory.  This is quite similar to how Excel is often 
installed into a subdirectory of a “MSOFFICE” directory.   

One subdirectory of the DTOOLS directory will be the @RISK 
directory (by default called RISK45).  This directory contains the 
@RISK program files (RSKMODEL.EXE and RSKRSLTS.EXE) plus 
example models and other files necessary for @RISK to run.  Another 
subdirectory of DTOOLS is the SYSTEM directory which contains 
files which are needed by every program in the DecisionTools Suite, 
including common help files and program libraries. 

When you launch one of the elements of the Suite (such as @RISK) 
from its desktop icon, Excel will load a “DecisionTools Suite” toolbar 
which contains one icon for each program of the Suite.  This allows 
you to launch any of the other products in the suite directly from 
Excel. 

Note:  In order for TopRank, the what-if analysis program in the 
DecisionTools Suite, to work properly with @RISK, you must have 
release TopRank 1.5e or higher.   

Removing 
@RISK from 
Your Computer 

The 
DecisionTools 
Toolbar 
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Setting Up the @RISK Icons or Shortcuts 
In Windows, setup automatically creates an @RISK command in the 
Programs menu of the Taskbar.  However, if problems are 
encountered during Setup, or if you wish to do this manually another 
time, follow the following directions. 

1) Click the Start button, and then point to Settings. 

2) Click Taskbar, and then click the Start Menu Programs tab. 

3) Click Add, and then click Browse. 

4) Locate the file RISK.EXE and double click it. 

5) Click Next, and then double-click the menu on which you want the 
program to appear. 

6) Type the name “@RISK”, and then click Finish. 

Creating the 
Shortcut in the 
Windows 
Taskbar 
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Quick Start 

On-line Tutorial 
In the on-line tutorial, @RISK experts guide you through sample 
models in streaming .WMV movie format. This tutorial is a multi-media 
presentation on the main features of @RISK. 

The system requirements for the tutorial are:  

•  Windows Media Player plug-in 

•  A computer with audio capability 

The tutorial can be run by selecting the Start Menu/ Programs/ 
Palisade DecisionTools/ Tutorials/ @RISK Tutorial and clicking on 
the file RISK45.html.  

Starting On Your Own 
If you're in a hurry, or just want to explore @RISK on your own, here's 
a quick way to get started. 

After attaching @RISK according to the Installation instructions 
outlined previously in this section: 

1) Click the @RISK icon in the Windows Start Programs Palisade 
DecisionTools group.  

2) Use the Excel Open command to open the example spreadsheet 
FINANCE.XLS.  The default location for the examples is 
C:\DTOOLS\RISK45\EXAMPLES. 

3) Click the List icon on the @RISK Toolbar — the one on the Toolbar 
with the red and blue arrow.  The Outputs and Inputs list, listing 
the distribution functions in the FINANCE worksheet along with 
your output cell C10, NPV at 10%, is displayed. 

4) Click the "Simulate" icon — the one with the red distribution 
curve.  You've just started a risk analysis on NPV for the 
FINANCE worksheet.  The Simulation analysis is underway.  
When it is complete, your risk analysis results will be displayed.  
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To make graphs for Risk Analysis results: 
1) When results are shown, right click on the name of an output or 

input in the Explorer list and select Histogram.  A graph of 
simulation results for the highlighted output or input cell will be 
displayed. 

2) To modify a graph, click the right mouse button when the cursor is 
located over the graph window.  Select Graph Format from the pop-
up menu. 

For all analyses, if you want to see @RISK "animate" its operation 
during the simulation, turn the Simulation Settings dialog box Update 
Display check box on or press the <Num Lock> key during the 
simulation.  @RISK then will show you how it changes your 
spreadsheet iteration by iteration and generates results. 

Quick Start with Your Own Spreadsheets 
Working through the @RISK On-Line Tutorial and reading the @RISK 
Reference Guide is the best method for preparing to use @RISK on 
your own spreadsheets.  However, if you're in a hurry, or just don't 
want to work through the Tutorial, here is a quick step-by-step guide 
to using @RISK with your own spreadsheets: 

1) Click the @RISK icon in the Windows Start Programs Palisade 
DecisionTools group.  

2) If necessary, use the Excel Open command to open your spreadsheet 
3) Examine your spreadsheet and locate those cells where uncertain 

assumptions or inputs are located. You will substitute @RISK 
distribution functions for these values. 

4) Enter distribution functions for the uncertain inputs which reflect 
the range of possible values and their likelihood of occurrence.  Start 
with the simple distribution types — such as UNIFORM, which 
just requires a minimum and maximum possible value, or TRIANG 
which just requires a minimum, most likely and maximum possible 
value. 

5) Once you've entered your distributions, select the spreadsheet cell 
or cells for which you wish to get simulation results and click the 
"Add Output" icon — the one with the single red arrow — on the 
@RISK Toolbar.   

To run a simulation: 
1) Click the "Simulate" icon — the one with the red distribution curve 

— on the @RISK Toolbar. A simulation of your spreadsheet will be 
executed and results displayed. 
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Using @RISK 4.5 Spreadsheets in @RISK 3.5 or 
earlier 
@RISK 4.5 spreadsheets can only be used in @RISK 3.5 or earlier when 
the simple forms of distribution functions are used.  In the simple 
distribution function format only required distribution parameters 
can be used.  No new @RISK 4.5 distribution property functions can 
be added.  In addition, RiskOutput functions must be removed and 
outputs reselected when simulating in @RISK 3.5.   

Using @RISK 4.5 Spreadsheets in @RISK 4.0 
@RISK 4.5 spreadsheets can be used directly in @RISK 4.0 with the 
following exceptions: 

! Alternate Parameter functions, such as RiskNormalAlt, will 
not work and will return an error. 

! Cumulative Descending functions, such as RiskCumulD, 
will not work and will return an error. 
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Introduction 
@RISK brings advanced modeling and Risk Analysis to Microsoft 
Excel.  You might wonder if what you do qualifies as modeling 
and/or would be suitable for Risk Analysis.  If you use data to solve 
problems, make forecasts, develop strategies, or make decisions, then 
you definitely should consider doing Risk Analysis.   

Modeling is a catch-all phrase that usually means any type of activity 
where you are trying to create a representation of a real life situation 
so you can analyze it.  Your representation, or model, can be used to 
examine the situation, and hopefully help you understand what the 
future might bring.  If you've ever played "what-if" games with your 
project by changing the values of various entries, you are well on 
your way to understanding the importance of uncertainty in a 
modeling situation. 

Okay, so you do analyses and make models — what is involved in 
making these analyses and models explicitly incorporate risk?  The 
following discussion will try to answer this question.  But don't 
worry, you don't have to be an expert in statistics or decision theory 
to analyze situations under risk, and you certainly don't have to be an 
expert to use @RISK.  We can't teach you everything in a few pages, 
but we'll get you started.  Once you begin using @RISK you'll 
automatically begin picking up the type of expertise that can't be 
learned from a book. 

Another purpose of this chapter is to give you an overview of how 
@RISK works with your spreadsheet to perform analyses.  You don't 
have to know how @RISK works to use it successfully, but you might 
find some explanations useful and interesting.  This chapter discusses: 
•  What risk is and how it can be quantitatively assessed. 
•  The nature of Risk Analysis and the techniques used in @RISK. 
•  Running a simulation. 
•  Interpreting @RISK results. 
•  What Risk Analysis can and cannot do. 
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What Is Risk? 
Everyone knows that "risk" affects the gambler about to roll the dice, 
the wildcatter about to drill an oil well, or the tightrope walker taking 
that first big step.  But these simple illustrations aside, the concept of 
risk comes about due to our recognition of future uncertainty — our 
inability to know what the future will bring in response to a given 
action today.  Risk implies that a given action has more than one 
possible outcome. 

In this simple sense, every action is "risky", from crossing the street to 
building a dam.  The term is usually reserved, however, for situations 
where the range of possible outcomes to a given action is in some way 
significant.  Common actions like crossing the street usually aren't 
risky while building a dam can involve significant risk.  Somewhere 
in between, actions pass from being nonrisky to risky.  This 
distinction, although vague, is important — if you judge that a 
situation is risky, risk becomes one criterion for deciding what course 
of action you should pursue.  At that point, some form of Risk 
Analysis becomes viable. 

Characteristics of Risk   
Risk derives from our inability to see into the future, and indicates a 
degree of uncertainty that is significant enough to make us notice it.  
This somewhat vague definition takes more shape by mentioning 
several important characteristics of risk. 

First, risk can be either objective or subjective.  Flipping a coin is an 
objective risk because the odds are well known.  Even though the 
outcome is uncertain, an objective risk can be described precisely 
based on theory, experiment, or common sense.  Everyone agrees 
with the description of an objective risk.  Describing the odds for rain 
next Thursday is not so clear cut, and represents a subjective risk.  
Given the same information, theory, computers, etc., weatherman A 
may think the odds of rain are 30% while weatherman B may think 
the odds are 65%.  Neither is wrong.  Describing a subjective risk is 
open-ended in the sense that you could always refine your assessment 
with new information, further study, or by giving weight to the 
opinion of others.  Most risks are subjective, and this has important 
implications for anyone analyzing risk or making decisions based on 
a Risk Analysis. 
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Second, deciding that something is risky requires personal judgment, 
even for objective risks.  For example, imagine flipping a coin where 
you win $1 for a heads and lose $1 for a tails.  The range between $1 
and -$1 would not be overly significant to most people.  If the stakes 
were $100,000 and -$100,000 respectively, most people would find the 
situation to be quite risky.  There would be a wealthy few, however, 
who would not find this range of outcomes to be significant.   

Third, risky actions and therefore risk are things that we often can 
choose or avoid.  Individuals differ in the amount of risk they 
willingly accept.  For example, two individuals of equal net worth 
may react quite differently to the $100,000 coin flip bet described 
above — one may accept it while the other refuses it.  Their personal 
preference for risk differs. 

The Need for Risk Analysis 
The first step in Risk Analysis and modeling is recognizing a need for 
it.  Is there significant risk involved in the situation you are interested 
in?  Here are a few examples that might help you evaluate your own 
situations for the presence of significant risk: 
•  Risks for New Product Development and Marketing — Will the 

R&D department solve the technical problems involved?  Will a 
competitor get to market first, or with a better product?  Will 
government regulations and approvals delay product introduction?  
How much impact will the proposed advertising campaign have on sales 
levels?  Will production costs be as forecast?  Will the proposed sales 
price have to be changed to reflect unanticipated demand levels for the 
product? 

•  Risks for Securities Analysis and Asset Management — How 
will a tentative purchase affect portfolio value?  Will a new management 
team affect market price?  Will an acquired firm add earnings as 
forecast?  How will a market correction impact a given industry sector? 

•  Risks for Operations Management and Planning — Will a given 
inventory level suffice for unpredictable demand levels?  Will labor costs 
rise significantly with upcoming union contract negotiations?  How will 
pending environmental legislation impact production costs?  How will 
political and market events affect overseas suppliers in terms of exchange 
rates, trade barriers, and delivery schedules? 

•  Risks for Design and Construction of a Structure (building, 
bridge, dam,...) — Will the cost of construction materials and labor be 
as forecast?  Will a labor strike affect the construction schedule?  Will 
the levels of stress placed on the structure by peak load crowds and 
nature be as forecast?  Will the structure ever be stressed to the point of 
failure?
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•  Risks for Investment in Exploration for Oil and Minerals — Will 

anything be found?  If a deposit is found, will it be uneconomical, or a 
bonanza?  Will the costs of developing the deposit be as forecast?  Will 
some political event like an embargo, tax reform, or new environmental 
regulations drastically alter the economic viability of the project? 

•  Risks for Policy Planning —  If the policy is subject to legislative 
approval, will it be approved?  Will the level of compliance with any 
policy directives be complete or partial?  Will the costs of 
implementation be as forecast?  Will the level of benefits be what you 
projected? 

Assessing and Quantifying Risk 
The first step in Risk Analysis and modeling is recognizing a need for 
it.  Is there significant risk involved in the situation you are interested 
in?  Here are a few examples that might help you evaluate your own 
situations for the presence of significant risk. 

Realizing that you have a risky situation is only the first step.  How 
do you quantify the risk you have identified for a given uncertain 
situation?  "Quantifying risk" means determining all the possible 
values a risky variable could take and determining the relative 
likelihood of each value.  Suppose your uncertain situation is the 
outcome from the flip of a coin.  You could repeat the flip a large 
number of times until you had established the fact that half of the 
times it comes up tails and half of the times heads.  Alternatively, you 
could mathematically calculate this result from a basic understanding 
of probability and statistics. 

In most real life situations, you can't perform an "experiment" to 
calculate your risk the way you can for the flip of a coin.  How could 
you calculate the probable learning curve associated with introducing 
new equipment?  You may be able to reflect on past experiences, but 
once you have introduced the equipment, the uncertainty is gone.  
There is no mathematical formula that you can solve to get the risk 
associated with the possible outcomes.  You have to estimate the risk 
using the best information you have available. 

If you can calculate the risks of your situation the way you would for 
a coin flip, the risk is objective.  This means that everyone would 
agree that you quantified the risk correctly.  Most risk quantification, 
however, involves your best judgment.   
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There may not be complete information available about the situation, 
the situation may not be repeatable like a coin flip, or it just may be 
too complex to come up with an unequivocal answer.  Such risk 
quantification is subjective, which means that someone might 
disagree with your evaluation. 

Your subjective assessments of risk are likely to change when you get 
more information on the situation.  If you have subjectively derived a 
risk assessment, you must always ask yourself whether additional 
information is available that would help you make a better 
assessment.  If it is available, how hard and how expensive would it 
be to obtain?  How much would it cause you to change the 
assessment you already have made?  How much would these changes 
affect the final results of any model you are analyzing? 

Describing Risk with a Probability Distribution 
If you have quantified risk — determined outcomes and probabilities 
of occurrence — you can summarize this risk using a probability 
distribution.  A probability distribution is a device for presenting the 
quantified risk for a variable.  @RISK uses probability distributions to 
describe uncertain values in your Excel worksheets and to present 
results.  There are many forms and types of probability distributions, 
each of which describes a range of possible values and their likelihood 
of occurrence.  Most people have heard of a normal distribution — the 
traditional "bell curve".  But there is a wide variety of distribution 
types ranging from uniform and triangular distributions to more 
complex forms such as gamma and weibull. 

All distribution types use a set of arguments to specify a range of 
actual values and distribution of probabilities.  The normal 
distribution, for example, uses a mean and standard deviation as its 
arguments.  The mean defines the value around which the bell curve 
will be centered and the standard deviation defines the range of 
values around the mean.  Over thirty types of distributions are 
available to you in @RISK for describing distributions for uncertain 
values in your Excel worksheets.   

The @RISK Define Distribution window allows you to graphically 
preview distributions and assign them to uncertain values.  Using its 
graphs, you can quickly see the range of possible values your 
distribution describes. 
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What Is Risk Analysis? 
In a broad sense, Risk Analysis is any method — qualitative and/or 
quantitative — for assessing the impacts of risk on decision situations.  
Myriad techniques are used that blend both qualitative and 
quantitative techniques.  The goal of any of these methods is to help 
the decision-maker choose a course of action, given a better 
understanding of the possible outcomes that could occur. 

Risk Analysis in @RISK is a quantitative method that seeks to 
determine the outcomes of a decision situation as a probability 
distribution.  In general, the techniques in an @RISK Risk Analysis 
encompass four steps:   
•  Developing a Model — by defining your problem or situation in 

Excel worksheet format 
•  Identifying Uncertainty — in variables in your Excel worksheet and 

specifying their possible values with probability distributions, and 
identifying the uncertain worksheet results you want analyzed 

•  Analyzing the Model with Simulation — to determine the range 
and probabilities of all possible outcomes for the results of your 
worksheet 

•  Making a Decision — based on the results provided and personal 
preferences 

@RISK helps with the first three steps, by providing a powerful and 
flexible tool that works with Excel to facilitate model building and 
Risk Analysis.  The results that @RISK generates can then be used by 
the decision-maker to help choose a course of action. 

Fortunately, the techniques @RISK employs in a Risk Analysis are 
very intuitive.  As a result, you won't have to accept our methodology 
on faith.  And you won't have to shrug your shoulders and resort to 
calling @RISK a "black box" when your colleagues and superiors 
query you as to the nature of your Risk Analysis.  The discussion to 
follow will give you a firm understanding of just what @RISK needs 
from you in the way of a model, and how an @RISK Risk Analysis 
proceeds. 
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Developing an @RISK Model 
You are the "expert" at understanding the problems and situations 
that you would like to analyze.  If you have a problem that is subject 
to risk, then @RISK and Excel can help you construct a complete and 
logical model.   

A major strength of @RISK is that it allows you to work in a familiar 
and standard model building environment — Microsoft Excel.  @RISK 
works with your Excel model, allowing you to conduct a Risk 
Analysis, but still preserves the familiar spreadsheet capabilities.  You 
presumably know how to build spreadsheet models in Excel — 
@RISK now gives you the ability to easily modify these models for 
Risk Analysis. 

Variables 
Variables are the basic elements in your Excel worksheets that you 
have identified as being important ingredients to your analysis.  If 
you are modeling a financial situation, your variables might be things 
like Sales, Costs, Revenues or Profits whereas if you are modeling a 
geologic situation, your variables might be things like Depth to 
Deposit, Thickness of Coal Seam or Porosity.  Each situation has its 
own variables, identified by you.  In a typical worksheet, a variable 
labels a worksheet row or column, for example: 

You may know the values your variables will take in the time frame 
of your model — they are certain, or what statisticians call 
"deterministic".  Conversely, you may not know the values they will 
take — they are uncertain, or "stochastic".  If your variables are 
uncertain you will need to describe the nature of their uncertainty.  
This is done with probability distributions, which give both the range 
of values that the variable could take (minimum to maximum), and 
the likelihood of occurrence of each value within the range.  In 
@RISK, uncertain variables and cell values are entered as probability 
distribution functions, for example: 

RiskNormal(100,10) 

RiskUniform(20,30) 

RiskExpon(A1+A2) 

RiskTriang(A3/2.01,A4,A5) 

These "distribution" functions can be placed in your worksheet cells 
and formulas just like any other Excel function.

Certain or 
Uncertain 
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In addition to being certain or uncertain, variables in a Risk Analysis 
model can be either "independent" or "dependent".  An independent 
variable is totally unaffected by any other variable within your model.  
For example, if you had a financial model evaluating the profitability 
of an agricultural crop, you might include an uncertain variable called 
Amount of Rainfall.  It is reasonable to assume that other variables in 
your model such as Crop Price and Fertilizer Cost would have no 
effect on the amount of rain — Amount of Rainfall is an independent 
variable. 

A dependent variable, in contrast, is determined in full or in part by 
one or more other variables in your model.  For example, a variable 
called Crop Yield in the above model should be expected to depend 
on the independent variable Amount of Rainfall.  If there's too little or 
too much rain, then the crop yield is low.  If  there's an amount of rain 
that is about normal, then the crop yield would be anywhere from 
below average to well above average.  Maybe there are other variables 
that affect Crop Yield such as Temperature, Loss to Insects, etc. 

When identifying the uncertain values in your Excel worksheet, you 
have to decide whether your variables are correlated.  These variables 
would all be “correlated” with each other.  The Corrmat function in 
@RISK is used to identify correlated variables.  It is extremely 
important to correctly recognize correlations between variables or 
your model might generate nonsensical results.  For example, if you 
ignored the relationship between Amount of Rainfall and Crop Yield, 
@RISK might choose a low value for the rainfall at the same time it 
picked a high value for the crop yield — clearly something nature 
wouldn't allow. 

Output Variables 
Any model needs both input values and output results, and a Risk 
Analysis model is no different.  An @RISK Risk Analysis generates 
results on cells in your Excel worksheet.  Results are probability 
distributions of the possible values which could occur.  These results 
are usually the same worksheet cells that give you the results of a 
regular Excel analysis — Profit, the "bottom line" or other such 
worksheet entries.   

Independent or 
Dependent 
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Analyzing a Model with Simulation 
Once you have placed uncertain values in your worksheet cells and 
have identified the outputs of your analysis, you have an Excel 
worksheet that @RISK can analyze. 

Simulation 
@RISK uses simulation, sometimes called Monte Carlo simulation, to 
do a Risk Analysis.  Simulation in this sense refers to a method 
whereby the distribution of possible outcomes is generated by letting 
a computer recalculate your worksheet over and over again, each time 
using different randomly selected sets of values for the probability 
distributions in your cell values and formulas.  In effect, the computer 
is trying all valid combinations of the values of input variables to 
simulate all possible outcomes.  This is just as if you ran hundreds or 
thousands of "what-if" analyses on your worksheet, all in one sitting. 

What is meant by saying that simulation "tries all valid combinations 
of the values of input variables"?  Suppose you have a model with 
only two input variables.  If there is no uncertainty in these variables, 
you can identify a single possible value for each variable.  These two 
single values can be combined by your worksheet formulas to 
calculate the results of interest — also a certain or deterministic value.  
For example, if the certain input variables are: 

Revenues = 100 
Costs = 90 

then the result 

Profits = 10 

would be calculated by Excel from 

Profits = 100 - 90 

There is only one combination of the input variable values, because 
there is only one value possible for each variable. 

Now consider a situation where there is uncertainty in both input 
variables.  For example, 

Revenues = 100 or 120  
Costs = 90 or 80 

gives two values for each input variable.  In a simulation, @RISK 
would consider all possible combinations of these variable values to 
calculate possible values for the result, Profits. 
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There are four combinations: 

Profits = Revenues - Costs 
10 = 100 - 90 
20 = 100 - 80 
30 = 120 - 90 
40 = 120 - 80 

Profits also is an uncertain variable because it is calculated from uncertain 
variables. 

How Simulation Works 
In @RISK, simulation uses two distinct operations: 
•  Selecting sets of values for the probability distribution functions contained in 

the cells and formulas of your worksheet 
•  Recalculating the Excel worksheet using the new values 

The selection of values from probability distributions is called sampling and 
each calculation of the worksheet is called an iteration. 

The following diagrams show how each iteration uses a set of single values 
sampled from distribution functions to calculate single-valued results.  
@RISK generates output distributions by consolidating single-valued results 
from all the iterations. 

The Alternative to Simulation 
There are two basic approaches to quantitative Risk Analysis.  Both have the 
same goal — to derive a probability distribution that describes the possible 
outcomes of an uncertain situation — and both generate valid results.  The 
first approach is the one just described for @RISK, namely, simulation.  This 
approach relies on the ability of the computer to do a great deal of work very 
quickly — solving your worksheet repeatedly using a large number of 
possible combinations of input variable values.   

The second approach to Risk Analysis is an analytical approach.  Analytical 
methods require that the distributions for all uncertain variables in a model 
be described mathematically.  Then the equations for these distributions are 
combined mathematically to derive another equation, which describes the 
distribution of possible outcomes.  This approach is not practical for most 
uses and users.  It is not a simple task to describe distributions as equations, 
and it is even more difficult to combine distributions analytically given even 
moderate complexity in your model.  Furthermore, the mathematical skills 
necessary to implement the analytical techniques are significant. 
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Making a Decision:  Interpreting the Results 
@RISK analysis results are presented in the form of probability 
distributions.  The decision-maker must interpret these probability 
distributions, and make a decision based on the interpretation.  How 
do you interpret a probability distribution? 

Interpreting a Traditional Analysis 
Let's start by looking at how a decision-maker would interpret a 
single-valued result from a traditional analysis — an "expected" value.  
Most decision-makers compare the expected result to some standard 
or minimum acceptable value.  If it's at least as good as the standard, 
they find the result acceptable.  But, most decision-makers recognize 
that the expected result doesn't show the impacts of uncertainty.  
They have to somehow manipulate the expected result to make some 
allowance for risk.  They might arbitrarily raise the minimum 
acceptable result, or they might non rigorously weigh the chances that 
the actual result could exceed or fall short of the expected result.  At 
best, the analysis might be extended to include several other results — 
such as "worst case" and "best case" — in addition to the expected 
value.  The decision-maker then decides if the expected and "best 
case" values are good enough to outweigh the "worst case" value. 

Interpreting an @RISK Analysis 
In an @RISK Risk Analysis, the output probability distributions give 
the decision-maker a complete picture of all the possible outcomes.  
This is a tremendous elaboration on the "worst-expected-best" case 
approach mentioned above.  But the probability distribution does a 
lot more than just fill in the gaps between these three values: 
•  Determines a "Correct" Range — Because you have more rigorously 

defined the uncertainty associated with every input variable, the possible 
range of outcomes may be quite different from a "worst case-best case" 
range — different, and more correct. 

•  Shows Probability of Occurrence —  A probability distribution 
shows the relative likelihood of occurrence for each possible outcome. 

As a result, you no longer just compare desirable outcomes with 
undesirable outcomes.  Instead, you can recognize that some outcomes 
are more likely to occur than others, and should be given more weight in 
your evaluation.  This process also is a lot easier to understand than the 
traditional analysis because a probability distribution is a graph — you 
can see the probabilities and get a feel for the risks involved. 
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Individual Preference 
The results provided by an @RISK analysis must be interpreted by 
you as an individual.  The same results given to different individuals 
may be interpreted differently, and lead to different courses of action.  
This is not a weakness in the technique, but a direct result of the fact 
that different individuals have different preferences with regard to 
possible choices, time, and risk.  You might feel that the shape of the 
output distribution shows that the chances of an undesirable outcome 
far outweigh the chances of a desirable outcome.  A colleague who is 
less risk averse might come to the opposite conclusion. 

The Distribution "Spread" 
Range and likelihood of occurrence are directly related to the level of 
risk associated with a particular event.  By looking at the spread and 
likelihood of possible results, you can make an informed decision 
based on the level of risk you are willing to take.  Risk averse 
decision-makers prefer a small spread in possible results, with most of 
the probability associated with desirable results.  But if you are a risk-
taker, then you will accept a greater spread or possible variation in 
your outcome distribution.  Furthermore, a risk-taker will be 
influenced by "bonanza" outcomes even if their likelihood of 
occurrence is small. 

Regardless of your personal risk preferences, there are some general 
conclusions about riskiness that apply to all decision-makers.  The 
following probability distributions illustrate these conclusions: 

Probability distribution A represents greater risk than B despite identical 
shapes because the range of A includes less desirable results — the spread 
relative to the mean is greater in A than B. 

A

-10 0 10  90 100 110

B
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Probability distribution C represents greater risk than D because the 
probability of occurrence is uniform across the range for C whereas it is 
concentrated around 98 for D. 

 

 

 

Probability distribution F represents greater risk than E because the range is 
larger and the probability of occurrence is more spread out than for E. 
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Skewness 
A simulation output distribution also can show skewness — how 
much the distribution of possible results deviates from being 
symmetrical.  Suppose your distribution had a large positive 'tail'.  If 
you saw only a single number for the expected result, you might not 
realize the possibility of a highly positive outcome that could occur in 
the tail.  Skewness such as this can be very important to decision 
makers.  By presenting all the information,  @RISK "opens up" a 
decision by showing you all possible outcomes. 
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What Risk Analysis Can (Cannot) Do 
Quantitative analysis techniques have gained a great deal of 
popularity with decision-makers and analysts in recent years.  
Unfortunately, many people have mistakenly assumed that these 
techniques are magic "black boxes" that unequivocally arrive at the 
correct answer or decision.  No technique, including those used by 
@RISK, can make that claim.  These techniques are tools that can be 
used to help make decisions and arrive at solutions.  Like any tools, 
they can be used to good advantage by skilled practitioners, or they 
can be used to create havoc in the hands of the unskilled.  In the 
context of Risk Analysis, quantitative tools should never be used as a 
replacement for personal judgment. 

Finally, you should recognize that Risk Analysis cannot guarantee 
that the action you choose to follow — even if skillfully chosen to suit 
your personal preferences — is the best action viewed from the 
perspective of hindsight.  Hindsight implies perfect information, 
which you never have at the time the decision is made.  You can be 
guaranteed, however, that you have chosen the best personal strategy 
given the information that is available to you.  That's not a bad 
guarantee! 
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Introduction 
@RISK 4.5 and its predecessor, @RISK 4.0, are major upgrades to 
earlier versions of @RISK.  @RISK 4.5 brings together features of its 
companion programs BestFit and RISKview to provide a fully 
functional risk analysis environment, while maintaining compatibility 
with earlier versions of @RISK. It also offers enhanced integration 
with Microsoft Excel to give easier access to simulation results 
directly in your spreadsheet. @RISK 4.5 is available in three versions – 
Standard, Professional and Industrial – to allow you to select the 
feature set you need. 

Key Features 
Key features of @RISK 4.5 include: 

•  Fully integrated RISKview (for distribution viewing) in all the 
versions.  

•  Fully integrated BestFit (for distribution fitting) in the 
Professional and Industrial versions.  

•  Fully integrated RISKOptimizer (for Simulation Optimization) in 
the Industrial version. 

Note: RISKview, BestFit and RISKOptimizer are also available as 
stand-alone programs. 

•  New toolbars, graphs and “Explorer” interface 

•  Improved integration with Excel with new functions and new 
reporting in Excel 

•  Improved performance with faster loading and simulation 

•  Full compatibility with existing @RISK models and functions 

Key enhancements of @RISK 4.5 vs. @RISK 4.0 include: 

•  Three new analyses – Goal Seek, Stress Analysis and Advanced 
Sensitivity Analysis – for advanced investigations on @RISK 
models (Professional and Industrial versions only) 

•  Alternate parameters (such as percentiles) can be used for 
defining many distribution types, and the distribution functions 
in Excel have been added that support alternate parameters 

•  Quick reports, designed for printing, for quick, single page 
reports on simulation results 
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•  Integrated support for multiple CPUs in a single PC for high-
speed simulations through parallel processing (Industrial version 
only) 

•  Enhanced Define Distribution window, including pop-up 
distribution pallette, intelligent default parameters, easy entry of 
Excel cell references and more 

•  Other enhancements, including improved filtering, report 
formatting and more 

Note: The information provided in this chapter is designed for users 
familiar with earlier versions of @RISK.  New users should skip this 
chapter and continue with Chapter 4: Getting to Know @RISK to 
gain a full understanding of the operation and features of @RISK 4.5. 

@RISK 4.5 is comprised of three main components: 

1) @RISK Model window for listing inputs and outputs, viewing 
input distributions, fitting distributions, and defining 
correlations. @RISK Model also allows the pop-up graphical 
definition of distributions for components of cell formulas. 

2) @RISK add-in to Excel, including new menus and icons, new 
distribution functions, new statistics functions, new output 
functions, and new simulation reports in Excel.   

3) @RISK Results window for interactive graphs of simulation 
results, statistics, data, sensitivity and scenario reports. 

Each of the three components share a common user interface 
including an “Explorer-style” listing of simulation inputs and outputs 
and customizable toolbars and icons. 

Three Main 
Components 
of @RISK 4.5 
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New @RISK Model Window 
A new @RISK Model Window provides an entire set of options for 
assigning and viewing probability distributions used in your 
spreadsheet model, correlating them, and fitting distributions to data.  
This window allows you to handle all the tasks necessary for setting 
up your @RISK model prior to simulating it. 
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Defining Probability Distributions in your 
Spreadsheet 
With @RISK 4.5 you can easily assign probability distributions to 
uncertain values in your spreadsheet model using a “pop-up” 
window.  This capability will be familiar to users of Palisade’s 
RISKview program.   

 
Using this pop-up, you can: 

•  Preview and assign probabilities to values in Excel cells and 
formulas.  This allows the quick, graphical assignment of 
distributions to any number or entry in an Excel cell formula, plus 
editing of previously entered distribution functions. 

•  Automatically enter distribution functions to formulas.  All 
edits made via RISKview pop-up are added directly to the cell 
formula in Excel. 

•  Fit probability distributions to data in Excel and use the results 
of the fit as a probability distribution in a formula. 

•  The pop-up window also allows you to edit multiple 
distributions in a single cell. 

Pop-Up Window 
for Assigning 
Distributions 
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With @RISK 4.5’s pop-up Define Distribution window, you can 
interactively switch between available probability distributions and 
preview the probabilities they describe.  While previewing 
distributions, you can: 

•  Interactively set and compare probabilities using sliding 
delimiters.  

•  Overlay multiple distributions to make comparisons. 

•  Change graph type and scaling using toolbars and the mouse. 

Review Distributions in the @RISK Model Window 
The @RISK Model window provides a complete “Explorer-style” list 
of all input probability distributions and simulation outputs described 
in your model.  This replaces the Outputs and Inputs list found in 
@RISK version 3.5 and earlier.  From this list, you can: 

•  Edit any input distribution or output by simply clicking on 
output or input in Explorer. 

•  Quickly graph and display all defined inputs. 

•  Edit and preview correlation matrices. 

 

Graphical 
Assessment of 
Probabilities 

Correlation 
Matrix and 
Distribution 
Graphs in the 
Model Window 
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Using Data to Define Probability Distributions 
The @RISK Model window fully integrates a new and enhanced 
version of Palisade’s BestFit program to allow you to fit probability 
distributions to your data (Professional and Industrial versions only).  
The distributions which result from a fit are then automatically added 
to the input distribution list in the @RISK Model window and added 
to your spreadsheet model.  

 
The distribution fitting features of the @RISK Model window include: 

•  The fitting of sample data (continuous or discrete) and data 
from a density or cumulative curve. 

•  Convenient result display that shows all relevant information 
about a single fit. 

•  Ranking of fits based on Chi-Squared, Kolmogorov-Smirnov, or 
Anderson-Darling statistics. 

•  Comparison graphs, difference graphs and P-P and Q-Q plots. 

•  Statistics and Goodness-of-fit tests. 

•  A summary window with results of all fits in a single report. 

•  Advanced fitting control, including the ability to control exactly 
how the Chi-Squared statistic is calculated using equal interval 
binning, equal probability binning or custom binning. 

•  Ability to define a custom list of predefined distributions for 
fitting. 

•  Ability to define multiple fits in a single project using a tabbed 
format similar to Microsoft Excel. 

Distribution 
Fitting in @RISK 
Model Window 
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New @RISK Add-in Features 
@RISK 4.5 includes a variety of new functions, menus and commands 
that make it easy to define your simulation model directly in your 
spreadsheet. This new functionality is provided in a new add-in 
program RISK.XLA that is installed with @RISK. 

New Menus, Icons and Commands 
The @RISK 4.5 add-in program in Excel includes the following new 
menus and commands: 

•  An @RISK menu is added to the Excel menubar.  This contains all 
commands necessary for setting up and running a simulation of 
your spreadsheet model. 

•  An @RISK “pop-up” menu is displayed on a right mouse click on 
a spreadsheet cell.  This menu allows you to define probability 
distributions for values in a cell formula and define simulation 
outputs. 

•  Reports icon for selecting reports on simulation results to be 
generated in Excel. 

New and Enhanced @RISK Functions in Excel 
@RISK 4.5 includes both new and enhanced custom functions that can 
be included in Excel cells and formulas. These functions include the 
RiskOutput function, @RISK statistics functions, enhanced @RISK 
distribution functions and @RISK reporting functions. 

Output cells are defined using new RiskOutput functions.  These 
functions allow easy copying, pasting and moving of output cells.  
RiskOutput functions are automatically added when the standard 
@RISK Add Output icon is pressed. RiskOutput functions optionally 
allow you to name your simulation outputs and add individual 
output cells to output ranges.  A typical RiskOutput function might 
be: 

=RiskOutput(“Profit”)+NPV(.1,H1…H10) 

where the cell, prior to its selection as a simulation output, simply 
contained the formula 

= NPV(.1,H1…H10) 

The added RiskOutput function here selects the cell as a simulation 
output and gives the output the name “Profit”. 

RiskOutput 
Functions 
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New @RISK statistics functions return a desired statistic on simulation 
results.  For example, the function RiskMean(A10) returns the mean of 
the simulated distribution for the cell A10.  These functions are 
updated real-time as a simulation is running. 

@RISK statistics functions include all standard statistics plus 
percentiles and targets (for example, =RiskPercentile(A10,.99) ) returns 
the 99th percentile of the simulated distribution).  @RISK statistics 
functions can include cell references for arguments just as standard 
Excel functions. 

A special @RISK function RiskResultsGraph will automatically place a 
graph of simulation results wherever it is used in a spreadsheet.  For 
example, =RiskResultsGraph (A10) would place a graph of the 
simulated distribution for A10 directly in your spreadsheet at the 
function's location at the end of a simulation.  Additional optional 
arguments to RiskResultsGraph allow you to select the type of graph 
you want to create, its format, scaling and other options. 

Additional options for @RISK probability distribution functions can 
be used to name input probability distributions, truncate their 
sampling, correlate them, and temporarily block sampling.  These 
options are invoked through additional optional arguments to 
distribution functions.  For example, the distribution function: 

=RiskNormal(10,5,”Price”,RiskTruncate(0,15))  

would specify a normal distribution named Price with a mean of 10, a 
standard deviation of 5,  a minimum possible value of 0, and a 
maximum of 15. 

All new arguments to @RISK probability distribution functions are 
optional as all functions can be used as they were in earlier versions of 
@RISK. 

Any standard simulation report can be placed directly in Excel at the 
end of a simulation.  You can select to place pre-formatted simulation 
reports and graphs directly in Excel, without going through the 
@RISK Results program.  You can also create custom templates which 
allow you to generate a standard report in Excel after each simulation. 

Note: In @RISK 4.5, a simulation model is defined by the @RISK 
entries in cell formulas (distribution functions, outputs) and can run 
entirely within Excel, without accessing @RISK Model for model 
definition or @RISK Results for viewing results. 

Statistics 
Functions 

Graphing 
Function 

Enhanced 
Distribution 
Functions 

Reporting in 
Excel 
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New @RISK Results Window 
The @RISK Results window familiar to users of earlier versions of 
@RISK has been enhanced to provide more interactive reporting and 
graphing of simulation results.   

 

New Results Window Options 
New features in the @RISK Results window include: 
•  “Explorer” style list of outputs and inputs for which simulation 

results were collected. 

•  Graphing of simulated distributions by simply clicking on 
output or input in Explorer. 

•  Graphs include tabbed reports on statistics, data, sensitivities, 
and scenarios for graphed results, and any overlays. 

•  Most graph changes can be made using toolbars and mouse, 
including  rescaling by dragging axes and setting the graph type 
using toolbar icons. 

•  Probabilities can be set and compared using sliding delimiters. 

•  Full report windows each provide a standard @RISK report 
(statistics, data, sensitivities, scenarios). 

•  The placement of related reports and graphs on separate tabs. 
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Reporting in @RISK 4.5 is not only available in the @RISK Results 
window.  In addition to the interactive graphs and reports of 
simulation results available in the @RISK Results window, you can 
use statistics and graphing functions and add-in reports to place your 
simulation results directly in Excel. 

 
All @RISK graphs may be created as standard Excel format graphs to 
allow easy editing and customization in your spreadsheet.  All 
standard Excel editing options are available for these improved 
@RISK 4.5 Excel format graphs. 

 

Reports in 
Results Window 
and Excel 

Graphs in Excel 
Format 
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Other Enhancements 
@RISK 4.5 includes other enhancements to improve the usability of 
simulations and spreadsheet models created with @RISK, including: 

•  Real time updating of simulation results 

•  A single results datafile with the .RSK extension to ease the 
transfer of simulation models among users. 

•  All simulation settings (outputs, # of iterations, etc.) stored in 
the workbook being simulated so a model may be used and 
simulated without a saved .RSK file 

•  Command/Icon in Excel to select all cells containing @RISK 
distribution functions or outputs 
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Chapter 3: Upgrade Guide 49 

New Features in @RISK 4.5 vs @RISK 4.0 
@RISK 4.5 brings a set of new analyses and new options to allow 
easier modeling and more in-depth studies on @RISK 4.0 models.  
New enhancements include: 

•  Three New Advanced Analyses - Advanced Sensitivity 
Analysis, Stress Analysis, and Goal Seek (@RISK Professional 
and Industrial only) 

•  Alternate Parameters for Probability Distributions, allowing the 
entry of percentile parameters as arguments to many input 
probability distributions.  These alternate parameters are 
available in both the pop-up Define Distribution window or in 
distribution functions in Excel. 

•  Cumulative Descending Percentiles, where percentile 
probabilities can be optionally reported as cumulative descending 
values as well as cumulative ascending values.  Alternate 
percentile parameters for probability distributions can also be 
entered as cumulative descending percentiles. 

•  Quick Reports - single one page reports in Excel containing 
statistics and graphs for a simulation result, formatted for 
printing. 

•  Enhanced Define Distribution window, with point and click 
selection of references from Excel, a pop-up distribution palette 
for selecting distributions, a new right-click menu and other 
enhancements.   

•  Improved Error Reporting during simulation, where the Pause 
On Error option now identifies the output(s) with errors and the 
cells in your model that caused the error for each. 

The RISK45 directory on your system contains multi-media tutorials 
that illustrate the new capabilities of @RISK 4.5.  These tutorials 
require a media player capable of running .WMV files and a PC with 
audio. 
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Advanced Analyses 
The Advanced Analyses include Advanced Sensitivity Analysis, 
Stress Analysis, and Goal Seek.  Each of these uses @RISK's multiple 
simulation capability to analyze a simulation model.  

•  Goal Seek allows you to find a specific simulated statistic for 
a cell (for example, the mean or standard deviation) by 
adjusting the value of another cell.  

•  Stress Analysis allows you to analyze the effects of stressing 
@RISK distributions. Stressing a distribution restricts samples 
drawn from the distribution to values between a specified 
pair of percentiles or samples a new “stress” distribution 
instead of the original distribution in your model. 

•  Advanced Sensitivity Analysis allows you to determine the 
effects of inputs on @RISK outputs. An input can be either an 
@RISK distribution or a cell in your Excel workbook.  
Advanced Sensitivity Analysis runs a full simulation at each 
of a set of possible values for an input, tracking the simulation 
results at each value.  

Each of these analyses has its own dialogs and generates a set of pre-
formatted reports and graphs in Excel. 
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Alternate Parameters for Probability Distributions 
@RISK 4.5 allows the entry of percentile parameters as arguments to 
many input probability distributions.  This allows you to specify 
values for specific percentile locations of an input distribution as 
opposed to the traditional arguments used by the distribution.  For 
example, the distribution: 

RiskNormal(100,20) – specifying a normal distribution with a mean 
of 100 and a standard deviation of 20 

could also be entered as: 

RiskNormalAlt(5%, 67.10, 95%, 132.89) - specifying a normal 
distribution with the 5th percentile at the value of 67.10 and the 95th 
percentile at the value of 132.89. 

Percentiles may also be mixed with the standard distribution 
arguments, such as: 

RiskNormalAlt("mu", 100, 95%, 132.89) - specifying a normal 
distribution with a mean of 100 and the 95th percentile at the value of 
132.89. 

These alternate parameter functions may be entered directly in your 
spreadsheet as with other @RISK distribution functions, or in the 
Define Distribution window: 
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Clicking the ALT icon allows you to switch from standard 
distribution arguments to alternate percentile arguments: 

 
A set of percentile arguments may be set as the default for a given 
distribution type, so that every lognormal distribution, for example, 
will be entered using a 10th and 90th percentile value. 

During a simulation @RISK calculates the appropriate distribution 
whose percentile values equal those alternate parameter values 
entered and then samples that distribution.  Just like all @RISK 
functions, the entered arguments may be references to other cells or 
formulas, and argument values may change iteration to iteration 
during a simulation.  

For more information on the @RISK distributions that are available 
using alternate parameters, see the Reference: @RISK Functions 
chapter of this manual, or check the list shown when the class of 
functions titled @RISK Distrib (Alt Params) is shown in the Function 
Wizard in Excel. 

Cumulative Descending Percentiles 
@RISK 4.5 can report percentile probabilities as cumulative 
descending values as well as cumulative ascending values.  This 
option causes reports to display percentiles as the probability of 
obtaining a value above a given threshold.  The display of cumulative 
descending percentiles is selected on the @RISK add-in menu Options 
command. 

Cumulative descending percentiles may also be used in specifying 
alternate percentile parameters for probability distributions.  In 
addition, arguments to the RiskCumul probability distribution may 
be entered using descending probabilities.  A new set of @RISK 
functions allow the entry of these cumulative descending values.  
Each of these functions has a "D" after the function name, such as 
RiskCumulD, RiskNormalAltD, etc.  For more information on using 
these functions, see the Reference: @RISK Functions chapter of this 
manual. 

The ALT icon 

Sampling 
Distributions 
with Alternate 
Parameters 
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Quick Reports 
Quick Reports are single one page reports in Excel containing 
statistics and graphs for a simulation result.   

Quick reports can be generated by simply right clicking on a graph in 
the @RISK Results Window and selecting Quick Report, or through 
the @RISK Report Settings dialog.  Using the Settings dialog, you 
may also choose to automatically generate Quick Reports for each 
output in your model at the end of a simulation. 
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Enhanced Define Distribution Window 
The pop-up Define Distribution window includes several new 
enhancements designed to make the graphical definition of 
probability distributions easier.  These include: 

•  A new Enter Excel Reference icon allows the point and click 
selection of cell references for distribution arguments 

•  A pop-up distribution palete (displayed when the Dist.. button is 
clicked) makes the selection of a distribution type easier 

 
•  A new right-click menu for easy selection of Define Distribution 

window options 



56 New Features in @RISK 4.5 vs @RISK 4.0 

 

Improved Error Reporting 
The Pause on Error in Outputs option in the Simulation Settings 
dialog now provides a detailed listing of the outputs for which errors 
were generated during a simulation and the cells in your spreadsheet 
that caused the error. 

 
When an error is generated for a simulation output in an iteration of a 
simulation, the Pause on Error in Outputs dialog shows each output 
for which an error was generated and the cell whose formula caused 
the output's error value. You can also review the formulas and values 
for cells which are precedents to the "error causing" cell, in order to 
examine values which feed into the problem formula.
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A Quick Overview to @RISK 
@RISK extends the analytical capabilities of Microsoft Excel to include risk 
analysis and simulation.  These techniques allow you to analyze your 
spreadsheets for risk.  Risk Analysis identifies the range of possible 
outcomes you can expect for a spreadsheet result and their relative 
likelihood of occurrence.  

To add risk analysis capabilities to your spreadsheet @RISK uses 1) 
menus, Toolbar and custom functions in your spreadsheet, 2) a Model 
window for defining model inputs and 3) a Results window for 
reviewing simulation results.  

@RISK Toolbars   

The Toolbars are used to make selections from @RISK or your spreadsheet 
in "add-in" style.  In addition, the DecisionTools toolbar is used to access 
the other programs in the DecisionTools Suite.  See Appendix B: Using 
@RISK with Other DecisionTools for more information on the Suite. 

Note: The @RISK add-in in Excel has two available toolbars – the 
standard toolbar and an expanded version that contains tools for the 
Advanced Analyses available in @RISK Professional and Industrial. 
Clicking the "expansion" icon at the end of the toolbar changes the toolbar 
from standard to expanded and back. 

The material in this chapter is presented on-line in the @RISK tutorial.  
This can be run by selecting the Start Menu/ Programs/ Palisade 

Using the On-
line Tutorial 
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DecisionTools/ Tutorials/ @RISK Tutorial and clicking on the file 
RISK45.html.    

How Does Risk Analysis Work? 
@RISK uses the technique of Monte Carlo simulation for risk analysis.  
With this technique, uncertain input values in your spreadsheet are 
specified as probability distributions. An input value is a value in a 
spreadsheet cell or formula which is used to generate results in your 
spreadsheet.  In @RISK, a probability distribution which describes the 
range of possible values for the input is substituted for its original single 
fixed value.  To find out more about inputs and probability distributions, 
see Chapter 2 of this User’s Guide, An Overview to Risk Analysis. 

Distribution Functions 
In @RISK, probability distributions are entered directly into your 
worksheet formulas using custom distribution functions.  These new 
functions, each of which represents a type of probability distribution 
(such as NORMAL or BETA), are added to your spreadsheets' functions 
set by @RISK.  When entering a distribution function you enter both the 
function name, such as RiskTriang — a triangular distribution — and the 
arguments which describe the shape and range of the distribution, such as 
RiskTriang (10,20,30), where 10 is the minimum value, 20 the most likely 
value and 30 the maximum value.   

Distribution functions may be used anywhere in your spreadsheet that 
there is uncertainty about the value which is used.  @RISK's functions 
may be used just as you would use any normal spreadsheet functions — 
include them in mathematical expressions and have cell references or 
formulas as arguments. 
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@RISK includes a pop-up Define Distribution window that allows you to 
easily add probability distribution functions to spreadsheet formulas.  By 
right-clicking on a cell in your spreadsheet (or by clicking the Define 
Distribution icon) you can display this window. 

 
The @RISK Define Distribution window graphically displays probability 
distributions which can be substituted for values in a spreadsheet 
formula.  By changing the displayed distribution you can see how various 
distributions would describe the range of possible values for an uncertain 
input in your model.  The displayed statistics further show how a 
distribution defines an uncertain input. 

The graphical display of an uncertain input is useful in showing your 
definition of an uncertain input to others.  It clearly displays the range of 
possible values for an input and the relative probability of any value in 
the range occurring.  Working with distribution graphs you can easily 
incorporate assessments of uncertainty from experts into your risk 
analysis models. 

Define 
Distribution 
Window 
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Simulation Outputs  
Once distribution functions have been entered into your spreadsheet, you 
need to identify those cells (or ranges of cells) that you are interested in 
seeing simulation results for.  Typically, these output cells contain the 
results of your spreadsheet model (such as "profit") but they can be any 
cells, anywhere in your spreadsheet.  To select outputs, simply highlight 
the cell or range of cells you want as outputs in your worksheet and then 
click the Add Output icon — the one with the red down arrow. 

Listing all Outputs and Distribution Functions 
The Model window displays all selected outputs and distribution 
functions in your spreadsheet model.   

 

This “Explorer-style” list on the left of the Model window allows you to: 

•  Edit any input distribution or output by simply clicking on output 
or input in Explorer. 

•  Quickly graph and display all defined inputs. 

•  Enter correlations between input distributions. 
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Using Data to Define Probability Distributions 
The @RISK Model window (Professional and Industrial versions only) 
also allows you to fit probability distributions to your data.  Fitting is 
done when you have a set of collected data that you want to use as the 
basis for an input distribution in your spreadsheet.  For example, you may 
have collected historical data on a product price and you might want to 
create a distribution of possible future prices that is based on this data.  
Fitting is done using the integrated capabilities of BestFit, a distribution 
fitting product also available from Palisade.  

 
 

If desired, the distributions which result from a fit can be assigned to an 
uncertain value in your spreadsheet model.  In addition, if data in Excel is 
used in a fit, it can be "hot-linked" so that the fit will automatically update 
whenever your data changes. 

Running a Simulation 
When a risk analysis is run, your spreadsheet is calculated over and over 
again — where each recalculation is a "iteration" — with a set of new 
possible values sampled from each input distribution each iteration.  Each 
iteration the spreadsheet is recalculated with the new set of sampled 
values and a new possible result is generated for your output cells. 

As a simulation progresses, new possible outcomes are generated each 
iteration.  @RISK keeps track of these output values.  A distribution of 
possible outcomes is created by taking all the possible output values 
generated, analyzing them and calculating statistics on how they are 
distributed across their minimum-maximum range. 

Distribution 
Fitting Window 
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Simulation Results 
@RISK simulation results include distributions of possible results for your 
outputs.  In addition, @RISK generates sensitivity and scenario analysis 
reports which identify the input distributions most critical to your results.  
These results are best presented graphically.  Available graphs include 
frequency distributions of possible output variable values, cumulative 
probability curves and summary graphs which summarize changing risk 
across a range of output cells. 

 
Simulation reports and graphs generated in the Results window are 
interactive, so you can easily manipulate graphs and reports to assess 
probabilities of different outcomes occurring.  You can also easily change 
graph types, overlay graphs on each other for comparison and perform 
other interactive reviews of simulation results. 

@RISK graphs and reports can be displayed either directly in your 
spreadsheet or in the Results window as shown above.  If you select to get 
simulation reports directly in Excel, a new workbook can be generated 
containing the reports you select. 

Graphs and  
Reports 
Generated by 
an @RISK 
Simulation in 
the Results 
Window 

Reporting in the 
Results window 
vs. in Excel 
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Simulation reports and graphs generated in the Excel window are less 
interactive than those displayed in the Results window, but you have 
access to all Excel’s capabilities for formatting the graphs and reports.  In 
addition, @RISK reports generated in Excel can use pre-built template 
sheets that contain custom formatting, titles, logos and more. 

Reports 
Generated in 
Excel by an 
@RISK 
Simulation  
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Advanced Analytical Capabilities 
Advanced capabilities are present in @RISK that allow sophisticated 
analysis of simulation data.  @RISK collects simulation data by iteration 
for both input distributions and output variables.  After completion of the 
simulation, it analyzes this data set to determine: 
•  Sensitivities, identifying the input distributions which are 'significant' in 

determining output variable value, and 
•  Scenarios, or the combinations of input distributions which generate output 

target values. 

 
 

The Sensitivity analysis — which identifies significant inputs — is carried 
out with two different analytical techniques.  The first technique used is a 
form of regression analysis.  With this analysis, sampled input variable 
values are regressed against output values, leading to a measurement of 
sensitivity by input variable. The second technique used is a rank 
correlation calculation.  With this analysis, correlation coefficients are 
calculated between the output values and each set of sampled input 
values.  The results of each form of sensitivity analysis can be displayed as 
a "tornado" type chart, with longer bars at the top representing the most 
significant input variables. 

Sensitivity 
Analysis  
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The Scenario analysis identifies combinations of inputs which lead to 
output target values.  Scenario analysis attempts to identify groupings of 
inputs which cause certain output values.  This allows simulation results 
to be characterized by statements such as "when Profit is 'high', significant 
inputs are low Operating Cost, very high Sales Price, high Sales Volume, 
etc." 

 
 

Scenario 
Analysis 
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Setting Up and Simulating an @RISK Model 
Now that you have a quick overview as to how @RISK works, let's step 
through the process of setting up an @RISK model in your spreadsheet 
and running a simulation on it.  We'll touch briefly on: 
•  Probability Distributions in Your Worksheet 
•  Correlations Between Distributions 
•  Running a Simulation 
•  Simulation Results 
•  Graphs of Simulation Results 

Probability Distributions in Your Worksheet 
As previously mentioned, uncertainty in an @RISK model is entered with 
distribution functions.  You can choose from over thirty different 
functions when entering uncertainty in your spreadsheet. Each function 
describes a different type of probability distribution.  The simplest 
functions are those such as TRIANG(min,most likely,max) or 
UNIFORM(min,max) which take arguments specifying the minimum, 
most likely or maximum possible value for the uncertain input.  More 
complex functions take arguments specific to the distribution — such as 
BETA(alpha,beta).   

For more sophisticated models, @RISK allows you to set up distribution 
functions which use cell references and spreadsheet formulas for function 
arguments.  Many powerful modeling features can be created by using 
these types of functions.  For example, you can set up a group of 
distribution functions across a spreadsheet row, with the mean of each 
function determined by the value sampled for the prior function. 
Mathematical expressions can also be used as arguments for distribution 
functions. 
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All distribution functions can be defined and edited using the pop-up 
Define Distribution window.  The Define Distribution window can also be 
used to enter multiple distribution functions in a cell’s formula, enter 
names that will be used to identify an input distribution, truncate a 
distribution, fit distributions to data and use a fit result as a distribution in 
a cell and more.  Multiple distribution functions in a cell formula can be 
assigned and edited using the Define Distribution window. 

All entries made in the Define Distribution Window are converted to 
distribution functions that are placed in your spreadsheet.  For example, 
the distribution function created by the entries in the window displayed 
here would be: 

=RiskNormal(3000,1000,RiskTruncate(1000,5000)) 

Thus, all the distribution arguments that are assigned through the Define 
Distribution window can also be entered directly in the distribution itself.  
In addition, all arguments can be entered as cell references or as formulas, 
just as are standard Excel functions.   

It often helps to first use the Define Distribution window to enter your 
distribution functions to better understand how to assign values to 
function arguments.  Then, once you better understand the syntax of 
distribution function arguments, you can enter the arguments yourself 
directly in Excel, bypassing the Define Distribution window. 

Distributions in 
the Pop-Up 
Window 

Define 
Distribution 
Window and 
Resulting  
Functions in 
Excel 
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Note: @RISK distribution functions have both required and optional 
arguments.  The only required arguments are the numeric values which 
define the range and shape of the distribution.  All other arguments, such 
as name, truncation, correlation and others, are optional and can be 
entered only when needed. 

Fitting Distributions To Data 
The @RISK Model window also allows you to fit probability distributions 
to your data (Professional and Industrial versions only).  Fitting is done 
when you have a set of collected data that you want to use as the basis for 
an input distribution in your spreadsheet.  For example, you may have 
collected historical data on a product price and you might want to create a 
distribution of possible future prices that is based on this data.   You can 
also quickly fit data and assign a fit result to a distribution in your model 
by clicking the New Fit button in the Define Distribution window. 

 
The distributions which result from a fit are listed in the Fit Result 
window and the comparison of each fitted distribution with the 
underlying data can be displayed by clicking through the list.  

Distribution 
Fitting Window 
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A variety of options are available for controlling the fitting process.  
Specific distributions can be selected to be fit.  In addition, input data can 
be in the form of sample, density or cumulative data.  You can also filter 
your data prior to fitting. 

 
Comparison, Difference, P-P and Q-Q plots are available to help you 
examine the results of your fits.  Delimiters on graphs allow you to 
quickly calculate probabilities associated with values in fitted 
distributions. 

 

Fitting Options 

Fit Reports 
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Fitting Data to Define a Distribution 
The Define Distribution window allows you to quickly fit distributions to 
data in Excel and use the distributions from the fit in your model.  
Clicking New Fit from the pop-up window allows you to quickly identify 
data in Excel, run a fit and then assign a resulting distribution to an 
uncertain value in your model. 

 
Data in Excel can then be "linked" to your fit.  If the data changes, your fit 
will automatically update and the distribution function from the new fit 
result will be placed in your model! 



74 Setting Up and Simulating an @RISK Model 

 

To help you view your model,  @RISK detects all distribution functions 
entered in your worksheet and places them the Explorer list in the @RISK 
Model window.  This list summarizes all the distribution functions you 
have entered, with their location and "name", so you can clearly see how 
you have defined the uncertainty in your model.  Clicking the List icon in 
the @RISK Toolbar in Excel — the one with a red and blue arrow — 
displays the Model Window with the Outputs and Inputs list, along with 
a window that summarizes all input distributions and outputs that have 
been selected. 

 
Using the Explorer style Outputs and Inputs list in the Model window, 
you can review and edit all the distribution functions you have entered.  It 
is easy to graph all your input distributions at once for comparison or 
presentation purposes. 

In the Model window all distribution functions can be edited just as if 
they were displayed in the Define Distribution pop-up window.  Changes 
made to distributions are automatically written to your spreadsheet 
formulas.  

 

 
List Icon 

Input 
Distribution 
Functions in 
Worksheet 
FINANCE 
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Correlating Input Variables 
During a simulation analysis it is important to account for correlation 
between input variables.  Correlation occurs when the sampling of two or 
more input distributions are related — for example, when the sampling of 
one input distribution returns a relatively "high" value, it may be that 
sampling a second input should also return a relatively high value.  A 
good example is the case of one input named "Interest Rate" and a second 
input called "Housing Starts".  There may be a distribution for each of 
these input variables, but the sampling of them should be related to avoid 
nonsensical results.  For example, when a high Interest Rate is sampled, 
Housing Starts should be sampled as relatively low.  Conversely, you 
would expect that when Interest Rates are low, Housing Starts should be 
relatively high.   

 
The Model window allows you to specify correlations between your 
inputs through correlation matrices.  The Explorer list has a heading 
Correlations (along with Outputs and Inputs) that expands to show all 
correlation matrices you have defined. 

Matrices are defined in the Model window by selecting input 
distributions in the inputs list and selecting the Model menu Correlate 
Inputs command.  Inputs may also be dragged from the Explorer list onto 
a pre-existing matrix.  Then, you can assign the correlation coefficients 
between these inputs in the displayed matrix. Correlation coefficients can 
be between -1 and 1, with –1 specifying complete negative correlation of 
the sampling of two inputs and 1 specifying complete positive correlation 
of the sampling of two inputs. 

Correlation 
Matrix 

Correlations in 
the Model 
Window 
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As with the Define Distribution window, correlation matrices entered in 
the Model window cause @RISK functions to be entered in your 
spreadsheet model.  A sheet named @RISK Correlations is also created in 
Excel that displays your entered matrix.  RiskCorrmat functions are added 
that contain all the correlation information that was entered in your 
matrix.  Once you see the RiskCorrmat entries that are created by the 
Model window and are comfortable with their syntax, you can enter these 
functions yourself directly in your spreadsheet, bypassing the Model 
window. 

Simulation Settings 
A variety of settings may be used to control the type of simulation @RISK 
performs.  A simulation in @RISK supports unlimited iterations and 
multiple simulations.   Multiple simulations allow you to run one 
simulation after another on the same model.  In each simulation you can 
change values in your spreadsheet so you can compare simulation results 
under different assumptions. 

 
In addition, simulation settings allow you to select either Latin Hypercube 
or Monte Carlo sampling types.  The update of the spreadsheet display 
may be turned on or off as desired.   

In the Macros tab, you can specify Excel spreadsheet macros to run 1) 
before a simulation, 2) after a simulation, 3) before each iteration's 
sampling and recalc and 4) after each iteration's sampling and recalc.  This 
allows custom applications created with the spreadsheet macro language 
to be integrated with @RISK.  

Available 
Simulation 
Settings 
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Simulation results may be reported in the interactive @RISK Results 
window or directly in Microsoft Excel.  The Reports icon on the @RISK 
toolbar in Excel allows you to select the type of reporting you want.   

 
When reports are placed directly in Microsoft Excel, you can select to use 
templates for each report that is generated.  These templates can contain 
custom formatting and titles. 

Reporting 
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Running a Simulation 
A simulation in @RISK involves repetitive recalculations of your 
worksheet.  Each recalculation is called an "iteration". Each iteration: 
•  All distribution functions are sampled.  
•  Sampled values are returned to the cells and formulas of the worksheet. 
•  The worksheet is recalculated. 
•  Values calculated for output cells are collected from the worksheet and stored. 

This repetitive recalculation process can run hundreds or thousands of 
iterations if necessary. 

Clicking the Simulate icon or selecting the Simulation menu Start 
command starts a simulation.  When a simulation is running you can 
watch Excel recalculate over and over using different sampled values 
from distribution functions, monitor the convergence of your output 
distributions and watch graphs of distributions of simulation results 
update real-time. 

@RISK includes a convergence monitoring capability to help evaluate the 
stability of the output distributions during a simulation.  As more 
iterations are run, output distributions become more "stable" as the 
statistics describing each distribution change less and less with additional 
iterations.  It is important to run enough iterations so that the statistics 
generated on your outputs are reliable.  However, there comes a point 
when the time spent for additional iterations is essentially wasted because 
the statistics generated are not changing significantly. 

 

 

 
Simulate Icon 

Convergence 

Monitoring 
Options 
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@RISK monitors a set of convergence statistics on each output distribution 
during a simulation. During monitoring, @RISK calculates these statistics 
for each output at selected intervals (such as every 100 iterations) 
throughout the simulation.  These statistics are then compared with the 
same statistics calculated at the prior interval during the simulation.  The 
amount of change in statistics due to the additional iterations is then 
calculated. 

As more iterations are run, the amount of change in the statistics becomes 
less and less until they "converge" or change less than a threshold percent 
you set. The statistics monitored on each output distribution are 1) the 
average percent change in percentile values (0% to 100% in 5% steps), 2) 
the mean and 3) the standard deviation.  

If desired, @RISK can run in Auto-Stop mode.  In this case @RISK will 
continue to run iterations until all outputs have converged.  The number 
of iterations required for output distributions to converge is dependent on 
the model being simulated and distribution functions included in the 
model.  More complex models with highly skewed distributions will 
require more iterations than simpler models. 

@RISK also allows you to preview your simulation results as a simulation 
is running.  Selecting the option Real Time Update of @RISK Results 
Window in the Settings dialog causes @RISK to begin updating 
simulation reports and graphs as the simulation runs.  By right-clicking 
on an output or an input in the Explorer list in the Results window, a real-
time graph of simulation results can be displayed.  These graphs show 
how the range and shape of the probability distribution of simulation 
results for the selected input or output changes as the run proceeds. 

 
Options for controlling Real Time Results are shown on a toolbar in the 
Results window.  Using this toolbar you can change the frequency (in 
iterations) with which reports and graphs are updated, turn updating on 
and off, and pause or stop a simulation. 

If you select Real Time Results and re-simulate a model, @RISK will 
update any reports or graphs displayed in the Results window.  These 
windows from the prior simulation will not be closed when a new run 
starts.  This allows you to keep graph formatting and reports consistent 
run to run. 

Real-Time 
Graphs of 
Results During 
a Simulation 

Real Time 
Results Toolbar 
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Simulation Status 
@RISK provides on-going monitoring of the progress of a simulation.  A 
counter displays the current iteration# and simulation# and convergence 
statistics are continuously updated. 

 

An Executing 
Simulation with 
Convergence 
Monitoring and 
Status Display 
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Results Window 
The interactive Results window can be used to display your simulation 
results.  It will be displayed after the run is complete.  As with the @RISK 
Model window, the @RISK Results window has an Explorer list showing 
all outputs and inputs for which simulation results were collected.  

 
Simulation results generated by @RISK include statistics and data reports 
for both input and output variables.  Statistics generated include 
minimum and maximum calculated values, mean, standard deviation and 
percentiles.  Simulation data can also be displayed by iteration, with all 
sampled input values and calculated output values shown. 

The Results window toolbar allows you to quickly display simulation 
reports on screen.  The Summary Statistics icon displays summary 
statistics by output and input variable.  The Detailed Statistics icon 
displays detailed statistics for each variable. The Data icon shows 
calculated output values and sampled input values by iteration. The 
Sensitivities icon displays sensitivity analysis results for each output. The 
Scenario Analysis icon displays scenario analysis results for each output. 

 

 

Simulation 
Statistics 

Results Window 
Toolbars 
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Target values can be calculated on simulation results.  A target shows the 
probability of achieving a specific outcome or the value associated with 
any probability level.  Using targets you can answer questions such as 
"What is the chance of a result greater than one million?" or "What is the 
chance of a negative outcome?".  Targets can be entered in the Summary 
Statistics window, the Detailed Statistics window, and can be set directly 
using delimiters on graphs of simulation results. 

 

By entering a desired target – such as 99% - for an output in the Summary 
Statistics window and copying it across all outputs, you can quickly see 
the same target calculated for all simulation results. 

Statistics 
Display 

Targets  
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Filters can be used to remove unwanted values from statistics calculations 
and graphs.  You would use a filter, for example, if you wanted to see 
statistics on only the positive outcomes in a model. Filters can be entered 
using the Filter dialog or in the Simulation Statistics window. 

 

Filters 
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Graphing Results 
Simulation results are easily expressed with graphs.   Right-clicking any 
output or input in the Explorer list in the Results window allows you to 
graph the simulation results for the selected output or input. 

A graph of the results for an output shows the range of possible outcomes 
and their relative likelihood of occurrence.  This type of graph may be 
displayed in standard histogram or frequency distribution form.  
Distributions of possible outcomes may also be displayed in cumulative 
form.   

 
Each graph created by @RISK is displayed in conjunction with the 
statistics, data, sensitivity and scenario results for the output or input that 
is graphed.  The type of graph displayed may be changed using the icons 
in the Graph toolbar.  In addition, by clicking the right mouse button on a 
graph window, a pop-up menu is displayed with commands that allow 
the changing of a graph’s format, scaling, colors, titles and other 
characteristics.  Each graph may be copied to the clipboard and pasted 
into your spreadsheet.  As graphs are transferred as Windows metafiles, 
they may be resized and annotated once pasted into a spreadsheet. 

Using the Graph in Excel command, graphs can be drawn in Excel's 
native graph format.  These graphs can be changed or customized just as 
with any Excel graph. 

 
 

Simulation 
Results in 
Histogram and 
Cumulative 
Format 
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By dragging the delimiters displayed on a histogram or cumulative graph, 
target probabilities may be calculated. When delimiters are moved, 
calculated probabilities are shown both in the delimiter bar beneath the 
graph and in the displayed statistics report.  This is useful for graphically 
displaying answers to questions such as “What is the probability of a 
result between 1 million and 2 million occurring?” and “What is the 
probability of a negative result occurring?”. 

Many times it is useful to compare several simulated distributions 
graphically.  This can be done using overlay graphs. 

 
Overlays are added by using the Overlay on Active Graph command on 
the Explorer right-click popup menu.  Once overlays are added, delimiter 
statistics display probabilities for all distributions included in the overlay 
graph. Data, sensitivities and scenarios are also displayed for all overlays. 

Each distribution in an overlay graph can be formatted independently.  By 
using the Style tab options in the Graph Format dialog box, the color, 
style and pattern of each curve in the overlay graph may be set. 

 

Delimiters 

Overlaying 
Graphs for 
Comparison 

Formatting 
Graphs 
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Where output variables have been selected as a "range" of cells — that is, 
you select a range of spreadsheet cells and click the "Add Output" button 
— summary graphs of risk are created following a simulation.  A 
Summary graph displays how risk changes across a range of output cells.   

 
A Summary graph is especially useful in displaying trends such as how 
risk changes across time.  If, for example, a range of 10 output cells 
contained Profit in years 1 through 10 of a project, the Summary graph for 
this range shows how your risk changed across the 10 year period.  The 
narrower the band, the less the uncertainty about your Profit estimates. 
Conversely, the wider the band the greater the possible variance in Profit 
and the greater the risk. 

The center line of the Summary graph represents the trend in mean value 
across the range.  The two outer bands above the mean are 1 standard 
deviation above the mean and the 95th percentile.  The two outer bands 
below the mean are one standard deviation below the mean and the 5th 
percentile.  The definition of these bands can be changed using the Type 
tab in the Graph Format dialog box. 

 

 

 

 

 

 

Summary 
Graphs 
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Sensitivity Analysis Results 
Sensitivity analysis results are displayed by clicking the Insert New 
Sensitivity Window icon.  These results show the sensitivity of each 
output variable to the input distributions in your worksheet.  This 
identifies the most "critical" inputs in your model. These are the inputs 
you should concentrate on most when making plans based on your 
model. 

 
The data displayed in the Sensitivity window is ranked for the output 
selected in the Rank Inputs for Output: entry window.  The sensitivity of 
all other outputs to the ranked inputs is also shown. 

Sensitivity analyses performed on the output variables and their 
associated inputs use either multivariate stepwise regression or a rank 
order correlation.  The type of analysis desired is set using the Display 
Significant Inputs Using: entry in the Sensitivity Window.   

In the regression analysis, the coefficients calculated for each input 
variable measure the sensitivity of the output to that particular input 
distribution.  The overall fit of the regression analysis is measured by the 
reported fit or R-squared of the model.  The lower the fit the less stable the 
reported sensitivity statistics.  If the fit is too low — beneath .5 — a similar 
simulation with the same model could give a different ordering of input 
sensitivities. 

The sensitivity analysis using rank correlations is based on the Spearman 
rank correlation coefficient calculations.  With this analysis, the rank 
correlation coefficient is calculated between the selected output variable 
and the samples for each of the input distributions. The higher the 
correlation between the input and the output, the more significant the 
input is in determining the output's value. 
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Sensitivity results are graphically displayed in tornado graphs.  A tornado 
graph can be generated by right-clicking any output in the Explorer list or 
selecting the Tornado Graph tab in a displayed graph window. 

 

Scenario Analysis Results 
The Scenarios Window icon displays the Scenario analysis results for your 
output variables.  Up to three scenario targets may be entered for each 
output variable. 

 

Tornado Graph 
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The Scenario analysis performed on output variable targets is based on a 
conditional median analysis.  In performing the Scenario analysis, first 
@RISK subsets the iterations of the simulation into only those iterations in 
which the output variable achieves the entered target. It then analyzes the 
values sampled for each input variable in those iterations.  @RISK finds 
the median of this "subset" of sampled values for each input and 
compares that with the median of the input for all iterations.   

The objective of this process is to find those inputs whose subset or 
conditional median differs significantly from the overall median.  If the 
subset median for the input variable is close to the overall median, the 
input variable is marked as insignificant.  This is because the values 
sampled for the input in the iterations where the target is achieved do not 
differ markedly from those sampled for the input for the entire 
simulation.  However, if the subset median for the input variable deviates 
significantly from the overall median (i.e. at least 1/2 a standard 
deviation) the input variable is significant.   The reported scenarios show 
all inputs which were significant in meeting the entered target. 

How is a 
Scenario 
Analysis 
Performed? 
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Reporting in Excel 
When you generate simulation reports and graphs in Excel, you have 
access to all Excel’s formatting.  In addition, @RISK reports generated in 
Excel can use pre-built @RISK template sheets that contain custom 
formatting, titles, logos and more. 

 

You can use template sheets to create your own custom simulation report.  
Simulation statistics and graphs are placed in a template using a set of 
@RISK functions added to Excel.  When a statistics function or graphing 
function is located in a template sheet,  the desired statistics and graphs 
are then generated at the end of a simulation in a copy of the template 
sheet to create your report.  The original template sheet with the @RISK 
functions remains intact for use in generating reports from your next 
simulation. 

Template sheets are standard Excel spreadsheets.  They are identified to 
@RISK in the Reports Settings dialog box.  These files can also contain any 
standard Excel formulas so custom calculations can be performed using 
simulation results. 
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Introduction 
The @RISK Modeling Techniques chapter will show you how to translate 
typical "risky" situations into @RISK models.  These risky situations have 
been identified from real-life modeling problems that Excel users often 
encounter.  As you use @RISK to analyze uncertainty in your Excel 
worksheets, look through the examples and illustrations provided in this 
chapter.  You just may find some helpful tips or techniques which will 
make your @RISK models better representations of uncertain situations. 

Seven @RISK techniques are presented here to illustrate common 
modeling situations under uncertainty.  To help you understand the 
modeling techniques employed, example Excel worksheets and 
accompanying @RISK simulations are provided with your @RISK system.  
The simulations are even "pre-run" so you can just look at the results if 
you like.  As you work through each modeling technique discussed, look 
at the corresponding worksheet and simulation.  It will help you 
understand the @RISK concepts and techniques involved in modeling 
each risky situation. 

The seven modeling techniques illustrated here are: 

•  Modeling Interest Rates and Other Trends - random trends over  
time and  "random walks". 

•  Projecting Today's Known Values Into the Future - an increasingly 
uncertain future or "increasing variability". 

•  Will the Flood Occur or the Competitor Enter the Market? — 
modeling uncertain "chance" events.   

•  Oil Wells and Insurance Claims - modeling an uncertain number of 
events, each with uncertain parameters. 

•  "I have to use this projection but don't trust it" - adding uncertainty 
around a fixed trend using "error terms". 

•  "These values will be affected by what happens someplace else" - 
dependency relationships using variable arguments and correlations. 

•  Sensitivity Simulation - how model changes affect simulation results. 
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Models from the book Financial Models Using 
Simulation and Optimization 
In addition to the seven models discussed here, this chapter also includes 
three @RISK examples from the book Financial Models Using 
Simulation and Optimization by Wayne Winston.  These models 
illustrate how @RISK is applied to everyday business modeling.  The full 
Financial Models book includes 63 examples of how @RISK and other 
add-ins can be applied to a wide variety of financial problems.  For more 
information on purchasing the full Financial Models book, contact 
Palisade Corporation or visit www.palisade.com. 

Loading the Example Models 
All example spreadsheet models discussed here can be found in the 
default installation location C:\DTOOLS\RISK45\EXAMPLES. 
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Modeling Interest Rates and Other Trends 
Example Model:RATE.XLS 

Whether you are getting a mortgage or evaluating the cost of a variable 
rate loan, projections of future interest rates are highly uncertain.  The 
movement of the rate of interest you are charged is often viewed as 
random - moving up and down erratically year to year.  This movement 
may be completely random or it may be a random fluctuation around an 
underlying known trend.  In either case, modeling the random portion of 
any projection is an important technique in Risk Analysis.   

 
Simulation accounts for randomness in a trend over time in a very 
powerful way - repetitively trying a different possible series of rates with 
each iteration of a simulation.  For example, you could set up a random 
trend to project the interest rate over ten years.  For each iteration, a new, 
randomly selected value is chosen for each year's interest rate, and results 
are calculated.  By doing this, simulation includes the effects of all 
possible future interest rates in your results, instead of just a single, most 
likely projection. 

A "random trend" can be easily and directly included in an Excel 
worksheet with @RISK.  And by using the Excel Copy commands, you 
can place a random trend anywhere in your worksheet.   

The simplest random trend is a distribution copied across time.  The value 
randomly selected in one period is independent of the value selected in 
any other time period: 

1) Enter a distribution function for the first cell of the trend 

2) Copy the distribution over the range of cells 

In this case, a new value will be sampled every period - a completely 
random trend with no correlation over time. 

Simple Random 
Trends    
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Maybe you don't think future rates are entirely random.  Perhaps next 
year's rate will be influenced by this year's.  In Excel terms, there will be 
some correlation between one cell in the range and the next.  Here's a 
simple way to model this: 

1) Enter a distribution function for the first cell in the range. 

2) Enter a distribution function for the second cell in the range that uses 
the value sampled for the first cell as one of its arguments (such as its 
mean or most likely value). 

3) Copy the formula of the second cell across the range.  The referenced 
argument in the formula is a relative reference - the third cell will use 
the value in the second as its referenced argument and likewise for 
the fourth, fifth, etc.  

For example: 

A1: RiskNormal(100,10) 

A2: RiskNormal(A1,10) 

A3: RiskNormal(A2,10) 

A4: RiskNormal(A3,10) 

In this manner there is some correlation between one cell and the next cell 
in the range. 

These are just simple examples of modeling random processes over time.  
As you get more sophisticated, you can include your random terms in 
formulas which place limits or caps on the amount of change, increase the 
amount of possible change with time, or other such extensions or 
variations.  And remember, interest rates are just one application for 
random trends.  Look at your Excel worksheets and the uncertain 
situations you model and you will undoubtedly see others. 

A "Random 
Walk" with 
Correlation 
Period to  
Period   

Refining Your  
Random Trends   
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Projecting Known Values into the Future 

Increasing Uncertainty Over Time 
Example Model:  VARIABLE.XLS 

You know today's values for critical variables in your models, but what 
about values for these same variables in the future?  Time often has a very 
important impact on estimates - they become less and less certain the 
further out in time your projections extend.  As a consequence, results 
based on your single "best estimates" become more and more risky the 
further out in time they are projected. 

Amount of
"Spread" or
Possible
Variation in Value

 
The widening variation around the trend of best estimates illustrates this 
problem.  @RISK lets you model the effect of time on your estimates by 
allowing you to easily increase the variability in a random value over 
time. 

The range of possible values for a worksheet cell is given in your 
distribution functions.  As you move out in time - across a range of 
worksheet cells - the argument of the function which specifies the range of 
possible values can increase.  For example: 

A1: RiskLognorm(10,10) 

A2: RiskLognorm(10,15) 

A3: RiskLognorm(10,20) 

A4: RiskLognorm(10,25) 

The standard deviation of the LOGNORM distribution function controls 
the possible variation in value.  In this example, as you move out across 
the range of cells, the standard deviation increases. 
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Increasing the possible variance in value as your projections extend 
further and further into the future is a good "rule of thumb" to follow.  By 
doing this, your results will more accurately reflect the greater uncertainty 
which exists in your knowledge of the distant future. 
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Modeling Uncertain or "Chance" Events 
Will the Flood Occur or the Competitor Enter the 
Market? 
Example Model:  DISCRETE.XLS 

Uncertainty often shows up in the form of chance events which may have 
significant impact on your results.  Either we will strike oil, or we won't.  
That competitor will either enter the market or he won't, but if he does ....!  
There's a 25% chance of a hailstorm that will wipe out this year's crop. 

Including the possibility of these types of events in your models is an 
important technique in Risk Analysis.  If you leave them out, the 
outcomes caused by these events will not be included in your results and 
your models will be incomplete.  Using the DISCRETE function provided 
by @RISK and Excel's IF function, modeling these events is easy. 

The DISCRETE function is the means by which you can include 
probabilities for chance events in your worksheet models.   

RiskDiscrete({0,1},{50,50})  

This example models the characteristic "coin flip" - the simplest chance 
event.  In this case, an outcome of 0 represents Heads and 1 represents 
Tails, and each is equally likely to occur.  A more complex example 
illustrates four possible scenarios for annual storm damage from floods: 

RiskDiscrete({0,1,2,3},{20,40,30,10})  

In this case, outcomes valued 0 to 3 represent four possible levels of flood 
damage ranging from none (0) through low (1), medium (2) and high (3).  
The probability of occurrence of no damage is 20%, low 40%, medium 
30% and high 10%. 

Including the  
Discrete Event   
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The DISCRETE function returns a value for each iteration that indicates 
which event has occurred.  Your worksheet model has to recognize which 
event has occurred and calculate different results appropriate to the event.  
The Excel IF function allows this.  Consider the following example and 
Excel cell entries: 

Cell C2 describes an event - the possible entry of a competitor in a given 
market.  There is a 50-50 chance of entry.  If entry occurs, your sales level 
will be 65; if entry does not occur, your sales level will be 100. 

C2:   RiskDiscrete({0,1},{50,50})  

D2:   IF(C2=1,100,65)  

In the above example, the IF function in cell D2 will return a value of 100 
if the outcome in cell C2 is 1 (no entry) and will return 65 if the outcome is 
0 (entry).  This simple example can be extended throughout your @RISK 
models.  Each iteration of a simulation the DISCRETE function will return 
one of the possible values.  Depending on the value returned, the 
calculations in your worksheet can change.   

People used to working with single estimates in spreadsheets often 
substitute discrete distributions where a continuous distribution should 
be used.  For example, they use a discrete distribution to put in three 
possible price levels where, in reality, price could take any value in a 
range. 

This common mistake occurs because many people are used to manual 
"what-if" modeling which necessarily limits the user to a small number of 
discrete estimates.  Use a continuous form when any value in a range is 
possible, and save DISCRETE for event modeling and variables that truly 
are discrete. 

 

Including the 
Effects of 
Chance Events 
in Your 
Worksheets   

Caution 
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Oil Wells and Insurance Claims  

Modeling an Uncertain Number of Events, Each with 
Uncertain Parameters 
Example Model: CLAIMS.XLS 

In real life situations, uncertainty often has two or more dimensions.  The 
situation you face may have an uncertain number of events, each of which 
has an uncertain value.  Think, for example, of the insurance industry.  An 
uncertain number of claims may be filed on a new policy.  And each claim 
filed has an uncertain dollar amount.  How do you simulate the total 
claim amount possible?  The oil industry faces a similar problem.  When 
drilling oil wells, an uncertain number of wells will be successful.  But the 
amount of oil discovered by each successful well is uncertain.  How do 
you simulate the total amount of oil discovered? 

Risk Analysis is very useful in modeling situations such as this.  @RISK, 
combined with the Excel IF function, can provide an easy means of 
performing such an analysis.  It is helpful to review the example 
simulation, CLAIMS.XLS, while proceeding through this modeling 
technique. 

To model situations where 2 or more levels of uncertainty are present, a 
worksheet is set up which includes a column of calculations for each of 
the possible events.  For example, if the maximum number of possible 
claims is 100, 100 columns would be used, each to calculate the results 
from a single possible claim.  A claim # (1-100) would be given at the top 
of each column. 

To run the analysis: 

1) First, a cell is used to sample the number of events which occur in a 
given iteration 

2) The number of events is compared to the # at the top of each column 
which refers to the calculation of results for a specific event 

The number of events sampled is compared to the "claim #" cell at the top 
of each column.  The Excel IF function is used to make the comparison.  
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For example, if cell A1 holds the Number of Claims (sampled from a 
probability distribution function) and B5 has the Claim #: 

Number of Claims A1:  6 

Claim # B5:  3 

Comparison B6:  IF(B5 <= A1, RiskNormal(100,10), 0) 

The formula in cell B6 says "if the Claim # is less than or equal to the 
Number of Claims, return a sample from the normal distribution - 
otherwise return a value of zero".  In the example above, the value in cell 
B5 is less than the value in A1 so a sample from the normal distribution is 
returned. 

Using this structure, it is possible to evaluate a changing number of events 
each iteration.  And because it is very simple in Excel to copy the 
calculation for one event across a worksheet, you just have to set up one 
column of calculations for a single event, then copy it.  In the example 
here, you would set up a column of calculations for Claim #1, and then 
copy that column across the worksheet to end up with a total number of 
columns equal to the maximum possible number of events. 
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Adding Uncertainty Around a Fixed Trend 

I Have To Use This Projection But Don't Trust It 
Example Model:  ERROR.XLS 

Often Excel modelers are given data from other sources for inclusion in 
their worksheets.  "The economics group has provided this projection for 
GNP growth, so include it in your worksheet model" - could be the 
guideline.  But how often does the future exactly follow even the best 
projection? 

Recognizing the uncertainty inherent to projections, you still may want to 
stay true to the basic direction offered by the values in the trend.  In this 
case "error terms" let you put a certain amount of variation around the 
values in the trend.  This allows you to examine how variation in trend 
value will impact your results. 

 
With @RISK, you can easily append an error term to a fixed trend you 
have already entered in your worksheet.  Let's say, for example, that 
worksheet row B contains the fixed trend in your model.  An error term is 
just a factor you'll multiply each worksheet cell value by.  (You also could 
add an error term to each trend value) 

Row B - GNP Growth in Percent 

B1:  3.2 * RiskNormal(1,.05) 
B2:  3.5 * RiskNormal(1,.05) 
B3:  3.4 * RiskNormal(1,.05) 
B4:  4.2 * RiskNormal(1,.05) 
B5:  4.5 * RiskNormal(1,.05) 
B6:  3.5 * RiskNormal(1,.05) 
B7:  3.0 * RiskNormal(1,.05) 
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In this example taken from Excel, the error term for all trend values is 
drawn from a normal distribution with a mean of 1 and a standard 
deviation of .05.  For each iteration of a simulation, a new error term will 
be sampled for each cell and will be used to multiply the fixed trend 
estimate in that cell, allowing variation around the fixed estimate. 

An added bonus of an error term is the expected value generated in 
normal Excel recalculations.  Because the expected values of the error 
terms in the example equal one, they will not affect your normal 
worksheet recalculations.  Thus you can leave the error terms in your 
formulas and only see their effects when you run your simulations.  The 
same comment holds true if you add, instead of multiply by, the error 
term.  If you add the error term to the fixed estimate, the mean of the error 
term probability distribution should be zero. 
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Dependency Relationships 

Using Variable Arguments and Correlations — These 
Values Will Be Affected By What Happens 
Someplace Else 
Example Models:  DEP.XLS, CORRMAT.XLS 

Many times you will not know precise argument values for a distribution 
function in your worksheet.  Often the range for a worksheet cell will 
depend on a value calculated or sampled elsewhere in your model.  "If 
price is low, the range for sales volume is one million to 2 million - but if 
price is high, the range is only 500,000 to 750,000" is an illustration of this 
type of dilemma.   

Two modeling techniques in @RISK help you to resolve problems such as 
this, namely (1) variable arguments for distribution functions and (2) 
correlations in sampling. 

The first technique - variable arguments for distribution functions - relies 
on a standard Excel capability most modelers are familiar with.  The 
referencing of cell addresses in functions is allowed in @RISK just as in 
Excel.  For example: 

Minimum A1:   RiskTriang(10,20,30)  
   

Maximum B1:   RiskNormal(80,10)  
   

Final Price C1:   RiskUniform(A1,B1)  
   

This example shows how the range for the uniform distribution for Final 
Price will change with the value sampled for Minimum and Maximum.  
Here the range for Final Price will change with each iteration of the 
simulation.  Final Price thus depends on the variables Minimum and 
Maximum.   

The second modeling technique which can be used to affect sampled 
values based on other calculations in a worksheet is correlations in 
sampling.  The @RISK function CORRMAT is used to correlate the values 
sampled in different distribution functions.  This correlation allows you to 
specify a relationship between the values sampled in different worksheet 
cells while still maintaining a degree of uncertainty for each. 

 

Variable 
Arguments   

Correlations in  
Sampling   
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Interest Rate 
 A1:  RiskUniform(6,14, RiskCorrmat (D1: E2,1))  

Housing Starts: 
B1:  RiskUniform(100000,200000, RiskCorrmat (D1: E2,2)) 

The CORRMAT function is used when you want to have the value 
sampled for one cell influence the value which is sampled for another.    
The variable Interest Rate - described by the distribution 
RiskUniform(6,14) - is the distribution that the Housing Starts distribution 
- RiskUniform(100000,200000) - should be correlated with.  The range 
D1:E2 contains a matrix of 4 cells and a single correlation coefficient, -.75.  
The -.75 is the coefficient which specifies how the two sampled values are 
correlated. Coefficients range from -1 to 1.  A value of -.75 is a negative 
correlation - as Interest Rate goes up, Housing Starts go down. 

When you are using sampled, uncertain variables in your worksheet 
models it is important to recognize correlations in sampling.  If you don't 
use methods such as the two presented here, all uncertain variables will 
be sampled as if they were completely independent of other variables in 
the model.  This can cause erroneous results.  Think about what could 
happen if Interest Rate and Housing Starts in the above example were 
completely independent.  Interest Rate and Housing Starts would be 
sampled entirely independent of one another.  A high Interest Rate and a 
high value for Housing Starts would be an entirely possible scenario 
during sampling.  But could this happen in real life?  Not in this economy! 

Correlating multiple distribution functions can be accomplished using the 
CORRMAT function or by selecting the cells containing the distributions 
in the @RISK Model Window and selecting the Model menu Correlate 
Distributions command.  Either of these methods allows you to enter a 
matrix of correlation coefficients.  @RISK then uses the coefficients to 
correlate the sampling of distribution functions.  This is especially useful 
when pre-existing correlation coefficients (calculated from actual collected 
data) are available and you want sampling to be governed by those 
coefficients.  Excel can calculate correlations from existing datasets using 
the CORREL function.  For more information on using Correlate or 
CORRMAT, see the example simulation CORRMAT.XLS. 

 

Correlating 
Interest Rates 
and Housing 
Starts 

Correlating 
Multiple 
Distributions 
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Sensitivity Simulation 

How Do Changes in Model Variables Affect My  
Simulation Results? 
Example Model:  SENSIM.XLS 

@RISK lets you see the impact of uncertain model parameters on your 
results.  But what if some of the uncertain model parameters are under 
your control?  In this case the value a variable will take is not random, but 
can be set by you.  For example, you might need to choose between some 
possible prices you could charge, different possible raw materials you 
could use or from a set of possible bids or bets.  To properly analyze your 
model, you need to run a simulation at each possible value for the "user-
controlled" variables and compare the results.  A Sensitivity Simulation in 
@RISK allows you to quickly and easily do this - offering a powerful 
analysis technique for selecting between available alternatives. 

The benefits of Sensitivity Simulation are not limited to evaluating the 
impacts of user-controlled variables on simulation results.  A sensitivity 
analysis can be run on the probability distributions which describe 
uncertain variables in your model.  You may wish to repetitively re-run a 
simulation, each time changing the parameters of one (or several) of the 
distributions in your model. After all the individual simulations are 
complete, you can then compare the results from each. 

The key to a Sensitivity Simulation is the repetitive simulation of the same 
model while making selected changes to the model each simulation.  In 
@RISK any number of simulations can be included in a single Sensitivity 
Simulation.  The SIMTABLE function is used to enter lists of values, 
which will be used in the individual simulations, into your worksheet 
cells and formulas.  @RISK will automatically process and display the 
results from each of the individual simulations together, allowing easy 
comparison. 

To run a Sensitivity Simulation: 

1) First, enter the lists of values you want used in each of the individual 
simulations into your cells and formulas using SIMTABLE.  For 
example, possible price levels might be entered into Cell B2: 

B2: RiskSimtable({100,200,300,400})  

will cause simulation #1 to use a value of 100 for price, simulation #2 
to use a value of 200, simulation #3 to use a value of 300 and 
simulation #4 to use a value of 400.   
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2) Set the number of simulations in the Settings dialog box and run the 
Sensitivity Simulation using the Start Simulation command. 

Each simulation executes the same number of iterations and collects data 
from the same specified output ranges.  Each simulation, however, uses a 
different value from the SIMTABLE functions in your worksheet. 

@RISK processes Sensitivity Simulation data just as it processes data from 
a single simulation.  Each output cell for which data was collected has a 
distribution for each simulation.  Using the functions of @RISK you can 
compare the results of the different alternatives or "scenarios" described 
by each individual simulation.  The Distribution Summary graph 
summarizes how the results for an output range change.  There is a 
different summary graph for each output range in each simulation, and 
these graphs can be compared to show the differences between individual 
simulations.  In addition, the Simulation Summary report is useful for 
comparing results across multiple simulations. 

You also can use Sensitivity Simulation to see how different distribution 
functions affect your results.  The values entered in the SIMTABLE 
function can be distribution functions.  For example, you may wish to see 
how your results change if you alternately try TRIANG, NORMAL, or 
LOGNORM as the distribution type in a given cell. 

It is important to distinguish between 1) controlled changes by simulation 
(which are modeled with the SIMTABLE function) and 2) random 
variation within a single simulation (which is modeled with distribution 
functions).  SIMTABLE should not be substituted for DISCRETE when 
evaluating different possible random discrete events.  Most modeling 
situations are a combination of random, uncertain variables and uncertain 
but "controllable" variables.  Typically, the controllable variables will 
eventually be set to a specific value by the user, based on the comparison 
conducted with a Sensitivity Simulation. 

@RISK 4.5 Professional and Industrial versions include an advanced 
analysis tool called Advanced Sensitivity Analysis.  This analysis greatly 
expands on the sensitivity simulation capabilities described here.  For 
more information on Advanced Sensitivity Analysis, see the Advanced 
Analyses command in the Reference: @RISK Add-in Menu section of this 
manual. 

Caution 

Advanced 
Sensitivity 
Analysis 
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Simulating a New Product: The Hippo Example 
(Chapter 28, Financial Models Using Simulation and Optimization) 

When a company develops a new product, the profitability of the product 
is highly uncertain. Simulation is an excellent tool to estimate the average 
profitability and riskiness of new products. The following example 
illustrates how simulation can be used to evaluate a new product. 

ZooCo is thinking of marketing a new drug used to make hippos 
healthier. At the beginning of the current year there are 1,000,000 hippos 
that may use the product.  Each hippo will use the drug (or a competitor’s 
drug) at most once a year.  The number of hippos is forecasted to grow by 
an average of 5% per year, and we are 95% sure that the number of hippos 
will grow each year by between 3% and 7%.  We are not sure what use of 
the drug will be during year 1, but our worst case guess is 20% use, most 
likely use is 40% and best case use is 70%. In later years, we feel the 
fraction of hippos using our drug (or a competitor's) will remain the same, 
but in the year after a competitor enters, we lose 20% of our share for each 
competitor who enters.  We will model Year 1 market use with a 
triangular random variable. See Figure 28.1.  Basically, @RISK will 
generate Year 1 market use by making the likelihood of a given market 
use proportional to the height of the "triangle" in Figure 28.1. Thus a 40% 
Year 1 market use is most likely; a 30% market use occurs half as often as 
a Year 1 40% market use, etc.  The maximum height of the triangle is 4, 
because that makes the total area under the triangle equal to one. 
Probability of market use being in a given range is equal to area in that 
range under the triangle. For example, the chance of a market use being at 
most 40% is .5*(4)*(.4-.2) =.4 or 40%. 

 

Example 28.1 
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There are three potential entrants (in addition to ZooCo). At the beginning 
of each year each entrant who has not already entered the market has a 
40% chance of entering the market.  The year after a competitor enters, 
our market use drops by 20% for each competitor who entered. Thus if in 
Year 1 two competitors enter the market, in Year 2 our market use will be 
reduced by 40%. To model the number of entrants you can use the 
binomial random variable (in @RISK this requires us to use the 
=RISKBinomial function). The formula 

= RISKBinomial (n, p) 

generates n independent binomial trials (each a success or failure) having 
probability of success p and keeps track of the number of successes. 

We consider a "success" to be a competitor entering the market. Then the 
formula  

= RISKBinomial (2,.4) 

will simulate the number of entrants during  a year in which two 
competitors have yet to enter the market. Make sure that if all three 
entrants have entered, no more entrants may enter. 

Each unit of the drug is sold for $2.20 and incurs a variable cost of $0.40. 
Profits are discounted by 10% (risk adjusted rate) annually.  

    Figure 28.1 
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Find a 95% CI for risk-adjusted NPV of project. For now we ignore  the 
fixed cost of developing the drug. 

Recall that risk-adjusted NPV is expected discounted value of cash flows 
(discounted at risk-adjusted rate). 

Our spreadsheet is in Figure 28.2 (file hippo.xls). 

 

 
Step 1:  In row 8 we determine the market size during each of the next 
five years. In B8 we enter =D3. Assuming year to year growth in market 
size is normally distributed, the given information tells us that the 
number of pigs grows from year to year by a percentage which is a 
normal random variable having mean .05 and standard deviation of .01.  
This follows because 95% of the time a normal random variable is within 
2 standard deviations of its mean. Therefore we may conclude 2σ = .02 or 
σ = .01.Thus in C8 we determine the Year 2 Market Size with the formula 

=B8*RISKNormal(1.05,0.01). 

Essentially, this formula ensures that each year there is a 68% chance that 
the size of the hippo market grows by between 4% and 6%, a 95% chance 
that the hippo market grows by between 3% and 7%, and a 99.7% chance 
that the hippo market grows by between 2% and 8%. Copying this 
formula to D8:F8 generates the market size for Years 3-5. 

Solution  

Figure 28.2 

Step by Step 
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Step 2:  In row 9 we determine our market use/hippo for each year. Year 
1 market use/hippo is computed in B9 with the formula 

=RISKTriang (D4,D5,D6). 

In C9:F9 we account for the fact that the year after entry, each entrant 
takes away 20% of our market share. Thus in C9 we compute our Year 2 
Market use/hippo with the formula 

= B9*(1-B11*$D$2). 

Copying this formula to D9:F9 computes Years 3-5 market share. 

Step 3:  In Row 11 we determine the number of entrants during each 
year. If less than 3 competitors have entered, then each competitor who 
has not yet entered has a 40% chance of entering during the current year. 
If all three competitors have entered, then nobody can enter. In B11 we 
compute the number of Year 1 entrants with the formula 

=If(B10<3, RISKBinomial(3-B10,$B$5),0). 

Copying this to C11:F11 computes Years 2-5 entrants. If we do not use the 
=If statement then in a year after all 3 competitors have entered we will 
obtain an error message because =RISKBinomial cannot take 0 trials as the 
first argument. 

Step 4:  In Row 10 we compute the number of competitors present at the 
beginning of each Year by adding the number of new entrants to the 
number of competitors already present. In B10 we enter 0 and in C10 we 
enter 

= B10 + B11. 

Copying this formula to D10:F10 computes the number of competitors 
present at the beginning of each year. 

Step 5:  In row 12 we compute each year’s unit sales = 
(use/hippo)*market size by copying the formula 

 = B8*B9 

from B12 to C12:F12. 



Chapter 5:  @RISK Modeling Techniques 113 

Step 6:  In row 13 we compute our annual revenues by copying the 
formula 

=$B$2*B12 

from B13 to C13:F13. 

Step 7:  In row 14 we compute our annual variable costs by copying the 
formula 

= $B$3*B12 

from B14 to C14:F14. 

Step 8:  In row 15 we compute our annual profits by copying the 
formula 

=B13-B14 

from B15 to C15:F15. 

Step 9:  In B17 we compute the NPV of our 5-year profits with the 
formula 

= NPV(B4,B15:F15). 

Step 10:  We now run a simulation with cell B17 (NPV) being our 
forecast cell. We used 500 trials. Our results follow.  

 

Figure 28.3 
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Our point estimate of risk adjusted NPV is the sample mean of NPV's 
from simulation ($2,312372.866). To find a 95% confidence interval for the 
mean in a simulation use the fact that we are 95% sure actual mean NPV 
is between 

(Sample Mean of NPV)±2*(Sample Standard deviation)/ n , 

where n = number of iterations. 

For example, we are 95% sure the mean NPV (or risk adjusted NPV) is 
between  

2,312373 ±2*(633418)/ 500  or 

$2,255,718 and $2,369,028. 

Thus we are pretty sure risk adjusted NPV is between 2.26 and 2.37 
million. Since 95% of the time we are accurate within $50,000 (which is 2% 
of sample mean) we feel comfortable that we have run enough iterations. 

The actual discounted (at 10% rate) value of cash flows has much more 
variability than our confidence interval for risk-adjusted NPV would  
indicate. To show this look at the following histogram. 

 
 

 

 

Figure 28.4 
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Note: If you are going to use distribution of NPV's as a tool to compare 
projects, then you must discount all the company's projects at the same 
rate (probably obtained from CAPM). Otherwise you will be double 
counting risk. 

Tornado Graphs and Scenarios 
A natural question is what factors have the most influence on the success 
of the project? Does market growth matter more than the timing of the 
entrance of competitors? Using @RISK Tornado graphs and Scenario 
Analysis we can easily answer questions such as: 

a. What factors appear to have the most influence on the NPV earned by 
the drug? 

b.  When NPV is in the top 10%ile of all possible NPV, what seems to be 
going on? 

Here we utilize a Tornado Graph. Make sure that in “Simulation 
Settings” you have checked “Collect Distribution Samples”.  Then right- 
click on NPV/B17 in the Explorer list and choose “Tornado Graph.”  You 
have two options: A Regression Tornado Graph (see Figure 28.5) or a 
Correlation Tornado Graph (see Figure 28.6). 

 

Solution - Part a  

Figure 28.5 
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We find (ceteris paribus) from Regression Tornado Graph (obtained by 
selecting “Regression” under the "Display Significant Inputs Using" entry 
on the Sens. Tab on the graph) that  

•  A one standard deviation increase in Year 1 use increases NPV by .853 
standard deviations. 

•  A one standard deviation increase in number of Year 1 entrants 
decreases NPV by .371 standard deviations. 

•  Not much else matters! 

Basically, when running a Tornado Graph @RISK runs a regression where 
each iteration represents an observation. The dependent variable is the 
output cell (NPV) and the independent variables are each "random" 
@RISK function in the spreadsheet. Then the .853 coefficient for Year 1 
Use is the standardized, or beta weight coefficient of Year 1 Use in this 
regression. 

 
 

From Tornado Correlation Graph in Figure 28.6 (obtained by a change 
similar to the one above, except with Correlation instead of Regression) we 
find 

•  Year 1 use is most highly correlated (.89) with NPV 

•  Next is Year 1 Entrants (-.44) 

•  Rest of the random cells in the spreadsheet do not matter much! 

These correlations are rank correlations; for example, for all iterations the 
values of Year 1 use are ranked, as are values of NPV. Then these ranks 
(not actual values) are correlated. 

        Figure 28.6 
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If you check “Collect Distribution Samples” under  Simulation Settings 
you can obtain a Scenario Analysis. For a given scenario, such as all 
iterations where NPV is in top 10% of all iterations, the Scenario Analysis 
identifies random variables whose values differ significantly from their 
median values.1 

We find from Scenario Approach (see Figure 28.7) (click on the “Insert 
New Scenarios Window” icon or click on “Insert” and then “Scenarios”) 
that in the iterations yielding the top 10% of all NPV’s the following 
variables differ significantly from their overall medians: 

•  Year 1 Use (median is .596, 1.66 sigma above average) 

•  Year 2 Entrants (median is 0, 1.53 sigma below average) 

To change the scenario settings just click on the “Scenario=” row in the 
Scenario Analysis box.   Figure 28.7 contains a listing of three Scenario 
settings (the top 25%, the bottom 25%, and the top 10% of NPV's) along 
with the random variables that differ significantly from their average 
values when the given scenario occurs. For example, for iterations in 
which the NPV is in the bottom 25% of all iterations, Year 1 Market Use 
averaged out to 13.9%. 

                                                           
1  @RISK will identify any random variable whose median value in 
iterations satisfying  the scenario condition differs by more than .5 
standard deviations from the median value of the random variable in all 
iterations. 

Solution - Part b 

 
Figure 28.7 
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Finding Value at Risk (VAR) of a Portfolio  
(Chapter 45, Financial Models Using Simulation and Optimization) 

Anybody who owns a portfolio of investments knows there is a great deal 
of uncertainty about the future worth of the portfolio. Recently the 
concept of value at risk (VAR) has been used to help describe a portfolio's 
uncertainty. Simply stated, value at risk of a portfolio at a future point in 
time is usually considered to be the fifth percentile of the loss in the 
portfolio's value at that point in time. In short, there is considered to be 
only one chance in 20 that the portfolio's loss will exceed the VAR. To 
illustrate the idea suppose a portfolio today is worth $100. We simulate 
the portfolio's value one year from now and find there is a 5% chance that 
the portfolio's value will be $80 or less. Then the portfolio's VAR is $20 or 
20%. The following example shows how @RISK can be used to measure 
VAR.  The example also demonstrates how buying puts can greatly 
reduce the risk, or hedge, a long position in a stock. 

Let's suppose we own one share of Dell computer on June 30, 1998. The 
current price is $94. From historical data (see Chapter 41) we have 
estimated that the growth of the price of Dell stock can be modeled as a 
Lognormal random variable with µ = 57% and σ = 55.7%. To hedge the 
risk involved in owning Dell we are considering buying (for $5.25) a 
European put on Dell with exercise price $80 and expiration date 
November 22, 1998.   Here you will: 

a) Compute the VAR on November 22, 1998 if we own Dell computer 
and do not buy a put. 

b) Compute the VAR on November 22, 1998 if we own Dell computer 
and buy the put. 

 

Example 45.1 
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The key idea is to realize that in valuing the put we let Dell price grow at 
the risk-free rate, but when doing a VAR calculation we should let Dell 
price grow at the rate at which we expect it to grow.  Our work is in file 
var.xls. See Figure 45.1. 

 
 

 

We have created range names as indicated in Figure 45.1. 

Step 1:  In cell B11 we generate Dell's price on November 22, 1998 with 
the formula 

=S*EXP((g-0.5*v^2)*d+RISKNormal(0,1)*v*SQRT(d)). 

Step 2:  In cell B12 we compute the payments from the put at expiration 
with the formula 

=If(B11>x,0,x-B11). 

Step 3:  The percentage gain on our portfolio if we just own Dell is 
given by 

icePrDellBeginning
icePrDellBeginningicePrDellEnding − . 

In B14 we compute the percentage gain on our portfolio if we do not buy 
a put with the formula 

=(B11-S)/S. 

 

 

Solution 

Figure 45.1 

Step by Step 
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Step 4:  The percentage gain on our portfolio if we own Dell and a put 
is 

icePrPuticePrDellBeginning
icePrPuticePrDellBeginningPutfromFlowsCashicePrDellEnding

+
−−+  

In cell B15 we compute the percentage gain on our portfolio if we buy the 
put with the formula 

  =((B12+B11)-(S+p))/(S+p). 

Step 5:  After selecting B14 and B15 as output cells and running 1600 
iterations we obtained the @RISK output in Figure 45.2. 

 
 

We find our VAR if we do not buy the put to be 33.9% of our invested 
cash while if we buy the put our VAR drops to 19.4% of the invested cash. 
The reason for this is, of course, that if Dell stock drops below $80, every 
one dollar decrease in the value of Dell is countered by a one dollar 
increase in the value of the put. Also note that if we do not buy the put, 
Dell (despite its high growth rate) might lose up to 64% of its value. 

 

Figure 45.2 
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The following histograms give the distribution of the percentage gain on 
our portfolio with and without the put. 

 
 

 
From Figures 45.3 and 45.4 we see that there is a much greater chance of a 
big loss if we do not buy the put. Note, however, that our average return 
without the put is 25.4% while our average return with the put is 21.1%.  
In effect, buying the put is a form of portfolio insurance, and we must 
pay for this insurance. 

Figure 45.3 

Figure 45.4 
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Simulating the NCAA Tournament 
(Chapter 62, Financial Models Using Simulation and Optimization) 

The file NCAA.xls lets you play out the NCAA tournament as many times 
as you want. We factor in the abilities (through the SAGARIN ratings 
published in USA Today) of each team. Extensive data analysis has 
indicated that teams play on average to SAGARIN ratings and perform 
according to a standard deviation of 7 points about that level. For 
example, in 1997 SAGARIN rated NC a 94 and Fairfield a 70. Thus we 
would model NC's play by a RISKNormal(94,7) and Fairfield by a 
RISKNormal(70,7) and declare the team with  the higher performance the 
winner. Our simulation of the 1996 NCAA tournament is in file 
NCAA96.xls 

To begin we label the EAST teams 1-16 in the order they are listed in 
bracket. Then teams 17-32 are the SOUTHEAST, teams 33-48 the WEST 
and teams 49-64 the MIDWEST. It is important that we list things so that 
winner of 1 and 2 plays winner of 3 and 4, etc. 

Step 1:  We enter the ratings, numerical codes, and team names in rows 
2-4. We name the range A3:BL4 Ratings. 

 

 
 

Step 2:  We model the UNC Fairfield game in A6:C7. In A7 we generate 
UNC's performance with the formula 

=RISKNormal(HLOOKUP(A6,Ratings,2),7). 

This looks up UNC's rating and generates a performance with that mean 
and a standard deviation of 7. 

Step by Step 
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Similarly, in C7 we generate Fairfield's performance. In B7 we determine 
who wins the game with the formula 

=If(A7>C7,A6,C6). 

After "playing" the Colorado-Indiana game in E6:G7 (see Figure 62.1) we 
play the winners of these two games in A9:C10. 

 
 

We ensure that the entry in A9 is the winner of UNC-Fairfield Game and 
the entry in C9 is winner of Indiana-Colorado game. Then in Row 10 we 
"play" this game. See Figure 62.2. 

 
 

You can follow this logic down to Row 57. Here the Final Four begins! See 
Figure 62.3. 

 
 

In 1997 East played West and Midwest played Mideast. Each year the 
final four matchups will change and you will need to adjust this part of 
spreadsheet. In C65 we print out the winner with the formula 

=HLOOKUP(C64,A1:BL2,2). 

This formula finds the Team Name corresponding to the code number of 
the winner. Hit the F9 key several times to see what happens. 

Figure 62.1 

Figure 62.2 

Figure 62.3 
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We used cell C64 as our output cell and ran the tournament 5000 times. 
The teams having at least a 5% chance of winning were 

•  UNC: 13% 

•  Kansas: 26% 

•  Kentucky: 27% 

•  Duke: 8% 

•  Minnesota: 9% 

Of course, Arizona won (we gave them a .0084 chance!). That's what 
makes sports great! 

 

Remarks 
Remember each year the Final Four brackets change. This will require you 
to rearrange the rows where the East, Midwest, Mideast and West regions 
are located. 
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Overview 
@RISK allows you to fit probability distributions to your data 
(Professional and Industrial versions only).  Fitting is done when you 
have a set of collected data that you want to use as the basis for an input 
distribution in your spreadsheet.  For example, you may have collected 
historical data on a product price and you might want to create a 
distribution of possible future prices that is based on this data.    

Fitting is done using an integrated copy of BestFit, Palisade Corporation's 
distribution fitting software package.  This program may also be run 
without @RISK.  BestFit running without @RISK looks very similar to the 
@RISK – Model window, except that there is no Model tab. 

To fit distributions to data using @RISK, there are five steps that you 
should consider: 

1. Define Input Data 

2. Specify Distributions to Fit 

3. Run the Fit 

4. Interpret the Results 

5. Using the Results of a Fit 

Each of these steps is discussed in this chapter. 
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Define Input Data 
@RISK allows you to analyze three kinds of data for distribution fitting:  
sample, density and cumulative.  @RISK supports up to 100,000 data 
points for each of these types.  The available data types are shown in the 
Input Data Options dialog box in the Model window. 

 

Sample Data 
Sample (or observation) data is a set of values drawn randomly from a 
large population.  Distributions are fit to sample data to estimate the 
properties of that population. 

Sample data is either continuous or discrete.  Continuous sample data can 
take on any value over a continuous range, while discrete data is limited 
to integer values.  Discrete data can be entered in two formats.  In the 
“standard” format, you enter each data point individually.  In the 
“counted” format, the data is entered in pairs, where the first value is the 
sampled value and the second is the number of samples drawn with that 
value. 

Data requirements for sample data include: 

♦  You must have at least five data values. 

♦  Discrete data values must be integral. 

♦  All sample values should fall in the range -1E+37 <= x <= +1E+37. 

Continuous vs. 
Discrete 
Samples 

Data 
Requirements 
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Density Data 
Density data is a set of (x,y) points that describe the probability density 
function of a continuous distribution.  Distributions are fit to density data 
to give the best representation of the curve points using a theoretical 
probability distribution. 

Since all probability distribution functions must have unit area, @RISK 
automatically will scale your y-values so that the density curve described 
by your data has an area of one.  Since the points you specify are isolated 
points on a continuum, linear interpolation between these points is used 
to calculate the normalization factor.  In certain cases, such as fitting to 
data generated from a mathematical function already known to be 
normalized,  it is undesirable to have @RISK apply its own normalization.  
In these cases, you may turn off this feature. 

Data requirements for density data include: 

♦  You must have at least three (x,y) data pairs. 

♦  All x-values must be in the range –1E+37 <= x <= +1E+37. 

♦  All x-values should be distinct. 

♦  All y-values must be in the range 0 <= y <= +1E+37. 

♦  At least one y-value must be non-zero. 

Cumulative Data 
Cumulative data is a set of (x,p) points that describe a continuous 
cumulative distribution function.  The p-value associated with a given x-
value is the probability of obtaining a value less than or equal to x.  
Distributions are fit to cumulative data to give the best representation of 
the curve points using a theoretical probability distribution. 

In order to calculate statistics and display graphs of your cumulative data, 
@RISK needs to know where the input minimum and maximum are (that 
is, the points with p=0 and p=1).  If you do not explicitly supply these 
points, @RISK will linearly interpolate them from your data.  In general, it 
is recommended that you always include the p=0 and p=1 points in your 
data set, if possible. 

Normalization of 
Density Data 

Data 
Requirements 

Endpoint 
Interpolation 
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Data requirements for cumulative data include: 

♦  You must have at least three (x,p) data pairs. 

♦  All x-values must be in the range –1E+37 <= x <= +1E+37. 

♦  All x-values must be distinct. 

♦  All p-values must be in the range 0 <= p <= 1. 

♦  Increasing x-values must always correspond to increasing p-values. 

Filtering Your Data 
You can further refine your input data by applying an input filter.  
Filtering tells @RISK to ignore outliers, based on criteria you specify, 
without requiring you to explicitly remove them from your data set.  For 
example, you may wish to only analyze x-values greater than zero.  Or, 
you may wish to filter values that lie outside two standard deviations 
from the mean. 

Bringing Data Into @RISK For Fitting 
Numerous methods are available for bringing your data into @RISK.  You 
may type it directly into the input data grid, paste it from another 
Windows application, fit directly from the @RISK-Results window, or 
even create a link between @RISK and an Excel spreadsheet. 

The Paste command imports data to the input sheet from the Windows 
Clipboard.  To do so, highlight the data you want to copy and paste into 
your @RISK input sheet.  To import data from a non-spreadsheet 
application, be sure that paired data is tab-delimited and each set ends 
with a carriage return. 

Data that resulted from an @RISK simulation can be fit very easily by 
choosing the Fit command from the Explorer list pop-up menu in the 
@RISK-Results window. 

You can also link the data on a fit tab to a range in Microsoft Excel.  To do 
this, highlight the range you want to link, and click the Fit Distributions 
to Data command from within Excel.  Alternatively, you can set the link 
directly in the Input Data Options dialog in the @RISK-Model window. 

Data 
Requirements 
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Select Distributions To Fit 
After you define your data set, you must specify the distributions you 
want @RISK to attempt to fit.  There are three general questions you must 
answer to do this. 

Continuous vs. Discrete Distributions 
For sample data, you should first decide if your data is continuous or 
discrete.  Discrete distributions always return integer values.  For 
example, presume you have a set of data describing the number of 
failures in a series of 100 trial batches.  You would only want to fit discrete 
distributions to this set because partial failures are not allowed.  In 
contrast, continuous data can take on any value in a range.  For example, 
presume you have a set of data describing the height, in inches, of 300 
people.  You would want to fit continuous distributions to this data, since 
heights are not restricted to integral values. 

If you specify that your data is discrete, all your data values must be 
integers.  Keep in mind, however, that the converse is not true.  Just 
because you have all integral data values does not mean you have to fit 
only discrete distributions.  In the previous example, the height data set 
may be rounded to the nearest inch, but fitting to continuous distributions 
is still appropriate. 

@RISK does not support the fitting of discrete distributions to density and 
cumulative curve data. 

You can specify whether your data set is continuous or discrete in the 
Input Data Options dialog. 

Estimated Parameters vs. Predefined Distributions 
Generally, you will want @RISK to estimate the parameters of your 
distributions.  However, in some cases, you may want to specify exactly 
what distributions to use.  For example you may want to have @RISK 
compare two competing hypotheses and tell you which one is a better 
description of your data. 

Predefined distributions can be set in the Specify Distributions to Fit 
dialog. 
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Domain Limits 
For continuous data sets (sample or curve data) you can specify how you 
want @RISK to treat the upper and lower limits of the distributions.  For 
both limits there are four choices:  fixed bound, unknown bound, open 
bound, and unsure.  Domain limits can be set in the Specify 
Distributions to Fit dialog. 

 
If you specify a fixed bound, you are telling @RISK that the limit of the 
distribution must be the value you specify.  For example, if you have a 
data set of the times between arrivals of customers in a queue, you might 
want to fit distributions which have a fixed lower bound of zero, since it is 
impossible to have a negative time between events.  

If you specify an unknown bound, you are telling @RISK that the limit of 
the distribution has a finite bound (that is, it does not extend to plus or 
minus infinity).  Unlike a fixed bound, however, you do not know what 
the actual value of the limit is.  You want @RISK to choose the value for 
you as it performs its fit. 

If you specify an open bound, you are telling @RISK that the limit of the 
distribution must extend to minus infinity (for a lower bound) or plus 
infinity (for an upper bound). 

Fixed Bound 

Unknown 
Bound 

Open Bound 
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This is the default option.  It is the combination of an unknown bound 
and an open bound.  The limits of distributions that are non-asymptotic 
are treated as in the unknown bound case, while asymptotic distributions 
are still included as in the open bound case. 

Note, not all distributions functions are compatible with all the possible 
choices.  For example, you can not specify a fixed or unknown lower 
bound for the Normal distribution, since it asymptotically extends to 
minus infinity. 

Unsure 
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Run The Fit 
To start the fitting process, click the Run Fit icon on the Fitting toolbar. 

For each of the distributions specified in the previous step, @RISK will try 
to find the set of parameters that make the closest match between the 
distribution function and your data set.  Keep in mind, @RISK does not 
produce an absolute answer, but rather identifies a distribution that most 
likely produced your data.  Always evaluate your @RISK results 
quantitatively and qualitatively, examining both the comparison graphs 
and statistics before using a result. 

@RISK uses two methods to calculate the best distributions for your data 
set.   For sample data, distribution parameters are estimated using 
Maximum Likelihood Estimators (MLEs).  For density and cumulative 
data (collectively known as curve data), the method of least squares is 
used to minimize the root-mean square error between the curve points 
and the theoretical function. 

Sample Data – Maximum Likelihood Estimators 
(MLEs) 
The MLEs of a distribution are the parameters of that function that 
maximize the probability of obtaining the given data set. 

For any density distribution f(x) with one parameter α, and a 
corresponding set of n sampled values Xi, an expression called the 
likelihood may be defined: 

 L =
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To find the MLE, simply maximize L with respect to α: 

 d
d

L
α

= 0 

and solve for α.   The method described above can be easily generalized to 
distributions with more than one parameter.  

Definition 
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An exponential function with a fixed lower bound of zero has only one 
adjustable parameter, and its MLE is easily calculated.  The distribution’s 
density function is:   

 β

β
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and the likelihood function is: 
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To simplify matters, we can use the natural log of the likelihood function: 
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To maximize the log of the likelihood, simply set its derivative with 
respect to b to zero: 
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Therefore, when @RISK tries to fit your data to the best Exponential 
function with a fixed lower bound of zero, it first finds the mean of the 
input data and uses it as the MLE for β.  

For some distributions, the MLE method described above does not work.  
For example, a 3-parameter Gamma distribution (a Gamma distribution 
whose lower bound is allowed to vary) can not always be fit using MLEs.  
In these cases @RISK will resort to a hybrid algorithm, which combines 
the standard MLE approach with a moment matching procedure. 

A Simple 
Example 

Modifications to 
the MLE Method 
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 In certain distributions, a strict MLE method produces parameters which 
are heavily biased for small sample sizes.  For example, the MLE of the 
“shift” parameter of an exponential distribution and the minimum and 
maximum parameters of the uniform distribution are heavily biased for 
small sample sizes.  Where possible, @RISK will correct for the bias. 

Curve Data – The Method of Least Squares 
The root-mean square error (RMSErr) between set of n curve points (Xi, 
Yi) and a theoretical distribution function f(x) with one parameter α is: 

∑
=

=
n
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iiRMSErr
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2( )y-),f(x
n
1 α  

The value of α  that minimizes this value is called the least squares fit.  In 
a sense, this value minimizes the “distance” between the theoretical curve 
and the data.  The formula above is easily generalized to more than one 
parameter. 

This method is used to calculate the best distribution for both density and 
cumulative curve data. 
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Interpret the Results 
Once @RISK has completed the fitting process, you should review its 
results.  @RISK provides a powerful array of graphs, statistics, and reports 
to help you evaluate fits and select the best choice for your models. 

Ranking of Fits 
@RISK ranks all the fitted distributions using one or more fit statistics.  
For continuous sample data, you can choose to rank fits by their chi-
squared statistic, Anderson-Darling statistic, or Kolmogorov-Smirnov 
statistic.  Each of these statistics is discussed in more detail, later in this 
section.  For discrete sample data, only the chi-squared statistic can be 
used.  For density and cumulative curve data, the fits are ranked by their 
RMS Error value. 

Graphs 
@RISK provides four types of graphs to help you visually assess the 
quality of your fits. 

A comparison graph superimposes the input data and fitted distribution 
on the same graph, allowing you to visually compare them either as 
density or cumulative curves.  This graph allows you to determine if the 
fitted distribution matches the input data in specific areas.  For example, it 
may be important to have a good match around the mean or in the tails. 

 

Comparison 
Graphs 
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A difference graph displays the absolute error between the fitted 
distribution and the input data.  

 
Probability-Probability (P-P) graphs plot the distribution of the input data 
(Pi) vs.  the distribution of the result (F(xi)).  If the fit is "good," the plot 
will be nearly linear.  P-P graphs are only available for fits to sample data. 

 

Difference 
Graphs 

P-P Graphs 
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Quantile-Quantile (Q-Q) graphs plots percentile values of the input 
distribution (xi) vs.  percentile values of the result (F-1(Pi)).  If the fit is 
"good," the plot will be nearly linear.  Q-Q graphs are only available for 
fits to continuous sample data. 

 

Q-Q Graphs 
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Statistics and Targets 
@RISK reports basic statistics (mean, variance, mode, etc.) for each fitted 
distribution, which can easily be compared to the same statistics for the 
input data. 

@RISK allows you to compare percentiles and target values between 
distributions and the input data.  For example, perhaps the 5th and 95th 
percentiles values are important to you.  This can be done in two ways.  
First, all @RISK graphs have a set of “delimiters” which allow you to 
visually set two different targets or percentiles.  Second, the @RISK 
Summary Report has a data entry area for specifying up to ten different 
targets or percentiles. 

 

Fit Statistics 
For each fit, @RISK  reports one or more fit statistics.  These statistics 
measure how good the distribution fits the input data and how confident 
you can be that the data was produced by the distribution function.  For 
each of these statistics, the smaller the value, the better the fit.  @RISK 
makes use of four different fit statistics: chi-squared, Kolmogorov-
Smirnov, Anderson-Darling, and Root-Mean Squared Error. 

When more than one fit statistic is available, there is no hard rule to 
decide which test will give you the "best" result.  Each test has its 
strengths and weaknesses.  You must decide which information is most 
important to you when considering which test to use. 
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The chi-squared statistic is the best known goodness-of-fit statistic.  It can 
be used with both continuous and discrete sample data.  To calculate the 
chi-squared statistic, you first must break up the x-axis domain into 
several “bins”.  The chi-squared statistic is then defined as: 
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where 

 K = the number of bins 

iN  = the observed number of samples in the ith bin 

iE = the expected number of samples in the ith bin. 

A weakness of the chi-squared statistic is that there are no clear guidelines 
for selecting the number and location of the bins.  In some situations, you 
can reach different conclusions from the same data depending on how 
you specified the bins. 

Some of the arbitrariness of the bin selection can be removed by telling 
@RISK to use equiprobable bins.  In this mode, @RISK will adjust the bin 
sizes based on the fitted distribution, trying to make each bin contain an 
equal amount of probability.  For continuous distributions this is straight-
forward.  For discrete distributions, however, @RISK will only be able to 
make the bins approximately equal. 

@RISK allows you full control of how bins are defined for the chi-squared 
test.  These settings are in the Define Chi-Squared Binning dialog. 

Another fit statistic that can be used for continuous sample data is the 
Kolmogorov-Smirnov statistic, which is defined as 

 ( ) ( )[ ]D F x F xn n= −sup $  

where 

n = total number of data points 

$ ( )F x = the fitted cumulative distribution function 

F x N
nn

x( ) =  

Nx  = the number of Xi ' s   less than x. 

The K-S statistic does not require binning, which makes it less arbitrary 
than the chi-squared statistic.  A weakness of the K-S statistic is that it 
does not detect tail discrepancies very well. 
 

Chi-Squared 
Statistic 

Kolmogorov-
Smirinov 
Statistic (K-S) 
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The final fit statistic that can be used with continuous sample data is the 
Anderson-Darling Statistic, which is defined as: 

 [ ]A n F x F x x f x dxn n
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n = total number of data points 
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$( )f x  = the hypothesized density function 

$ ( )F x = the hypothesized cumulative distribution function 

F x N
nn

x( ) =  

Nx  = the number of Xi ' s  less than x. 
 

Like the K-S statistic, the A-D statistic does not require binning.  But 
unlike the K-S statistic, which focuses in the middle of the distribution, 
the A-D statistic highlights differences between the tails of the fitted 
distribution and input data. 

For density and cumulative curve data, the only fit statistic used is the 
Root-Mean Squared Error.  This is the same quantity that @RISK 
minimized to determine the distribution parameters during its fitting 
process.   It is a measure of the “average” squared error between the input 
and fitted curve. 

Anderson-
Darling Statistic 
(A-D) 

Root-Mean 
Squared Error 
(RMSErr) 
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P-Values and Critical Values 
The goodness-of-fit statistic reports a measure of the deviation of the 
fitted distribution from the input data.  As mentioned earlier, the smaller 
the fit statistic is, the better the fit.   But how small a value is needed for a 
“good” fit?  For fits to sample data, this section explains how P-values and 
critical values can be used to analyze the “goodness” of  a fit.  

For the discussion below, suppose we have a distribution fitted to a set of 
N sampled values, and a corresponding fit statistic, s. 

How likely is it that a new set N samples drawn from the fitted 
distribution would generate a fit statistic greater than or equal to s?  This 
probability is referred to as the P-value and is sometimes called the 
“observed significance level” of the test.  As the P-value decreases to zero, 
we are less and less confident that the fitted distribution could possibly 
have generated our original data set.  Conversely, as the P-value 
approaches one, we have no basis to reject the hypothesis that the fitted 
distribution actually generated our data set. 

Often we want to turn the same question around and specify a particular 
level of significance to use, usually denoted by α.  This value is the 
probability that we will incorrectly reject a distribution because it 
generated, due to statistical fluctuations, a value of s that was very large.  
Now we want to know, given this significance level, what the largest 
value of s is that we would accept as a valid fit.  This value of s is called 
the “critical value” of the fit statistic at the α level of significance.  Any fit 
that has a value of s above the critical value is rejected, while fits with 
values of s below the critical value are accepted.  Typically, critical values 
depend on the type of distribution fit, the particular fit statistic being 
used, the number of data points, and the significance level. 

For the chi-squared test, the P-values and critical values can be calculated 
by finding the appropriate points on a chi-square distribution with k-1 
degrees of freedom (where k is the number of bins).  While this method is 
exactly correct when predefined distributions are used,  it turns out to be 
only an approximation for distributions where @RISK estimated one or 
more distribution parameters.  Conveniently, however, the approximation 
is always a conservative one.  That is, the reported values for both your 
critical values and P-value will be slightly higher than the exact values.  
More information about this can be found in Appendix D: Recommended 
Readings in this manual. 

P-Values 

Critical Values 

Calculation 
Methods in 
@RISK 
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Most critical values and P-values for the A-D and K-S fit statistics have 
been found by very detailed Monte-Carlo studies (see Appendix D: 
Recommended Readings for references).  Unfortunately, not all distributions 
have been analyzed in enough detail for @RISK to be able to report them.   
Where possible @RISK will report the appropriate P-values and critical 
values. Often, where an exact P-value calculation is not possible, a range 
is returned for the P-value, indicating that the true P-value lies between 
the specified upper and lower limit. 
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Using the Results of a Fit 

Exporting Graphs and Reports 
Once you have analyzed the results of your calculation, you may wish to 
export the results to another program.  Of course, you can always copy 
and paste any @RISK graph or report into Excel or another Windows 
application via the clipboard.  In addition, using the Graph In Excel 
command, @RISK allows you to create a copy of the current @RISK graph 
in Excel’s native chart format. 
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Specifying Distributions in Excel 
Often you will want to use the result of a fit in an @RISK model.  If you 
are using @RISK Professional or Industrial with the built-in fitting 
capabilities of BestFit, this is easy.  In the Define Distribution window, 
simply change the source list box to say “Fit Result” and select your 
distribution. 

 
A quick method for using a fit to define a distribution in an @RISK model 
using data that resides in an Excel spreadsheet is to click the New Fit 
button from the Define Distribution window.  Just pop-up the Define 
Distribution window when selecting the cell with the uncertain value.  
Then, click New Fit and select the data in Excel to fit.  Your fit will 
automatically run and return the fit results to the window.  Then you can 
select your distribution from the Fit Results. 
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Introduction 
This chapter describes the icons, commands, probability distribution 
functions and macros used to set up and execute a risk analysis using 
@RISK.  The @RISK Reference Guide chapter is divided into six sections: 
1) Reference: @RISK Icons 
2) Reference: @RISK Add-in Menu Commands 
3) Reference: @RISK Model Window Commands 
4) Reference: @RISK Results Window Commands 
5) Reference: @RISK Functions 
6) Reference: @RISK Macros
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Reference: @RISK Icons 
@RISK icons are used to quickly and easily perform tasks necessary to set 
up and run risk analyses.  @RISK icons appear in three places — on the 
spreadsheet "toolbar" (i.e., as a custom toolbar in Excel), in the @RISK 
Model window and in the @RISK Results window.  Some of the same 
icons are available in each location.  This section briefly describes each 
icon, outlining the functions they perform and the menu command 
equivalents associated with them. 

A second toolbar titled DecisionTools is also available when @RISK for 
Excel is installed.  This toolbar contains icons which can be used to run 
@RISK or any of the other programs in the DecisionTools suite (if these 
programs are installed on your system).  For more information on the 
DecisionTools suite, see Appendix B: Using @RISK With Other 
DecisionTools. 

@RISK Add-in Toolbar 
The following icons are shown on the @RISK toolbar in Excel.  Note: The 
@RISK add-in in Excel has two available toolbars – the standard toolbar 
and an expanded version that contains tools for the Advanced Analyses 
available in @RISK Professional and Industrial. Clicking the "expansion" 
icon at the end of the toolbar changes the toolbar from standard to 
expanded and back. 

Icon Function Performed and Command Equivalent

 
Open a saved @RISK simulation 

Command equivalent: File menu Open command 

 
Save the current @RISK simulation, including results and 
graphs 

Command equivalent: File menu Save command 

 
Add or edit probability distributions in the formula in 
the current cell 

Command equivalent: Model menu Define Distributions 
command 

 
Fits a distribution to the data in an Excel range (expanded 
toolbar only) 

Command equivalent: Model menu Fit Distributions to Data 
command 
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Icon Function Performed and Command Equivalent

 
Add the current selected spreadsheet cell (or range of 
cells) as a simulation output 

Command equivalent: Model menu Add Output command 

 
 

Display current output cell(s) along with all distribution 
functions entered in the worksheet in the Outputs and 
Inputs list 

Command equivalent: Model menu List Outputs and Inputs 
command 

 
Select cells in Excel containing @RISK distribution 
functions, output functions or statistics functions 

Command equivalent: Model menu Select @RISK Functions 
command 

 
View or change the simulation settings, including # of 
iterations, # of simulations, sampling type, standard 
recalc method, executed macros and other settings 

Command equivalent: Simulation menu Settings command 

 
Display reporting options 

Command equivalent: Results menu Report Settings command 

 
Simulate the current worksheet(s) 

Command equivalent: Simulation menu Start command 

 
Run a Goal Seek analysis (expanded toolbar only) 

Command equivalent: Advanced Analyses menu Goal Seek 
command 

 
Run a Stress analysis (expanded toolbar only) 

Command equivalent: Advanced Analyses menu Stress command 

 
Run an Advanced Sensitivity Analysis (expanded toolbar 
only) 

Command equivalent: Advanced Analyses menu Advanced 
Sensitivity Analysis command 
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Icon Function Performed and Command Equivalent

 
Display the Model window with outputs, inputs and 
fitting data 

Command equivalent: Model menu Show Model Window 
command 

 
Display the results of the most recent @RISK simulation 
in the Results window 

Command equivalent: Results menu Show Results Window icon 
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@RISK Model Window Toolbar 
The following icons are shown on the @RISK toolbar in the @RISK Model 
Window. 

Icon Function Performed and Command Equivalent

 
Open a saved @RISK simulation 

Command equivalent: File menu Open command 

 
Save the current @RISK simulation, including results and 
graphs 

Command equivalent: File menu Save command 

 
Add or edit probability distributions in the formula in 
the current cell 

Command equivalent: Model menu Define Distributions 
command 

 
 

Display current output cell(s) along with all distribution 
functions entered in the worksheet in the Outputs and 
Inputs list 

Command equivalent: Model menu List Outputs and Inputs 
command 

 
Correlate probability distributions in the formulas in the 
selected cells 

Command equivalent: Model menu Correlate Distributions 
command 

 
Display report settings options 

Command equivalent: Results menu Report Settings command 

 
View or change the simulation settings, including # of 
iterations, # of simulations, sampling type, standard 
recalc method, executed macros and other settings 

Command equivalent: Simulation menu Settings command 

 
Simulate the current worksheet(s) 

Command equivalent: Simulation menu Start command 
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Display the results of the most recent @RISK simulation 
in the Results window 

Command equivalent: Window menu Show Results Window 
command 

 
Display Excel and the @RISK add-in program 

Command equivalent: Window menu Show Excel command 

 
Fit distributions to data 

Command equivalent: Fitting menu Run Fit command 

 
Specify distribution(s) to fit 

Command equivalent: Fitting menu Distributions command 

 
Define Chi-Sq test binning 

Command equivalent: Fitting menu Define Chi-Sq Binning 
command 

 
Display input data options 

Command equivalent: Fitting menu Input Data Options 
command 

 
Sort input data 

Command equivalent: Fitting menu Sort command 

 
Generate random data 

Command equivalent: Fitting menu Generate command 

 
Transform data 

Command equivalent: Fitting menu Transform command 

 
Insert Fit Tab 

Command equivalent: Insert menu Fit Tab command 

 
Insert Artist Window 

Command equivalent: Insert menu Artist Window command 

 
Insert Distribution Window 

Command equivalent: Insert menu Distribution Window 
command 
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Insert Fit Results Window 

Command equivalent: Insert menu Fit Results Window 
command 

 
Insert Fit Results Window 

Command equivalent: Insert menu Fit Summary Window 
command 

 
Display current graph as a density graph 

Command equivalent: Graph menu Format Graph command 
Graph Type - Density option 

 
Display current graph as a cumulative ascending line 
graph 

Command equivalent: Graph menu Format Graph command 
Graph Type – Cumulative Ascending option 

 
Display current graph as a cumulative ascending area 
graph 

Command equivalent: Graph menu Format Graph command 
Graph Type – Cumulative Ascending option 

 
Display graph format options 

Command equivalent: Graph menu Format Graph command 

 
Generate current graph as an Excel format graph 

Command equivalent: Graph menu Graph in Excel command 
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@RISK Results Window Toolbar 
The following icons are shown on the toolbar in the @RISK Results 
Window, or when you right-click on an input or output in the Explorer 
list in the Results Window. 

Icon Function Performed and Command Equivalent

 
Open a saved @RISK simulation 

Command equivalent: File menu Open command 

 
Save the current @RISK simulation, including results and 
graphs 

Command equivalent: File menu Save command 

 
Display report settings options 

Command equivalent: Results menu Report Settings command 

 
View or change the simulation settings, including # of 
iterations, # of simulations, sampling type, standard 
recalc method, executed macros and other settings 

Command equivalent: Simulation menu Settings command 

 
Simulate the current worksheet(s) 

Command equivalent: Simulation menu Start command 

 
Display Excel and the @RISK add-in program 

Command equivalent: Window menu Show Excel command 

 
Display the Model window with outputs, inputs and 
fitting data 

Command equivalent: Window menu Show Model Window 
command 

 
Graphs the output or input which is selected in the 
Explorer 

Command equivalent: Insert menu Graph command 

 
Display summary statistics window 

Command equivalent: Insert menu Summary Statistics command 

 
Display detailed statistics window 

Command equivalent: Insert menu Detailed Statistics command 
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Display data window 

Command equivalent: Insert menu Data command 

 
Display sensitivity analysis window 

Command equivalent: Insert menu Sensitivity command 

 
Display scenario analysis window 

Command equivalent: Insert menu Scenarios command 

 
Graph tornado(s) of sensitivity analysis results 

Command equivalent: Insert menu Graph command – Tornado 
Graph  

 
Graph summary of simulation results for output range(s) 

Command equivalent: Insert menu Graph command – Summary 
Graph  

 
Display current graph as a histogram 

Command equivalent: Graph menu Graph Type command – 
Histogram – Bars option 

 
Display current graph as an area graph 

Command equivalent: Graph menu Graph Type command – 
Histogram – Area Graph option 

 
Display current graph as a fitted curve 

Command equivalent: Graph menu Graph Type command – 
Histogram – Fitted Curve option 

 
Display current graph as a cumulative ascending line 
graph 

Command equivalent: Graph menu Graph Type command – 
Ascending Cumulative – Line option 

 
Display current graph as a cumulative descending line 
graph 

Command equivalent: Graph menu Graph Type command – 
Descending Cumulative – Line option 
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Display current graph as a cumulative descending area 
graph 

Command equivalent: Graph menu Graph Type command – 
Descending Cumulative – Filled option 

 
Display current graph as a cumulative ascending area 
graph 

Command equivalent: Graph menu Graph Type command – 
Ascending Cumulative – Filled option 

 
Display graph format options 

Command equivalent: Graph menu Format Graph command 

 
Generate current graph as an Excel format graph 

Command equivalent: Graph menu Graph in Excel command 

 
Generate a quick , single page report on simulation 
results in Excel 

Command equivalent: Report menu Quick Report command 



172 Reference: @RISK Icons 

 

DecisionTools Toolbar 
The following icons are shown on the DecisionTools Suite toolbar in Excel 
only. 

 

Icon Functions Performed and Command 
Equivalent 

 
Load the @RISK add-in. 
Equivalent to the @RISK command on the Excel Tools menu. 

 
Load the TopRank add-in. 
Equivalent to the TopRank command on the Excel Tools menu. 

 
Load the PrecisionTree add-in. 
Equivalent to the PrecisionTree command on the Excel Tools 
menu. 

 
Load the Evolver add-in. 

Equivalent to the Evolver command on the Excel Tools menu. 

 
Load the RISKOptimizer add-in. 

Equivalent to the RISKOptimizer command on the Excel Tools 
menu. 

 
Starts the BestFit program. 
Starts the BestFit program for distribution fitting.  @RISK 
Professional and Industrial users can access distribution fitting 
byselecting the Show Model Window command on the @RISK 
menu in Excel, followed by the @RISK Model window Insert 
menu Fit Tab command. 

 
Display the Define Distribution pop-up window. 
Equivalent to the Define Distribution command on the @RISK 
menu in Excel. 
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Reference: @RISK Add-In Menu 
Commands    

This section of the @RISK Reference Guide details the available @RISK 
commands as they appear on the @RISK add-in menu in Excel.  
Commands are discussed as they appear on the menu, starting with the 
File command and subsequently moving down the menu.  @RISK icons 
can be used to perform many of the available commands.  The Reference: 
@RISK Icons section of this chapter gives the command equivalents for 
each @RISK icon. 

 
Several @RISK commands are also available in a pop-up floating menu 
that is displayed when the right mouse button is clicked on a cell in Excel. 
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File Menu 

New Command 
Clears all active @RISK simulation data and results 

The New command clears all active @RISK simulation data from the 
Results and Model windows and resets @RISK settings to their default 
values. 

Open Command 
Opens a saved @RISK simulation 

The File Open command opens a previously saved simulation data file 
(.RSK file or @RISK 3.5 .SIM file) including simulation settings, all input 
data and graphs (with supporting fitted datasets) and simulation results 
including any generated graphs.  

 

 
When the File Open command is selected (or the Open icon is clicked), a 
standard Windows File Open dialog box is displayed.  Using this dialog 
box, drives and directories can be changed and the desired @RISK .RSK 
file opened. 

@RISK .SIM files must have been saved with @RISK Version 3.0 or higher.  

@RISK will automatically load your simulation settings and specified 
outputs when you open a worksheet that was previously used with 
@RISK. 

 
Open Icon 

Open 
Simulation 
File Dialog 
Box 
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Save Command, Save As Command 
Saves the current @RISK simulation data or graph 

The File menu Save and Save As commands save the current @RISK data 
in a .RSK file.  The @RISK data saved includes the current input 
information in the Model window, any simulation results generated and 
any graphs created in the Results window.  The File menu Save command 
automatically saves the .RSK file in the drive and directory where the 
worksheet being simulated was saved to. 

 
When the File menu Save As command is selected, a standard Windows 
File Save dialog box appears.  Using this, a .RSK file may be saved to any 
desired drive or directory. 

Saving your @RISK data does not save your worksheet with distribution 
functions.  You need to save this separately using the Excel File Save 
commands. 

Note if you rename a saved worksheet outside of Excel, any attached .RSK 
files will be unable to locate your workbook! 

Exit Command 
Unloads the @RISK add-in from Excel 
The File menu Exit command unloads the @RISK add-in in Excel and 
shuts down the supporting @RISK-Model and @RISK-Results windows.  
If you shut down @RISK during an Excel session, you can restart it at a 
later time by clicking the @RISK icon on the DecisionTools toolbar. 

 

 
Save Icon 

Save Simulation 
File Dialog Box 
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Model Menu 

Define Distribution Command 
Defines or edits probability distributions entered in the current 
cell formula 

The Model menu Define Distribution command displays the Define 
Distribution pop-up window.  Using this window, probability 
distributions can be assigned to values contained in the formula of the 
selected cell.  This pop-up window also allows you to edit distributions 
already present in a cell’s formula.  All changes and edits made in the 
pop-up window are added directly to the cell’s formula when the window 
is closed. 

 
By right-clicking on a cell in your spreadsheet and selecting the @RISK 
Define Distribution command (or by clicking the Define Distribution 
icon or selecting the @RISK menu Model Define Distributions command) 
you can display the Define Distribution pop-up window. 

The @RISK Define Distribution window graphically displays probability 
distributions which can be substituted for values in the formula in the 
current cell.  By changing the displayed distribution you can see how 
various distributions would describe the range of possible values for an 
uncertain input in your model.  The displayed statistics further show how 
a distribution defines an uncertain input.   

Define 
Distribution 
Window 
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The graphical display of an uncertain input is useful in showing your 
definition of an uncertain input to others.  It clearly displays the range of 
possible values for an input and the relative probability of any value in 
the range occurring.  Working with distribution graphs you can easily 
incorporate other individual assessments of uncertainty into your risk 
analysis models. 

The different elements of the Define Distribution window are as follows: 

•  Cell Formula.  Displays the current cell formula including any @RISK 
distribution functions.  This formula may be edited here just as in Excel.   

•  Source.  Specifies the source of the distribution to be graphed, either 
function, fit results or none.  

1) Function specifies that distribution type and arguments are 
entered by the user directly in the window. 

2) Fit Results (Professional and Industrial Versions only) specifies 
that the distribution is from a fit result. For more on using fitting to 
select a distribution, see Defining a Distribution By Fitting later in this 
section. 

3) None removes any entered distribution.  None typically is used to 
remove an overlay. 

When source is set to function, the following items allow the entry of a 
distribution type and arguments: 

•  Dist. and Arguments.  Selects a distribution type from all available 
distributions.  Depending on the distribution type selected the 
displayed arguments will change.  For distributions that take a set 
with a variable number of p or x,p values, a grid is displayed that 
allows entry of those values.    

•  Tr. Min and Max.  Sets the minimum and maximum truncation limit 
for the entered distribution.  When truncation values are entered, no 
values outside the truncation limits will be sampled. 

Delimiters and Statistics are used to display underlying statistics on 
displayed distribution graphs: 

•  Delimiters (marked with inverted triangles).  Allows setting of target 
probabilities and x-axis scaling using the mouse.  Cumulative 
probabilities can be set directly on a distribution graph using the 
displayed probability delimiters. Dragging probability delimiters 
changes left and right x and p values shown in the probability bar 
below the graph and in the statistics grid.  Dragging the delimiters at 
either end of the x-axis rescales the x-axis. 

Contents of the 
Define 
Distribution 
Window 
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•  Statistics.  Displays the statistics for the graphed distributions, 
including any overlays. In addition, x and p values set using the 
delimiters in the statistics grid to the right of the distribution graph 
are also shown.   

 

•  Distribution Palette.  Clicking the Dist… button displays the 
Distribution Palette with graphical images of all available probability 
distribution types: 

 
 Clicking on the picture of a distribution selects it. 

Distribution 
Palette 
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The following icons are available in the Define Distribution Window (as 
displayed left to right in the window): 

•  Insert Function.  Inserts the displayed distribution function into the 
cell formula, replacing the selected text in the formula. 

•  Enter Reference.  Allows an Excel reference or formula to be entered 
for a distribution argument by pointing and clicking in Excel. Clicking 
this icon when the cursor is located in an argument entry text box 
displays a selector in Excel.  This allows you to click on a cell or cell 
range that you wish to reference and use as an argument value. 

•  Function Properties.  Displays the function properties for the selected 
distribution, including name, collect and lock status. The entry Use 
Default Cell Name indicates that @RISK will name your input using 
the labels for the cell where the distribution is located. Collect 
indicates that @RISK will collect the samples generated by the input 
during simulation (see the function Collect for more information on 
this).  Lock indicates that @RISK will not sample the input during 
simulation (see the function Lock for more information on this). 

 
•  Primary/Overlay Switch.  Switches the displayed graph and 

distribution information from the primary curve to the overlay curve.  
If no overlay is present on the graph, clicking the Primary/Overlay 
switch displays the Distribution Palette where a distribution type for 
the overlay can be selected. 

•  Alternate Parameters.  Allows the selection of percentile parameters 
as arguments to the selected distribution.   

•  Graph Formatting.  Displays the Graph Format dialog for changing 
type, scaling, style and titles for the displayed graph. 

Icons in the 
Define 
Distribution 
Window 
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Alternate Parameters allow you to specify values for specific percentile 
locations of an input distribution as opposed to the traditional arguments 
used by the distribution.  The percentiles to be entered are specified in the 
Alternate Distribution Parameters dialog, displayed by clicking the ALT 
icon.  Depending on the type of distribution being entered, the contents of 
the Alternate Distribution Parameters dialog will change. 

 
Percentile parameters may be mixed with standard parameters by clicking 
the appropriate radio buttons.  By selecting Save as Default, a set of 
percentile arguments may be set as the default for a given distribution 
type, so that every lognormal distribution, for example, will be entered in 
the Define Distribution window using a 10th and 90th percentile value. 

Selecting Use Cumulative Descending Percentiles specifies that the 
percentiles used for alternate parameters will be in terms of cumulative 
descending probabilities.  Percentiles entered in this case specify the 
probability of a value greater than the entered argument x-value. 

To replace a value in the formula with a distribution function: 

1) Select the value to be replaced by highlighting it in the Cell Formula. 

2) Select and graph the desired distribution function. 

3) Click the replace arrow below the Cell Formula box.  The desired 
distribution (in the form of a probability distribution function) will 
replace the selected value in the formula. 

To display the graph of a contained distribution function: 

1) Right-click anywhere inside the distribution function entry.  It will be 
displayed underlined and in red and the graph of the distribution will 
be displayed. 

2) Any changes to the displayed distribution will be automatically made 
to the distribution selected in the cell formula. 

Alternate 
Parameters 

Entering and 
Editing 
Distributions in 
the Define 
Distribution 
Window 
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In some cases an input distribution is selected by fitting probability 
distributions to a set of data.  You may have a set of sample data for an 
input and you wish to find the probability distribution that best describes 
that data.  A fit tab in the @RISK Model Window has all the commands 
necessary for fitting distributions to data.  This fitting can also be accessed 
directly from the Define Distribution window to allow you to quickly 
perform fits and then assign fit results to a model input. 

To perform a new fit and assign a fit result to a model input: 

1) Click the New Fit button in the Define Distribution window. A dialog 
is displayed that allows you to select a range of data in Excel to fit, 
along with the type and domain of data to be fitted. 

 
2) After selecting your data and its type, click OK and probability 

distributions will be fit to the data.  The Define Distribution dialog 
then shows a list of the fitted probability distributions, from best to 
worst.  From this list you can select a distribution to use for the input. 

 

Fitting from the 
Define 
Distribution 
Window 
(Professional 
and Industrial 
Versions) 
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More information on the fit is available on the Fit Tab in the @RISK – 
Model window that is created when the fit was performed.  Click Fit 
Details in the Define Distribution window to move to the tab for the 
current fit and change fitting options.  For more information on @RISK – 
Model window fitting options, see the Fitting Menu commands in the 
Reference: @RISK – Model section of this manual. 

The options available in the Fit Excel Data dialog include: 

•  Fit Tab Name.  Specifies the name of the fit tab in the @RISK- Model 
window where the detailed information on the fit can be found. 

•  Excel Data Range.  Identifies the location of the data in Excel to be 
fitted. 

The additional options for input data in the Fit Excel Data dialog are the 
same as shown when the Fitting Menu Input Data Options command is 
selected.  For more information on these options Fitting Menu Input Data 
Options command in the Reference: @RISK – Model section of this 
manual.  

Once you have selected a distribution from the list of fit results, the 
selected distribution function, including a RiskFit distribution property 
function, is shown in the top formula of the Define Distribution window.  
The RiskFit function maintains a link between the input distribution in 
your model and the fitted data and indicates what type of fit result, such 
as "Best Chi-Sq", you wish to use to select the distribution.  If you update 
or change the data at a later time, the fit will automatically be recalculated 
and the new fitted distribution placed in your model.  Distribution 
functions in Excel may be updated 1) immediately when a fit changes or 
2) when the next simulation is run or the outputs and inputs list is 
generated.  Use the @RISK Model window Fitting menu Update @RISK 
Linked Functions command to select when your distributions get 
updated.  For more information on the RiskFit function, see the 
Reference: @RISK Functions section of this manual. 

If no RiskFit function is used in the distribution function for a fit result, 
the distribution will be "unlinked" from the data which was fitted to select 
it.  If the data is later changed the distribution will remain as is. 

Fit Excel Data 
Dialog  

Linking with the 
RiskFit Function 
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Add Output Command  
Adds a cell or range of cells as a simulation output or output 
range  
Selecting the Model menu Add Output command (or clicking the Add 
Output icon) adds the currently selected range of worksheet cells as a 
simulation output.  A distribution of possible outcomes is generated for 
every output cell selected.  These probability distributions are created by 
collecting the values calculated for a cell each iteration of a simulation. 

A Summary graph may be generated when a selected output range has 
more than one cell in it.  For example, in one output range, you could 
select all the cells in a row in your worksheet.  The output distributions 
from these cells would be summarized in a Summary graph.  You could 
also see an individual probability distribution for any cell in the range. 

Sensitivity and Scenario analysis results are also generated for each 
output cell.  For more information on these analyses, see the descriptions 
of these analyses in Results Window section of this chapter. 

When a cell is added as a simulation output a RiskOutput function is 
placed in the cell.  These functions allow the easy copying, pasting and 
moving of output cells.  RiskOutput functions may also be entered in 
formulas the same way you would type in any standard Excel function, 
bypassing the Add Output command. RiskOutput functions optionally 
allow you to name your simulation outputs and add individual output 
cells to output ranges.  A typical RiskOutput function might be: 

=RiskOutput(“Profit”)+NPV(.1,H1…H10) 

where the cell, prior to its selection as a simulation output, simply 
contained the formula 

= NPV(.1,H1…H10) 

The added RiskOutput function selects the cell as a simulation output and 
gives the output the name “Profit”.  For more information on RiskOutput 
functions, see the section: Reference: @RISK Functions. 

When an output is added, you are given the opportunity to name it or use 
the default name @RISK has identified.  You can enter a reference to an 
Excel cell containing the name by simply clicking in the desired cell .  The 
name (if not the @RISK default name) is added as an argument to the 
RiskOutput function used to identify the output cell. 

 

 
Add Output icon 

RiskOutput 
Functions 

Naming an 
Output 
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At any time a name may be changed by editing the name argument to the 
RiskOutput function or by using the Model window Model menu 
Function Properties command.  If you do not wish to individually name 
outputs and just use @RISK default names, select Don't Show This 
Dialog Again.  If this is done, the Output Name dialog may be 
redisplayed by enabling the @RISK Add-in Options menu Prompt For 
Output Names option. 

To add a new output range: 

1) Highlight the range of cells in your spreadsheet that you wish to add 
as an output range.  If multiple cells are included in the range, 
highlight all the cells by dragging the mouse. 

2) Click the Add Output icon (the one with the single red arrow).  The 
selected range of cells will be added as outputs and RiskOutput 
functions will be entered.   

3) To view the outputs in the Outputs and Inputs list, click the List icon 
(the one with both a blue and red arrow) or select the @RISK Model 
menu List Outputs and Inputs command. 

Select @RISK Functions Command 
Selects cells in Excel containing @RISK functions   
The Select @RISK Functions command selects cells in Excel containing 
@RISK distribution functions,  output functions, statistics functions or 
graphing functions. 

 
Using the Select @RISK Functions command you can quickly identify and 
format cells containing @RISK functions so they can easily be identified. 

How To Add a 
Simulation 
Output 
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Fit Distributions to Data Command 
Fits probability distributions to data in Excel and displays the 
results on a fit tab in the @RISK-Model window 

The Model menu Fit Distributions to Data command (also invoked by 
clicking the Fit Distributions to Data icon on the expanded toolbar)  fits 
probability distributions to the data in a selected Excel range.  The Fit 
Excel Data dialog allows you to select the data in Excel you want to fit and 
its type.  Once fitting is done, the selected data and the results of the fit are 
shown on a fit tab in the @RISK-Model window. 

For more information on using the Fit Excel Data dialog, see Fit Excel 
Data Dialog under the Define Distributions command in this section.  For 
more information on @RISK – Model window fitting options and results, 
see the Fitting Menu commands in the Reference: @RISK – Model section 
of this manual. 

 

 
Fit Distributions 
to Data icon 
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List Outputs and Inputs Command 
Displays the Outputs and Inputs list in the Model window, 
listing output cells and distribution functions in your 
worksheet(s) 
The Model menu List Output and Inputs command (or clicking the List 
icon) shows all selected output cells and all identified input distribution 
functions in your worksheet(s) in an Explorer list in the @RISK Model 
program.   The Inputs and Outputs table displays all distribution and 
output functions in the model.  

 
For each Output variable, the list and table show: 

•  Cell Reference, or the reference of the selected output cell. 

•  Name, or the name of the cell as determined by @RISK or which you 
have previously entered. 

For each input distribution function, the list and table show: 

•  Cell Reference, or the reference of the input cell where the 
distribution function is located. 

•  Name, or the name of the cell as determined by @RISK or entered by 
you. 

The Inputs and Outputs table also displays the cell reference of all entered 
inputs and outputs and their current Lock and Collect settings.  Name, 
Collect and Lock information may be edited in this table. 

 
List Icon 
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How is the Outputs and Inputs List Created? 
The Outputs and Inputs list is set up automatically when you select to 
display the list.  When the list is displayed, your worksheets are scanned 
or re-scanned for @RISK functions. 

As new distribution functions are found, they are added to the Inputs list.  
This list summarizes all your distribution functions — their cell address 
and the "name" of the cell they are located in.   

If a name is not entered in a RiskOutput function or in a distribution 
function, @RISK will automatically try to create a name.  These names are 
created by scanning the spreadsheet around the cell where the input or 
output is located.  To identify names, @RISK moves from the input or 
output cell across the row of the spreadsheet to the left and up the column 
towards the top.  It moves across these ranges of the spreadsheet until it 
finds a label cell, or a cell without a formula in it.  It then takes these row 
and column "headings" and combines them to create a possible name for 
the input or output.  Many times, in standard spreadsheets with row 
labels down the left and column labels across the top, this process results 
in accurate names.  However, in some spreadsheets, automatic naming 
will pick up non-sensical labels.  In these cases you will need to edit the 
names displayed in the Outputs and Inputs list in order to enter more 
meaningful names for your variables. 

Tip:  If there is a significant delay as @RISK rescans your worksheet each 
time the Outputs and Inputs list is displayed, click the Show Model 
Window icon instead.  If this is done, @RISK simply redisplays your old 
Outputs and Inputs list and doesn't rescan the worksheet.  To rescan, use 
the Model menu List Outputs and Inputs command or select the List icon. 

Show Model Window Command 
Shows the @RISK Model window 

The Model menu Show Model Window command shows the @RISK 
Model window.  This command redisplays your old Outputs and Inputs 
list and doesn't rescan the worksheet.  To rescan, use the Model menu List 
Outputs and Inputs command or select the List icon. 

How Are 
Variable Names 
Generated? 

 

 
Show Model 
Window icon 
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Simulate Menu 

Simulation Settings Command 
Changes the settings which control the simulations performed by 
@RISK  
The Simulation Settings command affects the tasks performed during a 
simulation.  All settings come with default values which you may change 
if you wish.  The simulation settings affect the type of sampling @RISK 
performs, the updating of the worksheet display during simulation, the 
values returned by Excel in a standard recalculation, seeding of the 
random number generator used for sampling, the status of convergence 
monitoring and macro execution during simulation.  All simulation 
settings are saved when you save a simulation using the @RISK File menu 
Save command. 

Note: To save simulation settings so they will be used as the default 
settings each time you start @RISK, use the Save as Default button in the 
Settings dialog box. 

 
 

 

 
Simulation 
Settings Icon 
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Iterations Tab – Simulation Settings Command 
Allows entry or modification of the number of iterations and 
simulations which will be executed, as well as actions to perform 
each iteration 

 
•  # Iterations.  Allows entry or modification of the number of iterations 

which will be executed during a simulation.  Any positive integer 
value can be entered for # Iterations.  The default value is 100.  In 
each iteration: 

1) All distribution functions are sampled.  

2) Sampled values are returned to the cells and formulas of the 
worksheet. 

3) The worksheet is recalculated. 

4) New calculated values in the cells of the selected output ranges 
are saved for use in creating output distributions. 

The number of iterations performed will affect both your simulation 
execution time and the quality and accuracy of your results.  To get a 
quick look at results, run 100 iterations or less.  For the most accurate 
results you will probably need to run 300 or 500 (or more) iterations.  Use 
the Convergence Monitoring options (described in this section) to run the 
amount of iterations required for accurate and stable results.   
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The Excel Tools menu Options Calculation command Iterations option is 
used for solving worksheets which contain circular references.  You may 
simulate worksheets which use this option as @RISK will not interfere 
with the solution of circular references.  @RISK allows Excel to "iterate" to 
solve circular references each iteration of a simulation. 

Important! A single recalc with sampling, done with the Standard Recalc 
Monte Carlo option on, possibly will not resolve circular references.  If an 
@RISK distribution function is located in a cell which is recalculated 
during an Excel iteration, it will be resampled each iteration of the single 
recalc.  Because of this, the Standard Recalc Monte Carlo option should 
not be used for worksheets which use Excel Iterations capabilities to 
solve circular references. 

•  # Simulations.  Allows entry or modification of the number of 
simulations which will be executed in an @RISK simulation.  You can 
enter any positive integer value.  The default value is 1.  In each 
iteration of each simulation: 

1) All distribution functions are sampled. 

2) SIMTABLE functions return the argument corresponding to the 
number of the simulation being executed. 

3) The worksheet is recalculated. 

4) New calculated values in the cells of the selected output ranges 
are saved for use in creating output distributions. 

The number of simulations requested should be less than or equal to the 
number of arguments entered into the SIMTABLE functions.  If the 
number of simulations is greater than the number of arguments entered 
into a SIMTABLE function, the SIMTABLE function will return an error 
value during a simulation whose number is greater than the number of 
arguments. 

For more information on Sensitivity Simulation and using the SIMTABLE 
function, see Chapter 5: @RISK Modeling Techniques. 

Important! Each simulation executed when the # Simulations is greater 
than one uses the same random number generator seed value.  This 
isolates the differences between simulations to only the changes in the 
values returned by SIMTABLE functions.  If you wish to override this 
setting, select Multiple Simulations Use Different Seed Values in the 
Random Number Generator section of the Sampling tab prior to running 
multiple simulations. 
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•  Update Display.  Toggles on and off the updating of the 
worksheet display during a simulation.  For each iteration of a 
simulation, all distribution functions are sampled and the 
spreadsheet is recalculated.  Update Display allows you to either 
display the results of each recalculation on the screen (box 
checked) or suppress the display (no check).  The default is off, as 
updating the display for new values every iteration slows down 
the simulation. 

Note:  The Update Display setting may also be changed while a 
simulation is running by pressing the <Num Lock> key.  

•  Pause on Error in Outputs.  Toggles the Pause on Error capability 
on and off.  Pause on Error causes a simulation to pause if an 
Error value is generated in any output.  When an error is 
generated, the Pause on Error in Outputs dialog provides a 
detailed listing of the outputs for which errors were generated 
during a simulation and the cells in your spreadsheet that caused 
the error. 

 
The Pause on Error in Outputs dialog shows, on the left, an 
explorer list containing each output for which an error was 
generated.  As you select an output with an error in the explorer 
list, on the right the cell whose formula caused the output's error 
value is displayed.  @RISK identifies this cell by searching 
through the list of precedent cells for the output with the error 
until values switch from error to a non-error value.  The last 
precedent cell(s) returning error prior to precedent cells returning 
non-error values is identified as the "error causing" cell. 
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You can also review the formulas and values for cells which are 
precedents to the "error causing" cell by expanding the error-causing 
cell in the right-hand Explorer list.  This allows you to examine values 
which feed into the problem formula.  For example, a formula might 
return #VALUE because of a combination of values which are 
referenced by the formula.  Looking at precedents to the error causing 
formula allows you to examine these referenced values 

•  Use Multiple CPUs (@RISK Industrial only).  Instructs @RISK to use 
all CPUs present in your computer to speed simulations. Note: this 
option is available only for users of @RISK Industrial running 
Windows NT 4.0 or higher. 

•  Minimize @RISK and Excel when Simulation Starts.  Minimizes the 
Excel window and all @RISK windows at the start of a simulation.  
Any window, however, can be viewed during the run by clicking it in 
the Task bar. 

•  Auto-Stop Convergence Percentage.  When iterations are set to Auto, 
this setting controls whether @RISK should automatically halt the 
simulation when all output distribution statistics change less than the 
entered convergence threshold.  This allows you to run a simulation 
without setting a number of iterations in advance.  With Auto-Stop 
turned on, iterations will continue to be executed until convergence is 
achieved for all output distributions.  The Auto-Stop feature can only 
be used for a single simulation (i.e. the "#Simulations" setting must 
equal 1). 
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Sampling Tab – Simulation Settings Command 
Define sampling and recalculation settings for a simulation 

                  
Sets the type of sampling used during an @RISK simulation.  Sampling 
types vary in how they draw samples from across the range of a 
distribution.  Latin Hypercube sampling will accurately recreate the 
probability distributions specified by distribution functions in fewer 
iterations when compared with Monte Carlo sampling. 

We recommend using Latin Hypercube, the default sampling type setting, 
unless your modeling situation specifically calls for Monte Carlo 
sampling.  The technical details on each sampling type are presented in 
the Technical Appendices. 

•  Latin Hypercube.  Selects stratified sampling 

•  Monte Carlo.  Selects standard Monte Carlo sampling 

Specifies how distribution functions are evaluated during a regular Excel 
recalculation.  When a recalc is executed (such as by selecting the Excel 
Options menu Calculate Now command or by pressing <F9>), 
distribution functions will return a value for use in worksheet 
recalculations.  The type of value returned is set by the Standard Recalc 
options.   

•  Expected Value.  Causes distribution functions (except discrete 
distributions) to return their expected or mean value during a regular 
Excel recalculation.  For discrete distributions, the setting Expected 
Value returns the discrete value in the distribution closest to the true 
expected value.  The Expected Value setting allows your worksheet 
values to appear just as they would without @RISK with a single 
expected value displayed in each cell.  This is the default setting for 
Standard Recalc.   

Sampling Type 

Standard Recalc 
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•  Monte Carlo. Causes distribution functions to return a random Monte 
Carlo sample during a regular recalculation.  This setting allows your 
worksheet values to appear as they would during execution of a 
simulation with new samples drawn for distribution functions each 
recalculation.  

•  True EV.  Causes all distribution functions including discrete 
distributions to return their expected or mean value during a regular 
Excel recalc. This setting causes the same values to be returned as the 
option Standard Recalc Expected Value, except in the case of discrete 
distribution types such as DISCRETE, POISSON and similar 
distributions.  For these distributions the true expected value will be 
returned in an Excel recalc even if the expected value could not occur 
for the entered distribution, i.e., it is not one of the discrete points in 
the distribution. 

Allows the entry of a seed value for the random number generator.  The 
options for random number generator seed are: 

•  Choose Randomly, i.e., have @RISK randomly pick a new seed each 
simulation. 

•  Fixed, i.e., have @RISK use the same seed each simulation.  When you 
enter a fixed non-zero seed value for the random number generator, 
the exact same sequence of random numbers will be repeated 
simulation to simulation.  Random numbers are used in drawing 
samples from distribution functions.  The same random number will 
always return the same sampled value from a given distribution 
function. The seed value must be an integer in the range 1 to 
2147483647.  

Setting a fixed seed value is useful when you wish to control the 
simulation sampling environment.  For example, you may want to 
simulate the same model twice, only changing the argument values 
for one distribution function.  By setting a fixed seed, the same values 
will be sampled each iteration from all distribution functions except 
the one you changed.  Thus, the differences in the results between the 
two runs will be directly caused by changing the argument values of 
the single distribution function. 

•  Multiple Simulations Use Different Seed Values, i.e., have @RISK  
use a different seed each simulation in a multiple simulation run.  If a 
Fixed seed is used and Multiple Simulations Use Different Seed 
Values is selected, each simulation will use a different seed but the 
same sequence of seed values will be used each time the run is re-
executed.  Thus, results will be reproducible run to run. 

Random 
Number 
Generator Seed 
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The Collect Distribution Samples options specify how @RISK will collect 
random samples drawn from input distribution functions during a 
simulation.   

•  All.  Specifies that samples will be collected for all input distribution 
functions. 

•  Inputs Marked with Collect.  Specifies that samples will be collected 
for only those input distributions for which the Collect property is 
selected; i.e., a RiskCollect property function is entered inside the 
distribution.  Sensitivity and Scenario analyses will only include those 
distributions marked with Collect. 

•  None.  Specifies that no samples will be collected during a simulation.  
If no samples are collected, Sensitivity and Scenario analyses will not 
be available as simulation results.  In addition, statistics will not be 
provided on samples drawn for input distribution functions.  
Deselecting sample collection, however, does allow simulations to run 
faster and will sometimes allow large simulations with many outputs 
to be run on memory constrained systems. 

 

Collect 
Distribution 
Samples   
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Macro Tab – Simulation Settings Command 
Allows the specification of an Excel command macro to be 
executed before, during or after a simulation 

                   
The Run an Excel Macro option allows spreadsheet macros to be executed 
during an @RISK simulation.   

•  A macro can be run Before Each Simulation, Before Each Iteration’s 
Recalc (i.e., before @RISK performs its sampling and worksheet 
recalc), After Iteration’s Recalc (after @RISK performs its sampling 
and associated worksheet recalc) and After Each Simulation.   Macros 
can be run at any or all of the possible times during a simulation.  This 
feature allows calculations which only can be performed through the 
use of a macro to be made during a simulation.  Examples of such 
macro-performed calculations are optimizations, iterative "looping" 
calculations and calculations which require new data from external 
sources.  In addition, a macro may include @RISK distribution 
functions which are sampled during the execution of the macro. 

•  Macro Name.  Defines the macro to be run.  Should be “fully 
qualified” – should contain the full address (including filename) of 
the macro to be run. 

 

When Does a 
Macro Execute? 
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There are no restrictions on the operations performed by the macro each 
iteration.  The user should, however, avoid macro commands which will 
do things such as close the worksheet being simulated, quit Excel or other 
similar functions. 

@RISK can be operated using custom VBA commands that have been 
added to Excel.  This allows custom applications to be built using @RISK.  
These new commands are described in the Reference: @RISK Macros 
section of this chapter. 

Running @RISK 
from a Macro 
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Monitor Tab – Simulation Settings Command 
Define settings for updating Results windows and statistics 
functions during a simulation 

                  
The Monitor tab settings specify how graphs and reports in the @RISK – 
Results window, along with statistics functions in Excel, will be updated 
during a simulation.  When updated, graphs, reports and statistics show 
current results based on the iterations run so far in the simulation.  
Convergence monitoring shows the amount statistics on output 
distributions are changing as additional iterations are run during the 
simulation. 

The @RISK Results Window options specify how @RISK – Results 
window graphs and reports and the Convergence Monitoring window 
update during a simulation. 

•  Update Every XXXX Iterations.  Specifies the interval, in iterations, 
between updates of the selected windows and graphs. 

•  Update Real-Time.  Selects the updating of Results window reports 
and graphs during a simulation.  Graphs of simulation results and 
some report windows can be updated during simulation.  With this 
option selected, the Results Window will automatically be displayed 
when a simulation starts and the updating of open windows will 
begin.  A Real-Time Results toolbar is displayed in the Results 
window that allows you to control the updating of displayed reports 
and graphs. 

@RISK Results 
Window 
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•  Monitor Convergence.  Convergence monitoring can be performed 
during a simulation to track the stability of the output distributions 
being generated.  As more and more iterations are executed during a 
simulation, the output distributions generated become more "stable".  
Distributions become stable because the statistics which describe them 
change less and less as additional iterations are performed.  The 
number of iterations required to generate stable output distributions 
varies depending on the model being simulated and the distribution 
functions in the model. 

By monitoring convergence you can ensure that you have run a 
sufficient, but not excessive, number of iterations.  This is especially 
important with complex models that take a long time to recalculate. 

Tip: Convergence monitoring does add to simulation runtime.  If the 
fastest simulation is desired for a preset number of iterations, turn 
convergence monitoring off to maximize speed. 

Convergence is monitored on three sets of statistics calculated for each 
output distribution. These statistics are: 

•  Percentiles (0% to 100% in 5% increments) 

•  Mean 

•  Standard Deviation 

Monitoring convergence is done by calculating the above statistics on the 
data generated for each output cell at regular intervals throughout the 
simulation.  The interval between updates is set by the Update Every 
XXXX Iterations entry.   Each time new statistics are calculated the 
percentage change in statistics from the prior calculation is also 
determined.  As this percentage change gets smaller, the impact on the 
statistics of running additional iterations decreases and the output 
distributions become more stable. 

How Is 
Convergence 
Tested? 
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The convergence monitoring window is displayed in the @RISK - Results 
window while a simulation is running.  As each monitored statistic 
converges (i.e., it is changing less than the entered convergence threshold) 
it is highlighted. An output distribution with all three statistics converged 
is marked with a smile.   

The Convergence When Statistics Change < entry at the top of the 
Convergence Monitoring window controls the maximum amount of 
change allowed for a converged distribution.  When the statistics 
calculated change less than this entry for two consecutive calculations, the 
statistic is marked as converged (highlighted)  in the monitoring screen.  
They may change back to "unconverged" or unhighlighted if subsequent 
monitoring shows a change in the statistic greater than the convergence 
threshold.  It is important to remember that simulation, by nature, is a 
random process and there will always be some change in statistics with 
additional iterations.  Realistically, a 0% change in statistics is 
unachievable no matter how many iterations you run.   

The Auto-Stop Simulation on Convergence entry specifies whether a 
simulation will automatically stop when all output distributions converge.  
This setting is selected if the # of Iterations entry in the Simulation 
Settings dialog is set to Auto.   

Convergence 
Monitoring 
Window 



202 Simulate Menu 

Start Simulation Command 
Starts a simulation 

The Simulation menu Start command (or clicking the Simulate icon) starts 
a simulation using the current settings.  An executing simulation may be 
halted by clicking the Cancel button or pressing the <Esc> key.  The 
Update Display option may be toggled on and off by pressing <Num 
Lock> during the simulation. 

 

 

 
Simulate Icon 
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Results Menu 

Report Settings Command 
Specifies the location (Results window and/or Excel) that 
simulation results will be displayed and the type of reports that 
will be generated in Excel 
The Results Report Settings command allows you to specify the location 
and type of simulation reports that will be generated.  In addition, you 
can use this command to immediately generate reports in Excel on the 
most recently run simulation. 

                            
The At the End of Each @RISK Simulation options specify where 
simulation results will be displayed at the end of a simulation.  Available 
options include:  

•  Show Interactive Results Window.  Causes the @RISK Results 
window to pop forward at the end of a simulation.   

•  Generate Excel Reports Selected Below.  Generates the selected 
reports or graphs directly in Excel.   

Both options can be selected if each type of reporting is desired. 

 
Reports 
Settings Icon 
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A variety of different pre-built simulation reports are available directly in 
Excel at the end of a simulation.  The first two Quick format reports are 
reports on simulation results designed for printing.  The Quick Summary 
report summarizes an entire simulation run.  The Quick Output report 
contains a single page report for each output in a simulation.  The second 
section of available reports starting with Simulation Summary contain 
the same information as the equivalent report in the Results window.  For 
more information as to the content of these reports, see the section 
Reference: @RISK Results Window Commands in this chapter. 

Two options are available for locating reports in Excel:  

•  New Workbook.  Places simulation reports in a new workbook each 
time reports are generated.  

•  Active Workbook.  Places simulation reports in new sheets in the 
active workbook each time reports are generated.   

You can use template sheets to create your own custom simulation report.  
Simulation statistics and graphs are placed in a template using @RISK 
statistics functions (such as RiskMean) or the graphing function 
RiskResultsGraph.  When a statistics function or graphing function is 
located in a template sheet,  the desired statistics and graphs are then 
generated at the end of a simulation in a copy of the template sheet to 
create your report.  The original template sheet with the @RISK functions 
remains intact for use in generating reports from your next simulation. 

Template sheets are standard Excel spreadsheets.  They are identified to 
@RISK in the Reports Settings dialog box.  These files can also contain any 
standard Excel formulas so custom calculations can be performed using 
simulation results. 

 

Types of 
Reports in 
Available in 
Excel 

Template 
Sheets 
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The example file Template.XLS shown above contains a template sheet.  
You can review this sheet to see how to set up your own custom reports 
and template sheets. 

 

Show Results Window Command 
Displays the @RISK Results window for viewing simulation 
results 

The Results menu Show Results Window command shows the @RISK 
Results window.  To redisplay Excel and the @RISK add-in program, 
select the @RISK Results Window menu Show Excel Window command 
or simply click on the Excel window. 

 

 
Show Results 
Window Icon 
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Options Menu 

Show Expanded Toolbar Command 
Displays the expanded @RISK Professional and Industrial 
toolbar in Excel 
The Options menu Show Expanded Toolbar command displays the 
expanded @RISK toolbar.  This toolbar contains the icons for the advanced 
analyses available in @RISK Professional and Industrial.  This toolbar may 
also be displayed by clicking the expansion icon at the end of the standard 
@RISK toolbar. 

Prompt For Output Names Command 
Turns the display of the @RISK output naming dialog on and off 

The Options menu Prompt For Output Names command turns the 
automatic display of the output name dialog when outputs are added on 
or off.  Turn this off to default to @RISK default names when outputs are 
added. 

Display Cumulative Descending Percentiles 
Command 
Displays cumulative descending percentiles in @RISK reports 
and sets them as the default for alternate parameter probability 
distributions 

The Options menu Display Cumulative Descending Percentiles 
Command switches all @RISK statistics reports, targets and graph x and p 
values to display cumulative descending percentiles.  By default, @RISK 
reports percentile values in terms of cumulative ascending percentiles, or 
the probability that a value is less than or equal to a given x value.  
Selecting this command causes @RISK to report cumulative descending 
percentiles, or the probability that a value is greater than a given x value.   

Selecting Display Cumulative Descending Percentiles also causes @RISK 
to default to the entry of cumulative descending percentiles when 
alternate parameter distributions are entered in the Define Distribution 
window.  In this case, the percentage chance of a value greater than the 
entered value is specified. 
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Advanced Analyses Menu 
@RISK Professional and Industrial versions allow you to perform 
Advanced Analyses on your model. The Advanced Analyses include 
Advanced Sensitivity Analysis, Stress Analysis, and Goal Seek. These 
Advanced Analyses can be used to design your model, verify your model, 
or get many “What if?” kinds of results.   

Each of the Advanced Analyses generates its own sets of reports in Excel 
the show the results of the analysis being run.  However, each of the 
analyses uses standard @RISK multiple simulations to generate its results.  
Because of this the @RISK – Results window may also be used to review 
analysis results.  This is useful when you wish to generate a graph of 
results that is not included in the Excel reports or when you wish to 
review analysis data in more detail. 

Simulation Settings in Advanced Analyses 

Simulation settings specified in the @RISK Simulation Settings dialog 
(except for # of Simulations) are those used in each of @RISK's Advanced 
Analyses.  As many Advanced Analyses can involve large numbers of 
simulations, you should review your simulation settings to insure that 
analysis runtimes are minimized.  For example, when testing the setup of 
an advanced analysis you should set the # of Iterations to a relatively low 
value until you have verified that your setup is correct.  Then, set the # of 
Iterations back to the level necessary for stable simulation results and run 
the full Advanced Sensitivity Analysis, Stress Analysis, or Goal Seek.  
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Goal Seek 

Goal Seek Command 
Sets up and runs an @RISK Goal Seek 

Goal Seek allows you to find a specific simulated statistic for a cell (for 
example, the mean or standard deviation) by adjusting the value of 
another cell. The setup of an @RISK Goal Seek is very similar to the 
standard Excel’s Goal Seek.  Unlike Excel’s Goal Seek, however, @RISK's 
Goal Seek utilizes multiple simulations to find the adjustable cell value 
that achieves your results.  

When you know the desired statistic value for an output but not the input 
value needed to obtain that value, you can use the Goal Seek feature. An 
input can be any cell in your Excel workbook. An output is any cell that is 
an @RISK simulation output (i.e., a cell containing a RiskOutput() 
function). The input should be a precedent of the output cell being 
targeted. When goal seeking, @RISK varies the value in the input cell and 
runs a full simulation.  This process is repeated until the desired 
simulation statistic for the output equals the result you want. 

Goal Seek is invoked by clicking the Goal Seek icon from the expanded 
@RISK toolbar, or via the @RISK Menu, Advanced Analyses Goal Seek 
command. 

 
 
     Goal Seek 

Note: For a full tutorial on Goal Seek and the other @RISK 4.5 Advanced 
Analyses,  run the on-line tutorial located in the DTOOLS\RISK45 
directory.
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The options available in the @RISK Goal Seek dialog are as follows: 

 
•  Set Statistic - Allows you to choose which output statistic to 

monitor for convergence on the goal. The list includes: Minimum, 
Maximum, Kurtosis, Mean, Mode, Median, 5th Percentile, 95th 
Percentile, Skewness, Standard Deviation, and Variance. 

•  In Cell - Identifies the cell reference for the output whose 
simulation statistic you are trying to set to the entered value.  This 
cell must be an @RISK output cell. If the cell does not contain a 
RiskOutput() function, you will be prompted to add a 
RiskOutput(). 

•  To Value -  Specifies the value you want the Set Statistic for In 
Cell to converge on. This value is called a goal. 

•  By Changing – Identifies the single cell that you want Goal Seek 
to change so that the Set Statistic for In Cell approximates the To 
Value. The In Cell must be dependent on the By Changing cell - 
if it is not, Goal Seek will not be able to find a solution. 

@RISK Goal 
Seek Dialog 
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Options Dialog – Goal Seek Command 
Sets the analysis options for a Goal Seek 

The Options dialog of Goal Seek allows you to set parameters that can 
affect the success and quality of the Goal Seek solution. The Options 
dialog is invoked by clicking the Options button in the Goal Seek dialog. 

 
The entries in the Options dialog are as follows: 

•  Changing Cell Minimum - Allows you to set the minimum value 
to use for the By Changing Cell. Goal Seek attempts to bracket a 
solution by assuming that there is one between the Changing Cell 
Minimum and Changing Cell Maximum.  

•  Changing Cell Maximum - Allows you to set the maximum value 
to use for the By Changing Cell. Goal Seek attempts to bracket a 
solution by assuming that there is one between the Changing Cell 
Minimum and Changing Cell Maximum.  

•  Maximum Number of Simulations - Specifies how many 
simulations Goal Seek will attempt while trying to meet your 
goal. If a solution is found before all simulations are completed, 
simulation activity will halt and Goal Seek Status dialog will be 
displayed. 
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•  Compare Accuracy - Determine how close the actual solution must be 
to the target.  This entry can be viewed as a range around the desired 
target value that is acceptable for the simulation statistic.  Any result 
within this range is defined as achieving the goal. 

1) Percent of Target Value - Specifies the accuracy as a 
percentage of the To Value.   

2) +/- Actual Value - Specifies the accuracy as the maximum 
difference between the goal and the value of the In Cell 
statistic found by Goal Seek. 

•  Generate Complete Simulation Results for Solution – If this is 
selected, after finding a solution Goal Seek performs an additional 
simulation that uses the found value for the By Changing cell. The 
statistics for that simulation are displayed in the @Risk – Results 
window. This option does not actually replace the original value of 
the By Changing cell with the found value in the spreadsheet. 
Instead, it enables you to see the effects such a replacement would 
have without performing it. 
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Analyze – Goal Seek Command 
Runs a Goal Seek 

Once Analyze is clicked, Goal Seek cycles through the following process 
until the goal statistic value is achieved or the maximum number of 
simulations are run: 

1) A new value is placed in the changing input cell  

2) A full simulation of all open workbooks is run using the current 
settings as specified in the @RISK Simulation Settings dialog box 

3) @RISK records the simulation statistic selected in the Set Statistic 
entry for the output identified in the In Cell entry.  This statistic 
value is compared to the To Value entry to see if the value 
achieves the goal (within the Compare Accuracy range entered) 

If a solution is found within the requested accuracy, Goal Seek will 
display a Status dialog. This will allow you to replace the contents of the 
Changing Cell with the solution value. If you choose to do this, the entire 
cell contents will be replaced by the solution value, and any formula or 
values that were previously in that cell will be lost. 

 
It is possible that Goal Seek will converge on a goal, but will not be able to 
converge within the requested accuracy. In this case Goal Seek will 
prompt you with its best solution. 
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An @RISK Goal Seek uses a two-tiered approach to converging on the 
target: 

1) If no brackets are set using Changing Cell Minimum and 
Maximum, Goal Seek will attempt to bracket the target value 
using a geometric expansion around the original value.  

2) Once a solution is bracketed, Goal Seek uses the Ridders' method 
of root finding. Using the Ridders' method, Goal Seek first 
simulates the model with the input value set to the midpoint of 
the bracketed range.  It then factors out that unique Exponential 
function which turns the residual function into a straight line.  
This has some important benefits for the Goal Seek process.  It 
insures that the tested input values never jump outside the 
brackets, and helps insure that Goal Seek moves toward a 
solution in as few cycles as possible (an important benefit when 
each "cycle" is a full simulation of your model!). 

It is possible that Goal Seek may have problems converging on a solution. 
Some desired solutions may just be impossible to achieve, or the model 
may behave so unpredictably that the root finding algorithm cannot 
converge on a solution.   You can help Goal Seek converge by: 

•  Starting Goal Seek with a Different Value in the Changing Cell.  
Because the iteration process begins with guesses around the original 
changing cell value,  starting Goal Seek with a different value in the 
cell being changed may help.  

•  Changing Your Brackets.  Setting the Changing Cell Minimum and 
Changing Cell Maximum in the Options dialog will help point Goal 
Seek toward a solution.  

Note: Goal Seek is not designed to work with multiple simulation models. 
For RiskSimtable functions, the first value in the table will be used for all 
simulations. 

 

How Are Input 
Values Selected 
in an @RISK 
Goal Seek? 

What if Goal 
Seek Cannot 
Find a Solution? 
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Stress Analysis 

Stress Analysis Command 
Sets up and runs a Stress Analysis 

Stress Analysis allows you to analyze the effects of stressing @RISK 
distributions. Stressing a distribution restricts samples drawn from the 
distribution to values between a specified pair of percentiles.  
Alternatively, stressing can be done by specifying a new “stress” 
distribution that will be sampled instead of the original distribution in 
your model.  With Stress Analysis you can select a number of @RISK 
distributions and run simulations while stressing those distributions 
jointly in one simulation or separately in multiple simulations. By 
stressing the selected distributions, you can analyze scenarios without 
changing your model. 

After completing a simulation, Stress Analysis provides you with a 
collection of reports and graphs that you can use to analyze the effects of 
stressing certain distributions on a selected model output.  

Stress Analysis is invoked by clicking the Stress Analysis icon from the 
expanded @RISK toolbar, or via the @RISK Menu, Advanced Analyses 
submenu. 

 
 
     Stress Analysis 

Note: For a full tutorial on Stress Analysis and the other @RISK 4.5 
Advanced Analyses,  run the on-line tutorial located in the 
DTOOLS\RISK45 directory.
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The options in the Stress Analysis dialog are as follows: 

 
•  Cell To Monitor - This is a single @RISK output that you want to 

monitor as the specified @RISK distributions are stressed. The 
Cell To Monitor can be specified by entering a cell reference, 
clicking the desired cell, or clicking the ... button. This button 
displays a dialog that contains a list of all @RISK outputs in 
currently open Excel workbooks. 

The Inputs to Stress section allows you to Add, Edit, and Delete the 
@RISK Distributions that you wish to stress. The specified distributions 
are maintained in a list that contains the cell range, the @RISK Name, the 
Current distribution, and an Analysis Name that you can edit. 

•  Add and Edit - Display the Input Definition dialog. This allows 
you to specify an @RISK distribution or range of @RISK 
Distributions to be stressed. You can then select from Low, High, 
or Custom sampling ranges, or specify an alternate stress 
distribution or formula. 

•  Delete - Completely removes the @RISK distribution(s) that are 
highlighted on the list from the Stress Analysis. To temporarily 
exclude a distribution or a range of distributions from the analysis 
without deleting them, click the check box beside its list item to 
remove the checkmark. 

@RISK Stress 
Analysis Dialog 
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The options in the Input Definition dialog are as follows: 

 
•  Type – For Stress Analysis, only @RISK distributions can be 

selected as inputs, so the only option for Type is Distributions. 

•  Reference – Selects the distributions to stress.  Distributions can 
be specified by typing appropriate cell references, by selecting a 
range of cells in the worksheet, or by clicking the ... button, which 
will open the @RISK Distribution Functions dialog, listing all the 
distributions in the model. 

 

Input Definition 
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The Sample options allow you to enter a range within the selected 
probability distribution(s) to sample from, or enter an alternate 
distribution or formula to substitute for the selected probability 
distribution(s) during the analysis. 

•  Low Values – Enters a low range to sample from, bounded at the 
minimum by the distribution minimum.  The Low Range default 
is 0% to 5%, sampling only values below the 5th percentile of the 
distribution.  Any desired upper percentile can be entered instead 
of 5%. 

•  High Values  – Enters a high range to sample from, bounded at 
the maximum by the distribution maximum. The High Range 
default is 95% to 100%, sampling only values above the 95th 
percentile. Any desired lower percentile can be entered instead of 
95%. 

•  From Custom Range - Allows you to specify any percentile range 
within the distribution to sample from. 

•  Distribution/Formula - Allows you to enter an alternate @RISK 
distribution function (or any valid Excel formula) that will be 
substituted for the selected distribution during a Stress Analysis.  
You can use the Excel Function Wizard the help enter an alternate 
distribution by clicking the icon to the right of the 
Distribution/Formula box. 
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Options – Stress Analysis Command 
Sets the analysis options for a Stress Analysis 

The Options dialog is used to determine how stressing will be performed 
and which reports or graphs to generate. The Options dialog is displayed 
when the Options button in the Stress Analysis dialog is clicked. 

 
The Multiple Inputs section allows you to stress all of your specified 
@RISK distributions during one simulation, or to run a separate 
simulation for each @RISK distribution. 

•  Stress Each Input in its Own Simulation – Specifies that a full 
simulation will be run for each stress range entered.  The only 
change made to the model during each simulation will be the 
stressing of a single input.  The number of simulations run will 
equal the number of stress ranges entered. 

•  Stress All Inputs in a Single Simulation – Specifies that a single 
simulation will be run using all stress ranges entered.  The 
simulation results will combine the effects of all stress ranges. 

The Reports section allows you to choose which reports and graphs you 
want to be generated at the end of the stress simulations. The options 
include a Summary report, Box-Whisker Plots, Comparison Graphs, 
Histograms, Cumulative Distribution Functions and Quick Reports.  
For more information on the reports generated by a Stress Analysis, see 
Reports in this section. 
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The Place Reports section allows you to place your results in the active 
workbook, or a new workbook. 

•  New Workbook - All reports are placed in a new workbook  

•  Active Workbook – All reports are placed in the active workbook 
with your model 

 



Reference: @RISK Add-In Menu Commands 223 

Analyze – Stress Analysis Command 
Runs a Stress Analysis 

Once you have selected the Cell to Monitor, and at least one @RISK 
distribution is specified to stress, you can click the Analyze button to run 
the analysis. The analysis runs one or more simulation(s) that restricts 
sampling of the selected @RISK distributions to the specified stress 
range(s) or substitutes in any alternate stress distributions or formulas 
you have entered. The results of the Stress Analysis simulations are 
organized in a summary sheet and several Stress Analysis graphs. 

The results of the Stress Analysis are also available in the @RISK - Results 
window. This allows you to further analyze the results of stressing the 
@RISK Iinputs. 

The Reports generated by a stress analysis include: 

•  Summary report 

•  Box-Whisker Plots 

•  Comparison Graphs 

•  Histograms 

•  Cumulative Distribution Functions 

•  Quick Reports 

Reports 
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The Summary reports describes the stressed inputs, and the 
corresponding statistics of the monitored output: Mean, Minimum, 
Maximum, Mode, Standard Deviation, Variance, Kurtosis, Skewness, 5th 
Percentile and 95th Percentile. 

 

Summary 
Report 
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The Box-Whisker Plot gives an overall indication of the monitored 
output, describing the mean, median, and outlying percentiles. 

Box Plot Comparison

Baseline

Next month's spot 
price C14  0% to 

5.00% 

Next month's 
futures price C15 

90.00% to 
100.00% 

-60 -40 -20 0 20 40 60

 
The left and right of the box are indicators of the first and third quartiles. 
The vertical line inside the box represents the median, and the X indicates 
the location of the mean. The box width represents the interquartile range 
(IQR). The IQR is equal to the 75th percentile data point minus the 25th 
percentile data point. The horizontal lines extending from either side of 
the box indicate the first data point that is less than 1.5 times the IQR 
below the low edge of the box, and the last data point that is less than 1.5 
times the IQR above the high edge of the box. Mild outliers, shown as 
hollow squares, are data points between 1.5 times IQR and 3.0 times IQR 
outside the box. Extreme outliers, shown as solid squares, are points 
beyond 3.0 times IQR outside the box. 

Box-Whisker Plot 
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A Quick Report provides single page summary of the Stress Analysis as a 
whole.  This reports is designed to fit on a single page. 

 

 

Quick Report 
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The four Comparison Graphs compare means, standard deviations, 5th 
percentiles, and 95th percentiles for each of the specified @RISK inputs (or 
their combination) and the Baseline simulation.  
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The Histograms are standard @RISK histograms of the monitored output 
for each of the stressed inputs (or their combination) and the Baseline 
simulation. 
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The CDFs (Cumulative Distribution Functions) are standard @RISK 
cumulative ascending density graphs. There is also a Summary CDF for 
all of the inputs. 
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Advanced Sensitivity Analysis  

Advanced Sensitivity Analysis Command 
Sets up and runs an Advanced Sensitivity Analysis 

Advanced Sensitivity Analysis allows you to determine the effects of 
inputs on @RISK outputs. An input can be either an @RISK distribution or 
a cell in your Excel workbook. Advanced Sensitivity Analysis allows you 
to select a number of @RISK distributions or worksheet cells and run trial 
simulations while varying these inputs across a range.  Advanced 
Sensitivity Analysis runs a full simulation at each of a set of possible 
values for an input, tracking the simulation results at each value.  The 
results then show how simulation results changed as the input value was 
changed.  As with the standard @RISK Sensitivity Analysis, the Advanced 
Sensitivity Analysis shows the sensitivity of an @RISK output to the 
specified input. 

Advanced Sensitivity Analysis can be used to test the sensitivity of an 
@RISK output to the input distributions in a model.  When testing an 
@RISK distribution, @RISK runs a set of simulations for the input.  In each 
simulation, the input distribution is fixed at a different value across the 
min-max range of the distribution.  Typically theses "step" values are 
different percentile values for the input distribution. 

Advanced Sensitivity Analysis is invoked by clicking the Advanced 
Sensitivity Analysis icon from the expanded @RISK toolbar, or via the 
@RISK Menu, Advanced Analyses submenu. 

 
 
     Advanced Sensitivity Analysis 

Note: For a full tutorial on Advanced Sensitivity Analysis and the other 
@RISK 4.5 Advanced Analyses,  run the on-line tutorial located in the 
DTOOLS\RISK45 directory.
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Advanced Sensitivity Analysis Dialog 
The options in the Advanced Sensitivity Analysis dialog are as follows: 

 
•  Cell To Monitor - This is a single @RISK output that you want to 

monitor as individual simulations are run while stepping across 
possible input values. The Cell To Monitor can be specified by 
entering a cell reference, clicking the desired cell, or clicking the ... 
button. This button displays a dialog that contains a list of all 
@RISK outputs in currently open Excel workbooks. 

The Inputs to Analyze options allow you to Add, Edit, and Delete the 
worksheet cells and @RISK distributions that you wish to include in the 
analysis.  The specified cells and distributions are maintained in a list that 
contains the cell range, the @RISK Name, the Current distribution, and an 
Analysis Name that you can edit. 

•  Add and Edit - Displays the Input Definition dialog.  This allows 
you to specify either a single @RISK distribution or worksheet 
cell, or a range of @RISK distributions or worksheet cells to be 
analyzed. 

•  Delete - Completely removes inputs from the Advanced 
Sensitivity Analysis. To temporarily exclude an input or group of 
inputs from the analysis without deleting them, click the check 
box in the appropriate line in the list to remove the check mark 
from that input. 
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Input Definition - Advanced Sensitivity Analysis 
Command 
Defines Inputs in an Advanced Sensitivity Analysis 

The Input Definition dialog allows you to enter the type of an input, its 
name, a base value and data which describes the possible values for the 
input that you wish to test in the sensitivity analysis.  A full simulation 
will be run at each value you enter for an input.  The options in the Input 
Definition dialog are detailed in this section. 

 
Type specifies the type of input you are entering (either distribution or a 
worksheet cells).  Inputs to an Advanced Sensitivity Analysis can be either 
@RISK distributions that have been entered into your worksheet 
formulas or worksheet cells.   

Type 
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Reference specifys the worksheet location of your input(s).  If you are 
selecting distribution input(s) you can click the ... button, which will open 
the @RISK Distributions Functions dialog, listing all the distributions in 
all open worksheets.  

 
Name names your input(s). If you are selecting distribution inputs the 
existing @RISK name for each input is shown.  If you wish to use a 
different name for a distribution, simply change the @RISK name by 
adding a RiskName function to the distribution in Excel or by editing the 
name in the @RISK – Model window. 

If you are selecting worksheet cells as inputs, the name of a single input 
can be typed directly in the Name entry.  When you have selected a range 
of inputs, the Name entry shows the names of each cell, separated by 
commas.   

 

Theses names can be edited by typing in the box (keeping the comma-
separated format) or by clicking the ... button, which opens the Sensitivity 
Analysis Cell Names dialog.  

 

Reference 

Name 
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Cell names are defined in the Input Definition dialog only for the 
purposes of Advanced Sensitivity Analysis.  These names are used in 
@RISK Results window and in the reports generated by Advanced 
Sensitivity Analysis; however, these cell names do not become part of 
your Excel model. 

The Base Value is used to determine the sequence of values to step 
through for an input and as a reference point in the Percent Change report 
graph.  The Base Value is especially important when you wish to apply a 
Step Type that is a change from base, such as +/- Percent Change from 
Base.  By default, the Base Value is the value a distribution or cell 
evaluates to when Excel recalculates the worksheet, but you can change it 
to a different value.  Note: If your distribution or cell evaluates to 0, and 
Base Value is set to Auto, you need to enter a non-zero base value if you 
use the +/- Percent Change from Base option. 

If selected, Fix Distribution to Base Value When Not Stepping causes an 
input distribution to return its Base Value in the simulations when it is not 
the particular input being stepped across.  This causes the distribution not 
to sample, essentially locking it to the entered Base Value.  If Fix 
Distribution to Base Value When Not Stepping is not selected, the 
distribution will behave normally, that is, samples will be drawn from it 
in the simulations in which it is not being stepped across.  Note: This 
option is not available when an input is a worksheet cell type. 

 

 

Base Value 

Fix Distribution 
to Base Value 
When Not 
Stepping  
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Step Type - Advanced Sensitivity Analysis Command 
Defines values to be used for inputs in an Advanced Sensitivity 
Analysis  
The Step Type options describe the type of variation you will use to select 
the values that will be tested for your input(s).  During an analysis, inputs 
are "stepped" across a range of possible values and a full simulation is run 
at each step value.  The Step Type defines the nature of this range – either 
+ / - Percent Change from Base, + / - Actual from Base Value, Values 
Across Range, Percentiles of a Distribution, Table of Values, or Table 
from Excel Range.  These different step types provide a great deal of 
flexibility in describing the values to be tested for an input.  Depending on 
the Step Type you select, the entry information for defining the actual 
range and step values (as shown on the right side of the Input Definition 
dialog) will change. 

Each Step Type and its associated range and value entries is described 
here. 

With this Step Type, the first and the last value in the sequence to step 
through are obtained by incrementing or decrementing the input's Base 
Value by the percentage values specified in Min Change (%) and Max 
Change (%) entries. The intermediate values are at equal intervals, with 
the number of values to test is set by # of Steps. 

 
With this Step Type, the first and the last value in the sequence to step 
through are obtained by adding to the Base Value the values specified in 
Min Change and Max Change entries. The intermediate values are at 
equal intervals, with the number of values to test is set by # of Steps. 

 

+ / - Percent 
Change from 
Base 

 
+ / - Actual from 
Base Value 
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With this Step Type, the sequence of values to step through starts at the 
Minimum and ends at the Maximum. The intermediate values are at 
equal intervals, with the number of values to test is set by # of Steps. 

 
This Step Type is only used when the selected input Type is Distribution.  
You specify steps as percentiles of the selected @RISK distribution, and 
you can define up to 20 steps.  During the analysis, the input will be fixed 
at the percentile values as calculated from the entered input distribution.   

 
 

With this Step Type, you enter the sequence of values to step through 
directly in a Table in the right portion of the Input Definition dialog.  The 
Base Value is not used as the specific values you enter are the values 
tested. 

 

 
Values Across 
Range 

Percentiles of 
Distribution 

Table of Values  
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With this Step Type, the sequence of values to step through is found in the 
range of worksheet cells specified in Excel Range entry.  This range can 
contain any number of values; however, it is important to remember that 
a full simulation will be run for each value in the referenced range. 

 
By clicking the Add Analysis Names button, a descriptive name can 
be added to each input value that will be tested in an Advanced 
Sensitivity Analysis.  This name will be used to identify the 
simulation run when an input is fixed at a particular value.  These 
names will make your reports more readable and will help identify 
individual simulations when results are reviewed in the @RISK – 
Results window. 

 
The Sensitivity Analysis Names dialog allows you to enter a name 
for the simulation to be run at each stepped input value.  The default 
name @RISK has created is initially shown and you can change this as 
desired. 

 
Table from 
Excel Range  

Add Analysis 
Names 
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Options - Advanced Sensitivity Analysis Command 
Defines analysis options for an Advanced Sensitivity Analysis  
The Sensitivity Options dialog allows you to select the output statistic you 
wish to evaluate during the sensitivity analysis, identify the reports you 
want to generate and specify the behavior of @RISK Simtable functions in 
the analysis. 

 
The Sensitivity Options dialog is invoked by clicking the Options button 
from the main Advanced Sensitivity Analysis dialog.  The selections in 
this dialog include: 

•  Tracking Statistic - Allows you to specify the particular statistic 
that you wish to monitor for the @RISK output during each 
simulation.  The comparison graphs and reports from the analysis 
will show the change in the value for this statistic simulation to 
simulation. 

•  Reports -  Allows you to choose which analysis reports are 
generated at the end of the Sensitivity run. They include 
Summary, Box-Whisker Plot, Input Graphs, Quick Reports, 
Percentile Graphs, Percent Change Graphs, and Tornado 
Graphs.  For more information on each of these reports, see 
Reports in this section. 

The Place Reports section allows you to place your results in the active 
workbook, or a new workbook. 

•  New Workbook - All reports are placed in a new workbook  

•  Active Workbook – All reports are placed in the active workbook 
with your model 

. 
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If a sensitivity analysis is run on worksheets which include RiskSimtable 
functions, this option causes the values specified by these functions to be 
included in the analysis.  If Include Simtable Functions as Inputs to 
Analyze is selected, open workbooks will be scanned for RiskSimtable 
functions. The Advanced Sensitivity Analysis will then step through the 
values specified in the RiskSimtable function arguments, running a full 
simulation at each value. The reports generated after the run will show 
the sensitivity of the output statistic to both: 

1) The variation of the inputs set up in the Advanced Sensitivity 
Analysis dialog and  

2) The variation of the values from Simtable functions. 

This option is especially useful if an Advanced Sensitivity Analysis is run 
on an @RISK model that was set up for multiple simulations.  Simtable 
and @RISK's multiple simulation capability are often used to analyze how 
simulation results change when an input value is changed, by simulation, 
using the Simtable function.  This analysis is similar to that performed by 
an Advanced Sensitivity Analysis.   By simply selecting the option 
Include Simtable Functions as Inputs to Analyze and running an 
Advanced Sensitivity Analysis, multiple simulation models can get the 
benefit of all Advanced Sensitivity Analysis reports and graphs with no 
additional setup. 

For more information on the RiskSimtable function, see the chapter 
@RISK: Functions in this manual. 

Include 
Simtable 
Functions as 
Inputs to 
Analyze 
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Analyze - Advanced Sensitivity Analysis Command 
Runs an Advanced Sensitivity Analysis  
When the Analyze button is clicked, the Advanced Sensitivity Analysis 
prompts the user with the number of simulations, iterations per 
simulation, and total number of iterations. At this point, the analysis can 
be canceled.  

 
When a smaller, faster analysis is desired, the Cancel button gives the user 
an opportunity to change the # of Iterations per simulation in the 
Simulation Settings dialog, the number of Inputs to Analyze or the 
number of values in the sequence associated with each input (that is, # of 
Steps or table items). 

When an Advanced Sensitivity Analysis is run, the following actions 
occur for each input in the analysis: 

1) One of the step values for the input is substituted for the existing 
cell value or @RISK distribution in the worksheet. 

2) A full simulation of the model is run. 

3) The simulation results for the tracked output Cell to Monitor are 
collected and stored. 

4) This process is repeated until a simulation has been run for each 
possible step value for the input. 

The results of the Sensitivity Analysis are also available in the @RISK-
Results window. You can analyze them further using tools available in 
this window. 
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The Advanced Sensitivity Analysis reports include: 

•  Summary 

•  Box-Whisker Plot 

•  Input Graphs 

•  Quick Reports 

•  Percentile Graph 

•  Percent Change Graph 

•  Tornado Graph   

Each of these reports is generated in Excel, either in the workbook with 
your model or in a new workbook.  These reports are detailed in this 
section. 

The Summary report describes the values assigned to the analyzed inputs, 
and the corresponding statistics of the monitored output: Mean, 
Minimum, Maximum, Mode, Standard Deviation, Variance, Kurtosis, 
Skewness, 5th Percentile and 95th Percentile. 

 
 

Reports 

Summary  
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The Input Graphs report identifies how the tracked simulation statistic 
changed when simulations were run at each of the selected step values for 
an input.  These graphs  include: 

•  Line Graph – Plots the value of the tracked simulation statistic for 
the output against the value used for the input in each simulation.  
There is one point on the line graph for each simulation run when 
the Advanced Sensitivity Analysis was stepping across the 
particular input.  

•  Overlayed Cumulative Distribution – Shows the cumulative 
distribution for the output in each simulation run at each step 
value for the input.  There is one cumulative distribution for each 
simulation run when the Advanced Sensitivity Analysis was 
stepping across the particular input.  

•  Box-Whisker Plots - Give an overall indication of the output 
distribution in each simulation run for the input, describing the 
mean, median, and outlying percentiles. There is one Box-
Whisker plot for each simulation run when the Advanced 
Sensitivity Analysis was stepping across the particular input.  For 
more information on Box-Whisker graphs, see Stress Analysis in 
this manual. 

 

Input and Box-
Whisker Plots 
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Quick Reports provide single page summaries of the Advanced 
Sensitivity Analysis as a whole or for a single input in an Advanced 
Sensitivity Analysis.  These reports are designed to fit on a single page. 

 

Quick Report 
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The Percent Change Graph plots the Cell To Monitor statistic against 
each of the selected inputs as a Percent Change from Base.  The input 
value on the X-axis is calculated by comparing each input value tested 
with the entered base value for the input. 

 

The Percentile Graph plots the Cell To Monitor statistic against 
percentiles of each of the @RISK distributions that were selected for 
analysis with step type Percentiles of Distribution.  Note: Only inputs 
that were @RISK distributions will be displayed on this graph. 

 

Percent Change 
Graph 

Percentile 
Graphs 
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The Tornado Graph shows a bar for each of the inputs defined for 
analysis, showing the minimum and maximum values that the specified 
Cell To Monitor statistic acquires, as the values of the input vary. 

 

Tornado 
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File Menu 

New Command 
Clears all active @RISK simulation data and results 

The New command clears all active @RISK simulation data from the 
Results and Model windows and resets @RISK settings to their 
default values. 

Open Command 
Opens a saved simulation 

The File Open command opens a previously saved simulation data 
file (.RSK file) including simulation settings, all input data and graphs 
(with supporting fitted datasets) and simulation results including any 
generated graphs.   For more information on the File Open command, 
see File Open in Reference: @RISK Add-In Menu Commands. 

Save Command, Save As Command 
Saves the current simulation data  
The File menu Save and Save As commands save the current @RISK 
data in a .RSK file. For more information on the File Save and Save As 
commands, see File Save in Reference: @RISK Add-In Menu 
Commands. 

Print Command 
Prints the current graph or report 
The Print command prints the active Model window graph.  

 
Open Icon 

 
Save Icon 
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Exit Command 
Unloads the @RISK add-in from Excel 
The File menu Exit command unloads the @RISK add-in in Excel and 
shuts down the supporting @RISK-Model and @RISK-Results 
windows.  If you shut down @RISK during an Excel session, you can 
restart it at a later time by clicking the @RISK icon on the 
DecisionTools toolbar. 
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Edit Menu 

Cut Command 
Cuts the current selection 

The Edit menu Cut command cuts the current selection.  This data can 
be pasted from the Clipboard to other applications. 

Copy Command 
Copies @RISK reports and graphs to the Windows Clipboard 

The Edit menu Copy command is used to transfer @RISK reports, 
graphs and fit data to the Clipboard so they can be pasted into your 
spreadsheet or word processor.  The data to be copied is determined 
by the current active window and selection in @RISK.  The active 
window is the one with its title bar highlighted. 

@RISK graphs are copied to the clipboard as Windows metafiles.  
When placed in your spreadsheet they may be resized and annotated. 

Paste Command 
Pastes the current contents of the Clipboard into an @RISK 
window 

The Edit menu Paste command is used to transfer the Clipboard 
contents into the current selection.   

Clear Command 
Removes data from the Input Data grid 

The Edit menu Clear command is used to remove data from the Input 
data grid on a Fit Tab.  Clear permanently removes data from the 
current selection in the input data grid, allowing new data to be 
entered. 
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Delete Tab Command 
Deletes the current tab 

The Delete Tab command (also selected by right-clicking on a Tab at 
the bottom of the Model window and selecting Delete) deletes the 
current tab.  All open windows on the current tab are also deleted. 

Note:  The Model tab cannot be deleted. 

Rename Tab Command 
Renames the current tab 

The Rename Tab command (also selected by right-clicking on a Tab at 
the bottom of the Model window and selecting Rename) renames the 
current tab.  

Note:  The Model tab cannot be renamed. 
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View Menu  
Turns display of screen elements on and off 

The View menu options allow you to optionally display or not 
display the @RISK Results window toolbars, Explorer and status bar, 
and customize the displayed toolbars. 
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Insert Menu 

Fit Tab Command 
Inserts a Fit Tab in the Model window 

The Insert menu Fit Tab command (or clicking the Insert Fit Tab icon) 
inserts a new fit tab in the Model window.  A fit tab holds a data set 
and the distribution fitting results associated with the data set. 

 
When initially inserted, a fit tab contains an empty Input Data grid on 
the left where a data set to be fit can be entered.  As fitting is 
performed, Fit Results and Summary windows are displayed in the 
other part of the fit tab. 

To learn about the commands used to fit probability distributions to a 
data set contained on a fit tab, see Fitting Menu Commands in this 
Reference section. 

Note:  One data set can be added to a single fit tab.  To fit additional 
data sets, insert additional fit tabs. 

Fit Tab 
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Fit Results Window Command 
Inserts a Fit Results Window in the Model window 

The Insert menu Fit Results Window command (or clicking the Insert 
Fit Results Window icon) inserts a Fit Results window on a fit tab in 
the Model window.  A Fit Results window displays the results of the 
most recent fit performed on the data set on the fit tab where the Fit 
Results window is placed. 

 
When you run a fit, a new Fit Result window is automatically created 
for you if one does not exist.  Multiple Results windows can be 
displayed for the current fit results.  This allows different fitted 
distributions to be displayed simultaneously and compared. 

To learn about the contents of the Fit Results window and the 
commands used for fitting probability distributions to data, see the 
Fitting Menu: Run Fit Now Command in this Reference section. 

 

 

 

 

Results Window 
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Fit Summary Window Command 
Inserts a Fit Summary window in the Model window 

The Insert menu Fit Summary Window command (or clicking the 
Insert Fit Summary Window icon) inserts a Fit Summary window on 
a fit tab in the Model window.  A Fit Summary window displays a 
report of the results of the most recent fit performed on the data set 
shown on the active fit tab. 

 
A Fit Summary window displays all relevant statistics on the results 
of a fit.  For more information on the contents of the Fit Summary 
window, see Fit Results under Fitting Menu: Run Fit Now 
Command in this section. 

Fit Summary 
Window 
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Artist Window Command 
Inserts an Artist window in the Model window 

The Insert menu Artist Window command (or clicking the Insert 
Artist Window icon) inserts a Artist window in the Model window.  
An Artist window allows a free-form curve to be drawn, which can 
then be used to define a probability distribution. 

 
To learn about the commands used to draw curves in the Artist 
window, see Artist Menu Commands in this Reference section. 

Artist Window 
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Distribution Window Command 
Inserts a Distribution window in the Model window 

The Insert menu Distribution Window command (or clicking the 
Insert Distribution Window icon) inserts a Distribution window in the 
Model window.  Distribution windows can be used at any time to 
preview a probability distribution, input and fit results. 

A Distribution window displays either a: 

1) Graph of a theoretical distribution whose parameters are 
entered in the distribution window. 

2) Graph of input data contained in the Input data grid on a fit tab. 

3) Graph of a distribution function generated by a fit.   

An overlay graph may also be placed on a distribution graph in the 
Distribution window.  This overlay can come from any of the three 
sources listed above. 

 
The contents of the Distribution window are similar to the Define 
Distribution window which is either popped up over Excel or 
displayed when an input is graphed from the Outputs and Inputs.  
The Define Distribution window contains Excel cell formula 
information which a Distribution window does not.  Otherwise, the 
two windows are nearly identical.  For information on using all 
elements of the Distribution window (except those listed below) see 
the Define Distribution Command in the @RISK Add-In Menu 
section of this Reference chapter. 

 

Distribution 
Window 

Contents of the 
Distribution 
Window 
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Correlation Window Command 
Inserts a Correlation window in the Model window 

The Insert menu Correlation Window command (or clicking the Insert 
Correlation Window icon) inserts a blank Correlation window in the 
Model window.   A Correlation window allows you to correlate input 
distributions in your model by entering a matrix of correlation 
coefficients.  By dragging input distributions from the Explorer list 
onto a blank matrix you can select which inputs you wish to correlate 
in a matrix. 

 
Any number of correlation matrices may be specified for your model.  
Each matrix entered is listed in the Correlations section of the 
Explorer list on the Model tab.  At any time you can edit an existing 
matrix by right-clicking on the matrix name in the Explorer and 
selecting the Edit Correlation Matrix command. 

To learn more about setting up and editing correlation matrices, see 
the Correlations Menu Commands in this Reference section. 
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Inputs and Outputs Window Command 
Inserts an Inputs and Outputs Window in the Model window 
The Insert menu Inputs and Outputs Window command (or clicking 
the Insert Inputs and Outputs Window icon) inserts an Inputs and 
Outputs in the Model window.  An Inputs and Outputs Window 
displays a summary of all inputs and outputs currently defined in the 
open worksheets in Excel. 

 
 
The Inputs and Outputs window displays the location and definition 
of all @RISK distribution functions in your open worksheets.  In this 
window you can change the name of any input or output, lock it to 
keep it from sampling or select to have samples collected for a 
distribution (when the Simulation Settings option for Collect 
Distribution Samples is set to Inputs Marked with Collect). 
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Simulation Menu 

Settings Command 
Changes the settings which control the simulations 
performed by @RISK  
The Simulation menu Settings command affects the tasks performed 
during a simulation.  For more information on the available 
simulation settings, see the Simulation menu Settings Command in 
the section @RISK Add-In Menu Commands in this chapter. 

Start Command 
Starts a Simulation 

The Simulation menu Start command (or clicking the Simulate icon) 
starts a simulation using the current settings.    

 

 
Simulation 
Settings Icon 
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Model Menu 
The Model menu commands allow the entering and editing of input 
distribution functions, outputs and correlation matrices that have 
been entered in an @RISK model in Excel.  The Model menu 
commands are also displayed when an output, input or correlation 
matrix is right-clicked in the Explorer list on the Model tab in the 
Model window. 

Define Distribution Command  
Displays the @RISK Define Distribution window with a 
graph of the selected input distribution displayed 

The Graph menu Define Distribution command displays the input(s) 
currently selected in the Explorer list on the Model tab in the Define 
Distribution window(s).  Once displayed, each selected input 
distribution can be edited or deleted and new distributions can be 
added to the displayed formula.   

 
For more information on using the @RISK Define Distribution 
window, see the @RISK Add-In Model Menu Define Distribution 
Command in this Reference chapter. 
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Function Properties Command  
Displays the current properties of an @RISK input 
distribution or output 
The Model menu Function Properties command displays the current 
property settings for an @RISK input distribution or output.  
Properties include name (both inputs and outputs), collect and lock 
settings (inputs only), and output range settings (outputs only). 

Once specified, function properties for probability distributions are 
added to distribution functions in Excel using distribution property 
functions.  For more information on distribution property functions, 
see Distribution Property Functions in the Reference: @RISK 
Functions section of this chapter. 

 
The properties available for outputs in an @RISK model include: 

•  Name.  Selects the name to use to identify the output in graphs 
and reports.  The Use Default Cell Name entry specifies that 
@RISK will automatically generate a name for the output using 
row and column headings it identifies in your worksheet. 

•  Output is Member of Output Range.  Selects whether or not the 
output cell is part of an output range.  Output ranges are groups 
of related cells (such as Profit by Year). 

•  Range Name.  If output is part of an output range, specifies the 
name of the range. 

•  Position in Range.  If output is part of an output range, specifies 
the position of the cell in the range, where cells are ordered from 1 
to the total number of cells in the range. 

Each property is entered as an argument to the RiskOutput function 
which identifies the output cell in Excel.  Properties can be specified 
or changed by adding arguments directly to the RiskOutput function 
instead of using the Function Properties dialog. 

 

Function 
Properties for 
Outputs 
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For more information on the RiskOutput function, see RiskOutput in 
the Reference: @RISK Functions section of this chapter. 

 
The properties available for inputs in an @RISK model include: 

•  Name.  Selects the name to use to identify the input in graphs and 
reports.  The Use Default Cell Name entry specifies that @RISK 
will automatically generate a name for the input using row and 
column headings it identifies in your worksheet. 

•  Collect.  Specifies whether or not samples will be collected for the 
distribution during a simulation when the Inputs Marked with 
Collect option is selected for Collect Distribution Samples in the 
Simulation Settings dialog. 

•  Lock.  Specifies whether or not the distribution will be sampled 
during a simulation.  If Lock is selected, the distribution will 
return its expected value during a simulation.  This allows you to 
temporarily remove a probability distribution from a simulation 
to test the impacts of the removal on simulation results. 

Each property is entered as a distribution property function which is 
used as an argument to the distribution function in Excel.  Properties 
can also be specified or changed by adding distribution property 
functions directly to the distribution function, instead of using the 
Function Properties dialog.  For more information on distribution 
property functions, see Distribution Property Functions in the 
Reference: @RISK Functions section of this chapter. 

Remove Functions Command 
Removes @RISK functions from selected cells or all 
worksheets in Excel 
The Remove Functions command removes all @RISK functions from 
either the cells currently selected in the Explorer list in the Model 
window or from all open worksheets in Excel. 

Function 
Properties for 
Inputs 
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Correlate Distributions Command 
Defines or edits correlations between probability 
distributions in the formulas of the selected cells 

The Model menu Correlate Distributions command allows the 
samples of input probability distributions to be correlated. When the 
Correlate Distributions command is selected (or the Correlate 
Distributions icon is clicked), a matrix is displayed in the Model 
window which includes a row and column for each probability 
distribution currently selected in the Explorer list.  Correlation 
coefficients between the probability distributions can be entered using 
this matrix. 

 
Two input distributions are correlated when their samples should be 
"related" — that is, the value sampled for one distribution should 
affect the value sampled for the other.  This correlation is necessary 
when, in reality, two input variables move to some degree in tandem.  
For example, imagine a model with two input distributions — Interest 
Rate and Housing Starts.  These two inputs are related, as the value 
sampled for Housing Starts depends on the value sampled for Interest 
Rate.  A high Interest Rate would tend to cause a low value for 
Housing Starts, and conversely a low Interest Rate would tend to 
cause a high value for Housing Starts.  If this correlation were not 
accounted for in sampling, some iterations of the simulation would 
reflect non-sensical conditions that could not occur in reality — such 
as a high Interest Rate and a high value for Housing Starts. 

 
Correlate 
Distributions 
Icon 
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If the Correlate Distributions command is selected and the active 
window is a pre-existing correlation matrix, you have the option to 
add each probability distribution currently selected in the Explorer 
list to the current matrix. When distributions are added to a pre-
existing matrix, the following options are displayed: 

 

Select Replace to replace the inputs starting at the highlighted 
position in the matrix with the new inputs, while maintaining the 
entered coefficients.  Select Insert to add new row/columns for the 
inputs at the current location.  Select Append to add the inputs as 
new row/columns after the last row/column in the matrix. Clicking 
Adjust Row/Column for Insertion and Replacement moves the 
highlighted row/column through the matrix. 

A single input may be added to a matrix by holding down the mouse 
button on an input in the Explorer and dragging the input onto a 
correlation matrix.  The input is added at the location highlighted as 
you move your mouse across the matrix.  Replace, Insert and 
Append options are also shown when dragging a new input onto a 
matrix. 

Adding Inputs 
to a Pre-Existing 
Matrix 
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Entering Correlation Coefficients 
Correlations between input distributions are entered into a matrix 
displayed when the Correlate Distributions command is selected (or 
the Correlate Distributions icon is clicked).  The rows and columns of 
this matrix are labeled with each of the input distributions in the 
currently selected cells.  Any specific cell in the matrix specifies the 
correlation coefficient between the two input distributions identified 
by the row and column of the cell. 

Correlation coefficients range in value between -1 and 1.  A value of 0 
indicates there is no correlation between the two variables — i.e., they 
are independent.  A value of 1 is a complete positive correlation 
between the two variables — i.e., when the value sampled for one 
input is "high", the value sampled for the second will also be "high".  
A value of -1 is a complete inverse correlation between the two 
variables — i.e., when the value sampled for one input is "high", the 
value sampled for the second will be "low".  Coefficient values in 
between, such as -.5 or .5, specify a partial correlation.  For example, a 
coefficient of .5 specifies that when the value sampled for one input is 
"high", the value sampled for the second will tend to, but not always, 
be "high". 

Correlations may be entered between any input distributions.  A 
distribution may be correlated with many other input distributions.  
Often your correlation coefficients will be calculated from actual 
historical data on which you are basing the distribution functions in 
your model. 

To enter correlations between your input distributions: 

1) Select the inputs in the Explorer list that you wish to correlate.  
Hold the <Ctrl> key down as you select multiple inputs.  

2) Click the Correlate Distributions icon, or select the Correlate 
Distributions command from the right-click pop-up menu in the 
Explorer. 

3) Scroll the matrix and highlight the cell that represents the 
intersection of the row representing one distribution and the 
column representing the second.  Type in the desired coefficient 
value. 

4) Move to other cells as needed to enter additional coefficients.   

5) When done, click Apply to enter the matrix in Excel and add 
RiskCorrmat functions to the input distribution functions in the 
matrix. 

Entering 
Correlation 
Coefficients 



Reference: @RISK Model Window Commands 269 

To add distributions to an existing matrix (or a blank matrix created 
with the Insert menu Correlation Window command): 

1) Drag input distributions from the Explorer list onto an existing 
matrix. 

2) Edit the correlation coefficients in the matrix as described in the 
prior section. 

Note: There are two possible cells where the correlation between any 
two inputs may be entered (row of the first and column of the second, 
or column of the first and row of the second).  You can use either cell 
— as you enter a coefficient value in one it is automatically entered 
in the second cell. 

 
When Apply is clicked from a correlation matrix window the entered 
matrix is added to a worksheet in Excel, and RiskCorrmat functions 
that reference the matrix are added to the input distributions 
contained in the matrix.  Correlation coefficients may be changed in 
this Excel matrix, as well as in the matrix displayed in the model 
window.  New inputs, however, cannot be added to the matrix 
displayed in Excel.  To add new inputs to a matrix, edit the matrix in 
the Model window. 

For more information on entering and editing correlation matrices, 
see the Model Window Correlation Menu Commands in this 
Reference section. 

Correlation 
Matrix 
Displayed in 
Excel 
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Understanding Rank Order Correlation Coefficient 
Values 
The correlation of input distributions in @RISK is based on the rank 
order correlations.  The rank order correlation coefficient was 
developed by C. Spearman in the early 1900's.  It is calculated using 
rankings of values, not actual values themselves (as is the linear 
correlation coefficient).  A values "rank" is determined by its position 
within the min-max range of possible values for the variable. 

@RISK generates rank-correlated pairs of sampled values in a two 
step process.  First, a set of randomly distributed "rank scores" is 
generated for each variable.  If 100 iterations are to be run, for 
example, 100 scores are generated for each variable.  (Rank scores are 
simply values of varying magnitude between a minimum and 
maximum.  @RISK uses van der Waerden scores based on the inverse 
function of the normal distribution).  These rank scores are then 
rearranged to give pairs of scores which generate the desired rank 
correlation coefficient.  For each iteration there is a pair of scores, with 
one score for each variable. 

In the second step, a set of random numbers (between 0 and 1) to be 
used in sampling is generated for each variable.  Again, if 100 
iterations are to be run, 100 random numbers are generated for each 
variable.  These random numbers are then ranked smallest to largest.   

For each variable, the smallest random number is then used in the 
iteration with the smallest rank score, the second smallest random 
number is used in the iteration with the second smallest rank score 
and so on.  This ordering based on ranking continues for all random 
numbers, up to the point where the largest random number is used in 
the iteration with the largest rank score. 

In @RISK this process of rearranging random numbers happens prior 
to simulation.  It results in a set of paired random numbers that can be 
used in sampling values from the correlated distributions in each 
iteration of the simulation. 

This method of correlation is known as a "distribution-free" approach 
because any distribution types may be correlated.  Although the 
samples drawn for the two distributions are correlated, the integrity 
of the original distributions is maintained.  The resulting samples for 
each distribution reflect the input distribution function from which 
they were drawn. 
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Correlations between input distributions may also be entered directly 
in your worksheet using the CORRMAT function.  The correlations 
specified using this function are identical to those entered when 
Apply is clicked from the Correlation Matrix window. 

For more information on using these functions to enter correlations, 
see the description of these functions in the Reference: @RISK 
Functions section of this chapter. 

For further information on working with correlation matrices, see the 
Correlation Menu Commands in this section. 

Delete Correlation Matrix Command 
Deletes the selected correlation matrix  
The Model menu Delete Correlation Matrix command deletes the 
selected correlation matrix.  All RiskCorrmat functions will be 
removed from distribution functions used in the matrix and the 
correlation matrix displayed in Excel will be deleted. 

Find Outputs and Inputs Command  
Scans open worksheets, identifies all @RISK functions and 
updates the Explorer list in the Model window 

The Model menu Find Outputs and Inputs finds all @RISK 
distributions in all open worksheets in Excel.  Use this command to 
update all entries in the Explorer list in the Model window.  If you are 
entering probability distributions directly in formulas in Excel use this 
command to keep your Explorer list up to date.  @RISK also checks 
that Model window information for individual cells is up to date 
when an input or output is edited using the Model menu Define 
Distribution or Edit Output command. 

Note: When Apply is clicked from an open @RISK Define Distribution 
window, the cell formula (including any @RISK distribution 
functions) that is shown in the window is placed in the specified cell.  
This formula will overwrite the existing formula in the cell, even if 
the formula in the cell has been changed in Excel while the @RISK 
Define Distributionwindow for the cell is open. 

Specifying 
Correlations 
With Functions 
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Correlation Menu 
The Correlation menu commands allow you to edit correlation 
matrices and create new instances of existing matrices.  There are also 
options in the Correlation Window itself for identifying and 
describing an entered matrix.  These options are also described in this 
section. 

Check Matrix Consistency Command 
Checks the consistency of the active correlation matrix  
The Model menu Check Matrix Consistency command checks if the 
entered matrix in the active correlation window is valid.  @RISK can 
correct any invalid matrix and generate the closest valid matrix to the 
entered invalid one.   

An invalid matrix specifies inconsistent simultaneous relationships 
between three or more inputs.  It is quite easy to make a correlation 
matrix which is invalid.  A simple example is: correlate input A and B 
with a coefficient of +1, B and C with a coefficient of +1, and C and A 
with a coefficient of -1.  This example is clearly illegal, but invalid 
matrices are not always this obvious.  In general, a matrix is valid 
only if it is positive semi-definite.  A positive semi-definite matrix has 
eigenvalues which are all greater than  or equal to zero, and at least 
one eigenvalue that is greater than zero. 

If @RISK determines you have an invalid matrix when the Check 
Matrix Consistency command is selected, it will give you the option 
of letting @RISK generate the closest valid matrix to the entered 
invalid one.  @RISK follows these steps to modify a matrix:  

1) Finds the smallest eigenvalue (E0) 

2) "Shifts" the eigenvalues so that the smallest eigenvalue equals 
zero by adding the product of -E0 and the identity matrix (I) to 
the correlation matrix (C): C' = C - E0I. 

3) Divides the new matrix by 1 - E0 so that the diagonal terms equal: 
C'' = (1/1-E0)C' 

This new matrix is positive semi-definite, and therefore, valid. It is 
important to check the new valid matrix to ensure that its correlation 
coefficients accurately reflect your knowledge of the correlation 
between the inputs included in the matrix. 

Invalid 
Correlation 
Matrices 
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Note: A correlation matrix entered in the Correlation window is 
automatically checked for consistency when the Apply button is 
clicked, prior to entering the matrix in Excel and adding RiskCorrmat 
functions for each input in the matrix. 

Insert Row/Column Command 
Inserts a row and column in the active correlation matrix  
The Model menu Insert Row/Column command inserts a new row 
and column in the active correlation matrix.  A new column will be 
placed in the matrix at the cursor location, shifting existing columns 
to the right.  A new row is also added at the same position as the 
added column, shifting existing rows down. 

Once a new row/column is added to a matrix, a new input can be 
added to the matrix by dragging an input from the Explorer list onto 
the new row.  Select Replace from the displayed dialog to assign the 
new input to the new row/column. 

Delete Selected Row/Column(s) Command 
Deletes a row and column in the active correlation matrix  
The Model menu Delete Selected Row/Column(s) command deletes 
the selected rows and columns from the active correlation matrix.   
This command is only available when one or more rows or columns 
are selected in the matrix by clicking on row or column headings. 

Detach Selected Input(s) Command 
Removes the selected input(s) from the active correlation 
matrix  
The Model menu Detach Selected Input(s) command removes the 
selected input(s) from the active correlation matrix.   This command is 
only available when one or more rows or columns are selected in the 
matrix by clicking on row or column headings.  When inputs are 
detached, only the inputs are removed – the coefficients specified in 
the matrix remain. 
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Instance Commands 
An instance is a new copy of an existing matrix that can be used to 
correlate a new set of inputs.  Each instance contains the same set of 
correlation coefficients; however, the inputs that are correlated with 
each instance are different.  This allows you to easily set up groups of 
similarly correlated variables without repeating the entry of the same 
matrix over and over.  In addition, when a correlation coefficient is 
edited in any instance of a matrix, it is automatically changed in all  
instances. 

Each instance of a matrix has a name. Instances can be deleted or 
renamed at any time. 

Instance is a third optional argument to the RiskCorrmat function.  
This allows you to easily specify instances when entering correlation 
matrices and RiskCorrmat functions directly in Excel.  For more 
information on the RiskCorrmat function and the Instance argument, 
see RiskCorrmat in the Reference: @RISK Functions section of this 
chapter. 

Note: When a correlation matrix with multiple instances is created in 
the Model window and displayed in Excel, only the inputs for the 
first instance are shown in the headings of the matrix added to the 
@RISK Correlation sheet.   
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Create New Instance Command 
Creates a new instance of the active correlation matrix  
The Model menu Create New Instance command creates a new 
instance of the active correlation matrix.  Prior to creating a new 
instance, you must give it a name. 

 
When a new instance is created, a new copy of the active matrix is 
made with no inputs attached to the rows and columns of the matrix.  
To add inputs to the new instance: 

•  Simply drag input distributions from the Explorer list onto the 
new matrix. 

To view a different instance of the matrix: 

•  Switch the Active Instance entry at the bottom of the correlation 
window. 
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Delete Instance Command 
Deletes the current instance of the active correlation matrix  
The Model menu Delete Instance command deletes the current 
instance of the active correlation matrix.  Correlations are removed for 
all inputs included in the instance. 

Rename Instance Command 
Renames the current instance of the active correlation matrix 

The Model menu Rename Instance command renames the current 
instance of the active correlation matrix.  The new name is shown in 
the Active Instance entry at the bottom of the correlation window. 
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Correlation Window Options 
The Correlation Window contains entries for Name, identifying the 
matrix in the window, Description, describing the matrix in the 
window, and Workbook, specifying the location in Excel for the 
matrix entered.  This information is used when the entered correlation 
matrix is added to Excel when the Apply button is clicked. 

 
The entries in the Correlation window include: 

•  Name.  Specifies the Name of the matrix which will be used to 
identify the matrix in the RiskCorrmat functions that are created 
for each input distribution included in the matrix.  This name 
must be a valid Excel range name. 

•  Description.  Gives a description of the correlations included in 
the matrix.  This entry is optional. 

•  Workbook.  Specifies the name of the workbook where the @RISK 
Correlations sheet will be placed.  By default the sheet will be 
placed in the same workbook where your inputs are located. 
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When you enter a correlation matrix in the Model Window and click 
Apply, the following events take place: 

1) The matrix is added to a worksheet named @RISK Correlations 
located in the workbook specified in the Workbook entry in the 
Correlation window.  This matrix in Excel is identified with an 
Excel range name that has the name specified in the Name entry 
in the Correlation window.  The Description entry is shown at 
the top of the matrix in Excel. 

 
2) RiskCorrmat functions are added to each of the input distribution 

functions that are included in the matrix.  The RiskCorrmat 
function is added as an argument to the distribution function 
itself, such as: 

=RiskNormal(200000, 30000,RiskCorrmat(NewMatrix,2)) 

where NewMatrix is the range name for this matrix and the 2 is 
the position of the distribution function in the matrix. 

After the matrix and RiskCorrmat functions are added to Excel, you 
can change the coefficient values in your matrix without editing the 
matrix in the Model window. 

How a 
Correlation 
Matrix is Added 
to Your Model in 
Excel 
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Fitting Menu 
The Fitting menu commands are used to set up and fit probability 
distributions to a data set displayed in a fit tab.  These commands 
allow you to run a fit, specify distribution types to be included in a fit 
and enter binning used in a fit’s Chi-Sq tests.  The Fitting menu also 
allows you to filter, sort or otherwise transform the input data that is 
displayed in the Input data grid on a fit tab. 

Run Fit Command 
Runs a fit on the input data that is displayed in the Input data 
grid using the current settings  
The Run Fit command fits probability distributions to the input data 
that is displayed in the Input data grid on a fit tab.  A fit is run using 
the current settings as entered using the Fitting menu Specify 
Distributions to Fit, Define Chi-Sq Binning and Input Data Options 
commands. 

For more information on the techniques used during distribution 
fitting, see Chapter 6: Distribution Fitting in this manual. 

Distribution fitting results in a set of theoretical probability 
distributions that are ranked according to how well they fit your data. 
These results are displayed in Fit Results and Fit Summary windows.   

 
Run Fit Icon 
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Fit Results Window 
The Fit Results window displays a list of fitted distributions, graphs 
that illustrate how the selected distribution fits your data, and 
statistics on both the fitted distribution and the input data and the 
results of the goodness-of-fit (GOF) tests on the fit.   

 

Note: No goodness-of-fit test information is generated if the input 
data type is Density Curve or Cumulative Curve (as set using the 
Fitting menu Input Data Options command).  In addition, only 
Comparison and Difference graphs are available for these data types. 

The Fitted Distributions list displays all distributions for which valid 
fit results were generated.  These distributions are ranked according 
to the goodness-of-fit test selected with the Rank By entry. Only 
distribution types selected using the Fitting menu Specify 
Distributions to Fit command are tested when fitting. 

Clicking on a distribution listed in the Fitted Distributions list 
displays the fit results for that distribution, including graphs and 
statistics on the selected fit. 

If a fit did not return valid results for a distribution type, that 
distribution is not listed in the Fitted Distributions list.  The number 
of invalid fits is shown beneath the list. 

Fitted 
Distributions 
List 
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The Rank By entry ranks the distributions according to the selected 
goodness-of-fit test, which measures how well the sample data fit a 
hypothesized probability density function. Three types of tests are 
available: 

•  Chi Sq or Chi-Square test.  The Chi-Square test is the most 
common goodness-of-fit test.  It can be used with sample input 
data and any type of distribution function (discrete or 
continuous).  A weakness of the Chi-Square test is that there are 
no clear guidelines for selecting intervals or bins.  In some 
situations, you can reach different conclusions from the same data 
depending on how you specified the bins.  The bins used in the 
Chi-Square test can be defined using the Fitting menu Define 
Chi-Sq Binning command. 

•  K-S, or Kolmogorov-Smirnov test.  The Kolmogorov-Smirnov test 
does not depend on the number of bins, which makes it more 
powerful than the Chi-Square test.  This test can be used with 
sample input data but cannot be used with discrete distribution 
functions.  A weakness of the Kolmogorov-Smirnov test is that it 
does not detect tail discrepancies very well. 

•  A-D, or Anderson-Darling test.  The Anderson-Darling test is 
very similar to the Kolmogorov-Smirnov test, but it places more 
emphasis on tail values.  It does not depend on the number of 
intervals.  

•  RMS Error, or root mean squared error.  If the input data type is 
Density Curve or Cumulative Curve (as set using the Fitting 
menu Input Data Options command), only the RMS Error test is 
used to fit distributions.  For more information on the RMS Error 
test, see Chapter 6: Distribution Fitting. 

Rank By 
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To display the fit results for different distributions in the Fitted 
distribution list at the same time: 

1) Select the Insert menu Fit Results Window command.  A new Fit 
Results window will be displayed on the current fit tab in which 
results for other fitted distributions can be displayed. 

 
 

Displaying Fit 
Results for 
Multiple 
Distributions 
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Fit Results – Graphs 
When the input data type is Sampled Values, four graphs – 
Comparison, Difference, P-P and Q-Q –  are available for any fit 
selected by clicking in the Fitted Distribution list.  If the input data 
type is Density Curve or Cumulative Curve, only the Comparison 
and Difference graphs are available. 

For all graph types delimiters may be used to graphically set specific 
X-P values on the graph.  X-axis minimum and maximum values may 
also be set by dragging the X-axis endpoint delimiters.  Delimiters are 
marked by the inverted triangles above the graph. 

 

A Comparison Graph displays two curves -  the input distribution 
and the distribution created by the best fit analysis. 

Two delimiters are available for a Comparison graph.  These 
delimiters set the Left X and Left P values, along with the Right X 
and Right P values.  Values returned by the delimiters are displayed 
in both the probability bar under the graph and in the statistics grid to 
the right of the graph. 

Comparison 
Graph 
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A Difference graph displays one curve -  the difference between the 
input distribution and the distribution created by the best fit analysis. 

A single delimiter can be used on the Difference graph to return 
specific X-Y values along with the difference between the input data 
and the fitted distribution at any X-value on the graph. 

 

The P-P (or Probability-Probability) graph plots the p-value of the 
fitted distribution vs. the p-value of the fitted result.  If the fit is 
"good," the plot will be nearly linear.  A single delimiter can be used 
on the P-P graph to return the p-value of the input data and the fitted 
distribution at any X-value on the graph. 

 

Difference 
Graph 

P-P Graph 
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A Q-Q (or Quantile-Quantile graph) plots the plot percentile values of 
the fitted distribution vs. percentile values of the input data.  If the fit 
is "good," the plot will be nearly linear.  A single delimiter can be used 
on the Q-Q graph to return the percentile value of the input data and 
the fitted distribution at any X-value on the graph. 

Q-Q Graph 
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Fit Results – Statistics and Goodness of Fit 
Statistics on fit results for the currently selected distribution are 
displayed in the statistics grid in the Results window.  Both standard 
Stats and GOF (or Goodness of Fit) results are shown on separate 
tabs.  Statistics and GOF results for all fitted distributions can be 
shown in the Fit Summary window displayed with the Insert menu 
Fit Summary Window command.  

 
The Stats tab in the Fit Results window displays relevant statistics for 
both the displayed fitted distribution and the distribution of the input 
data.  If a statistic is not valid for either the fitted distribution or the 
distribution of the input data, n/a is shown.  Statistics include: 

•  Formula, or distribution and arguments for the fitted distribution.  
When a fit is used as input for an @RISK model, this formula 
corresponds with the distribution function that will be placed in 
your spreadsheet. 

•  Parameters, or an entry for each parameter value included in 
Formula.  Shift is any X-value shift that is applied if the input 
data exceeds the range of the fitted distribution.  A shifted 
distribution is expressed in the form Dist(arg1,arg2…argn) ± Shift, 
where a sample drawn from the shifted distribution will have the 
shift amount added to or subtracted from it.  For more 
information on shift factors, see Chapter 6: Distribution Fitting.  

 

Stats 
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•  Delimiter values (Left and Right X,P entries on Comparison 
graph, Difference entry on Difference graph, Delimiter entry on P-
P and Q-Q graphs).  These entries display the current values for 
delimiters set on a graph. 

•  Standard Statistics (Minimum, Maximum, Mean, etc.).  These 
entries display the statistics calculated for both the displayed 
fitted distribution and the distribution of the input data. 

The GOF (or Goodness of Fit) tab displays the results of goodness-of-
fit tests that were calculated during fitting.  Test results are displayed 
for each of the three available tests (Chi-Sq, A-D and K-S) that are 
performed.  Goodness-of-Fit information is only available when the 
Input Data type is Sampled Values. 

The goodness-of-fit statistic tells you how probable it is that a given 
distribution function produced your data set.  The goodness-of-fit 
statistic can be used for comparing the values to the goodness-of-fit of 
other distribution functions.  

 
The entries in the GOF report include: 

•  Test Value, or the test statistic for the fitted probability 
distribution for each of the three tests. 

•  P-value, or observed level of the significance of the fit.  For more 
information on P-values, see Chapter 6: Distribution Fitting. 

•  Rank, or the rank of the fitted distribution among all distributions 
fit for each of the three tests.  Depending on the test, the returned 
rank can change. 

•  C Val, or critical values, at different significance levels for each of 
the three tests.  For more information on critical values and their 
calculation, see Chapter 6: Distribution Fitting. 

GOF 
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•  Bin statistics for each bin for both the input and the fitted 
distribution (Chi-Sq test only).  These entries return the min and 
max of each bin plus the probability value for the bin for both the 
input and the fitted distribution.  Bin sizes can be set using the 
Fitting menu Define Chi-Sq Binning command. 
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Fit Results – Fit Summary Window 
The Fit Summary window displays a summary of calculated statistics 
and test results for all distributions fit to the current data set. 

 
The following entries are shown in the Fit Summary window: 

•  Formula, or distribution and arguments for the fitted distribution.  
When a fit is used as input for an @RISK model, this formula 
corresponds with the distribution function that will be placed in 
your spreadsheet. 

•  Parameters, or individual entries for each of the distribution 
parameter values included in Formula.  Shift is any X-value shift 
that is applied if the input data exceeds the range of the fitted 
distribution.  A shifted distribution is expressed in the form 
Dist(arg1,arg2…argn) ± Shift, where a sample drawn from the 
shifted distribution will have the shift amount added to or 
subtracted from it.  For more information on shift factors, see 
Chapter 6: Distribution Fitting.  

•  Standard Statistics (Minimum, Maximum, Mean, etc.).  These 
entries display the statistics calculated for all fitted distributions 
and the distribution of the input data. 

Fit Summary 
Window 
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•  Targets identify the probability of achieving a specific outcome or 
the value associated with any probability level. Target entries 
have default values (10% through 95%) that you may change if 
you wish.   

Either values or probabilities may be entered into the target area 
in the Fit Summary window.  If a value is entered, the probability 
of a value occurring that is less than or equal to the entered value 
is calculated.  If a probability is entered, the value in the 
distribution whose associated cumulative probability equals the 
entered probability is calculated.  If the @RISK Add-in Options 
menu Display Cumulative Descending Percentiles option is 
selected, the reported target probability will be in terms of a 
probability of exceeding the entered target value. 

Note: Any target entered in the Fit Summary window is 
automatically applied to all fitted distributions and the 
distribution for input data. 

For each of the three tests performed (Chi Sq, A-D and K-S) the Fit 
Summary window displays the information shown on the GOF tab of 
the Fit Results window.  See the Fit Results – Statistics and 
Goodness-of-fit section in this chapter for more information on these 
statistics. 

The Rank By entry changes the order that fitted distributions are 
displayed in the Fit Summary window.  Select Name to list fitted 
distributions alphabetically, or Chi-Sq, A-D, or K-S to list according to 
the rankings returned for each test. 

 

 

 

 

Rank By 
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Specify Distributions to Fit Command 
Selects probability distributions to fit or specifies a 
predefined distribution to fit  
The Fitting menu Specify Distributions to Fit command selects the 
probability distributions to include in a fit.  This command can also be 
used to specify predefined distributions with preset parameter values 
to fit.  Probability distributions to be included in a fit may also be 
selected by entering information on the lower and upper limits of the 
allowable distributions. 

 
Parameter Estimation options control whether 1) a group of 
distribution types will be fitted or 2) a set of predefined distributions 
will be used.  The selection for Parameter Estimation determines the 
other options that are displayed in the Specify Distributions to Fit 
dialog. The options available for Parameter Estimation include: 

•  Find BestFit Parameters, or find the parameters for the selected 
distribution types that best fit your data set. 

•  Fit to Predefined Distributions, or determine how the entered 
probability distributions (with preset parameters values) fit your 
data set. 

 

 
Specify 
Distributions to 
Fit Icon 

Parameter 
Estimation 
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When Find BestFit Parameters is selected, the following options are 
available in the Specify Distributions to Fit dialog: 

•  List of Distribution Types.  Checking or unchecking a specific 
distribution type will include or remove that type from the fit to 
be performed. The list of distribution types that are displayed will 
change depending on the options selected for Lower Limit and 
Upper Limit. 

Each distribution type has different characteristics with respect to the 
range and limits of the data it can describe.  Using the Lower Limit 
and Upper Limit options you can select the types of distributions to 
include.  Limit options are set based on your knowledge of the range 
of values which could occur for the item that your input samples 
describe. 

Lower Limit and Upper Limit options include: 

•  Fixed Bound of.  Specifies a value that will fix the lower and/or 
upper limit of the fitted distribution to a specific value.  Only 
specific distribution types, such as Triangular, have fixed lower 
and upper limits.  Your entry for Fixed Bound will restrict a fit to 
certain types of distributions. 

•  Bounded, but unknown.  Specifies that the fitted distribution has 
a finite lower and/or upper limit, but you don’t know what the 
boundary value is. 

•  Open (extends to +/- infinity).  Specifies that the data described 
by the fitted distribution can possibly extend to any possible 
positive or negative value. 

•  Unsure.  Specifies that you are not sure about the possible values 
that could occur and thus the full range of distributions should be 
available for fitting. 

Find BestFit 
Parameters 
Options 
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When Fit to Predefined Distributions is selected, a set of predefined 
distributions are entered and only these predefined distributions will 
be tested during fitting.   

 
Predefined distributions are specified using the following options: 

•  Name.  Specifies the name you wish to give to a predefined 
distribution. 

•  Distribution.  Selects the type of distribution for a predefined 
distribution from the dropdown list of all available distribution 
types. 

•  Parameter values.  Depending on the type of distribution 
selected, the possible entries for parameter values will change.  
Entering the relevant parameter values completes the 
specification of a predefined distribution. 

The Add button adds an entered predefined distribution to the list of 
predefined distributions to be used.  Once a set of predefined 
distributions have been entered, any or all of the entered distributions 
can be selected for inclusion in a fit.  Select All selects all predefined 
distributions in the list to be included in a fit.  Alternatively, 
individual predefined distributions can be selected by clicking on the 
name of the predefined distribution to be included (holding down the 
Ctrl-key to select multiple distributions).  Delete deletes a predefined 
distribution from the displayed list, and Clear All unchecks all 
entries. 

Fit to Predefined 
Distributions 
Options 
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Define Chi-Sq Binning Command 
Defines the binning to be used in Chi-Sq goodness-of-fit 
tests  
The Fitting menu Define Chi-Sq Binning command defines the 
number of bins, type of bins and custom binning to be used for Chi-Sq 
goodness-of-fit tests.  Bins are the groups that your input data are 
divided into, similar to the classes used to draw a histogram.  Binning 
can affect the results of Chi-Sq tests and the fit results that are 
generated.  By using the Define Chi-Sq Binning options you can 
ensure that the Chi-Sq test is using the bins that you deem 
appropriate.  For more information on how the number of bins is used 
in a Chi-Sq test, see Chapter 6: Distribution Fitting. 

Note: If you are unsure about the number or type of bins to use for 
a Chi-Square test, set “Number of Bins” to “Auto” and set “Bin 
Style” to “Equal Probabilities”. 

 
The following entries can be used to define Chi-Sq binning: 

•  Number of Bins.  Specifies a fixed number of bins or, 
alternatively, specifies that the number of bins will be 
automatically calculated for you. 

 
Define Chi-Sq 
Binning Icon 
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Bin Style options specify the style of the binning that will be 
performed or, alternatively, allow the entry of fully custom bins with 
user-entered minimum and maximum values.  Options for Bin Style 
include: 

•  Equal Probabilities.  Specifies that bins will be made at equal 
probability intervals across the fitted distribution.  This usually 
results in unequal length bins.  For example, if ten bins are used, 
the first bin would extend from the minimum to the 10th 
percentile, the second from the 10th percentile to the 20th and so 
on.  In this mode, @RISK will adjust the bin sizes based on the 
fitted distribution, trying to make each bin contain an equal 
amount of probability.  For continuous distributions this is 
straight-forward.  For discrete distributions, however, @RISK will 
only be able to make the bins approximately equal. 

•  Equal Intervals. Specifies that bins will be of equal length across 
the input data set.  Several options are available for entering equal 
interval bins across an input data set.  Any or all of these options 
may be selected: 

1) Extend First Bin from Minimum to -Infinity.  Specifies that 
the first bin used will stretch from the specified minimum to -
Infinity.  All other bins will be of equal length.  In certain 
circumstances, this improves fitting for data sets with 
unknown lower bounds. 

2) Extend Last Bin from Maximum to +Infinity.  Specifies that 
the last bin used will stretch from the specified maximum to 
+Infinity.  All other bins will be of equal length. In certain 
circumstances, this improves fitting for data sets with 
unknown upper bounds. 

3) Automatic Minimum and Maximum Based on Input Data.  
Specifies that the minimum and maximum of your data set 
will be used to calculate the minimum and maximum of equal 
interval bins.  First and last bins, however, may be added 
based on the settings for Extend First Bin and Extend Last 
Bin options described above. If Automatic Minimum and 
Maximum Based on Input Data is not selected, you can enter 
a specific Minimum and Maximum value where your bins 
will start and end.  This allows you to enter a specific range 
where binning will be performed without regard to the 
minimum and maximum values in your data set. 

Bin Style 
Options 
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There are times when you wish to have complete control over the bins 
that are used for Chi-Sq testing.  For example, custom bins could be 
used when there is a natural grouping of collected sample data and 
you want your Chi-Square bins to reflect that grouping.  Entering 
custom bins allows you to enter a specific minimum-maximum range 
for each bin that is defined.   

 
 

To enter custom bins: 

1) Click Custom in Bin Style.  This grays out all automatic binning 
options. 

2) Enter a set of minimum or maximum values for your bins.  As 
you enter subsequent values, the range for each bin will be 
automatically filled in. 

Custom Bins 
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Input Data Options Command 
Specifies the type of input data to be fitted, its domain and 
any filtering to be applied to the data 

The Fitting menu Input Data Options command specifies the source 
and type of input data entered, whether it represents a continuous or 
discrete distribution and whether it should be filtered in any way. 

                
The Data Source options specify the source of the data to be fit.  Data 
can originate in the: 

•  Fit Tab Data Grid. Specifies that the data was typed, loaded or 
copied into the Data Grid on the left of the Fit Tab by the user. 

•  Link to Excel Range.  Specifies a range in Excel that contains the 
data to be fit.  A copy of the data in this range is shown in the 
Data Grid on the left of the Fit Tab. 

The Type of Data options specify the type of data that is entered in 
the Input Data grid on a fit tab. Three different types of data can be 
entered: 

•  Sampled Values.  Specifies that the data is in the form of Sample 
(or observation) data that are a set of values chosen from a 
population. The sample data is used to estimate the properties of 
that population.  

•  Density Curve.  Data for a Density curve are in the form of [X, Y] 
pairs.  The Y value specifies the relative height (density) of the 
density curve at each X value. 

 
Input Data 
Options Icon 

Data Source 

Type of Data 
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•  Cumulative Curve. Data for a Cumulative Curve are in the form 
of [X, p] pairs, where each pair has a X value and a cumulative 
probability p that specifies the height (distribution) of the 
cumulative probability curve at the X value.  A probability p 
represents the probability of a value occurring that is less than or 
equal to the corresponding X value. 

Depending on the option chosen for Type of Data one column 
(Sampled Values) or two columns (Density Curve and Cumulative 
Curve) will be displayed in the Input Data grid.  

For more information on how distribution fitting is performed on 
each of these data types, see Chapter 6: Distribution Fitting. 

•  Normalize Curve to Unit Area (Density curve data only).  
Selecting this option causes the entered Density curve (in the form 
of [X, Y] pairs) to be normalized so that the area under the density 
curve equals one.  It is recommended that you select this option to 
improve fitting of density curve data.  Do not use this option if 
your Y data are taken from a curve that has already been 
normalized. 

The Domain options specify the domain of the data – Continuous or 
Discrete - that is entered in the Input Data grid on a fit tab.  These 
options are only available for the Sampled Data type.  Density Curve 
and Cumulative Curve data are automatically continuous.   

Domain options include: 

•  Continuous.  Specifies that the distribution described by the input 
data ranges continuously and any value in the range is possible. 

•  Discrete.  Specifies that the distribution described by the input 
data is discrete and only integral values – and none in between – 
are possible.  If Discrete is selected, the Data in counted format 
option is available.  This option specifies that the input data will 
be in the form of X, Count pairs, where Count specifies the number 
of points that fall at value X. 

The selected Domain option will affect the distributions that can be 
fitted to the data set as selected using the Fitting menu Specify 
Distributions to Fit command (i.e., only discrete distributions will be 
fitted if Discrete Domain is selected). 

Domain 
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Filtering allows you to exclude unwanted values outside an entered 
range from your input data set. Filtering lets you specify outliers in 
your data that will be ignored during fitting.  For example, you may 
wish to only analyze X values greater than zero.  Or, you may wish to 
filter out tail values by only looking at data within a few standard 
deviations of the mean.  Filtering options include: 

•  No Filtering. Specifies that the data will be fitted as entered. 

•  Filter Data Outside Range.  Specifies a minimum X-value, a 
maximum X-value or both to define a range of valid data to be 
included in a fit.  Values outside the entered range will be 
ignored.  If just a minimum or just a maximum is entered for the 
range, the data will be filtered only below the entered minimum 
or above the entered maximum. 

•  Filter Data that Falls X Standard Deviations beyond the Mean.  
Specifies that data outside the entered number of standard 
deviations from the mean will be filtered from the data set prior 
to fitting. 

A fit can be automatically updated when the input data in the Data 
Grid or the referenced data range in Excel changes.  If Automatically 
Run Fit When Input Data Changes is selected, a new fit will be run 
when @RISK detects that the data has changed.   

Input distribution functions in Excel can also be automatically 
updated when a fit changes due to a change in data.  Input 
distribution functions are linked to a fit on a fit tab via the RiskFit 
function.  When a fit referenced by a RiskFit function changes, @RISK 
will automatically update the probability distribution function to 
reflect the new fit results either 1) automatically or 2) when a new 
simulation starts or the Outputs and Inputs list is generated.  
Updating an @RISK function in Excel could include: 

•  Changing the distribution function to a new type, such as when 
the RiskFit function includes the argument "Best Chi-Sq".  In this 
case the new distribution function entered in Excel will be the best 
fit returned by the Chi-Sq test performed during the new fit. 

•  Changing the distributions' arguments, such as when the RiskFit 
function includes the argument "Normal". In this case the new 
distribution function entered in Excel will be Normal wit the best 
fitting arguments returned by the new fit. 

Filtering 
Options 

Automatically 
Run Fit When 
Input Data 
Changes 
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The Fitting menu command Update Linked @RISK Functions 
command controls how the @RISK functions in your model update 
when a fit they are derived from changes. 

Sort Data Command 
Sorts the data set displayed in the input data grid 

The Fitting menu Sort Data command sorts the current data set in 
ascending order.  For cumulative curve and density curve data types, 
data is sorted by X value. 

Generate Data Command 
Generates a new data set in the input data grid using random 
samples from an entered distribution 

The Fitting menu Generate Data command generates a new data set 
in the input data grid on the current fit tab by drawing samples from 
an entered probability distribution. By using the Generate Data 
command you can quickly generate sets of random data from specific 
distributions for testing distribution fitting. 

 
The following options are available for generating input data: 

•  # of Points.  Specifies the number of points to be generated. 

•  Random Sampling Seed.  Selecting Random causes a new set of 
random samples from an entered distribution to be generated 
each time the Generate Data command is selected.  Using a Fixed 
seed causes the same sequence of samples to be generated each 
time the Generate Data command is selected for the same 
distribution. 

•  Distribution Definition. Specifies the distribution from which 
samples will be drawn to generate the input data set.  Options 
include: 

 

 
Sort Data Icon 

 

 
Generate Data 
Icon 
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1) Distribution.  Specifies the type of distribution for a 
predefined distribution from the dropdown list of all 
available distribution types. 

2) Parameter values.  Depending on the type of distribution 
selected, the possible entries for parameter values will 
change.  

Clicking OK in the Generate Input Data dialog causes a new data set 
with the specified number of points to be generated, overwriting the 
current data set. 
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Transform Data Command 
Generates a new data set in the input data grid by modifying 
the current data set using a selected transformation 

The Fitting menu Transform Data command modifies the current data 
set according to a transformation you select.  Available types of 
transformations include Linear, Power, Logrithmic, Exponential and 
Round. 

 
Options in the Transform Data dialog include: 

•  Variable to Transform.  Selects the variable of the data set to 
transform. When the input data type is Sampled Values, only X 
values can be transformed; however, when the input data type is 
Density Curve and Cumulative Curve, X or Y values can be 
transformed. 

•  Parameters.  Specifies the parameter value to be used in the 
transformation for Linear and Power transformations.  Enter the 
appropriate value as shown in the equations listed under Type of 
Transformation. 

•  Type of Transformation. Selects the type of transformation to be 
performed on the current input data. 

Note: Once a transformation is performed, the data set in the input 
grid is permanently changed. 
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Update Linked @RISK Functions Command 
Selects the method used for updating @RISK distribution 
functions which are based on fitted data 

The Fitting menu Update Linked @RISK Functions command allows 
you to select how @RISK distributions in Excel are updated when 
they are linked to a fit.  This allows you to insure that the 
distributions in your model stay current when fitted data changes.   

An @RISK distribution function in Excel can be linked to a data set 
and the fit of that data set.  The data used in a fit can be either in Excel 
or on a fit tab in the @RISK – Model window.  A link is made by the 
RiskFit function.  When the fitted data changes in either one of these 
locations, the following actions take place: 

1) @RISK re-runs the fit using the current settings on the fit tab 
where the fit was originally run 

2) The distribution function that includes the RiskFit function that 
references the fit is changed to reflect the new fit results.  The 
changed function replaces the original one in Excel.  If, for 
example, the distribution function's RiskFit argument specified 
"Best Chi-sq" for selected fit result, the new best-fitting distribution 
based on the Chi-Sq test would replace the original one.  This new 
function would also include the same RiskFit function as the 
original one. 

When @RISK will perform the above actions depends on the setting 
selected for the Update Linked @RISK Functions command.  
Available options are:  

•  Always, or immediately update distribution functions when the 
data and fit have changed.  

•  Only on Simulation Start or List Update, or update when a 
simulation starts or the list of Outputs and Inputs is generated. 

•  Never, or disable links and don't update when fits change. 

The Update method used affects all linked distributions.  It may be 
helpful to select Only on Simulation Start or List Update when re-
fitting takes too much time and frequent changes are made to fitted 
datasets. 
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Graph Menu 

Format Graph Command  
Changes the type or appearance of the current graph 

The Graph menu Format Graph command changes the appearance of 
the selected graph.  Use this command to change the type, scaling, 
style and titles of your graphs and turn delimiters on and off. 

Clicking Save as Default sets the current format settings as the 
default.  All new graphs generated will use these defaults. 

Type Tab – Graph Format Command 
Changes the type and format of a displayed graph 

The Type tab on the Graph Settings dialog box allows you to change 
the type of a displayed graph.   

 
•  Display As.  Displays a graph in density, cumulative ascending 

or cumulative descending format.  Auto specifies that the type of 
graph displayed will be based on the type of input data entered.  
In this case, graphs will be displayed in density format except 
when the curves being graphed would naturally be displayed in 
cumulative format. 

Save as Default  
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•  #Bins.  Sets the number of histogram intervals calculated across 
the range of a graph.  The value entered must be in the range 1 to 
200.  The setting Auto calculates the best number of bins to use for 
your data using an internal heuristic. 

•  Minimum.  Sets the minimum value where histogram bins start.  
Auto specifies that @RISK will start the histogram bins based on 
the minimum of the data graphed. 

•  Maximum.  Sets the maximum value where histogram bins end. 
Auto specifies that @RISK will end the histogram bins based on 
the maximum of the data graphed. 
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Scaling Tab – Graph Format Command 
Changes the scaling, units and axis tick marks on the active 
graph 

The available Scaling options allow you to rescale the current graph, 
set the number of X and Y axis ticks, set the scale factor with which 
values are displayed and display gridlines on the graph.  You can also 
select to have @RISK automatically scale the X and Y axis of a graph. 

Note: X-axis scaling can also be changed by dragging the delimiters 
at the X-axis endpoints using the mouse directly on the graph. 

 
•  Automatically Scale.  Specifies that @RISK will automatically 

calculate X or Y axis minimum and maximum values based on the 
range and probabilities of the data displayed in the graph. 

Note: Clicking the AutoScale button in the top right corner of a graph 
selects the Automatically Scale option and rescales the graph. 

•  X-Axis Maximum.  Enters the X-axis maximum value for the 
current graph.  This specifies the maximum value shown on the 
horizontal X-axis of the displayed graph.  Values are entered in 
terms of actual values with all digits.  Using the current scale 
factor, @RISK converts those values to the appropriate units (in 
thousands, in millions, etc.) for display.  X-axis scaling may be 
adjusted to include all of a distribution or just a portion of it.  This 
allows you to view only a piece of a distribution when more detail 
is desired. 

•  X-Axis Minimum.  Enters the X-axis minimum value for the 
current graph.   Information given for the X-maximum option also 
applies to X-minimum. 
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•  Y-Axis Maximum.  Enters the Y-axis maximum value for the 
current graph.  This specifies the maximum probability value 
displayed on the Y-axis.  

•  Y-Axis Minimum.  Enters the Y-axis minimum value for the 
current graph.   

•  # of Ticks.  Defines the number of ticks drawn on the X-axis or Y-
axis between the origin and the extreme values. 

•  Scale Factor.  Sets the factor used in displaying units on the X- 
and Y-axis in @RISK graphs.   Factors are entered as the listed 
unit names (thousands, millions, etc.) or as powers of 10.  

•  Show Scale Factor Label. Specifies that the scale factor will be 
labeled on the X and Y axes. 

•  Show Grid Lines.  Specifies if Y or X-axis grid lines are to be 
displayed. 

When @RISK initially scales a graph it calculates a default scale factor 
based on the magnitude of the values displayed in the graph.  
Entering a new scale factor causes the units displayed (i.e., in 
thousands, in millions, etc.) to change. 

 



Reference: @RISK Model Window Commands 311 

Style Tab – Graph Format Command 
Changes the color, format and pattern of elements in the 
displayed graph 

The Style tab in the Graph Format dialog box changes the colors, 
format and patterns on a displayed graph. 

 
 

The Foreground and Background Color options set the color of the 
foreground and background elements in the displayed graph. Colors 
can be selected by clicking on the box to the right of the Color entry. 

The Curve Style options change the color, format, pattern and other 
options of the current graph and its overlays.  The Format, Pattern 
and Options available change with the type of the graph displayed. 

The Format settings include: 

•  Points Format.  Graphs unconnected points at each point on the 
density or cumulative curve.  

•  Line Format.  Graphs cumulative line graph or density curve line 
graph.  

•  Bars Format. Graphs standard histogram bars. 

•  Solid Format.  Graphs all curves with the area under the curve 
filled. 

Pattern options include a variety of available line, point and fill 
patterns. 

When an overlay is present, the Overlay entry displays the color, 
format, pattern and options for the overlay graph. 

Foreground and 
Background 
Color 

Curve Style 
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Titles Tab – Format Command 
Allows the entry of custom titles for a graph 

The Titles tab allows the entry of a custom title for the top of any 
graph, along with custom X- and Y-axis titles.  Font style may also be 
set for titles. 

 
•  Main Graph and Axis Titles.  Changes a selected title.  Titles may 

also be formatted using any of the font styles listed in the 
dropdown font style entries. 

•  Display.  Adds or removes the @RISK-generated labels on graphs 
- Legend (graphs with overlays only) and Expected Value. 

Text and graphics may also be placed on graphs using the drawing 
and text editing capabilities of your spreadsheet.  Using the @RISK 
Edit menu Copy command, the active graph can be transferred to the 
Clipboard where it can be pasted into your spreadsheet as a Windows 
Metafile.  Once pasted, the graph can be resized and text and graphics 
may be attached to it. 
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Delimiters Tab – Graph Format Command 
Selects the display mode for delimiters on a histogram graph 
or cumulative graph  
Delimiters can be displayed on any graphs to allow 1) the setting of 
target probabilities directly on the graph and 2) X-axis rescaling.  
Delimiters are marked by inverted triangles at the top of a graph. 

 
Delimiters can be turned on and off as desired and shading between 
delimiters can be displayed or removed.  The color of delimiters and 
their associated shading can be specified by clicking on the box to the 
right of the Delimiter Color entry. 

To move delimiters: 

1) Click and drag any of the four delimiters marked by an upside 
down triangle at the top of the graph to the desired location.  
When a comparison graph is displayed, moving probability 
delimiters also updates the Left X, Left P, Right X, Right P, 
X(diff)  and P(diff) in the displayed Statistics tab.  The diff 
statistics show the value and probabilities falling between the left 
and right probability delimiters.  On a difference graph, 
delimiters update the X,Y and difference entries in displayed 
Statistics tab.  For P-P and Q-Q graphs, moving the single 
delimiter updates the Delimiter entry in the displayed Statistics 
tab. 

Using Delimiters 
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Graph in Excel Command 
Draws the selected graph in Microsoft Excel in the 
spreadsheet's native format 
The Graph menu Graph in Excel command places the selected graph 
data points in an Excel worksheet.  Then, a native format graph is 
created on the worksheet from the data points. 

 
Once the graph is created, it can be customized and rescaled using 
Excel's editing features.  Please consult your spreadsheet's 
documentation for more information on editing the graphs. 

For histograms, bar heights can be changed directly in Excel by 
changing the relevant series data. 

Delimiter Defaults Command 
Specifies the position of the left and right delimiters for all 
distribution graphs 

The Graph menu Delimiter Defaults command specifies the starting 
delimiter positions for new distribution graphs.   These settings affect 
all new distribution graphs for all models. 
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Artist Menu 
The Artist window is used to draw freeform curves that can be used 
to create probability distributions.  The commands on the Artist menu 
control both how drawing is performed in the Artist window and 
how a probability distribution is created from a drawn curve.  The 
Artist menu is only available when an Artist window is the active 
window. 

Artist Window 

 
After an Artist window has been inserted using the Insert menu 
Artist Window command, a curve may be drawn simply by dragging 
the mouse through the window.  The following entries in the Artist 
window control the scaling and type of graph that is drawn: 

•  X Min and X Max.  Specifies the X-axis scaling for the drawn 
graph. 

•  # Markers.  Sets the number of markers that will be drawn as you 
drag across the min-max range of the graph.  Markers allow you 
to drag the points on the curve to change its shape. 

•  Curve Type.  Specifies the type of curve that will be created, 
where Density is a probability density curve, Cumulative Asc. is 
an ascending cumulative curve and Cumulative Des. is a 
descending cumulative curve. 

•  Marker Drag Style.  Specifies whether markers will be connected 
with straight lines or curves when they are moved. 

Drawing in the 
Artist Window 
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If you are drawing an ascending cumulative distribution (as specified 
in the Curve Typeoption), you will only be able to draw a curve with 
ascending Y values, and vice-versa for a descending cumulative 
curve. 

When you have completed a curve, the end-points on your curve will 
be automatically plotted. 

After drawing a curve, you may want to "drag" one of the markers to 
a new location.  Simply click the left mouse button on the marker and, 
while holding down the button, drag the point to a new location.  
When you lift the button, the curve is redrawn automatically to 
include the new data point.  

You can only move data points along the Y-axis, and you cannot drag 
points outside the axes.  You cannot modify the positions of the end 
points. 

Clear Curve Command  
Erases the curve in the active Artist window 

The Artist menu Clear Curve command erases the curve in the active 
Artist window. 

Smooth Curve Command  
Smoothes the curve in the active Artist window 

The Artist menu Smooth Curve command smoothes the curve in the 
active Artist window.  Repeated selection of the Smooth Curve 
command makes a progressively smoother (and flatter) curve. 

Copy Command  
Copies data from the active Artist window to the clipboard 

The Artist menu Copy command copies the selected data or the graph 
from the Artist window to the Clipboard. All Points copies all X and 
Y data points which define the drawn curve, including those 
calculated on lines connecting markers.  Marked Points copies X and 
Y data points for markers only.  Graph places a copy of the drawn 
graph in the clipboard. 
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Create Distribution Command  
Creates a General distribution from the drawn curve 

The Artist menu Create Distribution command creates a General 
distribution from a drawn curve.  A General distribution is a user-
defined @RISK distribution that takes a minimum value, a maximum 
value and a set of X,P data points which define the distribution. 

 
When the Artist menu Create Distribution command is selected, the 
General distribution created from a curve in an Artist window is 
displayed in a Distribution window.  By using the Copy command 
this distribution can be placed in an @RISK Define Distribution 
window where it can be used to define an @RISK input. 

General 
Distribution 
from a Curve in 
an Artist 
Window 



318 Artist Menu 

Fit Curve Command  
Fits a drawn curve to a probability distribution 

The Artist menu Fit Curve command fits a probability distribution to 
a drawn curve.  When a drawn curve is fitted, the X and Y values 
associated with the curve are placed in the Input Data grid and fit.  
The results of the fit are displayed in a standard Fit Result window 
where each of the fitted distributions can be reviewed. 

 
Fitting a drawn curve uses the same fitting techniques used for either 
Density Curve input data (if the drawn curve type is Density) or 
Cumulative Curve input data (if the drawn curve type is 
Cuml.Ascending or Cuml.Descending).  For more information on 
input data types, see the Fitting Menu: Input Data Options 
Command.  For more information on fitting Density Curve input data 
and Cumulative Curve input data, see Chapter 6: Distribution 
Fitting. 

Fitted 
Distribution 
from a Curve in 
an Artist 
Window 
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Write Function to Excel Command  
Writes the General probability distribution defined by the 
curve in the Artist window to a cell in Excel 
The Artist menu Write Function to Excel command creates a 
RiskGeneral distribution function from the drawn curve and allows 
you to select a cell in Excel to place the function in.  The RiskGeneral 
distribution function created is identical to the function created when 
the Artist menu Create Distribution command is selected. 
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Window Menu 

Show Excel Window Command 
Shows Excel and the @RISK add-in 

The Window menu Show Excel Window command shows the Excel 
window and the @RISK add-in.  To show the @RISK Model window 
again, click the Show Model Window icon in the @RISK toolbar. 

Show Results Window Command 
Shows the @RISK Results window 

The Window menu Show Results Window command shows the 
@RISK Results window.  To show the @RISK Model window again, 
click the Show Model Window icon in the @RISK toolbar. 

Cascade Command, Tile Command 
Arranges open windows and graphs in the @RISK Model 
window 

The Window menu Cascade and Tile commands cascade or tile the 
open windows neatly within the @RISK Model window. 

List of Available Windows 
Lists all open windows in the @RISK Model window 

The bottom items in the Window menu list all open windows in the 
current tab in the @RISK Model window (the active window is noted 
with a check mark).  To activate a window, select its name from the 
list. 
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Help Menu 

How Do I? 
Opens the How Do I guide for @RISK 

The Help menu How Do I? command opens the How Do I guide for 
@RISK.  This contains quick instructions in how to perform many 
common @RISK tasks. 

@RISK Help, Distributions Help 
Opens on-line help files for @RISK 

The Help menu @RISK Help command opens the main help file for 
@RISK.  All of @RISK's features and commands are described in this 
file. 

The Help menu Distributions Help command opens the distribution 
help file for @RISK.  Information on all of @RISK's distribution 
functions, including formulas, statistics and graphs, is included in this 
file. 

Online Manual 
Opens on-line manual for @RISK 

The Help menu Online Manual command opens this manual on-line 
in PDF format.  You must have Adobe Acrobat reader installed to 
view the online manual. 

Authorization Command 
Displays authorization information for @RISK and allows the 
authorization of trial versions 

The Help menu Authorization command displays the Authorization 
dialog box, listing the version and authorization information for your 
copy of @RISK.  Using this dialog box you can also convert a trial 
version of @RISK into an authorized copy. 
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About Command 
Displays version and copyright information about @RISK 

The Help menu About command displays the About dialog box, 
listing the version and copyright information for your copy of @RISK 
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File Menu 

New Command 
Clears all active @RISK simulation data and results 

The New command clears all active @RISK simulation data from the 
Results and Model windows and resets @RISK settings to their 
default values. 

Open Command 
Opens a saved @RISK simulation 

The File Open command opens a previously saved simulation data 
file (.RSK file) including simulation settings, all input data and graphs 
(with supporting fitted datasets) and simulation results including any 
generated graphs.  For more information on the File Open command, 
see File Open in Reference: @RISK Add-In Menu Commands. 

Save Command, Save As Command 
Saves the current @RISK simulation data  
The File menu Save and Save As commands save the current @RISK 
data in a .RSK file. For more information on the File Save and Save As 
commands, see File Save in the @RISK Add-In Menu Commands 
section. 

Print Command 
Prints the current graph or report 
The Print command prints the active Results window graph.  

 
Open Icon 

 
Save Icon 



328 File Menu 

Exit Command 
Unloads the @RISK add-in from Excel 
The File menu Exit command unloads the @RISK add-in in Excel and 
shuts down the supporting @RISK-Model and @RISK-Results 
windows.  If you shut down @RISK during an Excel session, you can 
restart it at a later time by clicking the @RISK icon on the 
DecisionTools toolbar. 
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Edit Menu 

Copy Command 
Copies @RISK reports and graphs to the Windows Clipboard 

The Edit menu Copy command is used to transfer @RISK reports and 
graphs to the Clipboard so they can be pasted into your spreadsheet 
or word processor.  The report or graph to be copied is determined by 
the current active window in @RISK.  The active window is the one 
with its title bar highlighted. 

@RISK graphs are copied to the clipboard as Windows metafiles.  
When placed in your spreadsheet they may be resized and annotated. 

Paste Command 
Pastes the current contents of the Clipboard into an @RISK 
statistics report 
The Edit menu Paste command is used to transfer the Clipboard 
contents into the editable area of an @RISK statistics report.  The 
editable area of the report is the section of the report where Scenarios, 
Filters and Targets are entered. 

Fill Down Command 
Copies an entered target across a set of simulation results 

The Edit menu Fill Down command is used to copy an entered target 
in the Summary Statistics window.  To use the Fill Down command: 

1) Enter the desired value in a cell in the x1=, x2=, p1= or p2= column 
in the window.  

2) Highlight the range you wish to copy the value down with the 
mouse, with the cell with the value to be copied as the first cell in 
the range. 

3) Select the Edit menu Fill Down command.  The value will be 
"filled" into each cell in the range and the corresponding target 
values or probabilities calculated. 
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Fill Right Command 
Copies an entered target, scenario or filter across a set of 
simulation outputs 

The Edit menu Fill Right command is used to copy an entered target, 
scenario or filter across a row in the Detailed Statistics window.  To 
use the Fill Right command: 

1) Enter the desired value in a cell in the report.  

2) Highlight the range you wish to copy the value across with the 
mouse, with the cell with the value to be copied as the first cell in 
the range. 

3) Select the Edit menu Fill Right command.  The value will be 
"filled" into each cell in the range. 

Move or Copy Window Command 
Copies or moves a displayed window to a different tab 

The Edit menu Move or Copy Window Command moves or copies 
windows between tabs. 

 
Using the Move or Copy command you can rearrange your windows 
so logical groups of windows are placed on the same tab. 
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Delete Tab Command 
Deletes the current tab 

The Delete Tab command (also selected by right-clicking on a Tab at 
the bottom of the Results window and selecting Delete) deletes the 
current tab.  All open windows on the current tab are also deleted. 

Rename Tab Command 
Renames the current tab 

The Rename Tab command (also selected by right-clicking on a Tab at 
the bottom of the Results window and selecting Rename) renames the 
current tab. 
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View Menu  
Turns display of screen elements on and off 

The View menu options allow you to optionally display or not 
display the @RISK Results window toolbars, Explorer and status bar, 
and customize the displayed toolbars. 
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Insert Menu  
The Insert menu commands insert new windows on the current tab or 
inserts a new tab. Multiple copies of any window can be inserted on a 
tab. 

Tab Command 
Inserts a new tab before the current tab 

The Insert Tab command inserts a tab before the current tab.  These 
commands can also be selected by right-clicking on a Tab at the 
bottom of the @RISK  Results window. 

Graph Command 
Inserts new graph window(s) on the current tab 

The Insert menu Graph command allows you to insert one or more 
graph windows on the current tab.  The type of graph that will be 
inserted is determined by the menu item selected from the Graph 
command. 

 
The Insert menu Graph command displays a graph for each entry 
currently selected in the Results window Explorer list.  By holding 
down the <Ctrl> or <Shift> key to select multiple variables in the 
Explorer list, multiple results can be graphed. 
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A variety of graphs of simulation results can be generated in the 
Results Window: 

Histogram and Cumulative Graphs 

 
Graphs of simulation results are generated when 1) an output or input 
is “right-clicked” in the Explorer list and a graph command is selected 
or 2) the Insert Graph command is selected.  Graphs may be 
generated for: 

•  Output cells, where the graph displays the distribution of values 
calculated during the simulation for the output cell selected. 

•  Input distribution functions, where the graph displays the 
distribution of values sampled during the simulation from the 
distribution function selected. 

Graphs are displayed using the default graph type and patterns. The 
available graph types and patterns are described in the Graph menu 
Format Graph command later in this section. 

Multiple graphs can be created for any simulation result.  To create 
additional graphs, simply highlight the appropriate entry in the 
Explorer list and right-click. 

The statistics, data, sensitivities and scenarios for the graphed output 
or input are displayed in the tabbed report to the right of the graph.  
For graphs of simulation outputs, clicking on the Graph tab changes 
the displayed graph to either a Tornado graph of the same output or a 
Summary graph of the output range of which includes the output.  

 
Histogram and 
Cumulative 
Graph Icons 



Reference: @RISK Results Window Commands 337 

  

Note: The amount of the window devoted to the graph and reports 
can be changed by moving the separator bar between the two parts of 
the window.  By default, enlarging the window by dragging makes 
the Graph larger, while maintaining a constant report size.  If you 
hold down the <Ctrl> key while stretching the window the report 
will be made larger while maintaining a graph size. 

Tornado Graphs 
Graphs of sensitivity analysis results are created when an output is 
“right-clicked” in the Explorer list and Tornado Graph is selected 
from the pop-up menu (or the Insert menu Graph Tornado Graph 
command is selected).    

 
A "tornado graph" can be displayed for either regression or 
correlation coefficients.  Changing the Display Significant Inputs 
Using Entry: switches a Tornado graph between Regression and 
Correlation sensitivity results. The length of the bar shown for each 
input distribution function is based on the coefficient value calculated 
for the input.  For more information on the coefficient values that are 
calculated in a Sensitivity analysis, see the Insert Menu Sensitivities 
Command later in this chapter. 

 

 

 
Tornado Graph 
Icon 
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Summary Graphs 
Summary graphs are created when the Insert menu Graph Summary 
Graph command is selected (or an output or output range is “right-
clicked” in the Explorer list and Summary Graph is selected from the 
pop-up menu). Summary Graphs are only available for multiple cell 
output ranges.  This type of output range is created when a set of cells 
is highlighted in your worksheet and the Add Output icon is clicked.  
If multiple simulations have been run, multiple summary graphs may 
be displayed in the same graph window to allow the comparison of 
results by simulation. 

 
A Summary graph summarizes changes in probability distributions 
across an output range.  When an output range contains multiple 
cells, a distribution of possible outcomes is calculated for each cell in 
the range.  The Summary graph takes five parameters from each 
distribution — the mean, two upper and two lower band values and 
graphs the changes in the five parameters across the output range.  
The upper band values default to +1 standard deviation and the 95th 
percentile of each distribution, while the two lower band values 
default to -1 standard deviation and the 5th percentile of each 
distribution.  These may be changed by using the Type options in the 
Graph Menu Graph Format dialog box. 

The Summary graph is especially useful in displaying changes in risk 
over time.  An output range may be an entire worksheet row  — such 
as Profit by Year.  The Summary graph would then show the trends in 
the distributions for profit year to year.  The wider the band around 
the mean the larger the variability in possible results.   

 
Summary Graph 
Icon 
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Summary graphs may be rescaled on both the X- and Y-axis.  See the 
section on the Graph Format Dialog Box Scaling Options in this 
chapter for more information on rescaling. 

When generating a Summary graph, @RISK calculates the mean and 
the four band values (such as 5th and 95th percentile) for each cell in 
the output range graphed.  These points are graphed with hi-lo lines.  
Patterns in-between the points for each cell are then added.  The mean 
and two band values for these added points are calculated by 
interpolation. 

When multiple simulations are run and multiple cell output range(s) 
have been selected, a summary graph is available for each multiple 
cell output range in each simulation.  Often it is desirable to compare 
the summary graphs created for the same output range in different 
simulations.  This comparison shows how the trend in expected value 
and risk changes for the output range by simulation. 

 

To create a summary graph that compares the results for a single 
output range in multiple simulations: 

1) Run multiple simulations by setting the # of Simulations in the 
Simulation Settings dialog box to a value greater than one.  Use 
the RiskSimtable function to change worksheet values by 
simulation. 

2) Right-click on output range you wish to graph in the Explorer 
and select Summary Graph. 

3) Select the entry Sim#1 to Sim#n in the Graph Output Range 
Summary dialog box (where n is the number of simulations run) 
and click OK. 

 

Summary 
Graphs from 
Multiple 
Simulations 

Summary Graph 
from One 
Output Range in 
Three 
Simulations 



340 Insert Menu 

 

Overlay Graphs 
An overlay graph is created when the Insert menu Graph Overlay on 
Active Graph command is selected (or an output is “right-clicked” in 
the Explorer list and Overlay on Active Graph is selected from the 
pop-up menu).  This command is only available when the active 
window is a histogram or cumulative graph of a simulation output. 

 

Multiple outputs may be overlaid at the same time by holding the 
<Ctrl> key or <Shift> key while selecting outputs in the Explorer list, 
prior to selecting Overlay on Active Graph from the pop-up menu. 

Overlays may be removed using the Variables to Graph tab in the 
Graph Format dialog box.  For more information on doing this, and 
for more information on overlay graphs themselves, see the Variables 
To Graph Tab – Graph Format Command later in this chapter. 
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Summary Statistics Command 
Inserts a new Summary Statistics window on the current tab 

The Insert menu Summary Statistics command (also invoked by 
clicking the Summary Statistics icon) displays a summary of the 
simulation results for both output cells and inputs. 

 

The Summary Statistics window displays the minimum, mean and 
maximum values calculated for all output cells and input 
distributions that were sampled.  In addition,  two target values and 
probabilities (x1 and p1, along with x2 and p2) along with the number 
of errors calculated are displayed.  

The values and probabilities in the x1, p1, x2 and p2 columns may be 
edited and the new corresponding value or probability will be 
calculated.  The Edit menu Fill Down command can be used to 
quickly copy a target across a group of outputs and/or inputs.  Using 
this you can quickly calculate a statistic such as the 99th percentile for 
all results. 

 

 

 
Insert Summary 
Statistics 
Window Icon 
Summary 
Statistics 
Window 

Targets in the 
Summary 
Statistics 
Window 
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Detailed Statistics Command 
Inserts a new Detailed Statistics window on the current tab 

The Insert menu Detailed Statistics command (also invoked by 
clicking the Detailed Statistics icon) displays detailed statistics on the 
simulation results for output cells and inputs. 

 
The Detailed Statistics window displays relevant statistics that were 
calculated for all output cells and input distributions that were 
sampled.  In addition, percentile values (in increments of 5 perc%) are 
shown, along with filter information and up to 10 target values and 
probabilities. 

Targets in @RISK may be calculated for any simulation result — either 
a probability distribution for an output cell or a distribution for a 
sampled input distribution.  These targets identify the probability of 
achieving a specific outcome or the value associated with any 
probability level.  Either values or probabilities may be entered into 
the target entry area at the bottom of the Detailed Statistics window.   

 

 

 

 

 

 
Insert Detailed 
Statistics 
Window Icon 
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Window 
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The target entry area is viewed by scrolling the Detailed Statistics 
window to the target rows where values and probabilities can be 
entered.  If a value is entered, @RISK calculates the probability of a 
value occurring that is less than or equal to the entered value.  If the 
@RISK Add-in Options menu Display Cumulative Descending 
Percentiles option is selected, the reported target probability will be 
in terms of a probability of exceeding the entered target value. 

If a probability is entered, @RISK calculates the value in the 
distribution whose associated cumulative probability equals the 
entered probability. 

Once a target value or probability has been entered, it may be quickly 
copied across a range of simulation results by simply dragging the 
value across the range of cells you wish to enter it in.  An example of 
this is shown above, with the 99% target entered for each of the 
output cells in the Detailed Statistics window.  To copy targets: 

1) Enter the desired target value or probability in a single cell in the 
Detailed Statistics window target rows. 

2) Highlight a range of cells across the row adjacent to the entered 
value by dragging the mouse across the range. 

3) Select the Edit menu Fill Right command and the same target will 
be calculated for each of the simulation results in the highlighted 
range. 

 

 

Copying Targets 
Across 
Simulation 
Results 
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Data Command 
Inserts a new Data window on the current tab 

The Insert menu Data command (also invoked by clicking the Insert 
Data Window icon) displays data values calculated during a 
simulation for output cells and inputs. A simulation generates a new 
set of data for each iteration of the simulation.  During each iteration a 
value is sampled for each input distribution and a value is calculated 
for each output cell. Selecting the Insert Data command displays the 
simulation data in a worksheet where it can be further analyzed or 
exported (using the @RISK Edit menu Copy command) to another 
application for additional analysis.  

 
Data is displayed by iteration for each output cell and sampled input 
distribution.  By moving across a row of the Simulation Data window 
you can see the exact combination of input samples which led to the 
shown output values in any given iteration. 

 
Insert Data 
Window Icon 

Data Window 
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Sensitivities Command 
Inserts a new Sensitivity Analysis window on the current tab 

The Insert menu Sensitivities command (also invoked by clicking the 
Insert Sensitivities Window icon) displays sensitivity analysis results 
for output cells. These results show the sensitivity of each output 
variable to its input variables.  

 
The Sensitivity analysis performed on the output variables and their 
associated inputs uses either a multivariate stepwise regression 
analysis or a rank order correlation analysis.    The input distributions 
in your model are ranked by their impact on the output whose name 
is selected in the drop-down listbox titled Rank Inputs for Output.  
The type of data displayed in the table – Regression, Correlation or 
Both – is selected in the drop-down listbox titled Display Significant 
Inputs Using. 

Two methods are used for calculating sensitivity analysis results, as 
discussed here: 

Multivariate Stepwise Regression 
Regression is simply another term for fitting data to a theoretical 
equation.  In the case of linear regression, the input data is fit to a line.  
You may have heard of the "Least-Squares" method, which is a type of 
linear regression. 

Multiple regression tries to fit multiple input data sets to a planar 
equation that could produce the output data set.  The sensitivity 
values returned by @RISK are normalized variations of the regression 
coefficients. 

 
Insert 
Sensitivities 
Icon 

What is Linear 
Regression? 
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Stepwise regression is a technique for calculating regression values 
with multiple input values.  Other techniques exist for calculating 
multiple regressions, but the stepwise regression technique is 
preferable for large numbers of inputs since it removes all variables 
that provide an insignificant contribution from the model. 

The coefficients listed in the @RISK sensitivity report are normalized 
regression coefficients associated with each input.  A regression value 
of 0 indicates that there is no significant relationship between the 
input and the output, while a regression value of 1 or -1 indicates a 1 
or -1 standard deviation change in the output for a 1 standard 
deviation change in the input. 

The R-squared value listed at the bottom of the column is simply a 
measurement of the percentage of variation that is explained by the 
linear relationship.  If this number is less than ~ 60% then the linear 
regression does not sufficiently explain the relationship between the 
inputs and outputs and another method of analysis should be used. 

Even if your sensitivity analysis produces a relationship with a large 
value of R-squared, examine the results to verify that they are 
reasonable.  Do any of the coefficients have an unexpected magnitude 
or sign? 

Rank Order Correlation 
Correlation is a quantitative measurement of the strength of a 
relationship between two variables.  The most common type of 
correlation is linear correlation, which measures the linear 
relationship between two variables. 

The rank order correlation value returned by @RISK can vary 
between -1 and 1.  A value of 0 indicates there is no correlation 
between variables; they are independent.  A value of 1 indicates a 
complete positive correlation between the two variables; when the 
input value samples "high," the output value will sample "high."  A 
value of -1 indicates a complete inverse correlation between the two 
variables; when the input value samples "high," the output value will 
sample "low."  Other correlation values indicate a partial correlation; 
the output is affected by changes in the selected input, but may be 
affected by other variables as well. 

What is 
Multivariate 
Stepwise 
Regression? 

What is 
Correlation? 
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Rank order correlation calculates the relationship between two data 
sets by comparing the rank of each value in a data set.  To calculate 
rank, the data is ordered from lowest to highest and assigned 
numbers (the ranks) that correspond to their position in the order. 

This method is preferable to linear correlation when we do not 
necessarily know the probability distribution functions from which 
the data were drawn.  For example, if data set A was normally 
distributed and data set B was lognormally distributed, rank order 
correlation would produce a better representation of the relationship 
between the two data sets. 

Comparison of Methods 
So, which measurement of sensitivity should you use?  If the R-
squared value reported by the Stepwise Regression is low, you can 
conclude that the relationship between the input and output variables 
is not linear.  In this case, you should use the Rank-Order Correlation 
analysis to determine the sensitivity in your model. 

If the R-squared value reported by the Stepwise Regression is high, it 
is easy to conclude that the relationship is linear.  But, as mentioned 
above, you should always verify that the regression variables are 
reasonable.  For example, @RISK might report a significant positive 
relationship between two variables in the regression analysis and a 
significant negative correlation in the rank-order analysis.  This effect 
is called multicollinearity. 

Multicollinearity occurs when independent variables in a model are 
correlated to each other as well as to the output.  Unfortunately, 
reducing the impact of multicollinearity is a complicated problem to 
deal with, but you may want to consider removing the variable that 
causes the multicollinearity from your sensitivity analysis. 

What is Rank 
Order 
Correlation? 
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Scenarios Command 
Inserts a new Scenario Analysis window on the current tab 

The Insert menu Scenarios command (also invoked by clicking the 
Insert Scenarios Window icon) displays scenario analysis results for 
output cells.  Up to three targets may be entered for each output 
variable.  Targets are entered in the top row of the scenario analysis 
window (labeled Scenario=) or in the Scenarios section of the 
Detailed Statistics window.  Targets are preceded by a >, <, >=, <= 
operator and can be specified in terms of percentiles or actual values. 

 

What is Scenario Analysis? 
Scenario analysis allows you to determine which input variables 
contribute significantly towards reaching a goal.  For example, which 
variables contribute to exceptionally high sales?  Or, which variables 
contribute to profits below $1,000,000? 

@RISK allows you to define target scenarios for each output.  You 
might be interested in the highest quartile of values in the Total Sales 
output, or the value less than 1 million in the Net Profits output.  
Enter these values directly in the Scenarios row of the @RISK Scenario 
Analysis window to study these situations. 

When you display a scenarios window, @RISK looks at the data 
created by your @RISK simulation.  For each output, the following 
steps are followed: 

1) The median and standard deviation of the samples for each input 
distribution for the entire simulation are calculated. 

2) A "subset" is created containing only the iterations in which the 
output achieves the defined target. 

3) The median of each input is calculated for the subset of data. 

 
Insert Scenarios 
Window Icon 
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4) For each input, the difference between the simulation median 
(found in step 1) and the subset median (found in step 3) is 
calculated and compared to the standard deviation of the input 
data (found in step 1).  If the absolute value of the difference in 
medians is greater than 1/2 a standard deviation then the input is 
termed "significant"; otherwise the input is ignored in the scenario 
analysis. 

5) Each significant input found in step 4 is listed in the scenario 
report. 

Interpreting the Results 
From the above explanation, you know that the scenario report will 
list all input variables that are "significant" toward reaching a defined 
goal for an output variable.  But what exactly does that mean? 

For example, @RISK may tell you that the Retail Price input is 
significant when studying the highest quartile of Total Sales.  So, you 
know that when Total Sales are high, the median Retail Price is 
significantly different than the median Retail Price for the whole 
simulation. 

@RISK calculates three statistics for each significant input distribution 
in a scenario: 

•  Actual Median of Samples in Iterations Meeting Target.  The 
median of the subset of iterations for the selected input 
(calculated above in step 3).  You can compare this to the median 
of the selected output for the whole simulation (the 50% 
percentile reported in the statistics report). 

•  Percentile Median of Samples in Iterations Meeting Target.  The 
percentile value of the subset median in the distribution 
generated for the whole simulation (equivalent to entering the 
subset median as a Target Value in the @RISK statistics report).  If 
this value is less than 50%, the subset median is smaller than the 
median for the whole simulation, if it is greater than 50% the 
subset median is greater than the median for the whole 
simulation. 

You might find that the subset median for Retail Price is lower 
than the median for the whole simulation (thus the percentile is 
less than 50%).  This indicates that a lower Retail Price can help 
you reach the goal of high Total Sales. 
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•  Ratio Shown Median to Original Standard Deviation.  The 
difference between the subset median and the median for the 
whole simulation, divided by the standard deviation of the input 
for the whole simulation.  A negative number indicates that the 
subset median is smaller than the median for the whole 
simulation, a positive number indicates that the subset median is 
greater than the median for the whole simulation.  The larger the 
magnitude of this ratio, the more "significant" the variable is in 
reaching the defined target. 

Perhaps another input variable, Number of Salespeople, is 
significant towards reaching the target of high Total Sales.  But, its 
ratio of median to standard deviation is only half the magnitude 
of the ratio for the Retail Price input.  You could conclude that, 
while the Number of Salespeople does affect your goal of high 
Total Sales, the Retail Price is more significant and may require 
more attention. 

Caution:  The greatest danger in using scenario analysis is that the 
analysis results may be deceiving if the subset contains a small 
number of data points.  For example, in a simulation of 100 iterations 
and a scenario target of ">90%," the subset will contain only 10 data 
points! 
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Simulation Menu 

Settings Command 
Changes the settings which control the simulations 
performed by @RISK  
The Simulation menu Settings command affects the tasks performed 
during a simulation.  For more information on the available 
simulation settings, see the Simulation menu Settings Command in 
the section @RISK Add-In Menu Commands in this chapter. 

Start Command 
Starts a Simulation 

The Simulate menu Start command (or clicking the Simulate icon) 
starts a simulation using the current settings.    

 
Settings Icon 

 
Start Icon 
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Results Menu 

Real-Time Results Command 
Selects whether or not simulation results will be updated 
real-time as the simulation runs and specifies the interval for 
updating 

Simulation results can be updated in the Results window as a 
simulation runs.  Graphs of simulation results and some report 
windows can be updated during simulation.  If Real-Time Update of 
@RISK Results Window is selected on the Monitor tab in the 
Simulation Settings dialog, the Results window will automatically be 
displayed when a simulation starts and the updating of open 
windows will begin.  A Real-Time Results toolbar is displayed that 
allows you to control the updating of displayed reports and graphs 
and pause and stop a running simulation. 

 
The Real-Time Results toolbar is displayed in the Results window 
whenever a simulation is running.  Using the options on this toolbar 
you can control whether or not reports and graphs are updated as a 
simulation runs, the interval (in iterations) between updates, whether 
convergence monitoring is performed, and pause or stop a 
simulation.  The icons and options available in the Real-Time Results 
toolbar are as follows: 

•  Run, Pause and Stop.  Causes a running simulation to pause or 
stop, or resumes a paused simulation. 

•  Enable/Disable Convergence Monitoring.  Turns convergence 
monitoring off or resumes convergence monitoring.  Only 
available when the Monitor Convergence option is selected on 
the Monitor tab in the Simulation Settings dialog. 

•  Enable/Disable Real-Time Results Updating.  Turns real-time 
updating of simulation results on or off.  This option can be 
selected regardless of the Real-Time Update of @RISK Results 
Window selection in the Simulation Settings dialog box. 

Real-Time 
Results Toolbar  
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•  Update Every XXX Iterations.  Specifies the interval between 
updates of displayed graphs, reports and convergence 
monitoring.  As updating adds to simulation runtime, set the 
interval to a higher number of iterations if a large number of 
reports and graphs are updated real-time. 

While a simulation is running, you can manipulate graphs, move 
delimiters, and create new graphs and reports, just as you can do 
when a simulation is complete.  Some reports, such as full Sensitivity 
and Scenario analysis reports (displayed when the Insert menu 
Sensitivities or Scenarios commands are selected), are not updated 
real-time as they typically take longer to generate and this would 
unduly slow a simulation. 

If the same model is re-simulated, @RISK keeps your graph and 
report windows open simulation to simulation.  By doing this you can 
keep the same graphs, with the same format and scaling, between 
runs, just changing the data displayed.  However, if you add new 
distributions to your model or add new outputs, @RISK will close all 
open reports and graphs.  You will need to recreate graphs and 
reports, either while the simulation is running or after the run is 
complete. 

Convergence Monitoring Command 
Turns Convergence Monitoring On and Off 

The Results menu Convergence Monitoring command turns 
convergence monitoring off and back on.  This command is only 
available when the Monitor Convergence option is selected in the 
Simulation Settings dialog.  For more information on Convergence 
Monitoring, see Convergence Monitoring in the @RISK Add-In 
Menu Simulation Settings Command in this Reference chapter. 

What Can Be 
Performed 
While a 
Simulation is 
Running? 

Updating 
Graphs and 
Reports 
Simulation to 
Simulation 
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Filter Command 
Filters values from simulation statistics calculations and 
graphs 

Filters may be entered for each selected output cell or sampled input 
probability distribution.  Filters allow you to remove unwanted 
values from the statistics calculations and graphs generated by 
@RISK.  Filters are entered using the Filter dialog box or, alternatively, 
in the Detailed Statistics window in the three Filter entry rows.  

 
A filter can be defined for any simulation output or sampled input 
distribution, as listed in the Name column of the Filter Settings table.  
When entering a filter, a type, a minimum allowed value, maximum 
allowed value or minimum-maximum range may be entered. If the 
Filter Minimum or Filter Maximum entry is left blank, the Filter 
range will be unbounded on one end — allowing a filter with only a 
maximum or minimum, such as "process only values equal to or 
above a minimum of 0".   

•  Show Only Outputs or Inputs With Filters – In the Filter dialog, 
displays only those outputs or inputs for which filters have been 
entered. 

•  Same Filter For All Simulations – If multiple simulations have 
been run, the Same Filter For All Simulations option copies the 
first filter entered for an input or output to the results for the 
same input or output in all other simulations.  

•  Apply - Filters are applied as soon as you click the Apply button 
in the Filter dialog box.   

Filter Dialog   

Filter Dialog 
Options 
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•  Clear Filters - To remove all current filters, click the Clear Filters 
button to remove the filters from the table and then click Apply.  
To simply disable a filter but leave the entered filter range, set the 
Filter Type to Off. 

The available Filter Types are: 

•  Standard Filter (Std) — This type of filter is applied only to the 
output cell or sampled input probability distribution for which 
the filter was entered.  Values below the entered minimum or 
above the entered maximum are removed from the statistics, 
sensitivity and scenario calculations for the result and not 
included in generated graphs for the simulation result.  

•  Iteration Filter (Iter) — This type of filter affects all simulation 
results.  In processing a global iteration filter, first @RISK applies 
the filter to the output cell or sampled input probability 
distribution for which the filter was entered.  Values below the 
entered minimum or above the entered maximum are removed 
from the statistics, sensitivity and scenario calculations for the 
result and not included in generated graphs for the simulation 
result.  The iterations which satisfy the conditions of this filter for 
the output or input are then "marked" and all other output cells or 
sampled input probability distributions are filtered to include 
only values generated in these iterations.  This type of filter is 
especially useful when you want to review simulation results (for 
all outputs and inputs) for only those iterations which meet a 
specific filter condition — such as where "Profit > 0".   

 

Filter Types 
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Fit Command 
Fits probability distributions to the simulation data collected 
for a output or sampled input. 
The Results menu Fit command uses the fitting features of the @RISK 
– Model window to fit probability distributions to the simulation data 
collected for an output or a sampled input.  This allows the 
comparison of simulation results to theoretical probability 
distributions. 

When the Results menu Fit command is selected (or an output or 
sampled input is “right-clicked” in the Explorer list and Fit is selected 
from the pop-up menu) the data collected for the output or input is 
transferred to a new Fit tab in the model window and a fit is 
performed using the default settings for distribution fitting.  The fit 
results are displayed in a Fit Results window. 

Report Settings Command 
Specifies the location (Results window or Excel) that 
simulation results will be displayed and the type of reports 
that will be generated in Excel 
The Results Report Settings command specifies the location and type 
of simulation reports that will be generated.  For more information, 
see the Results Report Settings Command in the @RISK Add-In 
Menu Commands section of this chapter. 
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Quick Report Command 
Generates a single one page report on simulation results in 
Excel 
The Results menu Quick Report command generates a single one 
page report in Excel containing statistics and graphs for the output or 
input selected in the Explorer list.  This report is designed for 
printing.  If the Quick Report command is selected when right-
clicking on a graph, the report will included the selected graph. 
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Graph Menu 

Format Graph Command  
Changes the appearance of the selected graph 

The Graph menu Format Graph command allows you to change the 
appearance of the active graph.  Use this command to change the 
type, scaling, style and titles of your graphs, turn delimiters on and 
off and add overlays. 

Clicking Save as Default sets the current format settings as the default 
for the appropriate graph type (probability distribution or Summary).  
All new graphs of the relevant type generated will use this default. 

Type Tab – Graph Format Command 
Changes the type and format of a displayed @RISK graph 

The Type tab on the Graph Settings dialog box allows you to change 
the type of a displayed graph.  The options which are available when 
the Type command is selected depend on the graph being edited — 
standard probability distribution graph or summary graph.  For 
Tornado graphs no Type options are available. 

Save as Default  
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•  Display As.  Changes the displayed distribution from a 

histogram format to a cumulative ascending or descending 
format.  This option is displayed only for probability distribution 
graphs (either simulation results for output cells or sampled input 
distributions).   

•  Format.  Selects Density or Relative Freq. as the unit of measure 
reported on the Y-axis.  Relative Frequency is the probability of a 
value in the range of a bin occurring (observations in a bin/total 
observations).  Density is the relative frequency value divided by 
the width of the bin, insuring that Y-axis values stay constant as 
the number of bins is changed. 

•  # Bins.  Sets the number of histogram intervals calculated across 
the range of a graph.  The value entered must be in the range 1 to 
200.  The setting Auto calculates the best number of bins to use for 
your data is based on an internal heuristic. 

•  Minimum.  Sets the minimum value where histogram bins start.  
Auto specifies that @RISK will start the histogram bins based on 
the minimum of the data graphed. Auto (Graph Axis) specifies 
that bins will start at the minimum value set on the X-axis,  
(except when the minimum data value is greater than the 
minimum X-axis value; in this case bins start at the minimum 
data value). 

Type Tab for 
Probability 
Distribution 
Graphs 
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•  Maximum.  Sets the maximum value where histogram bins end. 
Auto specifies that @RISK will end the histogram bins based on 
the maximum of the data graphed.Auto (Graph Axis) specifies 
that bins will start at the maximum value set on the X-axis,  
(except when the maximum data value is less than the maximum 
X-axis value; in this case bins start at the maximum data value). 

Note: the setting Auto (Graph Axis) causes histogram binning to act 
just as binning was performed (by default) in versions of @RISK 
earlier than 4.5.  This setting causes histograms to automatically 
rebin to the graph scale range as rescaling is performed, "zooming in" 
on your data.  The setting Auto in @RISK 4.5 does not rebin as 
rescaling is performed; perserving graph bins regardless of X-axis 
scaling. 

The options for Summary graphs allow you to review and change the 
settings for the bands shown on the Summary graph.  The values 
shown for both inner and outer bands may be set.   

 
A Summary Graph displays the trend of mean values for distributions 
in an output range, surrounded by a band above and below the mean.  
The "width" of the band is set by the values entered for Summary 
Inner and Outer Bands using the Type options.  Each band may be 
specified in terms of: 

•  Percentiles (Perc%) or  

•  Standard Deviations (SDev).  

For both percentiles and standard deviations an entry is made for the 
top band (+, or above the mean) and the bottom band (-, or below the 
mean).  The default value for the inner band is +1 standard deviation 
above the mean and -1 standard deviation below the mean.  The 
default value for the outer band is 95th and 5th percentiles, with the 
95th percentile lying above the mean and the 5th percentile lying 
below it. 

Type Tab for 
Summary 
Graphs 

Units and 
Bounds 
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To enter a band in terms of Percentiles: 

1) Click the Percentiles button 

2) Enter a value between 50 and 100 for the Top entry and between 0 
and 50 for the Bottom entry 

To enter a band in terms of Standard Deviations 

1) Click the Standard Deviations radio button 

2) Enter a value between 0 and 5 for each of the Top + and Bottom - 
entries.  The Top + and Bottom - values do not have to be the 
same. 

Different types of entries — either Percentiles or Standard Deviations 
— may be used for each band. 

When generating a Summary graph, @RISK calculates the mean and 
the four band values (such as +/-1 standard deviation and the 5th and 
95th percentile) for each cell in the output range graphed.  These 
points are graphed with hi-lo lines, along with interpolated 
intermediate points between each of the cells in the range. 

Entering 
Summary Graph 
Band Values 
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Scaling Tab – Graph Format Command 
Changes the scaling, units and axis tick marks on the active 
graph 

The available Scaling options are affected by whether the displayed 
graph is for a probability distribution (simulation results for output cells 
or input distributions) or a summary graph. 

Note: X-axis scaling on a probability distribution graph can also be 
changed by dragging the delimiters at the X-axis endpoints using the 
mouse, directly on the graph. 

 
•  Automatically Scale.  Specifies that @RISK will automatically 

calculate X or Y axis minimum and maximum values based on the 
range and probabilities of the data displayed in the graph. 

Note: Clicking the AutoScale button in the top right corner of a graph 
selects the Automatically Scale option and rescales the graph. 
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•  X-Axis Maximum.  Enters the X-Axis maximum value for the 
current graph.   

1) For a probability distribution graph — Specifies the 
maximum value shown on the horizontal X-axis of the 
displayed graph.  Values are entered in terms of actual values 
with all digits.  Using the current scale factor, @RISK converts 
those values to the appropriate units (in thousands, in 
millions, etc.) for display.  X-axis scaling may be adjusted to 
include all of a distribution or just a portion of it.  This allows 
you to view only a piece of a distribution when more detail is 
desired. 

2) For a Summary graph — Specifies the first cell in an output 
range to include in the Summary graph.  For example, if there 
are 10 cells in an output range, a Summary graph including 
all 10 will have an X-minimum of 1 and an X-maximum of 10.  
Changing the X-minimum to 5 would cause only the last 5 
cells in the output range to be displayed in the Summary 
graph. 

•  X-Axis Minimum.  Enters the X-axis minimum value for the 
current graph.   Information given for the X-maximum option also 
applies to X-minimum. 

•  Y-Axis Maximum.  Enters the Y-axis maximum value for the 
current graph.   

1) For a histogram or cumulative graph — Specifies the 
maximum probability value displayed on the Y-axis.  This 
value should be greater than zero and less than or equal to 
one.  

2) For a Summary graph — Specifies the Y-axis maximum value 
for the current graph.  Information provided for the Summary 
graph Y-axis minimum also applies here.  
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•  Y-Axis Minimum.  Enters the Y-axis minimum value for the 
current graph. 

1) For a histogram or cumulative graph — No entry possible.  
The Y-axis minimum is always set to zero. 

2) For a Summary graph — Specifies the Y-axis minimum value 
for the current graph.  Values are entered in terms of actual 
values with all digits.  Using the current scale factor, @RISK 
converts those values to the appropriate units (in thousands, 
in millions, etc.) for display.  Y-axis scaling may be adjusted 
to include all of a Summary graph or just a portion of it.  This 
allows you to view only a piece of a Summary graph when 
more detail is desired.  

•  # of Ticks.  Defines the number of ticks drawn on the X-Axis or 
Y-axis between the origin and the extreme values. 

•  Scale Factor.  Sets the factor used in displaying units on the X- 
and Y-axis in @RISK graphs.   Factors are entered as the listed 
unit names (thousands, millions, etc.) or as powers of 10.  Scale 
factor entries apply to the X and Y-axis scaling of histogram and 
cumulative curves and the Y-axis scaling of Summary graphs. 

When @RISK initially scales a graph it calculates a default scale 
factor based on the magnitude of the values displayed in the 
graph.  Entering a new scale factor causes the units displayed (i.e., 
in thousands, in millions, etc.) to change. 

•  Show Scale Factor Label. Specifies that the scale factor will be 
labeled on the X and Y axes. 
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Style Tab – Graph Format Command 
Changes the color, format and pattern of elements in the 
displayed graph 

The Style tab in the Graph Format dialog box change the colors, 
format and patterns on a displayed graph. 

 
The Foreground and Background Color options set the color of the 
foreground and background elements in the displayed graph.  Colors 
can be selected by clicking on the box to the right of the Color entry. 

The Curve Style options change the color, format, pattern and other 
options of the current graph and its overlays.  The Format, Pattern 
and Options available change with the type of the graph displayed. 

Combined Format and Options settings include: 

•  Points Format.  Graphs unconnected points at midpoint of top of 
histogram bars or at each point on a cumulative curve. No 
Options available. 

•  Line Format.  Graphs outlined histogram bars (Graph Type-
Histogram; Option-None), cumulative line graph (Graph Type-
Cumulative; Option-None), connected midpoints (Graph Type-
Histogram; Option-Link Midpoints) or fitted curve (Graph Type-
Histogram; Option-Fitted Curve) 

•  Bars Format. Graphs standard histogram bars. (Graph Type-
Histogram; No Options available). 

•  Filled Format.  Graphs unseparated histogram bars (Graph Type-
Histogram; Option-None), area graph using midpoints of each class 
(Graph Type-Histogram; Option-Link Midpoints), filled cumulative 
graph (Graph Type-Cumulative; Option-None) or fitted curve (Graph 
Type-Histogram; Option-Fitted Curve) 

Foreground and 
Background 
Color 

  Curve Style 
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Pattern options include a variety of available line, point and fill 
patterns. 

When overlays are present, the Overlay entry displays the color, 
format, pattern and options for the overlay graph for the output listed 
in Selected Overlay.  By changing the selected overlay entry you can 
switch between editing the curve style of the different overlays 
present on a graph. 

 

Selected 
Overlay 



368 Graph Menu 

Titles Tab – Format Command 
Allows the entry of custom titles for a graph 

The Titles tab allows the entry of a custom title for any graph, along 
with custom X- and Y-axis legends.  Font style may also be set for 
titles. 

 
 

•  Graph and Axis Titles.  Changes a selected title.  Titles may also 
be formatted using any of the font styles listed in the dropdown 
font style entries.  The Auto entry specifies that @RISK will 
automatically generate a graph title for you. 

•  Display.  Adds or removes the @RISK-generated labels on graphs 
- Legend (graphs with overlays only) and Expected Value. 

Text and graphics may also be placed on graphs using the drawing 
and text editing capabilities of your spreadsheet.  Using the @RISK 
Edit menu Copy command, the active graph can be transferred to the 
Clipboard where it can be pasted into your spreadsheet as a Windows 
Metafile.  Once pasted, the graph can be resized and text and graphics 
may be attached to it. 
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A summary graph has additional options for labeling the tick marks 
on the X-axis.  The Units entry specifies the units used for the tick 
labels (either Cell,  Name, Years, Months or any custom units type 
you wish to enter).  Units are labeled to the left of the X-axis on the 
graph.  If Name is used for Units @RISK will label each X-axis tick 
with the name of the output cell associated with the tick on the graph.  
If you wish to use Name for units you should enter short output 
names so they can be displayed on the graph.  The Start entry 
specifies the value for the first axis tick and the Increment entry 
specifies the increment between ticks.   

Summary Graph 
Titles Tab 
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Delimiters Tab – Graph Format Command 
Selects the display mode for delimiters on a histogram graph 
or cumulative graph.  
Delimiters can be displayed on histogram graphs or cumulative 
graphs to allow 1) the setting of target probabilities directly on a 
graph and 2) X-axis rescaling.  Delimiters are marked by inverted 
triangles at the top of a graph. 

 
Delimiters can be turned on and off as desired and shading between 
delimiters can be displayed or removed.  The color of delimiters and 
their associated shading can be specified by clicking on the box to the 
right of the Delimiter Color entry. 

To move delimiters: 

1) Click and drag any of the four delimiters marked by an upside-
down triangle at the top of the graph to the desired location.  
Moving probability delimiters also updates the Left X, Left P, 
Right X, Right P, X(diff)  and P(diff) in the displayed Statistics 
tab.  The diff statistics show the value and probabilities falling 
between the left and right probability delimiters. 

Note:  If you hold down the <Ctrl> key while dragging delimiters, 
delimiters will move a much smaller increment each time they change 
position. 

Using Delimiters 
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Variables To Graph Tab – Graph Format 
Command 
Selects the input variables to display on a histogram graph, 
cumulative graph or Tornado graph 

The Variables to Graph tab allows multiple distributions to be 
overlaid on a histogram or cumulative graph.  In addition, the 
Variables to Graph tab allows the customization of Tornado graphs to 
show only those input distribution sensitivities you are interested in.   

Note: A shortcut method for creating overlay graphs is to use the 
Overlay on Active Graph command from the Explorer list right-click 
pop-up menu. 

When a simulation output is initially graphed, the distribution of 
possible results for that output alone is displayed in a new graph 
window using the default graph type.  By using the Variables to 
Graph tab, additional outputs may be added to the graph or currently 
overlaid outputs may be removed from the graph. 

 
To select or deselect output variables whose distributions will be 
overlaid on the current graph: 

1) When a histogram or cumulative graph is displayed and active, 
select the Graph menu Graph Format command and then select 
the Variables to Graph tab. 

2) Highlight those inputs you wish to overlay on the graph by 
holding down the <Ctrl> key while clicking on the variable 
names with the mouse.  Clicking on an already highlighted 
output deselects it. 

 

 

Overlay Graphs 

Selecting Inputs 
to Display in a 
Histogram or 
Cumulative 
Graph 
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Overlay graphs are displayed in the same format as the initially 
displayed graph.  However, the graph style of any displayed curve 
may then be changed using the Graph Format dialog settings.  @RISK 
will initially rescale your graph when overlays are added, based on 
the maximum X and Y values in all distributions being graphed.  
Once graphed, however, scale values may be changed as needed 
using Graph Format dialog Scaling options. 

Overlays are especially useful for comparing output distributions in 
cumulative format.  This comparison shows which outputs have 
higher probabilities at various points across the X-scale range.  As 
delimiters are moved on overlay graphs target probabilities are 
updated for each included distribution.  The probability bar at the 
bottom of the graph continues to return values for the primary curve.  
Comparisons may also be made for outputs in different simulations 
when multiple simulations are run. 

Note: A maximum of ten outputs may be overlaid on a single graph. 

 

 

 

 

 

 

 

 

 

Cumulative 
Curve 
Overlays 

Comparing 
Results with 
Overlays 
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The Variables to Graph tab allows the customization Tornado graphs 
to show only those input distribution sensitivities you are interested 
in.  By default, @RISK displays a tornado bar for each input 
distribution with a non-zero coefficient value, up to a maximum of 15 
inputs. By using the Variables to Graph tab, bars may be removed 
from the tornado graph. 

 
To select or deselect input variables whose bars will be displayed in a 
Tornado graph: 

1) When a Tornado graph is displayed and active, select the Graph 
Format dialog Variables to Graph tab. 

2) Highlight those inputs you wish to include in the Tornado graph 
by holding down the <Ctrl> key while clicking on the variable 
names with the mouse.  Clicking on an already highlighted input 
deselects it. 

Variables to 
Graph- 
Simulation 
Sensitivity 
Tornado Graphs 

Selecting Inputs 
to Display in a 
Tornado Graph 
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Graph Type Command 
Changes the type of the current graph 

The Graph menu Graph Type command quickly changes the type and 
style of a histogram or cumulative graph.  Using the icons on the 
Graph Toolbar, the type of an active graph may be quickly changed.  
Graph Type may also be changed using the Graph Format command.  
The available types include: 

1) Histogram.  Selects a histogram or a "relative frequency" 
distribution for the current output cell.  Three formats for a 
histogram are available through the Graph Type command: 

•  Bar Graph.  Selects bar format for the current graph.  In bar 
format each bin in a distribution is represented by a bar that 
has a height corresponding with the probability density value 
for the bin.  

•  Area Graph.  Selects an area graph where probability density 
values are connected by line segments and the area under the 
curve is filled solid.  Points representing histogram bar 
heights are located at the midpoint of each bar.  

•  Fitted Curve.  Selects a fitted curve where a cubic spline fit is 
generated for the midpoint probability density values for the 
bars in the histogram.  This spline fit is then displayed in 
filled format. 

2) Cumulative Ascending.  Selects a graph of ascending cumulative 
probabilities.  A point on an ascending cumulative curve shows 
the probability that a random value will be less than or equal to 
the associated value on the horizontal X-axis.  For example, at the 
distribution maximum, the probability is 100% as there is a 100% 
chance of a value less than or equal to the distribution maximum 
occurring.  Cumulative graphs can be displayed as lines or filled. 

3) Cumulative Descending.  Selects a graph of descending 
cumulative probabilities.  A point on the descending cumulative 
distribution shows the probability that a random value will be at 
least as great as the value shown on the horizontal X-axis.   For 
example, at the distribution maximum, the probability is 0% as 
there is a 0% chance of a value greater than the distribution 
maximum occurring. Cumulative graphs can be displayed as lines 
or filled. 
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Graph in Excel Command 
Draws the selected graph in Microsoft Excel in the 
spreadsheet's native format 
The Graph menu Graph in Excel command places the selected graph 
data points in an Excel worksheet.  Then, a native format graph is 
created on the worksheet from the data points. 

 
Once the graph is created, it can be customized and rescaled using 
Excel's editing features.  Please consult your spreadsheet's 
documentation for more information on editing the graphs. 

For histograms, bar heights can be changed directly in Excel by 
changing the relevant series data. 

Delimiter Defaults Command 
Specifies the position of the left and right delimiters for all 
histogram and cumulative graphs 

The Graph menu Delimiter Defaults command specifies the starting 
delimiter positions for new histogram and cumulative graphs.   These 
settings affect all new histogram and cumulative graphs for all 
simulations run. 
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Window Menu 

Show Excel Window Command 
Shows Excel and the @RISK add-in 

The Window menu Show Excel Window command shows the Excel 
window and the @RISK add-in.  To show the @RISK Results window 
again, click the Show Results Window icon in the @RISK toolbar. 

Show Model Window Command 
Shows the @RISK Model window 

The Window menu Show Model Window command shows the 
@RISK Model window.  To show the @RISK Results window again, 
click the Show Results Window icon in the @RISK toolbar. 

Cascade Command, Tile Command 
Arranges open windows and graphs in the @RISK Results 
window 

The Window menu Cascade and Tile commands cascade or tile the 
open windows neatly within the @RISK Results window. 

List of Available Windows 
Lists all open windows in the @RISK Results window. 
The bottom items in the Window menu list all open windows in the 
@RISK Results window (the active window is noted with a check 
mark).  To activate a window, select its name from the list. 
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Help Menu 

How Do I? 
Opens the How Do I guide for @RISK 

The Help menu How Do I? command opens the How Do I? guide for 
@RISK.  This contains quick instructions in how to perform many 
common @RISK tasks. 

@RISK Help, Distributions Help 
Opens on-line help files for @RISK 

The Help menu @RISK Help command opens the main help file for 
@RISK.  All of @RISK's features and commands are described in this 
file. 

The Help menu Distributions Help command opens the distribution 
help file for @RISK.  Information on all of @RISK's distribution 
functions, including formulas, statistics and graphs, is included in this 
file. 

Online Manual 
Opens on-line manual for @RISK 

The Help menu Online Manual command opens this manual on-line 
in PDF format.  You must have Adobe Acrobat reader installed to 
view the online manual. 

Authorization Command 
Displays authorization information for @RISK and allows the 
authorization of trial versions 

The Help menu Authorization command displays the Authorization 
dialog box, listing the version and authorization information for your 
copy of @RISK.  Using this dialog box you can also convert a trial 
version of @RISK into an authorized copy. 
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About Command 
Displays version and copyright information about @RISK 

The Help menu About command displays the About dialog box, 
listing the version and copyright information for your copy of @RISK 
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Reference: @RISK Functions 

Introduction 
@RISK includes custom functions that can be included in Excel cells 
and formulas. These functions are used for: 

1) Defining probability distributions (@RISK distribution functions 
and distribution property functions).  

2) Defining simulation outputs (RiskOutput function) 

3) Returning simulation results to your spreadsheet (@RISK 
statistics and graphing functions) 

This reference chapter describes each of these types of @RISK 
functions and gives details about both the required and optional 
arguments for each function. 

Distribution Functions 
Probability distribution functions are used for adding uncertainty — 
in the form of probability distributions — to the cells and equations in 
your Excel worksheet.  For example, you could enter 
RiskUniform(10,20) to a cell in your worksheet.  This specifies that the 
values for the cell will be generated by a uniform distribution with a 
minimum of 10 and a maximum of 20.  This range of values replaces 
the single "fixed" value required by Excel. 

Distribution functions are used by @RISK during a simulation for 
sampling sets of possible values.  Each iteration of a simulation uses a 
new set of values sampled from each distribution function in your 
worksheet.  These values are then used in recalculating your 
worksheet and generating a new set of possible results.  

As with Excel functions, distribution functions contain two elements, 
a function name and argument values which are enclosed in 
parentheses.  A typical distribution function is: 

RiskNormal(100,10)  
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A different distribution function is used for each type of probability 
distribution.  The type of distribution which will be sampled is given 
by the name of the function.  The parameters which specify the 
distribution are given by the arguments of the function. 

The number and type of arguments required for a distribution 
function vary by function.  In some cases, such as with: 

RiskNormal(mean,standard deviation) 

a fixed number of arguments are specified each time you use the 
function.  For others, such as DISCRETE, you specify the number of 
arguments you desire, based on your situation.   For example, a 
DISCRETE function may specify two possible outcomes, or three, or 
more as needed. 

Like Excel functions, distribution functions may have arguments 
which are references to cells or expressions. For example: 

RiskTriang(B1,B2*1.5,B3) 

In this case the cell value would be specified by a triangular 
distribution with a minimum value taken from cell B1, a most likely 
value calculated by taking the value for cell B2 and multiplying it by 
1.5 and a maximum value taken from cell B3. 

Distribution functions also may be used in cell formulas, just as are 
Excel functions.  For example, a cell formula could read: 

B2:  100+RiskUniform(10,20)+(1.5*RiskNormal(A1,A2))   

All standard Excel editing commands are available to you when 
entering distribution functions.  However, you will need to have 
@RISK loaded for the distribution functions to be sampled by Excel.  
If it is not attached, Excel will return the expected value of the 
function when the worksheet is recalculated. 

To enter probability distribution functions: 

1) Examine your worksheet and identify those cells which you think 
have uncertain values 

Look for those cells where the actual values which occur could vary 
from those shown in the worksheet.  At first, identify those important 
variables whose cell values may have the largest variation in value.  
As your Risk Analysis gets more refined, you can further expand your 
use of distribution functions throughout the worksheet. 

1) Select distribution functions for the cells you have identified.  In 
Excel, use the Insert menu Function command to enter the 
selected functions into formulas. 

Entering 
Probability 
Distribution 
Functions 
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You have over thirty types of distributions to choose from when 
selecting a distribution function.  Unless you know specifically how 
uncertain values are distributed it is a good idea to start with some of 
the simpler distribution types — uniform, triangular, or normal.  As a 
starting point, if possible, specify the current cell value as the mean or 
most likely value of the distribution function.  The range of the 
function you are using then reflects the possible variation around the 
mean or most likely value. 

The simple distribution functions can be very powerful as you can 
describe uncertainty with only a few values or arguments.  For 
example: 

•  RiskUniform(Minimum, Maximum) uses only two values to 
describe the full range of the distribution and assign probabilities 
for all the values in the range. 

•  RiskTriang(Minimum, Most Likely, Maximum) uses three easily 
identifiable values to describe a complete distribution. 

As your models become more complex, you probably will want to 
choose from more complex distribution types in order to meet your 
specific modeling needs.  Use the listings in this Reference section to 
guide you in selecting and comparing distribution types.  

A graph of the distribution is often helpful in selecting and specifying 
distribution functions.  You can use @RISK Define Distribution 
window to display distribution graphs and add distribution functions 
to cell formulas.  To do this, select the cell where you wish to add a 
distribution function and click the Define Distribution icon or the 
@RISK add-in menu Model Define Distribution command.  The on-
line file displayed when the @RISK Help menu Distributions Help 
command is selected also contains graphic depictions of different 
functions at selected argument values.  For more information on the 
Define Distribution window, see the Model Menu: Define 
Distribution Command in the @RISK Add-In Menu Commands 
section in this manual. 

It often helps to first use the Define Distribution window to enter 
your distribution functions to better understand how to assign values 
to function arguments.  Then, once you better understand the syntax 
of distribution function arguments, you can enter the arguments 
yourself directly in Excel, bypassing the Define Distribution window. 

Defining 
Distributions 
Graphically 
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The @RISK Model window (Professional and Industrial versions only) 
allows you to fit probability distributions to your data.  The 
distributions which result from a fit are then available to be assigned 
as input distributions and added to your spreadsheet model. By 
setting the Source: in the Define Distribution window to Fit Results, 
you can use the fit results from any fit tab for assigning distributions 
to model inputs.  For more information on distribution fitting see the 
Fitting Menu Commands in the @RISK Model Window Commands 
section in this manual. 

Optional arguments to distribution functions can be entered using 
Distribution Property functions.  These optional arguments are used 
to name an input distribution for reporting and graphing, truncate the 
sampling of a distribution, correlate the sampling of a distribution 
with other distributions and keep a distribution from being sampled 
during a simulation.  These arguments are not required, but can be 
added as needed.  

Optional arguments specified using @RISK distribution property 
functions are embedded inside of a distribution function. Distribution 
Property functions are entered just as are standard Excel functions 
and can include cell references and mathematical expressions as 
arguments.  

For example, the following function truncates the entered normal 
distribution to a range with a minimum value of 0 and a maximum 
value of 20: 

=RiskNormal(10,5,RiskTruncate(0,20)) 

No samples will be drawn outside this minimum-maximum range. 

Many distribution functions can be entered by specifying percentile 
values for the distribution you want.  For example, you may want to 
enter a distribution that is normal in shape and has a 10th percentile of 
20 and a 90th percentile of 50.  These percentiles may be the only 
values you know about this normal distribution – the actual mean 
and standard deviation required by the traditional normal 
distribution are unknown. 

Alternate parameters may be used instead of (or in conjunction with) 
the standard arguments for the distribution.  When entering 
percentile arguments, the Alt form of the distribution function is 
used, such as RiskNormalAlt or RiskGammaAlt.   

Fitting Data to 
Distributions  

Distribution 
Property 
Functions 

Alternate 
Parameters 
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Each parameter to an alternate parameter distribution function 
requires a pair of arguments in the function.  Each pair of arguments 
specifies: 

1) The type of parameter being entered 

2) The value for the parameter.    

Each argument in a pair is entered directly in the Alt function, such as 
RiskNormalAlt(arg1type, arg1value, arg2type, arg2value).  For example:  

•  RiskNormalAlt(5%, 67.10, 95%, 132.89) - specifies a normal 
distribution with the 5th percentile at the value of 67.10 and the 
95th percentile at the value of 132.89. 

Alternate parameters may be either percentiles or standard 
distribution arguments.  If a type of parameter argument is a label in 
quotes (such as "mu"), the parameter specified is the standard 
distribution argument that has the entered name.  This allows 
percentiles to be mixed with standard distribution arguments, such 
as: 

•  RiskNormalAlt("mu", 100, 95%, 132.89) - specifies a normal 
distribution with a mean of 100 and the 95th percentile at the value 
of 132.89. 

The allowable names for the standard arguments of each distribution 
can be found in the heading for each function in this chapter, in the 
Excel Function Wizard in the @RISK Distrib (Alt Param) section, or by 
using the Define Distribution window.  Note: If you click the Alt icon 
in the Define Distribution window and select a Standard Argument 
and click OK, @RISK will write the appropriate name for the 
standard argument in quotes in the function in the formula bar of 
the Define Distribution window. 

 If a type of parameter argument is a value between 0 and 1 (or 0% to 
100%), the parameter specified is the entered percentile for the 
distribution. 

Types of 
Alternate 
Parameters 
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Some distributions will have an additional location parameter when 
they are specified using alternate parameters.  This parameter is 
typically available for distributions that do not have a location value 
specified in one of their standard arguments.  Location is equivalent 
to the minimum or 0 perc% value of the distribution.  For example, 
the Gamma distribution does not have a location value specified 
through its standard arguments and thus a location parameter is 
available.  The normal distribution , on the other hand, does have a 
location parameter in its standard arguments – the mean or mu – and 
thus does not have a spearate location parameter when it is entered 
using alternate parameters.  The purpose of this "extra" parameter is 
to allow you to specify percentiles for shifted distributions. (e.g. a 
three parameter Gamma with a location of 10 and two percentiles) 

During a simulation @RISK calculates the appropriate distribution 
whose percentile values equal those alternate parameter values 
entered and then samples that distribution.  Just like all @RISK 
functions, the entered arguments may be references to other cells or 
formulas, just as with any Excel function; and argument values may 
change iteration to iteration during a simulation.  

Alternate percentile parameters to probability distributions may be 
specified in terms of cumulative descending percentiles as well as the 
standard cumulative ascending percentiles.  Each of the Alt forms for 
probability distribution functions (such as RiskNormalAlt) has a 
corresponding AltD form (such as RiskNormalAltD).  If the AltD 
form is used, any entered percentile values are cumulative 
descending percentiles, where the percentile specifies the chance of a 
value greater or equal to the entered value. 

If you select the @RISK add-in menu Options command Display 
Cumulative Descending Percentiles option, all @RISK reports will 
show cumulative descending percentile values.  In addition, when 
you click the Alt icon in the Define Distribution window to enter 
distributions using alternate parameters, cumulative descending 
percentiles will automatically be shown and AltD forms of probability 
distribution functions will be entered. 

In addition to cumulative descending percentiles for alternate 
parameters distributions, the @RISK cumulative probability 
distribution (RiskCumul) may also be specified using cumulative 
descending percentiles.  To do this, use the function RiskCumulD. 

Location or 
"loc" 
Parameters  

Sampling 
Distributions 
with Alternate 
Parameters 

Cumulative 
Descending 
Percentiles 
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The guidelines for entering Excel functions presented in the relevant 
User’s Guide are also applicable to entering @RISK functions.  
However, some additional guidelines specific to @RISK functions are: 

•  Where integer arguments are required by a distribution function, 
any non-integer argument values will be truncated to integers. 

•  Integer arguments must be greater than or equal to -32,767 and 
less than or equal to 32,767.  Values outside this range will cause 
the function to return #VALUE in Excel. 

•  Distribution functions with varying numbers of arguments (such 
as HISTOGRM, DISCRETE, and CUMUL) require that arguments 
of the same type be entered as arrays.  Arrays in Excel are 
denoted by either enclosing the values of the array in {} brackets 
or using a reference to a contiguous range of cells — such as 
A1:C1.  If a function takes a varying number of value/probability 
pairs, the values will be one array and the probabilities another.  
The first value in the value array is matched with the first 
probability in the probability array and so on. 

Some @RISK functions have optional arguments, or arguments that 
may be used but are not required.  The RiskOutput function, for 
example, has only optional arguments.  You can use it with 0, 1 or 3 
arguments, depending on what information you wish to define about 
the output cell where the function is used.  You can: 

1) Just identify the cell as an output, letting @RISK automatically 
generate a name for you (i.e., =RiskOutput()).  

2) Give the output a name you select (i.e., =RiskOutput(“Profit 
1999”)). 

3) Give the output a name you select and identify it as part of an 
output range (i.e., =RiskOutput(“Profit 1999”,” Profit By Year”,1)).   

Any of these forms of the RiskOutput function are allowed because 
all of its arguments are optional. 

When an @RISK function has optional arguments you can add the 
optional arguments you choose and ignore the rest.  You must, 
however, include all required arguments.  For example, for the 
RiskNormal function, two arguments, mean and standard deviation, are 
required.  All of the arguments which can be added to the 
RiskNormal function via distribution property functions are optional 
and can be entered in any order you like. 

Entering 
Arguments in 
@RISK 
Functions 

Optional 
Arguments 
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In Excel, you may not list cell references or names in arrays as you 
would list constants.  For example, you could not use {A1,B1,C1} to 
represent the array containing the values in cells A1, B1, and C1.  
Instead, you must use the cell range reference A1:C1 or enter the 
values of those cells directly in the arrays as constants — for example, 
{10,20,30}. 

•  Distribution functions with fixed numbers of arguments will 
return an error value if an insufficient number of arguments is 
entered and will ignore extra arguments if too many are entered. 

•  Distribution functions will return an error value if arguments are 
of the wrong type (number, array or text). 

This section briefly describes each probability distribution function 
available and the arguments required for each.  In addition, the on-
line file displayed when the @RISK Help menu Distributions Help 
command is selected describes the technical characteristics of each 
probability distribution function.  The appendices include formulas 
for density, distribution, mean, mode, distribution parameters and 
graphs of the probability distributions generated using typical 
argument values.  

Simulation Output Functions 
Output cells are defined using RiskOutput functions.  These functions 
allow the easy copying, pasting and moving of output cells.  
RiskOutput functions are automatically added when the standard 
@RISK Add Output icon is pressed.  RiskOutput functions optionally 
allow you to name your simulation outputs and add individual 
output cells to output ranges.  A typical RiskOutput function might 
be: 

=RiskOutput(“Profit”)+NPV(.1,H1…H10) 

where the cell, prior to its selection as a simulation output, simply 
contained the formula 

= NPV(.1,H1…H10) 

The added RiskOutput function selects the cell as a simulation output 
and gives the output the name “Profit”. 

Important Note 
on Excel Arrays 

More 
Information 
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Simulation Statistics Functions 
@RISK statistics functions return a desired statistic on simulation 
results.  For example, the function RiskMean(A10) returns the mean of 
the simulated distribution for the cell A10.  These functions are 
updated real-time as a simulation is running. 

@RISK statistics functions include all standard statistics plus 
percentiles, targets (for example, =RiskPercentile(A10,.99) returns the 
99th percentile of the simulated distribution).  @RISK statistics 
functions can be used the way you would use any standard Excel 
function. 

Statistics functions may also reference a simulation output or input by 
name.  This allows them to be included in templates which are used to 
generate pre-formatted reports in Excel on simulation results.  For 
example, the function =RiskMean(”Profit”) would return the mean of 
the simulated distribution for the output cell named Profit defined in 
a model. 

Note: A cell reference entered in a statistics function does not have to 
be a simulation output identified with a RiskOutput function. 

Graphing Function 
A special @RISK function RiskResultsGraph will automatically place a 
graph of simulation results wherever it is used in a spreadsheet.  For 
example, =RiskResultsGraph(A10) would place a graph of the 
simulated distribution for A10 directly in your spreadsheet at the 
function's location at the end of a simulation.  Additional optional 
arguments to RiskResultsGraph allow you to select the type of graph 
you want to create, its format, scaling and other options. 

Supplemental Functions 
Two additional functions — CurrentIter and CurrentSim — are 
provided for use in the development of macro-based applications 
using @RISK.  These functions return the current iteration and current 
simulation, respectively, of an executing simulation. 

Statistics in 
Report 
Templates 
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Limiting Workbooks and Worksheets Searched 
for @RISK Functions 
It is necessary for @RISK to scan open workbooks for its functions 
both prior to simulating and when the @RISK Model window 
Outputs and Inputs list is generated.  This is very quick for most 
models but can become time-consuming for larger multi-workbook 
models.  By defining Excel ranges with the name RiskSearchRange 
you can limit the regions of open workbooks which are searched for 
@RISK functions, speeding up the start of simulations and the display 
of lists. 

RiskSearchRange ranges can be added as either workbook or 
worksheet level names.  Adding RiskSearchRange as an Excel range 
name has the following effects: 

•  If a single RiskSearchRange range name is added as a workbook 
level name, only that single range in the workbook will be 
searched for @RISK functions . 

•  If RiskSearchRange range name(s) are added as worksheet level 
names (i.e. Sheet1!RiskSearchRange) in a single workbook, each 
worksheet-level RiskSearchRange range in the workbook will be 
searched for @RISK functions. 

•  If no RiskSearchRange range name is found in a workbook, the 
entire contents of the workbook will be searched for @RISK 
functions.  This is the default setting for @RISK’s function search. 

Note: There can be one RiskSearchRange name per sheet in a 
workbook when worksheet level names are used.  For more on the 
difference between workbook and worksheet-level range names, see 
your Excel documentation. 

To add a RiskSearchRange: 

1) Click the Excel Insert menu Name Define command 

2) Enter the name RiskSearchRange and the reference to the range 
you want @RISK to search.  If you want to make your 
RiskSearchRange name a worksheet level name, simply enter the 
sheet name prior to the name RiskSearchRange, such as 
Sheet1!RiskSearchRange. 

Note: @RISK functions located outside any entered RiskSearchRange 
will calculate; however, no sampling or correlation settings will be 
applied to them and they will not be displayed in @RISK Model or 
Results window lists. 

Adding a 
RiskSearchRange 
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Table of Available Functions 
This table lists the custom functions that are added to Excel by @RISK.   

Distribution Function Returns 
RiskBeta(alpha1,alpha2) beta distribution with shape parameters 

alpha1 and alpha2 

RiskBetaGeneral( alpha1, 
alpha2,minimum, maximum) 

beta distribution with defined minimum, 
maximum and shape parameters alpha1 and 
alpha2 

RiskBetaGeneralAlt(arg1type, 
arg1value, arg2type,arg2value, 
arg3type,arg3value, 
arg4type,arg4value) 

beta distribution with four parameters 
named arg1type to arg4type which can be 
either a percentile between 0 and 1 or 
“alpha1”, “alpha2”, “min” or “max” 

RiskBetaSubj(minimum, most 
likely, mean, maximum) 

beta distribution with defined minimum, 
maximum, most likely and mean 

RiskBinomial(n,p) binomial distribution with n draws and p 
probability of success on each draw 

RiskChiSq(v) Chi-Square distribution with v degrees of 
freedom 

RiskCumul(minimum,maximum, 
{X1,X2,...,Xn},{p1,p2,...,pn}) 
 

cumulative distribution with n points 
between minimum and maximum with 
cumulative ascending probability p at each 
point 

RiskCumulD(minimum,maximu
m, {X1,X2,...,Xn},{p1,p2,...,pn}) 
 

cumulative distribution with n points 
between minimum and maximum with 
cumulative descending probability p at each 
point 

RiskDiscrete({X1,X2,...,Xn}, 
{p1,p2,...,pn})  

discrete distribution with n possible 
outcomes with the value X and probability 
weight p for each outcome 

RiskDuniform({X1,X2,...Xn}) 
 

discrete uniform distribution with n 
outcomes valued at X1 through Xn 

RiskErf(h) error function distribution with variance 
parameter h 

RiskErlang(m,beta) m-erlang distribution with integral shape 
parameter m and scale parameter beta 

RiskExpon(beta) exponential distribution with decay 
constant beta 
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Distribution Function Returns 
RiskExponAlt(arg1type, 
arg1value, arg2type,arg2value) 

exponential distribution with two 
parameters named arg1type and arg2type 
which can be either a percentile between 0 
and 1 or “beta”or "loc" 

RiskExtvalue(a,b) extreme value (or Gumbel) distribution 
with location parameter a and scale 
parameter b 

RiskExtvalueAlt(arg1type, 
arg1value, arg2type,arg2value) 

extreme value (or Gumbel) distribution 
with two parameters named arg1type and 
arg2type which can be either a percentile 
between 0 and 1 or “alpha” or “beta” 

RiskGamma(alpha,beta) gamma distribution with shape parameter 
alpha and scale parameter beta 

RiskGammaAlt(arg1type, 
arg1value, arg2type,arg2value, 
arg3type,arg3value) 

gamma distribution with three parameters 
named arg1type, arg2type and arg3type 
which can be either a percentile between 0 
and 1 or “alpha”, “beta”or "loc" 

RiskGeneral(minimum,maximum
, {X1,X2,...,Xn},{p1,p2,...,pn}) 
 

general density function for a probability 
distribution ranging between minimum and 
maximum with n (x,p) pairs with value X 
and probability weight p for each point 

RiskGeometric(p) geometric distribution with probability p 

RiskHistogrm(minimum,maxi-
mum,{p1,p2,...,pn})  

histogram distribution with n classes 
between minimum and maximum with 
probability weight p for each class 

RiskHypergeo(n,D,M) hypergeometric distribution with sample 
size n, D number of items and M population 
size 

RiskIntUniform(minimum,maxi
mum) 

uniform distribution which returns integer 
values only between minimum and 
maximum 

RiskInvGauss(mu,lambda) inverse gaussian (or Wald) distribution 
with mean mu and shape parameter lambda 

RiskInvGaussAlt(arg1type, 
arg1value, arg2type,arg2value, 
arg3type,arg3value) 

inverse gaussian (or Wald) distribution 
with three parameters named arg1type, 
arg2type and arg3type which can be either a 
percentile between 0 and 1 or “mu”, 
“lambda”or "loc" 

RiskLogistic(alpha,beta) logistic distribution with location parameter 
alpha and scale parameter beta 
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Distribution Function Returns 
RiskLogisticAlt(arg1type, 
arg1value, arg2type,arg2value) 

logistic distribution with two parameters 
named arg1type and arg2type which can be 
either a percentile between 0 and 1 or “alpha” 
or “beta” 

RiskLoglogistic(gamma,beta, 
alpha) 

log-logistic distribution with location 
parameter gamma, scale parameter beta and 
shape parameter alpha 

RiskLoglogisticAlt(arg1type, 
arg1value, arg2type,arg2value, 
arg3type,arg3value) 

log-logistic distribution with three 
parameters named arg1type, arg2type and 
arg3type which can be either a percentile 
between 0 and 1 or “gamma”, “beta” or 
“alpha” 

RiskLognorm(mean,standard 
deviation) 

lognormal distribution with specified mean 
and standard deviation 

RiskLognormAlt(arg1type, 
arg1value, arg2type,arg2value, 
arg3type,arg3value) 

lognormal distribution with three 
parameters named arg1type, arg2type and 
arg3type which can be either a percentile 
between 0 and 1 or “mu”, “sigma”or "loc" 

RiskLognorm2(mean,standard 
deviation) 

lognormal distribution generated from the 
"log" of a normal distribution with specified 
mean and standard deviation 

RiskNegbin(s,p) negative binomial distribution with s 
successes and p probability of success on 
each trial 

RiskNormal(mean,standard 
deviation) 

normal distribution with given mean and 
standard deviation 

RiskNormalAlt(arg1type, 
arg1value, arg2type,arg2value) 

normal distribution with two parameters 
named arg1type and arg2type which can be 
either a percentile between 0 and 1 or “mu” 
or “sigma” 
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Distribution Function Returns 
RiskPareto(theta,a) pareto distribution 

RiskParetoAlt(arg1type, 
arg1value, arg2type,arg2value) 

pareto distribution with two parameters 
named arg1type and arg2type which can be 
either a percentile between 0 and 1 or “theta” 
or “alpha” 

RiskPareto2(b,q) pareto distribution 

RiskPareto2Alt(arg1type, 
arg1value, arg2type,arg2value) 

pareto distribution with two parameters 
named arg1type and arg2type which can be 
either a percentile between 0 and 1 or “b” or 
“q” 

RiskPearson5(alpha,beta) pearson type V (or inverse gamma) 
distribution with shape parameter alpha and 
scale parameter beta 

RiskPearson5Alt(arg1type, 
arg1value, arg2type,arg2value, 
arg3type,arg3value) 

pearson type V (or inverse gamma) 
distribution with three parameters named 
arg1type, arg2type and arg3type which can be 
either a percentile between 0 and 1 or 
“alpha”, “beta”or "loc" 

RiskPearson6(beta,alpha1, 
alpha2) 

pearson type VI distribution with scale 
parameter beta and shape parameters alpha1 
and alpha2 

RiskPert(minimum,most likely, 
maximum) 

pert distribution with specified minimum, 
most likely and maximum values 

RiskPertAlt(arg1type, arg1value, 
arg2type,arg2value, 
arg3type,arg3value) 

pert distribution with three parameters 
named arg1type, arg2type and arg3type 
which can be either a percentile between 0 
and 1 or “min”, “max” or “m. likely” 

RiskPoisson(lambda) poisson distribution 

RiskRayleigh(b) rayleigh distribution with scale parameter b 

RiskRayleighAlt(arg1type, 
arg1value, arg2type,arg2value) 

rayleigh distribution with two parameters 
named arg1type and arg2type which can be 
either a percentile between 0 and 1 or “beta” 
or "loc" 

RiskSimtable({X1,X2,...Xn})  
 

lists values to be used in each of a series of 
simulations 

RiskStudent(nu) student's t distribution with nu degrees of 
freedom 

RiskTriang(minimum,most likely, 
maximum) 

triangular distribution with defined 
minimum, most likely and maximum values 
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Distribution Function Returns 
RiskTriangAlt(arg1type, 
arg1value, arg2type,arg2value, 
arg3type,arg3value) 

triangular distribution with three 
parameters named arg1type, arg2type and 
arg3type which can be either a percentile 
between 0 and 1 or “min”, “max” or “m. 
likely” 

RiskTrigen(bottom,most 
likely,top, bottom perc.,top perc.) 

triangular distribution with three points 
representing value at bottom percentile, most 
likely value and value at top percentile. 

RiskUniform(minimum, 
maximum) 

uniform distribution between minimum and 
maximum 

RiskUniformAlt(arg1type, 
arg1value, arg2type,arg2value) 

uniform distribution with two parameters 
named arg#type which can be either a 
percentile between 0 and 1 or “min” or “max” 

RiskWeibull(alpha,beta) weibull distribution with shape parameter 
alpha and scale parameter beta 

RiskWeibullAlt(arg1type, 
arg1value, arg2type,arg2value, 
arg3type,arg3value) 

weibull distribution with three parameters 
named arg1type, arg2type and arg3type  
which can be either a percentile between 0 
and 1 or “alpha”, “beta”or "loc" 
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Distribution Property 
Function 

Specifies 

RiskCollect() Causes samples to be collected during a 
simulation for the distribution in which the 
Collect function is included (when 
simulation settings specify Collect Samples 
for Distributions Marked with Collect only) 

RiskCorrmat(matrix cell range, 
position,instance) 

Identifies a matrix of rank correlation 
coefficients and a position in the matrix for 
the distribution in which the Corrmat 
function is included.  Instance specifies the 
instance of the matrix at matrix cell range 
that will be used for correlating this 
distribution. 

RiskDepC("ID",coefficient) Identifies dependent variable in correlated 
sampling pair with rank correlation 
coefficient and "ID" identifier string 

RiskFit(ProjID,FitID,"selected fit 
result") 

Links a data set identified by ProjID and 
FitID and its fit results to the input 
distribution so the input can be updated 
when data changes 

RiskIndepC("ID") Identifies independent distribution in rank 
correlated sampling pair — "ID" is 
identifier string 

RiskLock() Blocks sampling of the distribution in 
which the Lock function is included 

RiskName(“input name”) Input name for the distribution in which the 
Name function is included 

RiskShift(shift) Shifts the domain of the distribution in 
which the Shift function is included by shift 
value 

RiskTruncate(minimum, 
maximum) 

Minimum-maximum range allowable for 
samples drawn for the distribution in which 
the Truncate function is included  

Output Function Specifies 
RiskOutput(“name”,”output 
range name”, position in range) 

Simulation output cell with name, output 
range name to which the output belongs, and 
the position in range (Note: all arguments to 
this function are optional) 
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Statistics Function Returns 
RiskData(cellref or output/input 
name, iteration#,Sim#) 

Data value of the simulated distribution for 
the entered cellref or output/input name in 
iteration# and Sim# 

RiskKurtosis(cellref or 
output/input name, Sim#) 

Kurtosis of the simulated distribution for 
the entered cellref or output/input name in 
Sim# 

RiskMax(cellref or output/input 
name, Sim#) 

Maximum value of the simulated 
distribution for cellref or output/input name 
in Sim# 

RiskMean(cellref or output/input 
name, Sim#) 

Mean of the simulated distribution for 
cellref or output/input name in Sim# 

RiskMin(cellref or output/input 
name, Sim#) 

Minimum value of the simulated 
distribution for cellref or output/input name 
in Sim# 

RiskMode(cellref or output/input 
name, Sim#) 

Mode of the simulated distribution for 
cellref or output/input name in Sim# 

RiskPercentile(cellref or 
output/input name, perc%, Sim#) 

Percentile perc% of the simulated 
distribution for cellref or output/input name 
in Sim# 

RiskPercentileD(cellref or 
output/input name, perc%, Sim#) 

Percentile perc% of the simulated 
distribution for cellref or output/input name 
in Sim# (perc% is a cumulative descending 
percentile) 

RiskRange(cellref or output/input 
name, Sim#) 
 

Range of the simulated distribution for 
cellref or output/input name in Sim# 

RiskSkewness(cellref or 
output/input name, Sim#) 

Skewness of the simulated distribution for 
cellref or output/input name in Sim# 

RiskStdDev(cellref or 
output/input name, Sim#) 

Standard deviation of the simulated 
distribution for cellref or output/input name 
in Sim# 

RiskTarget(cellref or output/input 
name, target value, Sim#) 

Ascending cumulative probability of target 
value in the simulated distribution for cellref 
or output/input name in Sim# 

RiskTargetD(cellref or 
output/input name, target value, 
Sim#) 

Descending cumulative probability of target 
value in the simulated distribution for cellref 
or output/input name in Sim# 

RiskVariance(cellref or 
output/input name, Sim#) 

Variance of the simulated distribution for 
cellref or output/input name in Sim# 
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Supplemental 
Function 

Returns 

RiskCurrentIter() returns the current iteration of the 
simulation 

RiskCurrentSim() returns the current simulation number 

Graphing Function Returns 
RiskResultsGraph(cellRef or 
output/input name 
,graphType,xlFormat, leftdelimiter, 
rightdelimiter,xMin,xMax,xScale, 
Sim#) 

Graph of the simulated distribution for the 
entered cellref or output/input name in Sim#, 
displayed using graphType in metafile or 
xlFormat, with leftdelimiter, rightdelimiter 
locations for delimiters 
andxMin,xMax,xScale settings for X-axis. 



Reference: @RISK Functions 399 

Reference: Distribution Functions 
Distribution functions are listed here with their required arguments.  
Optional arguments may be added to these required arguments using 
the @RISK Distribution Property functions listed in the next section. 

RiskBeta 
Description 
 

RiskBeta(alpha1,alpha2) specifies a beta distribution using the shape 
parameters alpha1 and alpha2.  These two arguments generate a beta 
distribution with a minimum value of 0 and a maximum value of 1.   
 

Examples 
 

RiskBeta(1,2) specifies a beta distribution using the shape parameters 1 and 
2. 
RiskBeta(C12,C13) specifies a beta distribution using the shape parameter 
alpha1 taken from cell C12 and a shape parameter alpha2 taken from cell C13. 

Guidelines  Both alpha1 and alpha2 must be greater than zero. 

 

RiskBetaGeneral 
Description 
 

RiskBetaGeneral(alpha1,alpha2,minimum,maximum) specifies a beta 
distribution with the defined minimum and maximum using the shape 
parameters alpha1 and alpha2.   
 

Examples 
 

RiskBetaGeneral(1,2,0,100) specifies a beta distribution using the shape 
parameters 1 and 2 and a minimum value of 0 and a maximum value of 100. 
RiskBetaGeneral(C12,C13,D12,D13) specifies a beta distribution using the 
shape parameter alpha1 taken from cell C12 and a shape parameter alpha2 
taken from cell C13 and a minimum value from D12 and a maximum value of 
from D13. 

Guidelines  Both alpha1 and alpha2 must be greater than zero. 
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RiskBetaGeneralAlt 
Description 
 

RiskBetaGeneralAlt(arg1type, arg1value, arg2type,arg2value, 
arg3type,arg3value, arg4type,arg4value) specifies a beta distribution with four 
arguments of the type arg1type to arg4type.  These arguments can be either a 
percentile between 0 and 1 or “alpha1”, “alpha2”, “min” or “max”. 
 

Examples 
 

RiskBetaGeneralAlt("min",0,10%,1,50%,20,"max",50) specifies a beta 
distribution with a minimum value of 0 and a maximum value of 50, a 10th 
percentile of 1 and a 50th percentile of 20. 

Guidelines  Both “alpha1” and “alpha2” must be greater than zero and “max” > “min”. 

 

RiskBetaSubj 
Description 
 

RiskBetaSubj(minimum, most likely, mean, maximum) specifies a beta 
distribution with a minimum and maximum value as specified.  The shape 
parameters are calculated from the defined most likely value and mean. 
 

Examples 
 

RiskBetaSubj(0,1,2,10) specifies a beta distribution with a minimum of 0, a 
maximum of 10, a most likely value of 1 and a mean of 2. 
RiskBetaSubj(A1,A2,A3,A4) specifies a beta distribution with a minimum 
value taken from cell A1, a maximum value taken from cell A4, a most likely 
value taken from cell A2 and a mean value taken from cell A3. 
 

Guidelines  Minimum must be less than maximum. 
Most likely must be greater than minimum and less than maximum. 
Mean must be greater than minimum and less than maximum. 
Most likely must be greater than minimum and less than maximum. 
Mean must be greater than minimum and less than maximum. 
If mean is less than (maximum + minimum) / 2 then most likely must be less 
than mean. 
If mean is greater than (maximum + minimum) / 2 then most likely must be 
greater than mean. 
If most likely equals (maximum + minimum) / 2 then mean must equal most 
likely. 
 

 



Reference: @RISK Functions 401 

RiskBinomial 
Description 
 

RiskBinomial(n, p) specifies a binomial distribution with n number of trials and 
p probability of success on each trial. The number of trials is often referred to 
as the number of draws or samples made.  The binomial distribution is a 
discrete distribution returning only integer values greater than or equal to zero. 
 

Examples 
 

RiskBinomial(5,.25) specifies a binomial distribution generated from 5 trials or 
"draws" with a 25% probability of success on each draw. 
RiskBinomial(C10*3,B10) specifies a binomial distribution generated from the 
trials or "draws" given by the value in cell C10 times 3.  The probability of 
success on each draw is given in cell B10. 
 

Guidelines  The number of trials n must be a positive integer greater than zero and less 
than or equal to 32,767. 
Probability p must be greater than or equal to zero and less than or equal to 1. 
 

RiskChiSq 
Description 
 

RiskChiSq(v) specifies a Chi-Square distribution with v degrees of freedom.   
 

Examples 
 

RiskChisq(5) generates a Chi-Square distribution with 5 degrees of freedom. 
RiskChisq(A7) generates a Chi-Square distribution with the degrees of 
freedom parameter taken from cell A7. 
 

Guidelines  Number of degrees of freedom v must be a positive integer. 
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RiskCumul 
Description 
 

RiskCumul(minimum,maximum,{X1,X2,..,Xn},{p1,p2,..,pn}) specifies a 
cumulative distribution with n points.  The range of the cumulative curve is set 
by the minimum and maximum arguments.  Each point on the cumulative curve 
has a value X and a probability p.  Points on the cumulative curve are specified 
with increasing value and increasing probability.  Any number of points may be 
specified for the curve.  
 

Examples 
 

RiskCumul(0,10,{1,5,9},{.1,.7,.9}) specifies a cumulative curve with 3 data 
points and a range of 0 to 10.  The first point on the curve is 1 with a cumulative 
probability of .1 (10% of the distribution values are less than or equal to 1, 90% 
are greater).  The second point on the curve is 5 with a cumulative probability 
.7 (70% of the distribution values are less than or equal to 5, 30% are greater).  
The third point on the curve is 9 with a cumulative probability of .9 (90% of the 
distribution values are less than or equal to 9, 10% are greater). 
RiskCumul(100,200,A1:C1,A2:C2) specifies a cumulative distribution with 3 
data points and a range of 100 to 200.  Row 1 of the worksheet — A1 through 
C1 — holds the values of each data point while row 2 — A2 through C2 — 
holds the cumulative probability at each of the 3 points in the distribution.  In 
Excel braces are not required when cell ranges are used as entries to the 
function. 
 

Guidelines  The points on the curve must be specified in order of increasing value 
(X1<X2<X3,...,<Xn). 
The cumulative probabilities p for points on the curve must be specified in order 
of increasing probability (p1<=p2<=p3,...,<=pn). 
The cumulative probabilities p for points on the curve must be greater than or 
equal to 0 and less than or equal to 1. 
Minimum must be less than maximum.  Minimum must be less than X1 and 
Maximum must be greater than Xn. 
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RiskCumulD 
Description 
 

RiskCumulD(minimum,maximum,{X1,X2,..,Xn},{p1,p2,..,pn}) specifies a 
cumulative distribution with n points.  The range of the cumulative curve is set 
by the minimum and maximum arguments.  Each point on the cumulative curve 
has a value X and a probability p.  Points on the cumulative curve are specified 
with increasing value and decreasing probability.  Probabilitites entered are 
cumulative descending probabilities, or the probability of a value greater than 
the entered X value.  Any number of points may be specified for the curve.  
 

Examples 
 

RiskCumulD(0,10,{1,5,9},{.9,.3,.1}) specifies a cumulative curve with 3 data 
points and a range of 0 to 10.  The first point on the curve is 1 with a cumulative 
descending probability of .9 (10% of the distribution values are less than or 
equal to 1, 90% are greater).  The second point on the curve is 5 with a 
cumulative descending probability .3 (70% of the distribution values are less 
than or equal to 5, 30% are greater).  The third point on the curve is 9 with a 
cumulative descending probability of .1 (90% of the distribution values are less 
than or equal to 9, 10% are greater). 
RiskCumulD(100,200,A1:C1,A2:C2) specifies a cumulative distribution with 3 
data points and a range of 100 to 200.  Row 1 of the worksheet — A1 through 
C1 — holds the values of each data point while row 2 — A2 through C2 — 
holds the cumulative probability at each of the 3 points in the distribution.  In 
Excel braces are not required when cell ranges are used as entries to the 
function. 
 

Guidelines  The points on the curve must be specified in order of increasing value 
(X1<X2<X3,...,<Xn). 
The cumulative probabilities p for points on the curve must be specified in order 
of decreasin cumulative descending probabilities (p1>=p2>=p3,...,>=pn). 
The cumulative descending probabilities p for points on the curve must be 
greater than or equal to 0 and less than or equal to 1. 
Minimum must be less than maximum.  Minimum must be less than X1 and 
Maximum must be greater than Xn. 
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RiskDiscrete 
Description 
 

RiskDiscrete({X1,X2,...,Xn},{p1,p2,...,pn}) specifies a discrete distribution with 
a number of outcomes equaling n.  Any number of outcomes may be entered.  
Each outcome has a value X and a weight p which specifies the outcome's 
probability of occurrence.  As with the RiskHistogrm function, weights may sum 
to any value — they are normalized to probabilities by @RISK. 
 

Examples 
 

RiskDiscrete({0,.5},{1,1}) specifies a discrete distribution with 2 outcomes 
valued 0 and .5.   Each outcome has an equal probability of occurrence as the 
weight for each is 1.  The probability of 0 occurring is 50% (1/2) and the 
probability of .5 occurring is 50% (1/2). 
RiskDiscrete(A1:C1,A2:C2) specifies a discrete distribution with three 
outcomes.  The first row of the worksheet — A1 through C1 — holds the values 
of each outcome while row 2 — A2 through C2 — holds the probability "weight" 
of each occurring.   
 

Guidelines  Weight values p must be greater than or equal to zero, and the sum of all 
weights must be greater than zero.   
 

RiskDUniform 
Description 
 

RiskDuniform({X1,X2,...,Xn}) specifies a discrete uniform distribution with n 
possible outcomes with an equal probability of each outcome occurring.  The 
value for each possible outcome is given by the X value entered for the 
outcome.  Each value is equally likely to occur.  To generate a discrete uniform 
distribution where every integer in a range is a possible outcome, use the 
RiskIntUniform function. 
 

Examples 
 

RiskDuniform({1,2.1,4.45,99}) specifies a discrete uniform distribution with 4 
possible outcomes.  The possible outcomes have the values 1, 2.1, 4.45 and 
99. 
RiskDuniform(A1:A5) specifies a discrete uniform distribution with 5 possible 
outcomes.  The possible outcomes have the values taken from cells A1 through 
A5. 

Guidelines  None. 
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RiskErf 
Description 
 

RiskErf(h) specifies an error function with a variance parameter h.  The error 
function distribution is derived from a normal distribution. 
 

Examples 
 

RiskErf(5) generates an error function with a variance parameter 5. 
RiskErf(A7) generates an error function with a variance parameter taken from 
cell A7. 

Guidelines  Variance parameter h must be greater than 0. 

RiskErlang 
Description 
 

RiskErlang(m,beta) generates an m-erlang distribution with the specified m and 
beta values.  m is an integer argument for a gamma distribution and beta is a 
scale parameter. 
 

Examples 
 

RiskErlang(5,10) specifies an m-erlang distribution with an m value of 5 and a 
scale parameter of 10. 
RiskErlang(A1,A2/6.76) specifies an m-erlang distribution with an m value 
taken from cell A1 and a scale parameter equaling the value in cell A2 divided 
by 6.76. 

Guidelines  m must be a positive integer.  
beta must be greater than zero. 

RiskExpon 
Description 
 

RiskExpon(beta) specifies an exponential distribution with the entered beta 
value.  The mean of the distribution equals beta. 
 

Examples 
 

RiskExpon(5) specifies an exponential distribution with a beta value of 5. 
RiskExpon(A1) specifies an exponential distribution with a beta value taken 
from cell A1. 

Guidelines  Beta must be greater than zero. 
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RiskExponAlt 
Description 
 

RiskExponAlt(arg1type, arg1value, arg2type,arg2value) specifies an 
exponential distribution with two arguments of the type arg1type and arg2type.  
arg1type and arg2type can be either a percentile between 0 and 1 or “beta” or 
"loc". 
 

Examples 
 

RiskExponAlt("beta",1,95%,10) specifies an exponential distribution with a 
beta value of 1 and a 95% percentile of 10. 

Guidelines  "beta" must be greater than zero. 

 

RiskExtValue 
Description 
 

RiskExtValue(a,b) specifies an extreme value distribution with location 
parameter a and shape parameter b. 
 

Examples 
 

RiskExtvalue(1,2) specifies an extreme value distribution with an a value of 1 
and a b value of 2. 
RiskExtvalue(A1,B1) specifies an extreme value distribution with an a value 
taken from cell A1 and a b value of taken from cell B1. 

Guidelines  b must be greater than zero. 

 

RiskExtValueAlt 
Description 
 

RiskExtValueAlt(arg1type, arg1value, arg2type,arg2value) specifies an 
extreme value distribution with with two arguments of the type arg1type and 
arg2type.  These arguments can be either a percentile between 0 and 1 or 
“alpha” or  “beta”. 
 

Examples 
 

RiskExtvalueAlt(5%,10,95%,100) specifies an extreme value distribution with 
a 5th percentile of 10 and a 95th percentile of 100. 

Guidelines  “beta” must be greater than zero. 
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RiskGamma 
Description 
 

RiskGamma(alpha,beta) specifies a gamma distribution using the shape 
parameter alpha and the scale parameter beta.   
 

Examples 
 

RiskGamma(1,1) specifies a gamma distribution where the shape parameter 
has a value of 1 and the scale parameter has a value of 1. 
RiskGamma(C12,C13) specifies a gamma distribution where the shape 
parameter has a value taken from cell C12 and the scale parameter has a 
value taken from cell C13. 

Guidelines  Both alpha and beta must be greater than zero. 

 

RiskGammaAlt 
Description 
 

RiskGammaAlt(arg1type, arg1value, arg2type,arg2value, arg3type,arg3value) 
specifies a gamma distribution with three arguments of the type arg1type to 
arg3type.  These arguments can be either a percentile between 0 and 1 or 
“alpha”, “beta” or "loc". 
 

Examples 
 

RiskGammaAlt("alpha",1,"beta",5,95%,10) specifies a gamma distribution 
where the shape parameter has a value of 1, the scale parameter has a value 
of 5 and the 95th percentile has a value of 10. 

Guidelines  Both alpha and beta must be greater than zero. 
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RiskGeneral 
Description 
 

RiskGeneral(minimum,maximum,{X1,X2,...,Xn},{p1,p2,...,pn}) generates a 
generalized probability distribution based on a density curve created using the 
specified (X,p) pairs.  Each pair has a value X and a probability weight p which 
specifies the relative height of the probability curve at that X value.  The 
weights p are normalized by @RISK in determining the actual probabilities 
used in sampling. 
 

Examples 
 

RiskGeneral(0,10,{2,5,7,9},{1,2,3,1}) specifies a general probability 
distribution density function with four points.  The distribution ranges from 0 to 
10 with four points — 2,5,7,9 — specified on the curve.  The height of the curve 
at 2 is 1, at 5 is 2, at 7 is 3 and at 9 is 1.  The curve intersects the X-axis at 0 
and 10. 
RiskGeneral(100,200,A1:C1,A2:C2) specifies a general probability distribution 
with three data points and a range of 100 to 200.  The first row of the worksheet 
— A1 through C1 — holds the X value of each data point while row 2 — A2 
through C2 — holds the p value at each of the three points in the distribution.  
Note that braces are not required when cell ranges are used as array entries to 
the function.   

Guidelines  Probability weights p must be greater than or equal to zero.  The sum of all 
weights must be greater than zero. 
X values must be entered in increasing order and must fall within the minimum-
maximum range of the distribution. 
Minimum value must be less than maximum. 
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RiskGeomet 
Description 
 

RiskGeomet(p) generates a geometric distribution with the probability p.  The 
value returned represents the number of failures prior to a success on a series 
of independent trials.  There is a p probability of success on each trial.  The 
geometric distribution is a discrete distribution returning only integer values 
greater than or equal to zero. 
 

Examples 
 

RiskGeomet(.25) specifies a geometric distribution with a 25% probability of 
success on each trial. 
RiskGeomet(A18) specifies a geometric distribution with a probability of 
success on each trial taken from cell A18. 

Guidelines  Probability p must be greater than zero and less than or equal to one. 
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RiskHistogrm 
Description 
 

RiskHistogrm(minimum,maximum,{p1,p2,...,pn}) specifies a user-defined 
histogram distribution with a range defined by the specified minimum and 
maximum values.  This range is divided into n classes.  Each class has a 
weight p reflecting the probability of occurrence of a value within the class.  
These weights may be any values — the only important factor is the weight of 
one class relative to the others.  This means that the sum of all the weights 
need not equal 100%.  @RISK normalizes the class probabilities for you.  
Normalizing is done by summing all specified weights and dividing each weight 
by this sum. 
 

Examples 
 

RiskHistogrm(10,20,{1,2,3,2,1}) specifies a histogram with a minimum value 
of 10 and a maximum value of 20.  This range is divided into 5 equal length 
classes as there are 5 probability values.  The probability weights for the five 
classes are the arguments 1, 2, 3, 2 and 1.  The actual probabilities which 
would correspond with these weights are 11.1% (1/9), 22.2% (2/9), 33.3% 
(3/9), 22.2% (2/9) and 11.1% (1/9).  Division by 9 normalizes these values so 
that their sum now equals 100%. 
RiskHistogrm(A1,A2,B1:B3) specifies a histogram with a minimum value 
taken from cell A1 and a maximum value taken from cell A2.  This range is 
divided into 3 equal length classes as there are 3 probability values.  The 
probability weights are taken from cells B1 through B3. 

Guidelines  Weight values p must be greater than or equal to zero, and the sum of all 
weights must be greater than zero.   
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RiskHypergeo 
Description 
 

RiskHypergeo(n,D,M) specifies a hypergeometric distribution with sample size 
n, number of items of a certain type equaling D and population size M.  The 
hypergeometric distribution is a discrete distribution returning only non-negative 
integer values. 
 

Examples 
 

RiskHypergeo(50,10,1000) returns a hypergeometric distribution generated 
using a sample size of 50, 10 items of the relevant type and a population size 
of 1000. 
RiskHypergeo(A6,A7,A8) returns a hypergeometric distribution generated 
using a sample size taken from cell A6, a number of items taken from cell A7 
and a population size taken from cell A8. 

Guidelines  All arguments — n, D and M — must be positive integer values. 
The value for sample size n must be less than or equal to the population size 
M. 
The value for number of items D must be less than or equal to the population 
size M. 

 

RiskIntUniform 
Description 
 

RiskIntUniform(minimum,maximum) specifies a uniform probability distribution 
with the entered minimum and maximum values.  Only integer values across 
the range of the uniform distribution can occur and each has an equal likelihood 
of occurrence.  

 
Examples 
 

RiskIntUniform(10,20) specifies a uniform distribution with a minimum value of 
10 and a maximum value of 20. 
RiskIntUniform(A1+90,B1) specifies a uniform distribution with a minimum 
value equaling the value in cell A1 plus 90 and a maximum value taken from 
cell B1. 

Guidelines  The minimum value entered must be less than the maximum value. 
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RiskInvgauss 
Description 
 

RiskInvgauss(mu,lambda) specifies an inverse gaussian distribution with 
mean mu and shape parameter lambda. 
 

Examples 
 

RiskInvgauss(5,2) returns an inverse gaussian distribution with a mu value of 
5 and a lambda value of 2. 
RiskInvgauss(B5,B6) returns an inverse gaussian distribution with a mu value 
taken from cell B5 and a lambda value taken from cell B6. 

Guidelines  mu must be greater than zero. 
lambda must be greater than zero. 

 

RiskInvgaussAlt 
Description 
 

RiskInvgaussAlt(arg1type, arg1value, arg2type,arg2value, 
arg3type,arg3value) specifies an inverse gaussian distribution with three 
arguments of the type arg1type to arg3type.  These arguments can be either a 
percentile between 0 and 1 or “mu” , “lambda” or "loc". 
 

Examples 
 

RiskInvgaussAlt("mu",10,5%,1,95%,25) returns an inverse gaussian 
distribution with a mu value of 1, a 5th percentile of 1 and a 95th percentile of 25. 

Guidelines  mu must be greater than zero. 
lambda must be greater than zero. 

 

RiskLogistic 
Description 
 

RiskLogistic(alpha,beta) specifies a logistic distribution with the entered alpha 
and beta values. 
 

Examples 
 

RiskLogistic(10,20) returns a logistic distribution generated using an alpha 
value of 10 and a beta value of 20. 
RiskLogistic(A6,A7) returns a logistic distribution generated using an alpha 
value taken from cell A6 and a beta value taken from cell A7. 

Guidelines  Beta must be a positive value. 
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RiskLogisticAlt 
Description 
 

RiskLogisticAlt(arg1type, arg1value, arg2type,arg2value) specifies a logistic 
distribution with two arguments of the type arg1type and arg2type.  These 
arguments can be either a percentile between 0 and 1 or “alpha” or “beta”. 
 

Examples 
 

RiskLogisticAlt(5%,1,95%,100) returns a logistic distribution with a 5th 
percentile of 1 and a 95th percentile of 100. 

Guidelines  “Beta” must be a positive value. 

  

RiskLogLogistic 
Description 
 

RiskLoglogistic(gamma,beta,alpha) specifies a log-logistic distribution with 
location parameter gamma and shape parameter alpha and scale parameter 
beta. 
 

Examples 
 

RiskLoglogistic(-5,2,3) returns a log-logistic distribution generated using a 
gamma value of -5, a beta value of 2, and an alpha value of 3. 
RiskLoglogistic(A1,A2,A3) returns a log-logistic distribution generated using a 
gamma value taken from cell A1, a beta value taken from cell A2, and an alpha 
value taken from cell A3. 

Guidelines  Alpha must be greater than zero. 
Beta must be greater than zero. 

 

RiskLogLogisticAlt 
Description 
 

RiskLoglogisticAlt(arg1type, arg1value, arg2type,arg2value, 
arg3type,arg3value) specifies a log-logistic distribution distribution with three 
arguments of the type arg1type to arg3type.  These arguments can be either a 
percentile between 0 and 1 or “gamma”, “beta” or “alpha”. 
 

Examples 
 

RiskLoglogisticAlt("gamma",5,"beta",2,90%,10) returns a log-logistic 
distribution generated using a gamma value of 5, a beta value of 2, and a 90th 
percentile of 10. 

Guidelines  ”Alpha” must be greater than zero. 
“Beta” must be greater than zero 
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RiskLognorm 
Description 
 

RiskLognorm(mean,standard deviation) specifies a lognormal distribution with 
the entered mean and standard deviation.  The arguments for this form of the 
lognormal distribution specify the actual mean and standard deviation of the 
generated lognormal probability distribution. 
 

Examples 
 

RiskLognorm(10,20) specifies a lognormal distribution with a mean of 10 and 
a standard deviation of 20. 
RiskLognorm(C10*3.14,B10) specifies a lognormal distribution with a mean 
equaling the value in cell C10 times 3.14 and a standard deviation equaling the 
value in cell B10. 

Guidelines  The mean and standard deviation must be greater than 0.  
 

 

RiskLognormAlt 
Description 
 

RiskLognormAlt(arg1type, arg1value, arg2type,arg2value, 
arg3type,arg3value) specifies a lognormal distribution distribution with three 
arguments of the type arg1type to arg3type.  These arguments can be either a 
percentile between 0 and 1 or “mu” , “sigma” or "loc". 
 

Examples 
 

RiskLognormAlt("mu",2,"sigma",5,95%,30) specifies a lognormal distribution 
with a mean of 2 and a standard deviation of 5 and a 95th percentile of 30. 

Guidelines  The “mu” and “sigma” must be greater than 0. 
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RiskLognorm2 
Description 
 

RiskLognorm2(mean of corresponding normal dist.,std. dev. of normal) 
specifies a lognormal distribution where the entered mean and standard 
deviation equal the mean and standard deviation of the corresponding normal 
distribution.  The arguments entered are the mean and standard deviation of 
the normal distribution for which an exponential of the values in the distribution 
was taken to generate the desired lognormal. 
 

Examples 
 

RiskLognorm2(10,20) specifies a lognormal distribution generated by taking 
the exponential of the values from a normal distribution with a mean of 10 and 
a standard deviation of 20. 
RiskLognorm2(C10*3.14,B10) specifies a lognormal distribution generated by 
taking the exponential  of the values from a normal distribution with a mean 
equaling the value in cell C10 times 3.14 and a standard deviation equaling the 
value in cell B10. 

Guidelines  The standard deviation must be greater than 0. 
 

 

RiskNegbin 
Description 
 

RiskNegbin(s,p) specifies a negative binomial distribution with s number of 
successes and p probability of success on each trial.  The negative binomial 
distribution is a discrete distribution returning only integer values greater than 
or equal to zero. 
 

Examples 
 

RiskNegbin(5,.25) specifies a negative binomial distribution with 5 successes 
with a 25% probability of success on each trial. 
RiskNegbin(A6,A7) specifies a negative binomial distribution with the number 
of successes taken from cell A6 and a probability of success taken from cell 
A7. 

Guidelines  Number of successes s must be a positive integer less than or equal to 32,767. 
Probability p must be greater than zero and less than or equal to one. 
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RiskNormal 
Description 
 

RiskNormal(mean,standard deviation) specifies a normal distribution with the 
entered mean and standard deviation.  This is the traditional "bell shaped" 
curve applicable to distributions of outcomes in many data sets. 
 

Examples 
 

RiskNormal(10,2) specifies a normal distribution with a mean of 10 and a 
standard deviation of 2. 
RiskNormal(SQRT(C101),B10) specifies a normal distribution with a mean 
equaling the square root of the value in cell C101 and a standard deviation 
taken from cell B10. 

Guidelines  The standard deviation must be greater than 0. 

 

RiskNormalAlt 
Description 
 

RiskNormaAlt(arg1type, arg1value, arg2type,arg2value) specifies a normal 
distribution with two arguments of the type arg1type and arg2type.  These 
arguments can be either a percentile between 0 and 1 or “mu" or “sigma”. 
 

Examples 
 

RiskNormalAlt(5%,1,95%,10) specifies a normal distribution with a 5th 
percentile of 1 and a 95th percentile of 10. 

Guidelines  "sigma" must be greater than 0. 

 

RiskPareto 
Description 
 

RiskPareto(theta,a) specifies a pareto distribution with the entered theta and a 
values.  
 

Examples 
 

RiskPareto(5,5) specifies a pareto distribution with a theta value of 5 and an a 
value of 5. 
RiskPareto(A10,A11+A12) specifies a pareto distribution with a theta value 
taken from cell A10 and an a value given by the result of the expression 
A11+A12. 

Guidelines  Theta must be greater than 1. 
The a argument must be greater than 0. 
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RiskParetoAlt 
Description 
 

RiskParetoAlt(arg1type, arg1value, arg2type,arg2value) specifies a pareto 
distribution with two arguments of the type arg1type and arg2type.  These 
arguments can be either a percentile between 0 and 1 or “theta" or “alpha”.  
 

Examples 
 

RiskParetoAlt(5%,1,95%,4) specifies a pareto distribution with a 5th percentile 
of 1 and a 95th percentile of 4. 

Guidelines  "Theta" must be greater than 1. 
"alpha" must be greater than 0. 

 

RiskPareto2 
Description 
 

RiskPareto2(b,q) specifies a pareto distribution with the entered b  and q 
values.  
 

Examples 
 

RiskPareto2(5,5) specifies a pareto distribution with a b value of 5 and a q 
value of 5. 
RiskPareto2(A10,A11+A12) specifies a pareto distribution with a b value taken 
from cell A10 and a q value given by the result of the expression A11+A12. 

Guidelines  b must be greater than 0. 
q  must be greater than 0. 

 

RiskPareto2Alt 
Description 
 

RiskPareto2Alt(arg1type, arg1value, arg2type,arg2value) specifies a pareto 
distribution with two arguments of the type arg1type and arg2type.  These 
arguments can be either a percentile between 0 and 1 or “b" or “q”.  
 

Examples 
 

RiskPareto2Alt(5%,.05,95%,5) specifies a pareto distribution with a 5th 
percentile of .05 and a 95th percentile of 5. 

Guidelines  "b" must be greater than 0. 
"q"  must be greater than 0. 
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RiskPearson5 
Description 
 

RiskPearson5(alpha,beta) specifies a pearson type V distribution with shape 
parameter alpha and scale parameter beta. 
 

Examples 
 

RiskPearson5(1,1) specifies a pearson type V distribution where the shape 
parameter has a value of 1 and the scale parameter has a value of 1. 
RiskPearson5(C12,C13) specifies a pearson type V distribution where the 
shape parameter has a value taken from cell C12 and the scale parameter has 
a value taken from cell C13. 

Guidelines  Alpha must be greater than zero 
Beta must be greater than zero. 

 

RiskPearson5Alt 
Description 
 

RiskPearson5Alt(arg1type, arg1value, arg2type,arg2value, 
arg3type,arg3value) specifies a pearson type Vdistribution with three 
arguments of the type arg1type to arg3type.  These arguments can be either a 
percentile between 0 and 1 or “alpha” , “beta” or "loc". 
 

Examples 
 

RiskPearson5Alt("alpha",2,"beta",5,95%,30) specifies a pearson type V 
distribution with a alpha of 2 and a beta of 5 and a 95th percentile of 30. 

Guidelines  "Alpha" must be greater than zero 
"Beta" must be greater than zero. 

RiskPearson6 
Description 
 

RiskPearson6(alpha1,alpha2,beta)  specifies a pearson type VI distribution 
with scale parameter beta and shape parameters alpha1 and alpha2. 
 

Examples 
 

RiskPearson6(5,1,2) specifies a pearson type VI distribution where beta has a 
value of 2, alpha2 has a value of 1 and alpha1 has a value of 5. 
RiskPearson6(E3,F3,D3) specifies a pearson type VI distribution where beta 
has a value taken from cell D3, alpha1 has a value taken from cell E3, and 
alpha2 has a value taken from cell F3. 

Guidelines  Alpha1 must be greater than zero. 
Alpha2 must be greater than zero. 
Beta must be greater than zero. 
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RiskPert 
Description 
 

RiskPert(minimum, most likely, maximum) specifies a PERT distribution (as 
special form of the beta distribution) with a minimum and maximum value as 
specified.  The shape parameter is calculated from the defined most likely 
value. 
 

Examples 
 

RiskPert(0,2,10) specifies a beta distribution with a minimum of 0, a maximum 
of 10, and a most likely value of 2. 
RiskPert (A1,A2,A3) specifies a PERT distribution with a minimum value taken 
from cell A1, a maximum value taken from cell A3, and a most likely value 
taken from cell A2. 

Guidelines  Minimum must be less than maximum. 
Most likely must be greater than minimum and less than maximum. 

 

RiskPertAlt 
Description 
 

RiskPertAlt(arg1type, arg1value, arg2type,arg2value, arg3type,arg3value) 
specifies a PERT distribution with three arguments of the type arg1type to 
arg3type.  These arguments can be either a percentile between 0 and 1 or 
“min” , “m. likely” or "max". 
 

Examples 
 

RiskPertAlt("min",2,"m. likely",5,95%,30) specifies a PERT distribution with a 
minimum of 2 and a most likely value of 5 and a 95th percentile of 30. 

Guidelines  "min" must be less than or equal to the "m. likely" value. 
"m. likely" must be less than or equal to the "max" value. 
The "min" must be less than the "max" value. 

 

RiskPoisson 
Description 
 

RiskPoisson(lambda) specifies a poisson distribution with the specified 
lambda value.  The argument lambda is also the same as the mean of the 
poisson distribution.  The poisson distribution is a discrete distribution returning 
only integer values greater than or equal to zero. 
 

Examples 
 

RiskPoisson(5) specifies a poisson distribution with a lambda of 5. 
RiskPoisson(A6) specifies a poisson distribution with a lambda value taken 
from cell A6. 

Guidelines  Lambda must be greater than zero. 

 



420 Reference: Distribution Functions 

RiskRayleigh 
Description 
 

RiskRayleigh(b) specifies a rayleigh distribution with mode b. 
 

Examples 
 

RiskRayleigh(3) specified a rayleigh distribution with a mode of 3. 
RiskRayleigh(C7) specifies a rayleigh distribution with a mode taken from the 
value in cell C7. 
 

Guidelines  b must be greater than zero. 

 

RiskRayleighAlt 
Description 
 

RiskRayleighAlt(arg1type, arg1value, arg2type,arg2value) specifies a rayleigh 
distribution with two arguments of the type arg1type and arg2type.  These 
arguments can be either a percentile between 0 and 1 or “beta" or “loc”. 
 

Examples 
 

RiskRayleighAlt(5%,1,95%,10) specifies a normal distribution with a 5th 
percentile of 1 and a 95th percentile of 10. 

Guidelines  "beta" must be greater than zero. 

 

RiskSimtable 
Description 
 

RiskSimtable({val1,val2,...,valn}) specifies a list of values which will be used 
sequentially in individual simulations executed during a Sensitivity Simulation.  
In a Sensitivity Simulation the number of simulations, set using the Iterations 
Simulations command, is greater than one. In a single simulation or a normal 
recalculation RiskSimtable returns the first value in the list.  Any number of 
RiskSimtable functions may be included in a single worksheet.  As with other 
functions, the arguments of RiskSimtable may include distribution functions. 
 

Examples 
 

RiskSimtable({10,20,30,40}) specifies four values to be used in each of four 
simulations. In Simulation #1 the SIMTABLE function will return 10, Simulation 
#2 the value 20 and so on. 
RiskSimtable(A1:A3) specifies a list of three values for three simulations.  In 
Simulation #1 the value from cell A1 will be returned.  In Simulation #2 the 
value from cell A2 will be returned.  In Simulation #3 the value from cell A3 will 
be returned. 

Guidelines  Any number of arguments may be entered. 
The number of simulations executed must be less than or equal to the number 
of arguments.  If the number of arguments is less than the number of an 
executing simulation, ERR will be returned by the function for that simulation. 
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RiskStudent 
Description 
 

RiskStudent(nu) specified a student's t distribution with nu degrees of 
freedom. 
 

Examples 
 

RiskStudent(10) specifies a student's t distribution with 10 degrees of 
freedom. 
RiskStudent(J2) specifies a student's t distribution with the degrees of 
freedom taken from the value in cell J2. 

Guidelines  Nu must be a positive integer. 

 

RiskTriang 
Description 
 

RiskTriang(minimum,most likely,maximum) specifies a triangular distribution 
with three points — a minimum, most likely and maximum.  The direction of the 
"skew" of the triangular distribution is set by the size of the most likely value 
relative to the minimum and the maximum.   
 

Examples 
 

RiskTriang(100,200,300) specifies a triangular distribution with a minimum 
value of 100, a most likely value of 200 and a maximum value of 300. 
RiskTriang(A10/90,B10,500) specifies a triangular distribution with a minimum 
value equaling the value in cell A10 divided by 90, a most likely value taken 
from cell B10 and a maximum value of 500. 

Guidelines  The minimum value must be less than or equal to the most likely value. 
The most likely value must be less than or equal to the maximum value. 
The minimum value must be less than the maximum value. 

 

RiskTriangAlt 
Description 
 

RiskTriangAlt(arg1type, arg1value, arg2type,arg2value, arg3type,arg3value) 
specifies a triangular distribution with three arguments of the type arg1type to 
arg3type.  These arguments can be either a percentile between 0 and 1 or 
“min” , “m. likely” or "max". 
 

Examples 
 

RiskTriangAlt("min",2,"m. likely",5,95%,30) specifies a triangular distribution 
with a minimum of 2 and a most likely value of 5 and a 95th percentile of 30. 

Guidelines  "min" must be less than or equal to the "m. likely" value. 
"m. likely" must be less than or equal to the "max" value. 
The "min" must be less than the "max" value. 

 



422 Reference: Distribution Functions 

RiskTrigen 
Description 
 

RiskTrigen(bottom value,most likely value,top value, bottom perc., top perc.) 
specifies a triangular distribution with three points — one at the most likely 
value and two at the specified bottom and top percentiles.  The bottom 
percentile and top percentile are values between 0 and 100.  Each percentile 
value gives the percentage of the total area under the triangle that falls to the 
left of the entered point.  Use of the RiskTrigen function avoids the problem of 
the minimum and maximum values not actually being possible occurrences in 
the standard RiskTriang function.  This is because in the RiskTriang function 
these are the points where the distribution intersects the X-axis, or points of 
zero probability.  
 

Examples 
 

RiskTrigen(100,200,300,10,90) specifies a triangular distribution with a 10th 
percentile value of 100, a most likely value of 200 and a 90th percentile value 
of 300. 
RiskTrigen(A10/90,B10,500,30,70) specifies a triangular distribution with a 
30th percentile value equaling the value in cell A10 divided by 90, a most likely 
value taken from cell B10 and a 70th percentile value of 500. 

Guidelines  The bottom percentile value must be less than or equal to the most likely value. 
The most likely value must be less than or equal to the top percentile value. 
The bottom percentile value must be less than the top percentile value. 

 

RiskUniform 
Description 
 

RiskUniform(minimum,maximum) specifies a uniform probability distribution 
with the entered minimum and maximum values.  Every value across the range 
of the uniform distribution has an equal likelihood of occurrence.  
 

Examples 
 

RiskUniform(10,20) specifies a uniform distribution with a minimum value of 
10 and a maximum value of 20. 
RiskUniform(A1+90,B1) specifies a uniform distribution with a minimum value 
equaling the value in cell A1 plus 90 and a maximum value taken from cell B1. 

Guidelines  The minimum value entered must be less than the maximum value. 
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RiskUniformAlt 
Description 
 

RiskUniformAlt(arg1type, arg1value, arg2type,arg2value) specifies a uniform 
distribution with two arguments of the type arg1type and arg2type.  These 
arguments can be either a percentile between 0 and 1 or “min" or “max”. 
 

Examples 
 

RiskUniformAlt(5%,1,95%,10) specifies a uniform distribution with a 5th 
percentile of 1 and a 95th percentile of 10. 

Guidelines  The "min" value entered must be less than the "max" value. 

 

RiskWeibull 
Description 
 

RiskWeibull(alpha,beta) generates a weibull distribution with the shape 
parameter alpha and a scale parameter beta.  The weibull distribution is a 
continuous distribution whose shape and scale vary greatly depending on the 
argument values entered. 
 

Examples 
 

RiskWeibull(10,20) generates a weibull distribution with a shape parameter 10 
and a scale parameter 20. 
RiskWeibull(D1,D2) generates a weibull distribution with a shape parameter 
taken from cell D1 and a scale parameter taken from cell D2. 

Guidelines  Both shape parameter alpha and scale parameter beta must be greater than 
zero. 

 

RiskWeibullAlt 
Description 
 

RiskWeibullAlt(arg1type, arg1value, arg2type,arg2value, arg3type,arg3value) 
specifies a weibull distribution with three arguments of the type arg1type to 
arg3type.  These arguments can be either a percentile between 0 and 1 or 
“alpha” , “beta” or "loc". 
 

Examples 
 

RiskWeibullAlt("alpha",1,"beta",1,95%,3) specifies a weibull distribution with 
a alpha of 1 and a beta of 1 and a 95th percentile of 3. 

Guidelines  Both shape parameter "alpha" and scale parameter "beta" must be greater than 
zero. 
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Reference: Distribution Property Functions 
The following functions are used to add optional arguments to 
distribution functions.  The arguments added by these functions are 
not required, but can be added as needed.  

Optional arguments are specified using @RISK distribution property 
functions that are embedded inside of a distribution function.   

RiskCollect 
Description 
 

RiskCollect() identifies specific distribution functions whose samples are 
collected during a simulation and whose: 
statistics are displayed 
data points are available 
sensitivities and scenario values are calculated 
When RiskCollect is used and Inputs Marked With Collect is selected for 
Collect Distribution Samples in the Simulation Settings dialog, only functions 
identified by RiskCollect are displayed in the Results window Explorer list.   
Earlier versions of @RISK had the RiskCollect function entered by placing it in 
the cell formula immediately preceding the distribution function for which 
samples will be collected, e.g.: 
=RiskCollect()+RiskNormal(10,10)  
RiskCollect is typically used when a large number of distribution functions are 
present in a simulated worksheet, but sensitivities and scenario analyses are 
desired on only a pre-identified subset of important distributions.  It can also be 
used to bypass Windows memory constraints that keep sensitivities and 
scenario analyses from being performed on all functions in a large simulation. 
 

Examples 
 

RiskNormal(10,2,RiskCollect()) collects samples from the probability 
distribution RiskNormal(10,2).  

Guidelines  The “Inputs Marked WithCollect" box in Simulation Settings must be selected 
for COLLECT functions to take effect. 
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RiskCorrmat 
Description 
 

RiskCorrmat(matrix cell range,position,instance) identifies a distribution 
function belonging to a set of correlated distribution functions. The function is 
used to specify multivariate correlation.  RiskCorrmat identifies 1) a matrix of 
rank correlation coefficients and 2) the location in the matrix of the coefficients 
used in correlating the distribution function which follows the RiskCorrmat 
function. 
Correlated distribution functions typically are defined using the @RISK Model 
Window Model menu Correlate Distributions command; however, the same 
type of correlation may be directly entered in your spreadsheet using the 
RiskCorrmat function.   
The matrix identified by the matrix cell range is a matrix of rank correlation 
coefficients.  Each element (or cell) in the matrix contains a correlation 
coefficient.  The number of distribution functions correlated by the matrix equals 
the number of rows or columns in the matrix.  The argument position specifies 
the column (or row) in the matrix to use in correlating the distribution function 
which follows the RiskCorrmat function.  The coefficients located in the column 
(or row) identified by position are used in correlating the identified distribution 
function with each of the other correlated distribution functions represented by 
the matrix.  The value in any given cell in the matrix gives the correlation 
coefficient between 1) the distribution function whose RiskCorrmat position 
equals the column coordinate of the cell and 2) the distribution function whose 
RiskCorrmat position equals the row coordinate of the cell.  Positions (and 
coordinates) range from 1 to N, where N is the number of columns or rows in 
the matrix. 
The instance argument is optional and is used when multiple groups of 
correlated inputs use the same matrix of correlation coefficients.  Instance is an 
integer or string argument and all inputs in a correlated group of inputs share 
the same instance value or string. String arguments used to specify instance 
need to be in quotes. 
The RiskCorrmat function generates correlated sets of random numbers to be 
used in sampling each of the correlated distribution functions.  The sample 
matrix of rank correlation coefficients calculated on the correlated set of 
random numbers approximates as closely as possible the target correlation 
coefficient matrix which was entered in the worksheet. 
Correlated sets of random numbers specified by the RiskCorrmat function are 
generated when the first RiskCorrmat function is called during a simulation.   
This is usually during the first iteration of the simulation.  This may cause a 
delay while values are sorted and correlated.  The length of the delay is 
proportional to the number of iterations and the number of correlated variables. 
The method used for generating multiple rank correlated distribution functions 
is based on the method used for DEPC and INDEPC functions.  For more 
information on this, see the section Understanding Rank Order Correlation 
Coefficient Values under the DEPC function in this section. 
Entry of CORRMAT functions outside of a distribution function (in the form 
RiskCorrmat+distribution function) as done in earlier versions of @RISK is still 
supported.  However, these functions will be moved inside the distribution 
function they are correlating whenever the formula or correlated distribution is 
edited in the @RISK Model window. 
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Examples 
 

RiskNormal(10,10, RiskCorrmat(C10:G14,1,”Matrix 1”)) specifies that the 
sampling of the distribution Normal(10,10) will be controlled by the first column 
of the 5 by 5 matrix of correlation coefficient values located in the cell range 
C10:G14.  There are five correlated distributions represented by the matrix as 
there are five columns in the matrix.  The coefficients used in correlating 
Normal(10,10) with the other four correlated distributions are found in row 1 of 
the matrix.  This distribution - Normal(10,10) - will be correlated with the other 
distributions that include the instance Matrix 1 in their embedded RiskCorrmat 
functions. 

Guidelines  Multiple matrices of correlation coefficients may be used in a single worksheet. 
The sample matrix of correlation coefficients (calculated on the correlated 
random numbers generated by @RISK) approximates as closely as possible 
the target correlation coefficient matrix located in the matrix cell range.  It is 
possible that the target coefficients are inconsistent and approximation cannot 
be performed.  @RISK will notify the user if this occurs. 
Any blank cells or labels in the matrix cell range specify a correlation coefficient 
of zero. 
Position may be a value between 1 and N, where N is the number of columns 
in the matrix. 
The matrix cell range must be square, that is, with an equal number of rows 
and columns. 
By default @RISK uses the correlation coefficients in the matrix cell range on a 
rowwise basis.  Because of this only the top 'half' of the matrix — the top right 
of the matrix when it is split on the diagonal — needs to be entered. 
Correlation coefficients must be less than or equal to 1 and greater than or 
equal to -1.  Coefficients on the diagonal of the matrix must equal 1. 
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RiskDepC 
Description 
 

RiskDepC("ID",coefficient) designates a dependent variable in a correlated 
sampling pair.  The ID in quotes is the string used to identify the independent 
variable being correlated with.  The string must be in quotes.  This is the same 
ID used in the RiskIndepC function for the independent variable. The coefficient 
entered is the rank-order correlation coefficient which describes the relationship 
of the values sampled for the distributions identified by the RiskDepC and 
RiskIndepC. The RiskDepC function is used with the distribution function which 
specifies the possible values for the dependent variable 
Understanding Rank-Order Correlation Coefficient Values 
The rank-order correlation coefficient was developed by C. Spearman in the 
early 1900's.  It is calculated using rankings of values, not actual values 
themselves (as is the linear correlation coefficient).  A value's "rank" is 
determined by its position within the min-max range of possible values for the 
variable. 
The coefficient is a value between -1 and 1 which represents the desired 
degree of correlation between the two variables during sampling.  Positive 
coefficient values indicate a positive relationship between the two variables — 
when the value sampled for one is high, the value sampled for the second will 
also tend to be high.  Negative coefficient values indicate an inverse 
relationship between the two variables — when the value sampled for one is 
high, the value sampled for the second will tend to be low. 
@RISK generates rank-correlated pairs of sampled values in a two step 
process.  First, a set of randomly distributed "rank scores" are generated for 
each variable.  If 100 iterations are to be run, for example, 100 scores are 
generated for each variable.  (Rank scores are simply values of varying 
magnitude between a minimum and maximum.  @RISK uses van der Waerden 
scores based on the inverse function of the normal distribution).  These rank 
scores are then rearranged to give pairs of scores which generate the desired 
rank correlation coefficient.  For each iteration there is a pair of scores, with 
one score for each variable. 
In the second step, a set of random numbers (between 0 and 1) to be used in 
sampling is generated for each variable.  Again, if 100 iterations are to be run, 
100 random numbers are generated for each variable.  These random numbers 
are then ranked smallest to largest.  For each variable, the smallest random 
number is then used in the iteration with the smallest rank score, the second 
smallest random number is used in the iteration with the second smallest rank 
score and so on.  This ordering based on ranking continues for all random 
numbers, up to the point where the largest random number is used in the 
iteration with the largest rank score. 
In @RISK this process of rearranging random numbers happens prior to 
simulation.  It results in a set of pairs of random numbers that can be used in 
sampling values from the correlated distributions in each iteration of the 
simulation.  
This method of correlation is known as a "distribution-free" approach because 
any types of distributions may be correlated. Although the samples drawn for 
the two distributions are correlated, the integrity of the original distributions are 
maintained.  The resulting samples for each distribution reflect the input 
distribution function from which they were drawn. 
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Earlier versions of @RISK had the RiskDepC function entered by placing it in 
the cell formula immediately preceding the distribution function which will be 
correlated, e.g.: 
=RiskDepC(”Price 1”,.9)+RiskNormal(10,10)  
This form of function entry is still supported.  However, these functions will be 
moved inside the distribution function they are correlating whenever the formula 
or correlated distribution is edited in the @RISK Model window. 
The correlation coefficient generated by using RiskDepC and RiskIndepC is 
approximate.  The generated coefficient will more closely approximate the 
desired coefficient as increasing numbers of iterations are executed.  There 
may be a delay at the start of a simulation when distributions are correlated 
when RiskDepC and RiskIndepC are used.  The length of the delay is 
proportional to the number of RiskDepC functions in the worksheet and the 
number of iterations to be performed.  See the @RISK Modeling Techniques 
chapter for a detailed example of dependency relationships  

Examples 
 

RiskNormal(100,10, RiskDepC("Price",.5)) specifies that the sampling of the 
distribution RiskNormal(100,10) will be correlated with the sampling of the 
distribution identified with the function RiskIndepC("Price").  The sampling of 
RiskNormal(100,10) will be positively correlated with the sampling of the 
distribution identified with the function RiskIndepC("Price") as the coefficient is 
greater than 0. 

Guidelines  Coefficient must be a value greater than or equal to -1 and less than or equal to 
1.  "ID" must be the same string of characters used to identify the   independent 
variable in the RiskIndepC function.  “ID” may be a reference to cell that 
contains an identifier string. 
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RiskFit 
Description 
 

RiskFit(ProjID,FitID,"selected fit result") links a data set and its fit results to 
the input distribution the RiskFit function is used in.  The ProjID and FitID are 
internal @RISK IDs that identify the fit from which the distribution was 
selected and should not be changed.  The selected fit result in quotes is a 
string used to identify the type of fit result to select.  The RiskFit function is 
used to link an input to the fit results for a data set so that when the data is 
changed the input distribution selected from the fit can be updated.  
The selected fit result can be any of the following entries: 
Best Chi-Sq, indicating the best fitting distribution from the Chi-Sq. test 
should be used 
Best A-D, indicating the best fitting distribution from the Anderson-Darling 
test should be used 
Best K-S, indicating the best fitting distribution from the Kolmogorov-Smirnov  
test should be used. 
Best RMS Err,  indicating the best fitting distribution from the RMS Error test 
should be used 
A distribution name, such as "Normal", indicating that the best-fitting 
distribution of the entered type should be used. 
What Happens When Data Changes When RiskFit is Used 
The RiskFit function "hot-links" a distribution function to a data set and the fit 
of that data set.  The data used in a fit can be either in Excel or on a fit tab in 
the @RISK – Model window.  When the fitted data changes in either one of 
these locations, the following actions take place: 
@RISK re-runs the fit using the current settings on the fit tab where the fit 
was originally run 
The distribution function that includes the RiskFit function that references the 
fit is changed to reflect the new fit results.  The changed function replaces the 
original one in Excel.  If, for example, the distribution function's RiskFit 
argument specified "Best Chi-sq" for selected fit result, the new best-fitting 
distribution based on the Chi-Sq test would replace the original one.  This 
new function would also include the same RiskFit function as the original one. 
@RISK can perform the above actions either 1) immediately when the data 
and fit have changed or 2) when a simulation starts or the list of Outputs and 
Inputs is generated.  The Update method used is specified using the @RISK 
Model window Fitting menu Update Linked @RISK Functions command. 
 

Examples 
 

RiskNormal(2.5, 1, RiskFit(71367, 59129, "Best A-D")) specifies that the 
best fitting distribution from the Anderson-Darling test for the fitted data 
associated with the specified ProjID and FitID is a Normal distribution with a 
mean of 2.5 and a standard deviation of 1. 

Guidelines  n/a 
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RiskIndepC 
Description 
 

RiskIndepC("ID") designates an independent variable in a rank correlated 
sampling pair.  The ID in quotes is a string used to identify the independent 
variable.  The RiskIndepC function is used with the distribution function which 
specifies the possible values for the independent variable.  RiskIndepC is just 
an identifier.   
Earlier versions of @RISK had the RiskIndepC function entered by placing it 
in the cell formula immediately preceding the distribution function which will 
be correlated, e.g.: 
=RiskIndepC(”Price 1”)+RiskNormal(10,10)  
This form of function entry is still supported. However, these functions will be 
moved inside the distribution function they are correlating whenever the 
formula or correlated distribution is edited in the @RISK Model window. 
 

Examples 
 

RiskNormal(10,10, RiskIndepC("Price")) identifies the function 
NORMAL(10,10) as the independent variable "Price".  This function will be 
used as the independent variable anytime a DEPC function with the ID string 
"Price" is used. 

Guidelines  "ID" must be the same string of characters used to identify the dependent 
variable in the DEPC function. "ID" must be the same string of characters 
used to identify the independent variable in the INDEPC function.  “ID” may 
be a reference to cell that contains an identifier string. 
A maximum of 64 individual INDEPC functions may be used in a single 
worksheet.  Any number of DEPC functions may be dependent on those 
INDEPC functions  
See the @RISK Modeling Techniques chapter for a detailed example of 
dependency relationships. 
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RiskLock 
Description 
 

RiskLock() keeps a distribution from being sampled in a simulation.   Locking 
an input distribution causes it to return the value set in using the Simulation 
Settings standard recalc options. 
 

Examples 
 

RiskNormal(10,2,RiskLock()) stops samples from being drawn from the 
probability distribution RiskNormal(10,2). 

Guidelines  None 
 

 

RiskName 
Description 
 

RiskName(“Input Name”) names the input distribution in which the function is 
used as an argument.  This name will appear in both the @RISK Model 
Window Outputs and Inputs list and in any reports and graphs which include 
simulation results for the input. 
 

Examples 
 

RiskTriang(10,20,30,RiskName(“Price”)) gives the name Price to the input 
described by the probability distribution RiskTriang(10,20,30).   
RiskTriang(10,20,30,RiskName(A10)) gives the name contained in the cell 
A10 to the input described by the probability distribution RiskTriang(10,20,30). 
  

Guidelines  The name specified must be entered in quotes. 
 Any valid cell references can be used to define a name. 

 

RiskShift 
Description 
 

RiskShift(shift amount) shifts the domain of the distribution in which it is used 
by the entered shift amount.  This function is automatically entered when a fit 
result includes a shift factor. 
 

Examples 
 

RiskBeta(10,2,RiskShift(100)) shifts the domain of the distribution 
RiskBeta(10,2) by 100 . 

Guidelines  None. 
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RiskTruncate 
Description 
 

RiskTruncate(minimum,maximum) truncates the input distribution in which 
the function is used as an argument.  Truncating a distribution restricts 
samples drawn from the distribution to values within the entered minimum-
maximum range.  Truncated forms of specific distributions available in earlier 
versions of @RISK (such as RiskTnormal and RiskTlognorm) are still 
supported. 
 

Examples 
 

RiskTriang(10,20,30,RiskTruncate(13,27)) restricts the samples drawn from 
the probability distribution RiskTriang(10,20,30) to a minimum possible value 
of 13 and a maximum possible value of 27.  
RiskTriang(10,20,30,RiskTruncate(D11,D12)) restricts the samples drawn 
from the probability distribution RiskTriang(10,20,30) to a minimum possible 
value of taken from cell D11 and a maximum possible value of taken from cell 
D12.   

Guidelines  Minimum must be less than or equal to maximum. 
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Reference: Output Functions 
Output cells are defined using RiskOutput functions.  These functions 
allow the easy copying, pasting and moving of output cells.  
RiskOutput functions are automatically added when the standard 
@RISK Add Output icon is pressed. RiskOutput functions optionally 
allow you to name your simulation outputs and add individual 
output cells to output ranges. 
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RiskOutput 
Description 
 

The function RiskOutput is used to identify output cells you have selected in 
your spreadsheet.  This function takes up to three arguments as shown here: 
=RiskOutput("output cell name", "output range name",element# in 
range) 
These arguments are optional, as a simple =RiskOutput() is sufficient for 
entering a single element output range where @RISK creates the name of the 
output for you.  RiskOutput used with a single argument such as: 
=RiskOutput ("output cell name") 
specifies for a single element output range where the name is entered by you.   
When a multiple element output range is identified, the form: 
=RiskOutput ("output cell name", "output range name", position# in 
range) 
is used; however, the output cell name entry can be omitted if you wish to 
have @RISK automatically generate a name for each output cell in the range. 
RiskOutput functions are automatically generated for you when you select 
outputs using the @RISK Add Output icon.  However, like any other @RISK 
function, RiskOutput may be typed directly in the cell which you wish to 
reference as a simulation output. 
A RiskOutput function is entered by adding it to the cell formula which is 
already present in the cell that is to be a simulation output.  For example, a 
cell containing the formula: 
=NPV(.1,G1…G10)  
would become 
=RiskOutput()+NPV(.1,G1…G10)  
when the cell is selected as an output. 
 

Examples 
 

=RiskOutput(“Profit 1999”, “Annual Profit”, 1)+NPV(.1,G1…G10) 
identifies the cell where the RiskOutput function is located as a simulation 
output and gives it the name Profit 1999 and makes it the first cell in a 
multiple cell output range named Annual Profit. 

Guidelines  If names are entered directly in the RiskOutput function, the entered output 
cell name and output range name must be enclosed in quotes. Names may 
also be included by referencing cells with labels in them. 
Position# must be a positive integer >=1. 
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Reference: Statistics Functions 
Statistics Functions return a desired statistic on simulation results for 
1) a specified cell or 2) a simulation output or input. These functions 
are updated real-time as a simulation is running.  Statistics functions 
located in template sheets used for creating custom reports on 
simulation results are only updated when a simulation is completed. 

If a cell reference is entered as the first argument, the cell does not 
have to be a simulation output identified with a RiskOutput function. 

If a name is entered instead of cellref, @RISK first checks for an output 
with the entered name.  If none exists, @RISK looks for a input 
probability distribution with the entered name and if one is found, 
returns the appropriate statistic for the samples drawn for that input. 
It is up to the user to insure that unique names are given to outputs 
and inputs referenced in statistics functions. 

The Sim# argument entered selects the simulation for which a statistic 
will be returned when multiple simulations are run.  This argument is 
optional and can be omitted for single simulation runs. 

RiskData 
Description 
 

RiskData(cellref  or output/input name,iteration#,Sim#) returns the data 
point(s) of the simulated distribution for cellref in the specified iteration# and 
simulation#. RiskData can optionally be entered as an array formula, where 
iteration# is the first iteration to be returned in the first cell in the array formula 
range.  The data points for each subsequent iteration will be filled into cells in 
the range where the array formula is entered. 
 

Examples 
 

RiskData(A10,1) returns the data point of the simulated distribution for cell 
A10 in iteration #1 of a simulation. 
RiskData("Profit",100,2) returns the data point of the simulated distribution 
for the output cell named Profit in the current model for the 100th iteration of 
the second simulation executed when multiple simulations are run. 

Guidelines   None. 
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RiskKurtosis 
Description 
 

RiskKurtosis(cellref  or output/input name,Sim#) returns the kurtosis of the 
simulated distribution for cellref. 
 

Examples 
 

RiskKurtosis(A10) returns the kurtosis of the simulated distribution for cell 
A10. 
RiskKurtosis("Profit",2) returns the kurtosis of the simulated distribution for 
the output cell named Profit in the current model for the second simulation 
executed when multiple simulations are run. 

Guidelines   None. 

 

RiskMax 
Description 
 

RiskMax(cellref or output/input name,Sim#) returns the maximum value of 
the simulated distribution for cellref. 
 

Examples 
 

RiskMax(A10) returns the maximum of the simulated distribution for cell A10. 
RiskMax(“profit”) returns the maximum of the simulated distribution for the 
output cell in the current model named “profit”. 

Guidelines   None. 

 

RiskMean 
Description 
 

RiskMean(cellref or output/input name,Sim#) returns the mean value of the 
simulated distribution for cellref. 
 

Examples 
 

RiskMean(A10) returns the mean of the simulated distribution for cell A10  
RiskMean(”Price”) returns the mean of the simulated distribution for the 
output cell named Price. 

Guidelines   None. 
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RiskMin 
Description 
 

RiskMin(cellref or output/input name,Sim#) returns the minimum value of the 
simulated distribution for cellref. 
 

Examples 
 

RiskMin(A10) returns the minimum of the simulated distribution for cell A10. 
RiskMin("Sales") returns the minimum value of the simulated distribution for 
the output cell in the current model named "Sales". 

Guidelines   None. 

 

RiskMode 
Description 
 

RiskMode(cellref or output/input name,Sim#) returns the mode of the 
simulated distribution for cellref. 
 

Examples 
 

RiskMode(A10) returns the mode of the simulated distribution for cell A10. 
RiskMode("Sales") returns the mode of the simulated distribution for the 
output cell in the current model named "Sales". 

Guidelines   None. 

 

RiskPercentile 
Description 
 

RiskPercentile(cellref or output/input name, percentile,Sim#) returns the 
value of the entered percentile of the simulated distribution for cellref. 
 

Examples 
 

RiskPercentile(C10,.99) returns the 99th percentile of the simulated 
distribution for cell C10. 
RiskPercentile(C10,A10) returns the percentile value from cell A10 of the 
simulated distribution for cell C10. 
 

Guidelines   The entered percentile must be a value >=0 and <=1. 
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RiskRange 
Description 
 

RiskRange(cellref or output/input name,Sim#) returns the minimum-
maximum range of the simulated distribution for cellref. 
 

Examples 
 

RiskRange(A10) returns the range of the simulated distribution for cell A10. 

Guidelines   None. 

 

RiskSkewness 
Description 
 

RiskSkewness(cellref or output/input name,Sim#) returns the skewness of 
the simulated distribution for cellref. 
 

Examples 
 

RiskSkewness(A10) returns the skewness of the simulated distribution for 
cell A10. 

Guidelines   None. 

 

RiskStdDev 
Description 
 

RiskSkewness(cellref or output/input name,Sim#) returns the skewness of 
the simulated distribution for cellref. 
 

Examples 
 

RiskSkewness(A10) returns the skewness of the simulated distribution for 
cell A10. 

Guidelines   None. 

  

RiskStdDev 
Description 
 

RiskStdDev(cellref or output/input name,Sim#) returns the standard deviation 
of the simulated distribution for cellref. 
 

Examples 
 

RiskStdDev(A10) returns the standard deviation of the simulated distribution 
for cell A10. 

Guidelines   None. 



Reference: @RISK Functions 441 

RiskTarget 
Description 
 

RiskTarget(cellref or output/input name, targetvalue,Sim#) returns the 
cumulative probability for targetvalue in the simulated distribution for cellref. 
The cumulative probability returned is the probability of a value <= targetvalue 
occurring. 
 

Examples 
 

RiskTarget(C10,100000) returns the cumulative probability of the value 
100000 as calculated using the simulated distribution for cell C10. 
 

Guidelines   The entered targetvalue can be any value. 

 

RiskVariance 
Description 
 

RiskVariance(cellref or output/input name,Sim#) returns the variance of the 
simulated distribution for cellref. 
 

Examples 
 

RiskVariance(A10) returns the variance of the simulated distribution for cell 
A10. 
 

Guidelines   None. 
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Reference: Supplemental Functions 
The following functions can be used in macro applications based on 
@RISK to determine the status of a running simulation. 

RiskCurrentIter 
Description 
 

RiskCurrentIter() returns the current iteration of an executing simulation. No 
arguments are required. 
 

Examples 
 

None. 

Guidelines  None. 

 

RiskCurrentSim 
Description 
 

RiskCurrentSim() returns the current simulation number.  No arguments are 
required.  
 

Examples 
 

None. 

Guidelines   None. 
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Reference: Graphing Function 
The @RISK function RiskResultsGraph will automatically place a graph 
of simulation results wherever it is used in a spreadsheet.  For 
example, =RiskResultsGraph (A10) would place a graph of the 
simulated distribution for A10 directly in your spreadsheet at the 
function's location at the end of a simulation.  Additional optional 
arguments to RiskResultsGraph allow you to select the type of graph 
you want to create, its format, scaling and other options. 

This function may also be called from the @RISK macro language to 
generate graphs in Excel in custom @RISK applications. 

RiskResultsGraph 
Description 
 

RiskResultsGraph(cellRef or output/input name 
,locationCellRange,graphType, xlFormat, leftdelimiter, 
rightdelimiter,xMin,xMax,xScale,Title,Sim#) adds a graph of simulation results 
to a worksheet.  The graphs generated are the same as generated in the 
@RISK-Results window. Many arguments to this function are optional. If 
optional arguments are not entered, RiskResultsGraph creates a graph using 
the current default settings in the @RISK Results window for any omitted 
argument. 
 

Examples 
 

RiskResultsGraph(A10) generates a graph of the simulation results for cell 
A10 as a Excel format graph at the location of the function, using the default 
graph type (histogram, cumulative ascending or cumulative descending). 
RiskResultsGraph(A10,C10:M30,1,TRUE,1,99) generates a graph of the 
simulation results for cell A10 in the range C10:M30 in Excel format as a 
histogram,  and sets the left and right delimiters at the 1% and 99% values, 
respectively. 

Guidelines  cellRef is any valid Excel cell reference. Either a cellRef or a output/input 
name argument needs to be included in a RiskResultsGraph function. When 
cellRef is entered, the results to be graphed depend on the following: 
If there is a RiskOutput function in cellref, the simulation results for this 
output will be graphed.   
If there is no RiskOutput function in cellRef but there is a distribution 
function,  RiskResultsGraph will graph the collected samples for this input. 
If there is no RiskOutput and no distribution function in cellRef, a RiskOutput 
function is automatically added and this output is graphed by 
RiskResultsGraph. 
locationCellRange is any valid Excel cell range. The created graph will be 
located in and sized according to this cell range. 
GraphType (optional) argument is one of the following constants: 

0 for histogram 
1 for cumulative ascending graph 
2 for cumulative descending graph 
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3 for tornado graph of regression sensitivity results 
4 for tornado graph of correlation sensitivity results 
5 for a summary graph of the output range that includes cellRef 

XlFormat (optional) specifies if the graph will be created as an Excel format 
chart.  Enter TRUE for an Excel format chart, or enter FALSE or leave blank 
for an Excel format chart. 
LeftXdelimiter (optional) specifies the location of the left delimiter on the graph 
in % for histograms and cumulative graphs. LeftXdelimiter is a value from 0 to 
100.  
RightXdelimiter (optional) specifies the location of the right delimiter on the 
graph in % for histograms and cumulative graphs. RightXdelimiter is a value 
from 0 to 100.  
Xmin (optional) specifies the minimum value for the X axis in unscaled units. 
XMax (optional) specifies the maximum value for the X axis in unscaled units. 
Xscale (optional) specifies the scale factor for the X axis.  Xscale is an integer 
value representing the power of 10 used to convert the x-axis values when 
labeling the axis.  For example, a Xscale of 3 would specify that values would 
be shown in thousands. 
Title (optional) specifies the graph title shown on the graph.  A string in quotes 
or cell reference containing the title can be entered. 
Sim# (optional)  specifies simulation number for which results are to be 
graphed when multiple simulations are run.   
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Reference:  @RISK Macros 

Overview 
The @RISK functions and types accessible by Excel VBA programmers 
fall into two general categories.  The first category allows you to 
automate the process of editing @RISK settings using code.  For 
example, you might wish to open all the .RSK files in a given folder, 
change their @RISK settings, and save them.  Or perhaps you want to 
make a custom settings interface, which shields other users from 
certain details.  The second category of functions and types allows 
you to start and control an @RISK simulation and get simulation 
results.  For example, you may wish to run multiple simulations, one 
after another, and compare the results between each.   

Organization 
This section, Overview, details how to use the @RISK VBA functions 
and variables, how to specify @RISK settings, and how to run 
simulations from VBA.  For more detailed information, all the 
documentation for the available variables and functions is provided 
in the on-line help file RiskMacro.CHM and in PDF format in the file 
RiskMacro.PDF. 

Using the VBA Functions 
To use any of the functions, types, and constants described here, you 
must first make a “reference” to the @RISK add-in from within your 
VBA application.  First, make sure @RISK is loaded in Excel.  Next, 
from within your VBA module, choose the “Tools” menu’s 
”References…” option.  This will bring up a dialog list of all the 
available references. Make sure RISK.XLA is checked as a reference. 
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Macro Example Files 
Two example files – RiskMacro.XLS and FitMacro.XLS – illustrate 
the use of @RISK functions and types in VBA.  They are located in the 
EXAMPLES folder in your RISK45 directory.  RiskMacro.XLS shows 
how to use @RISK macro functions to run simulations and retrieve 
simulation results.  FitMacro.XLS illustrates the use of @RISK VBA 
functions to fit probability distributions to data. 

Macros from Earlier Versions of @RISK 
Earlier versions of @RISK contained macro commands based on the 
Excel 4-style macro language where commands were placed in an 
Excel macro sheet.  These macro commands are not available in 
@RISK 4.5 and macro programs that use them need to be translated to 
the new VBA macro functions described in this chapter.  In addition, 
programs controlling @RISK for Excel developed using the @RISK 3.5 
Object Library need to be translated to the new VBA macro functions 
described in this chapter.  The @RISK 3.5 Object Library is not 
supported in @RISK 4.5.  Please contact Palisade for assistance 
translating applications developed using earlier versions of @RISK. 
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Using VBA to Modify @RISK Settings and 
Enter Outputs 

Public Variable Type Used for @RISK Settings 
The VBA control of the @RISK settings is based on a public defined 
variable type, which has been designed to closely match the user 
interface of @RISK.  Before reading this guide, you should be familiar 
with the @RISK 4.5 Excel interface.   

The defined public type RiskSettingsType contains all the @RISK 
settings (such as number of iterations, the sampling type, etc.).   

Defining @RISK Settings Using Code 
There are several public functions that @RISK provides for retrieving, 
copying, and storing @RISK settings:   

♦  The RiskGetSettings function will read the current @RISK 
settings and put them into a RiskSettingsType variable.   

♦  The RiskSetSettings function sets the @RISK settings equal to the 
information in a RiskSettingsType variable.  @RISK settings are 
not saved on disk until a .RSK file is saved using 
RiskSaveSimulation.  Keep in mind, changes made to a 
RiskSettingsType variable will not affect a simulation unless you 
have called RiskSetSettings.   

♦  The RiskGetSettingsDefaults function will fill a 
RiskSettingsType variable with a set of default settings.  These are 
the same settings a user would see when the @RISK settings 
toolbar button is pressed for a model with no current @RISK 
settings.   

Each of these functions is discussed in detail in the in the on-line help 
file RiskMacro.CHM and in PDF format in the file RiskMacro.PDF. 
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Adding Outputs and Distributions from VBA 
Simulation outputs can be defined from VBA using the 
RiskAddOutput function.  Using this function individual output cells 
or output ranges can be defined.  Outputs may also be added simply 
by modifying a cell's formula from VBA to include the desired 
RiskOutput function.  This same approach can be used for defining 
probability distributions or adding @RISK statistics functions.  Since 
@RISK functions are custom Excel functions, they may be added 
directly to cell formulas from VBA without using a custom @RISK 
macro command. 

Fitting Distributions to Data from VBA 
Users of @RISK Professional and Industrial can fit probability 
distributions to data using VBA and a set of functions for performing 
fits and getting fit results. The defined public type RiskFitType 
contains the data and settings for a fit that is to be performed.  The 
function RiskFitDistributions performs a fit using the information 
from a RiskFitType variable.  The function RiskFitGetFunction 
returns the best fitting distribution and arguments based on a 
specified test or for a specified distribution type.  Other functions, 
such as RiskFitGetStats, RiskFitGetPercentile and 
RiskFitGetTestResults return specific information about the fit 
results. 
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Using VBA to Run Simulations, Get Results 
and Generate Reports 

Simulating with Macros 
You can start a simulation by calling the RiskSimulate function. See 
the description of RiskSimulate in the Public Function Reference for 
more details. 

During the simulation, you can specify four different macros to run at 
different times during the simulation process.  The macros you write 
must be declared as public subroutines which take no arguments. The 
BeforeSimMacro runs when the simulation begins.  In a similar 
manner, the AfterSimMacro runs when the simulation ends.   

The two macros BeforeRecalcMacro andAfterRecalcMacro are called 
each time @RISK recalculates the spreadsheet.  The 
BeforeRecalcMacro is called after @RISK has placed new sampled 
values into the spreadsheet model, but before Excel is recalculated 
with these values.  This type of macro is useful if you want to modify 
these values before the calculation occurs.  The AfterRecalcMacro is 
called just after @RISK recalculates the spreadsheet model, but before 
the output value is stored internally.  This type of macro is useful if 
you want to modify the output value before @RISK uses it internally.   

Results and Reporting Macros 
Functions such as RiskGetStats, RiskGetData and 
RiskGetRegression allow you to access simulation statistics, data and 
sensitivities directly in variables in your VBA program.  The defined 
public type RiskStatsType contains all the @RISK statistics on 
simulation results (such as mean, standard deviation, etc.).   

Simulation reports can be generated using the RiskGenerateReports 
function.  Any combination of available reports may be selected.  In 
addition, the RiskResultsGraph function allows a specific graph of 
simulation results to be placed at a desired location in Excel. 

Additional simulation results may be reported using @RISK statistics 
functions and template reports.  These reports are created by placing 
the appropriate @RISK functions at any location in a worksheet.  
These functions can be added directly from VBA by modifying a cell's 
formula to include the desired @RISK function.   
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A template sheet causes a new report to be generated as each 
simulation is run.  A template sheet name can be specified using the 
TemplateSheetName variable in the RiskSettingsType.  To learn 
more about templates, see the Report Settings Command in Chapter 
7: @RISK Reference - @RISK Add-in Menu commands. 
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Using VBA to Run Advanced Analyses  
 

Each of the Advanced Analyses in @RISK Professional and Industrial 
can be setup and executed from macros.  For example,  
RiskGoalSeekSimulate runs an @RISK Goal Seek, while 
RiskAdvSensitivitySimulate runs an @RISK Advanced Sensitivity 
Analysis.  For more information on each available advanced analysis, 
see the Advanced Analyses Menu in the Reference: @RISK Add-in 
Menu Commands section of this manual. 

Using the VBA Functions for Advanced Analyses  
To use any of the functions, types, and constants for the @RISK 
Advanced Analyses, you must first make a “reference” to the @RISK 
Advanced Tools add-in from within your VBA application.  First, 
make sure @RISK is loaded in Excel.  Next, from within your VBA 
module, choose the “Tools” menu’s ”References…” option.  This will 
bring up a dialog list of all the available references. Make sure 
ADVTOOLS.XLA is checked as a reference. 
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Appendix A: Sampling Methods 
 

Sampling is used in an @RISK simulation to generate possible values from 
probability distribution functions. These sets of possible values are then 
used to evaluate your Excel worksheet.  Because of this, sampling is the 
basis for the hundreds or thousands of "what-if" scenarios @RISK 
calculates for your worksheet.  Each set of samples represents a possible 
combination of input values which could occur.  Choosing a sampling 
method affects both the quality of your results and the length of time 
necessary to simulate your worksheet.   

What is Sampling? 
Sampling is the process by which values are randomly drawn from input 
probability distributions.  Probability distributions are represented in 
@RISK by probability distribution functions and sampling is performed by 
the @RISK program.  Sampling in a simulation is done repetitively, with 
one sample drawn every iteration from each input probability distribution.  
With enough iterations, the sampled values for a probability distribution 
become distributed in a manner which approximates the known input 
probability distribution.  The statistics of the sampled distribution (mean, 
standard deviation and higher moments) approximate the true statistics 
input for the distribution.  The graph of the sampled distribution will even 
look like a graph of the true input distribution. 

Statisticians and practitioners have developed several techniques for 
drawing random samples.  The important factor to examine when 
evaluating sampling techniques is the number of iterations required to 
accurately recreate an input distribution through sampling.  Accurate 
results for output distributions depend on a complete sampling of input 
distributions.  If one sampling method requires more iterations and longer 
simulation runtimes than another to approximate input distributions, it is 
the less "efficient" method. 

The two methods of sampling used in @RISK — Monte Carlo sampling 
and Latin Hypercube sampling — differ in the number of iterations 
required until sampled values approximate input distributions.  Monte 
Carlo sampling often requires a large number of samples to approximate 
an input distribution, especially if the input distribution is highly skewed 
or has some outcomes of low probability.  Latin Hypercube sampling, a 
new sampling technique used in @RISK, forces the samples drawn to 
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correspond more closely with the input distribution and thus converges 
faster on the true statistics of the input distribution. 

Cumulative Distribution 
It is often helpful, when reviewing different sampling methods, to 
first understand the concept of a cumulative distribution.  Any 
probability distribution may be expressed in cumulative form.  A 
cumulative curve is typically scaled from 0 to 1 on the Y-axis, with Y-
axis values representing the cumulative probability up to the 
corresponding X-axis value. 

 
In the cumulative curve above, the .5 cumulative value is the point of 50% 
cumulative probability (.5 = 50%). Fifty percent of the values in the 
distribution fall below this median value and 50% are above.  The 0 
cumulative value is the minimum value (0% of the values will fall below this 
point) and the 1.0 cumulative value is the maximum value (100% of the 
values will fall below this point). 

Why is this cumulative curve so important to understanding sampling?  The 
0 to 1.0 scale of the cumulative curve is the range of the possible random 
numbers generated during sampling.  In a typical Monte Carlo sampling 
sequence, the computer will generate a random number between 0 and 1 — 
with any number in the range equally likely to occur.  This random number 
is then used to select a value from the cumulative curve.  For the example 
above, if a random number of .5 was generated during sampling, the value 
sampled for the distribution shown would be X1.  As the shape of the 
cumulative curve is based on the shape of the input probability distribution, 
more likely outcomes will be more likely to be sampled.  The more likely 
outcomes are in the range where the cumulative curve is the "steepest". 
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Monte Carlo Sampling 
Monte Carlo sampling refers to the traditional technique for using 
random or pseudo-random numbers to sample from a probability 
distribution.  The term Monte Carlo was introduced during World 
War II as a code name for simulation of problems associated with 
development of the atomic bomb.  Today, Monte Carlo techniques are 
applied to a wide variety of complex problems involving random 
behavior.  A wide variety of algorithms are available for generating 
random samples from different types of probability distributions.   

Monte Carlo sampling techniques are entirely random — that is, any 
given sample may fall anywhere within the range of the input 
distribution.  Samples, of course, are more likely to be drawn in areas 
of the distribution which have higher probabilities of occurrence.  In 
the cumulative distribution shown earlier, each Monte Carlo sample 
uses a new random number between 0 and 1.  With enough iterations, 
Monte Carlo sampling "recreates" the input distributions through 
sampling.  A problem of clustering, however, arises when a small 
number of iterations are performed.   

 
In the illustration shown here, each of the 5 samples drawn falls in the 
middle of the distribution.  The values in the outer ranges of the 
distribution are not represented in the samples and thus their impact 
on your results is not included in your simulation output. 

Clustering becomes especially pronounced when a distribution 
includes low probability outcomes which could have a major impact 
on your results.  It is important to include the effects of these low 
probability outcomes.  To do this, these outcomes must be sampled.  
But, if their probability is low enough, a small number of Monte Carlo 
iterations may not sample sufficient quantities of these outcomes to 
accurately represent their probability.  This problem has led to the 
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development of stratified sampling techniques such as the Latin 
Hypercube sampling used in @RISK. 

Latin Hypercube Sampling 
Latin Hypercube sampling is a recent development in sampling 
technology designed to accurately recreate the input distribution 
through sampling in fewer iterations when compared with the Monte 
Carlo method.  The key to Latin Hypercube sampling is stratification 
of the input probability distributions.  Stratification divides the 
cumulative curve into equal intervals on the cumulative probability 
scale (0 to 1.0).  A sample is then randomly taken from each interval 
or "stratification" of the input distribution.  Sampling is forced to 
represent values in each interval, and thus, is forced to recreate the 
input probability distribution.   

 
In the illustration above, the cumulative curve has been divided into 5 
intervals.  During sampling, a sample is drawn from each interval.  
Compare this to the 5 clustered samples drawn using the Monte Carlo 
method.  With Latin Hypercube, the samples more accurately reflect 
the distribution of values in the input probability distribution. 

The technique being used during Latin Hypercube sampling is 
"sampling without replacement".  The number of stratifications of the 
cumulative distribution is equal to the number of iterations 
performed.  In the example above there were 5 iterations and thus 5 
stratifications were made to the cumulative distribution.  A sample is 
taken from each stratification.  However, once a sample is taken from 
a stratification, this stratification is not sampled from again — its 
value is already represented in the sampled set. 

How does sampling within a given stratification occur?  In effect, 
@RISK chooses a stratification for sampling, then randomly chooses 
value from within the selected stratification. 
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When using the Latin Hypercube technique to sample from multiple 
variables, it is important to maintain independence between variables.  The 
values sampled for one variable need to be independent of those sampled 
for another (unless, of course, you explicitly want them correlated).  This 
independence is maintained by randomly selecting the interval to draw a 
sample from for each variable.  In a given iteration, Variable #1 may be 
sampled from stratification #4, Variable #2 may be sampled from 
stratification #22, and so on.  This preserves randomness and 
independence and avoids unwanted correlation between variables. 

As a more efficient sampling method, Latin Hypercube offers great 
benefits in terms of increased sampling efficiency and faster runtimes (due 
to fewer iterations).  These gains are especially noticeable in a PC based 
simulation environment such as @RISK.  Latin Hypercube also aids the 
analysis of situations where low probability outcomes are represented in 
input probability distributions.  By forcing the sampling of the simulation 
to include the outlying events, Latin Hypercube sampling assures they are 
accurately represented in your simulation outputs. 

When low probability outcomes are very important it often helps to run an 
analysis which just simulates the contribution to the output distribution 
from the low probability events.  In this case the model simulates only the 
occurrence of low probability outcomes — they are set to 100% probability.  
Through this you will isolate those outcomes and directly study the results 
they generate. 

The concept of convergence is used to test a sampling method.  At the 
point of convergence, the output distributions are stable (additional 
iterations do not markedly change the shape or statistics of the sampled 
distribution).  The sample mean versus the true mean is typically a 
measure of convergence, but skewness, percentile probabilities and other 
statistics are often used as well. 

@RISK provides a good environment for testing the speed at which the two 
available sampling techniques converge on an input distribution.  Run an 
equal number of iterations with each of the sampling techniques while 
selecting an input distribution @function as a simulation output.  Using the 
built-in Convergence Monitoring capability in @RISK, see how many 
iterations it takes the percentiles, mean and standard deviation to stabilize.  
It should be evident that Latin Hypercube sampling converges faster on 
the true distributions when compared with Monte Carlo sampling. 

Latin Hypercube 
and Low 
Probability  
Outcomes 

Testing the  
Techniques 
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More About Sampling Techniques 
The academic and technical literature has addressed both Monte Carlo and 
Latin Hypercube sampling.  Any of the references to simulation in the 
Recommended Readings give an introduction to Monte Carlo sampling.  
References which specifically address Latin Hypercube sampling are 
included in a separate section.
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Appendix B:  Using @RISK With 
Other DecisionTools® 

Palisade’s DecisionTools Suite is a complete set of decision analysis 
solutions for Microsoft Windows.  With the introduction of 
DecisionTools, Palisade brings you a decision-making suite whose 
components combine to take full advantage of the power of your 
spreadsheet software. 

The DecisionTools Suite 
The DecisionTools Suite focuses on providing advanced tools for any 
decision, from risk analysis to sensitivity analysis to distribution 
fitting.  Software packaged with the DecisionTools Suite includes: 
•  @RISK — risk analysis using Monte-Carlo simulation 
•  TopRank® — sensitivity analysis 
•  BestFit® — distribution fitting 
•  PrecisionTree® — decision analysis with decision trees and influence 

diagrams 
•  RISKview™ — distribution viewing companion 

Note:  When you purchase the DecisionTools Suite, all the features of 
BestFit and RISKview come fully integrated into your copy of @RISK 
Professional that comes with the Suite.   

While all the tools listed above can be purchased and used separately, 
they become more powerful when used together.  Analyze historical 
and fit data for use in an @RISK model.  Or use TopRank to determine 
which variables to define in your @RISK model. 

This chapter explains many of the ways the components of the 
DecisionTools suite interact and how they will make your decision 
making easier and more effective. 
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Note: Palisade also offers a version of @RISK for Microsoft Project.  
@RISK for Project allows you to run risk analyses on project 
schedules created in Microsoft Project, the leading software package 
for project management.  Contact Palisade for more information on 
this exciting implementation of @RISK! 

Purchasing Information 
All of the software mentioned here, including the DecisionTools Suite, 
can be purchased directly from Palisade Corporation.  To place an 
order or receive more information, please contact the technical sales 
department at Palisade Corporation using one of the following 
methods: 
•  Telephone us at (800) 432-7475 (U.S.  only) or (607) 277-8000 any 

weekday from 8:30 AM to 5:30 PM, EST 
•  Fax us at (607) 277-8001 
•  E-mail us at sales@palisade.com 
•  Visit us on the World Wide Web at http://www.palisade.com 
•  Mail us a letter at 

Technical Sales 
Palisade Corporation  
31 Decker Road 
Newfield, NY  14867 

If you want to contact Palisade Europe: 
•  E-mail us at sales@palisade-europe.com. 
•  Telephone us at +44 (0)207 426 9950 (UK). 
•  Fax us at +44 (0)207 375 1229 (UK). 
•  Mail us a letter at: 

Palisade Europe 
The Blue House, Unit 1 
30 Calvin Street 
London E1 6NW UK 
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Palisade’s DecisionTools Case Study 
The Excelsior Electronics company currently makes desktop 
computers.  They are working on a laptop computer, the Excelsior 
5000, and want to know whether or not the company will profit from 
this venture.  They built a spreadsheet model which spans the next 
two years, each column representing one month.  The model takes 
into account production costs, marketing, shipping, price per unit, 
units sold, etc.  The bottom line for each month is "Profit".  Excelsior 
expects some initial setbacks on this venture, but as long as they are 
not too great and profits are up towards the end of two years, they 
will go ahead with the E5000. 

Run TopRank First, Then @RISK 
TopRank is used on the model to find the critical variables.  The 
"Profit" cells are selected as outputs, and an automatic What-if 
analysis is run.  The results quickly show there are five variables (out 
of many more) that have the most impact on profits:  price per unit, 
marketing costs, build time, price of memory, and price of CPU chips.  
Excelsior decides to concentrate on these variables. 

 

TopRank 
Identifies Key 
Factors for New 
Computer 
Project 



464 Palisade’s DecisionTools Case Study 

Next, Assess Probabilities  
Distribution functions are needed to replace the five variables in the 
spreadsheet model.  Normal distributions are used for price per unit 
and build time, based on internal decisions and information from 
Excelsior’s manufacturing division.  At a marketing department 
meeting, @RISK’s Artist window is used by managers to draw 
distribution curves which represent the range of possible marketing 
costs.  Once a hand-drawn distribution is agreed upon, the Fit Curve 
command provides an @RISK distribution function for use in the 
model.   

Add Distribution Fitting 
Research is done to get weekly price quotes for memory and CPU’s 
over the past two years.  This data is fed into @RISK’s distribution 
fitting and distributions are fitted to the data.  Confidence level 
information confirms that the distributions are good fits, and the 
resulting @RISK distribution functions are pasted into the model. 

 
 

Fit Historical     
Data to  
Distributions 
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Simulate with @RISK 
Once all the @RISK functions are in place, the "Profit" cells are 
selected as outputs and a simulation is run.  Overall, the results look 
promising.  Although there will be losses initially, there is an 85% 
chance they will make an acceptable profit, and a 25% chance the 
venture will generate more revenue than they had initially assumed!  
The Excelsior 5000 project is given the go-ahead. 

 

Decide with PrecisionTree 
Excelsior Electronics had assumed they would sell and distribute the 
Excelsior 5000 themselves.  However they could use various catalogs 
and computer warehouses to distribute their product.  A decision tree 
model is built using PrecisionTree, taking into account unit prices, 
sales volume, and other critical factors for direct sales versus catalog 
sales.  A Decision Analysis is run and PrecisionTree suggests using 
catalogs and warehouses.  Excelsior Electronics puts that plan into full 
motion.  

 
 

@RISK 
Simulates Profit 
From Laptop 
Sales 
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Introduction to TopRank® 
TopRank is the ultimate What-if tool for spreadsheets from Palisade 
Corporation.  TopRank greatly enhances the standard What-if and 
data table capabilities found in your spreadsheet.  In addition, you 
can easily step up to powerful risk analysis with its companion 
package, @RISK. 

TopRank and What-if Analysis 
TopRank helps you find out which spreadsheet value(s) or variable(s) 
affects your results the most — an automated What-if or sensitivity 
analysis.  You also can have TopRank automatically try any number 
of values for a variable — a data table — and tell you the results 
calculated at each value.  TopRank also tries all possible combinations 
of values for a set of variables (a Multi-Way What-if analysis), giving 
you the results calculated for each combination. 

 
Running a What-if or sensitivity analysis is a key component of 
making any decision based on a spreadsheet.  This analysis identifies 
which variables affect your results the most.  It shows you those 
factors you should be most concerned with as you 1) gather more data 
and refine your model and 2) manage and implement the situation 
described by the model. 

TopRank for 
Excel 
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TopRank is a spreadsheet add-in for both Microsoft Excel and Lotus 
1-2-3 for Windows.  It can be used with any pre-existing or new 
spreadsheet.  To set up your What-if analyses, TopRank adds new 
custom “Vary” functions to the spreadsheet function set.  These 
functions specify how the values in your spreadsheet can be varied in 
a What-if analysis; for example, +10% and -10%, +1000 and -500, or 
according to a table of values you’ve entered. 

TopRank can also run a fully automatic What-if analysis.  It uses 
powerful auditing technology to find all possible values in your 
spreadsheet which could affect your results.  It can then change all 
these possible values automatically and find out which is most 
significant in determining your results. 

TopRank applications are the same as spreadsheet applications.  If 
you can build your model in a spreadsheet, you can use TopRank to 
analyze it.  Businesses use TopRank to identify the critical factors — 
price, up front investment amount, sales volume or overhead — that 
most affect the success of their new product.  Engineers use TopRank 
to show them the individual product components whose quality most 
affects final product production rates.  A loan officer can have 
TopRank quickly run her model at all possible interest rate, loan 
principle amount and down payment combinations and review 
results for each possible scenario.  Whether your application is in 
business, science, engineering, accounting or another field, TopRank 
can work for you to identify the critical variables which affect your 
results. 

Modeling Features 
As an add-in to Microsoft Excel and Lotus 1-2-3, TopRank links 
directly to your spreadsheet to add What-if analysis capabilities.  The 
TopRank system provides all the necessary tools for conducting a 
What-if analysis on any spreadsheet model.  And TopRank works in a 
style you are familiar with — Excel style menus and functions. 

What-if analysis and Data Tables are functions that can be performed 
directly in your spreadsheet, but only in a manual, unstructured 
format.  Simply changing a cell value in your spreadsheet and 
calculating a new result is a basic What-if analysis.  And a Data Table 
which gives a result for each combination of two values can also be 
built in your spreadsheet.  TopRank, however, performs these tasks 
automatically and analyzes their results for you.  It instantly performs 
What-ifs on all possible values in your spreadsheet which could affect 
your result, instead of requiring you to individually change values 

TopRank 
Applications 

Why TopRank? 
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and recalculate.  It then tells you what spreadsheet value is most 
significant in determining your result.   

TopRank also runs data table combinations automatically, without 
requiring you to set up tables in your spreadsheet.  Combine more 
than two variables in its Multi-Way What-if analysis — you can 
generate combinations of any number of variables — and rank your 
combinations by their affect on your results.  You can perform these 
sophisticated and automated analyses quickly, as TopRank keeps 
track of all the values and combinations it tries, and their results, 
separate from your spreadsheet.  By taking an automated approach, 
TopRank gives you What-if and Multi-Way What-if results almost 
instantly.  Even the least experienced modeler can get powerful 
analysis results. 

TopRank defines variations in spreadsheet values using functions.  To 
do this, TopRank has added a set of new functions to the Excel 
function set, each of which specifies a type of variation for your 
values.  These functions include: 
•  Vary and AutoVary functions which, during a What-if analysis, 

change a spreadsheet value across a + and - range you define.   
•  VaryTable functions which, during a What-if analysis, substitute each 

of a table of values for a spreadsheet value. 

TopRank uses functions to change spreadsheet values during a 
What-if analysis and keeps track of the results calculated for each 
value change.  These results are then ranked by the amount of change 
from the original expected results.  Then functions which caused the 
greatest change are identified as the most critical to the model. 

TopRank Pro also includes over 30 probability distribution functions 
found in @RISK.  These functions can be used along with Vary 
functions to describe variation in spreadsheet values. 

TopRank functions are entered wherever you want to try different 
values in a What-if analysis.  The functions can be added to any 
number of cells in a spreadsheet and can include arguments which are 
cell references and expressions — providing extreme flexibility in 
defining variation in value in spreadsheet models. 

In addition to adding Vary functions yourself, TopRank can 
automatically enter Vary functions for you.  Use this powerful feature 
to quickly analyze your spreadsheets without manually identifying 
values to vary and typing in functions.

Multi-Way 
What-if Analysis 

TopRank 
Functions 

How are 
TopRank 
Functions 
Entered? 
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When automatically entering Vary functions, TopRank traces back 
through your spreadsheet and finds all possible values which could 
affect the result cell you identify.  As it finds a possible value, it 
substitutes in an “AutoVary” function with the default variation 
parameters (such as +10% and -10%) you’ve selected.  With a set of 
AutoVary functions inserted, TopRank can then run its What-if 
analysis and rank the values which could affect your results by their 
importance. 

With TopRank, you can step through your Vary and AutoVary 
functions and change the variation each function specifies.  As a 
default you can use a -10% and +10% variation, but for a certain value 
you may feel that a -20% and +30% change is possible.  You can also 
select to not have a value varied — as in some cases a spreadsheet 
value is fixed and could never be changed.   

During its analysis TopRank individually changes values for each 
Vary function and recalculates your spreadsheet using each new 
value.  Each time it recalculates, it collects the new value calculated in 
each result cell.  This process of changing value and recalculating is 
repeated for each Vary and VaryTable function.  The number of 
recalculations performed depends on the number of Vary functions 
entered, the number of steps (i.e., values across the min-max range) 
you want TopRank to try for each function, the number of VaryTable 
functions entered, and the values in each table used. 

TopRank ranks all varied values by their impact on each result cell or 
output you’ve selected.  Impact is defined as the amount of change in 
the output value that was calculated when the input value was 
changed.  If, for example, the result of your spreadsheet model was 
100 prior to changing values, and the result was 150 when an input 
changed, there is a +50% change in results caused by changing the 
input.   

TopRank results can be view graphically in a Tornado, Spider or 
Sensitivity graph.  These graphs summarize your results to easily 
show the most important inputs for your results. 

 

Automated 
What-if’s 
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Using @RISK with TopRank 
What-if analysis is often the first analysis performed on a spreadsheet.  
Its results lead to a further refinement of the model, additional 
analyses and ultimately, a final decision based on the best model 
possible.  Risk analysis, a powerful analytical technique available 
using TopRank’s companion product, @RISK, is often the next 
analysis performed on a spreadsheet after a What-if analysis. 

Moving from What-if to Simulation 
A What-if analysis initially identifies what’s important in your model.  
You can then focus on these important components and better 
estimate what their values could be.  Usually, however, there are 
several or more of these important uncertain components, and, in 
reality, they could all vary at the same time.  To analyze an uncertain 
model such as this you need risk analysis or Monte Carlo simulation.  
Risk analysis varies all uncertain inputs simultaneously — just as they 
do in real life — and builds a range and distribution of the possible 
results that could occur. 

With risk analysis, inputs are described with a probability distribution 
— such as normal, lognormal, beta or binomial.  This is a much more 
detailed description of the uncertainty present in an input’s value 
than a simple + or - percentage variation.  A probability distribution 
shows both the range of values possible for an input and the 
likelihood of occurrence of any value in the range.  Simulation 
combines these input distributions to generate both a range of 
possible results from your model and the likelihood of any result 
occurring. 

The simple + and - change defined by a Vary function in a What-if 
analysis can be used directly in risk analysis.  @RISK actually samples 
your Vary functions directly in a risk analysis. 

The values sampled by @RISK from Vary and VaryTable functions 
during a simulation depend on either distribution argument entered 
for the function or the default distribution setting used in TopRank.  
For example, the TopRank function RiskVary(100,-10,+10), using a 
default distribution setting of Uniform and a default range type of +/- 
percentage, is sampled like the @RISK distribution 
RiskUniform(90,110).  VaryTable functions from TopRank are 
sampled as RiskDuniform functions in @RISK.   

 

Using What-if 
Definitions in a 
Risk Analysis 
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The Differences Between TopRank and @RISK 
TopRank and @RISK share many common features, so it's easy to 
think that they perform the same functions.  In fact, the two programs 
perform different, but complementary, tasks.  Don't ask yourself 
“Which should I use, @RISK or TopRank?”, ask yourself “Shouldn't I 
use both?” 

Both @RISK and TopRank are add-ins for analysis of models designed 
in spreadsheets.  By using special spreadsheet formulas, both 
programs explore how uncertainty affects your model, and thus the 
decisions you make.  And, a common user-interface guarantees a 
smooth transition between the two products:  one learning curve 
instead of two! 

There are three main areas where @RISK and TopRank differ: 
•  Inputs — how uncertainty is defined in your model 
•  Calculations — what happens during an analysis 
•  Results — what types of answers the analyses provide 

@RISK defines uncertainty in your model using probability 
distribution functions.  These functions define all the possible values 
an input can have with a corresponding probability of that value 
occurring.  There are over 30 probability distribution functions 
available in @RISK. 

To define uncertainty in @RISK, you need to assign a distribution 
function to every value that you think is uncertain.  It's up to you, the 
user, to determine which inputs are uncertain and which distribution 
function describes the uncertainty. 

TopRank defines uncertainty in your model using Vary functions.  
Vary functions are simple:  they define possible values that an input 
can have without assigning probabilities to those values.  There are 
only two basic Vary functions in TopRank — Vary and VaryTable. 

TopRank can automatically define variable cells in your model every 
time you select and output.  You don't need to know which cells are 
uncertain or important, TopRank identifies those cells for you. 

@RISK runs a Monte Carlo or Latin Hypercube simulation.  For each 
iteration (or step), every @RISK distribution in the spreadsheet model 
takes on a new value determined by the probability distribution 
function.  To run a thorough analysis, @RISK needs to run hundreds, 
sometimes thousands, of iterations. 

The Similarities 

The Differences 

Inputs 

Calculations 
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TopRank runs a single or Multi-Way sensitivity analysis.  During the 
analysis, only one cell (or a small number of cells) varies at a time 
according to the values defined in the Vary function.  With TopRank, 
only a few iterations are needed to study a large number of uncertain 
cells. 

For each output defined, @RISK produces a probability distribution as 
an analysis result.  The distribution describes which values an output 
(such as profit) could have, as well as how probable certain outcomes 
are.  For example, @RISK can tell you that there is a 30% chance that 
your company will not make a profit next quarter. 

For each output defined, TopRank tells you which inputs have the 
largest effect on the output.  The results show how much change you 
can expect in an output when a given input changes by a defined 
amount.  For example, TopRank can tell you that your company's 
profits are most sensitive to sales volume, and that when sales volume 
is 1000 units, you will lose $1 million.  So, TopRank told you that to 
make a profit, you'll need to concentrate on keeping sales volume 
high. 

The most important difference between the two packages is that 
@RISK studies how the combined uncertainty of all variables affect 
the output.  TopRank only tells you how an individual input (or a 
small group of inputs) affects the output.  So, while TopRank is faster 
and easier to use, @RISK provides a more detailed, comprehensive 
look at the problem.  We strongly recommend using TopRank first 
to determine which variables are the most important.  Then, use 
@RISK to run a comprehensive analysis of your problem for the 
best possible results. 

In summary, TopRank tells you what the most important variables 
are in your model.  The results of a TopRank What-if analysis can be 
used on their own to make better decisions.  But, for the most 
thorough analysis, use TopRank to find the most important variables 
in your model, then use @RISK to define uncertainty in those 
variables and run a simulation.  TopRank can help you optimize your 
@RISK simulations by defining uncertainty in only the most 
important variables, making your simulation faster and more 
compact. 

Results 

Summary 
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Introduction to PrecisionTree™ 
PrecisionTree from Palisade Corporation is a decision analysis add-in 
to Microsoft Excel.  Now you can do something you've never been 
able to do before - define a decision tree or influence diagram directly 
in your spreadsheet.  PrecisionTree allows you to run a complete 
decision analysis without leaving the program where your data is – 
your spreadsheet! 

Why You Need Decision Analysis and 
PrecisionTree 
You might wonder if the decisions you make are suitable for decision 
analysis.  If you are looking for a way to structure your decisions to 
make them more organized and easier to explain to others, you 
definitely should consider using formal decision analysis. 

When faced with a complex decision, decision makers must be able to 
organize the problem efficiently.  They have to consider all possible 
options by analyzing all available information.  In addition, they need 
to present this information to others in a clear, concise format.  
PrecisionTree allows decision makers to do all this, and more! 

But, what exactly does decision analysis allow you to do?  As the 
decision maker, you can clarify options and rewards, describe 
uncertainty quantitatively, weigh multiple objectives simultaneously 
and define risk preferences.  All in an Excel spreadsheet. 

Modeling Features 
As an "add-in" to Microsoft Excel, PrecisionTree "links" directly to 
Excel to add Decision Analysis capabilities.  The PrecisionTree system 
provides all the necessary tools for setting up and analyzing decision 
trees and influence diagrams.  And PrecisionTree works in a style you 
are familiar with — Excel-style menus and toolbars. 

With PrecisionTree, there's no limit to the size tree you can define.  
Design a tree which spans multiple worksheets in an Excel workbook!  
PrecisionTree reduces the tree to an easy-to-understand report right in 
your current workbook. 

PrecisionTree 
and Microsoft 
Excel 
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PrecisionTree allows you to define influence diagram and decision 
tree nodes in Excel spreadsheets.  Node types offered by 
PrecisionTree include: 
•  Chance nodes 
•  Decision nodes 
•  End nodes 
•  Logic nodes 
•  Reference nodes 

 

Values and probabilities for nodes are placed directly in spreadsheet 
cells, allowing you to easily enter and edit the definition of your 
decision models.   

Decision Tree in 
PrecisionTree 
and Excel 

PrecisionTree 
Nodes 
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PrecisionTree creates both decision trees and influence diagrams.  
Influence diagrams are excellent for showing the relationship between 
events and the general structure of a decision clearly and concisely, 
while decision trees outline the chronological and numerical details of 
the decision. 

In PrecisionTree, all decision model values and probabilities are 
entered directly in spreadsheet cells, just like other Excel models.  
PrecisionTree can also link values in a decision model directly to 
locations you specify in a spreadsheet model.  The results of that 
model are then used as the payoffs for each path through the decision 
tree. 

All calculations of payoffs happen in “real-time” – that is, as you edit 
your tree, all payoffs and node values are automatically recalculated. 

PrecisionTree's decision analyses give you straightforward reports 
including statistical reports, risk profiles and policy suggestions* 
(*PrecisionTree Pro only).  And, decision analysis can produce more 
qualitative results by helping you understand tradeoffs, conflicts of 
interest, and important objectives.   

All analysis results are reported directly in Excel for easy 
customization, printing and saving.  There's no need to learn a whole 
new set of formatting commands since all PrecisionTree reports can 
be modified like any other Excel worksheet or chart. 

Influence 
Diagram in 
PrecisionTree 
and Excel 

Model Types 

Values in 
Models  

Decision 
Analysis 
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Have you ever wondered which variables matter most in your 
decision?  If so, you need PrecisionTree's sensitivity analysis options.  
Perform both one and two-way sensitivity analyses and generate 
Tornado Graphs, spider graphs, strategy region graphs (PrecisionTree 
Pro only), and more! 

For those who need more sophisticated sensitivity analyses, 
PrecisionTree links directly to TopRank, Palisade Corporation's 
sensitivity analysis add-in. 

Because decision trees can expand as more possible decision options 
are added, PrecisionTree offers a set of features designed to help you 
reduce trees to a more manageable size.  All nodes can be collapsed, 
hiding all paths which follow the node from view.  A single subtree 
can be referenced from multiple nodes in other trees, saving the re-
entry of the same tree over and over.   

Sometimes you need help in creating a utility function that is used to 
factor your attitude towards risk into the calculations in your decision 
models.  PrecisionTree contains features which help you identify your 
attitude towards risk and create your own utility functions. 

PrecisionTree offers many advanced analysis options including: 
•  Utility functions 
•  Use of multiple worksheets to define trees 
•  Logic nodes 
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Using @RISK with PrecisionTree 
@RISK is a perfect companion to PrecisionTree.  @RISK allows you to 
1) quantify the uncertainty that exists in the values and probabilities 
which define your decision trees,  and 2) more accurately describe 
chance events as a continuous range of possible outcomes.  Using this 
information, @RISK performs a Monte-Carlo simulation on your 
decision tree, analyzing every possible outcome and graphically 
illustrating the risks you face. 

Using @RISK to Quantify Uncertainty 
With @RISK, all uncertain values and probabilities for branches in 
your decision trees and supporting spreadsheet models can be 
defined with distribution functions.  When a branch from a decision 
or chance node has an uncertain value, for example, this value can be 
described by an @RISK distribution function.  During a normal 
decision analysis, the expected value of the distribution function will 
be used as the value for the branch.  The expected value for a path in 
the tree will be calculated using this value. 

However, when a simulation is run using @RISK, a sample will be 
drawn from each distribution function during each iteration of the 
simulation.  The value of the decision tree and its nodes will then be 
recalculated using the new set of samples and the results recorded by 
@RISK.  A range of possible values will then be displayed for the 
decision tree.  Instead of seeing a risk profile with a discrete set of 
possible outcomes and probabilities,  a continuous distribution of 
possible outcomes is generated by @RISK.  You can see the chance of 
any result occurring. 

In decision trees, chance events must be described in terms of discrete 
outcomes (a chance node with a finite number of outcome branches).  
But, in real life, many uncertain events are continuous, meaning that 
any value between a minima and maxima can occur. 

Using @RISK with PrecisionTree makes modeling continuous events 
easier using distribution functions.  And, @RISK functions can make 
your decision tree smaller and easier to understand! 

Describing 
Chance Events 
as a Continuous 
Range of 
Possible 
Outcomes 
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Methods of Recalculation During a Simulation 
Two options are available for recalculation of a decision model during 
a simulation performed with @RISK.  The first option, Expected Values 
of the Model, causes @RISK to first sample all distribution functions in 
the model and supporting spreadsheets each iteration, then 
recalculate the model using the new values to generate a new 
expected value.  Typically the output from the simulation is the cell 
containing the expected value of the model.  At the end of the run an 
output distribution reflecting the possible range of expected values 
for the model and their relative likelihood of occurrence is generated.   

The second option, Values of One Sampled Path Through the Model, 
causes @RISK to randomly sample a path through the model each 
iteration of a simulation.  The branch to follow from each chance node 
is randomly selected based on the branch probabilities entered.  This 
method does not require that distribution functions be present in the 
model; however, if they are used a new sample is generated each 
iteration and used in path value calculations.  The output from the 
simulation is the cell containing the value of the model, such as the 
value of the root node of the tree. At the end of the run an output 
distribution reflecting the possible range of out values for the model 
and their relative likelihood of occurrence is generated.   

Using Probability Distributions in Nodes 
Let’s take a look at a chance node in an oil drilling decision tree: 

Don’t Drill

Drill Wet

Dry

SoakingOpen

-$80,000, 43%

$40,000, 34%

$190,000, 23%

-$10,000

EV = $22,900

 
The results of drilling are divided into three discrete outcomes (Dry, 
Wet and Soaking).  But, in reality, the amount of oil found should be 
described with a continuous distribution.  Suppose the amount of 
money made from drilling follows a lognormal distribution with a 
mean of $22900 and a standard deviation of $50000, or the @RISK 
distribution =RiskLognorm(22900,50000).   

Drilling Decision 
for Open Test 
Results 
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To use this function in the oil drilling model, change the chance node 
to have only one branch, and the value of the branch is defined by the 
@RISK function.  Here’s how the new model should look: 

Don’t Drill

Drill Results

Open RiskNormal(22900,50000) - $70,000

-$10,000

EV = $22,900

 
During an @RISK simulation, the RiskLognorm function will return 
random values for the payoff value of the Results node and 
PrecisionTree will calculate a new expected value for the tree. 

But, what about the decision to Drill or Not Drill?  If the expected 
value of the Drill node changes, the optimum decision could change 
iteration to iteration.  That would imply that we know the outcome of 
drilling before the decision is made.  To avoid this situation, 
PrecisionTree has an option Decisions Follow Current Optimal Path to 
force decisions before running an @RISK simulation.  Every decision 
node in the tree will be changed to a forced decision node, which 
causes each decision node to select the decision that’s optimal when 
the command is used.  This avoids changes in a decision due to 
changing a decision tree’s values and probabilities during a risk 
analysis.  

Using @RISK to Analyze Decision Options 
There may be times when you want to know the outcome of a chance 
event before making a decision.  You want to know the value of 
perfect information. 

Before running a risk analysis, you know the expected value of the 
Drill or Don’t Drill decision from the value of the Drill Decision node.  
If you ran a risk analysis on the model without forcing decisions, the 
return value of the Drill Decision node would reflect the expected 
value of the decision if you could perfectly predict the future.  The 
difference between the two values is the highest price you should pay 
(perhaps by running more tests) to find out more information before 
making the decision. 

Selecting @RISK Outputs 

Running a risk analysis on a decision tree can produce many types of 
results, depending on the cells in your model you select as outputs.  
True expected value, the value of perfect information, and path 
probabilities can be determined.

Drilling Decision 
With a 
Probability 
Distribution 

Decision 
Forcing During 
Simulation  

Value of Perfect 
Information 
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Select the value of a start node of a tree (or the beginning of any sub-
tree) to generate a risk profile from an @RISK simulation.  Since 
@RISK distributions generate a wider range of random variables, the 
resulting graph will be smoother and more complete than the 
traditional discrete risk profile. 

 

 

 

 

Start Node 
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See risk averse 

A probability distribution where any value between the minimum 
and maximum is possible (has finite probability). 
See discrete distribution 

A cumulative distribution, or a cumulative distribution function, is 
the set of points, each of which equals the integral of a probability 
distribution starting at the minimum value and ending at the 
associated value of the random variable. 
See cumulative frequency distribution, probability distribution 

A cumulative frequency distribution is the term for the output and 
the input cumulative distributions of @RISK.  A cumulative 
distribution is constructed by cumulating the frequency 
(progressively adding bar heights) across the range of a frequency 
distribution.  A cumulative distribution can be an "upwardly sloping" 
curve, where the distribution describes the probability of a value less 
than or equal to any variable value.  Alternatively, the cumulative 
curve may be a "downwardly sloping" curve, where the distribution 
describes the probability of a value greater than or equal to any 
variable value. 
See cumulative distribution 

A dependent variable is one that depends in some way on the values 
of other variables in the model under consideration.  In one form, the 
value of an uncertain dependent variable can be calculated from an 
equation as a function of other uncertain model variables.  
Alternatively, the dependent variable may be drawn from a 
distribution based on the random number which is correlated with a 
random number used to draw a sample of an independent variable. 
See independent variable 

The term deterministic indicates that there is no uncertainty 
associated with a given value or variable. 
See stochastic, risk

Averse 

Continuous 
Distribution 

Cumulative 
Distribution 

Cumulative 
Frequency 
Distribution 

Dependent 
Variable 

Deterministic 
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A probability distribution where only a finite number of discrete 
values are possible between the minimum and maximum. 
See continuous distribution 

The term event refers to an outcome or group of outcomes that might 
result from a given action.  For example, if the action is the pitch of a 
baseball, the possible events might include a hit (with outcomes 
single, double, triple, home run), an out, a foul ball, a ball, etc. 

See mean 

Frequency distribution is the proper term for the output probability 
distributions  and the input histogram distributions (HISTOGRM) of 
@RISK.  A frequency distribution is constructed from data by 
arranging values into classes and representing the frequency of 
occurrence in any class by the height of the bar.  The frequency of 
occurrence corresponds to probability. 

Higher moments are statistics of a probability distribution. The term 
generally refers to the skewness and kurtosis, the third and fourth 
moments respectively.  The first and second moments are the mean 
and the standard deviation, respectively.  
See skewness, kurtosis, mean, standard deviation 

An independent variable is one that does not depend in any way on 
the values of any other variable in the model under consideration.  
The value of an uncertain independent variable is determined by 
drawing a sample from the appropriate probability distribution.  This 
sample is drawn without regard to any other random sample drawn 
for any other variable in the model. 
See dependent variable 

An iteration is one recalculation of the user's model during a 
simulation.  A simulation consists of many recalculations or iterations.  
During each iteration, all uncertain variables are sampled once 
according to their probability distributions, and the model is 
recalculated using these sampled values. 
Also known as a simulation trial 

Kurtosis is a measure of the shape of a distribution.  Kurtosis 
indicates how flat or peaked the distribution is.  The higher the 
kurtosis value, the more peaked the distribution. 
See skewness 

Discrete  
Distribution 

Event 

Expected Value 

Frequency 
Distribution 

Higher Moments 

Independent  
Variable 

Iteration 

Kurtosis 
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Latin Hypercube is a relatively new stratified sampling technique 
used in simulation modeling.  Stratified sampling techniques, as 
opposed to Monte Carlo type techniques, tend to force convergence of 
a sampled distribution in fewer samples. 
See Monte Carlo 

The mean of a set of values is the sum of all the values in the set 
divided by the total number of values in the set. 
Synonym:  expected value 

Monte Carlo refers to the traditional method of sampling random 
variables in simulation modeling.  Samples are chosen completely 
randomly across the range of the distribution, thus necessitating large 
numbers of samples for convergence for highly skewed or long-tailed 
distributions.  
See Latin Hypercube 

The most likely value or mode is the value that occurs most often in a 
set of values.  In a histogram and a result distribution, it is the center 
value in the class or bar with the highest probability. 

Objective risk or objective probability refers to a probability value or 
distribution that is determined by "objective" evidence or accepted 
theory.  The probabilities associated with an objective risk are known 
with certainty. 
See subjective risk 

A percentile is an increment of the values in a data set.  Percentiles 
divide the data into 100 equal parts, each containing one percent of 
the total values.  The 60th percentile, for example, is the value in the 
data set for which 60% of the values are below it and 40% are above. 

Preference refers to an individual's choices where many attributes of a 
decision or object are considered.  Risk is an important consideration 
in personal preference. 
See risk averse 

Probability is a measure of how likely a value or event is to occur.  It 
can be measured from simulation data as frequency by calculating the 
number of occurrences of the value or event divided by the total 
number of occurrences.  This calculation returns a value between 0 
and 1 which then can be converted to percentage by multiplying by 
100. 
See frequency distribution, probability distribution 

Latin Hypercube 

Mean 

Monte Carlo 

Most Likely 
Value 

Objective Risk 

Percentile 

Preference 

Probability 
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A probability distribution or probability density function is the 
proper statistical term for a frequency distribution constructed from 
an infinitely large set of values where the class size is infinitesimally 
small. 
See frequency distribution 

A random number generator is an algorithm for choosing random 
numbers, typically in the range of 0 to 1.  These random numbers are 
equivalent to samples drawn from a uniform distribution with a 
minimum of 0 and a maximum of 1.  Such random numbers are the 
basis for other routines that convert them into samples drawn from 
specific distribution types. 
See random sample, seed 

A random sample is a value that has been chosen from a probability 
distribution describing a random variable.  Such a sample is drawn 
randomly according to a sampling "algorithm".  The frequency 
distribution constructed from a large number of random samples 
drawn by such an algorithm will closely approximate the probability 
distribution for which the algorithm was designed. 

The range is the absolute difference between the maximum and 
minimum values in a set of values.  The range is the simplest measure 
of the dispersion or "risk" of a distribution. 

@RISK (pronounced "at risk") is the name of the Excel Add-In for Risk 
Analysis described in this User’s Guide. 

The term risk refers to uncertainty or variability in the outcome of 
some event or decision.  In many cases the range of possible outcomes 
can include some that are perceived as a loss or undesirable along 
with others that are perceived as a gain or desirable.  The range of 
outcomes is often associated with levels of probability of occurrence. 

Risk Analysis is a general term used to describe any method used to 
study and understand the risk inherent to a situation of interest.  
Methods can be quantitative and/or qualitative in nature.  @RISK 
uses a quantitative technique generally referred to as simulation. 
See simulation 

Risk averse refers to a general characteristic of individuals with 
regard to their preference for risk. As the payoff and risk increase, the 
individual will be less likely to choose a course of action intended to 
achieve the higher payoff.  It is generally assumed that rational 
individuals are risk averse, although the degree of risk averseness 
varies from one individual to another.  There are situations or ranges 
of payoffs over which individuals may display the opposite behavior, 
namely, they will be risk takers. 

Probability  
Distribution 

Random  
Number 
Generator 

Random Sample 

Range 

@RISK 

Risk 

Risk Analysis 

Risk Averse 
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See random sample 

 

The seed is a number that initializes the selection of numbers by a 
random number generator.  Given the same seed, a random number 
generator will generate the same series of random numbers each time 
a simulation is run.   
See random number generator 

Simulation is a technique whereby a model, such as an Excel 
worksheet, is calculated many times with different input values with 
the intent of getting a complete representation of all possible scenarios 
that might occur in an uncertain situation. 

Skewness is a measure of the shape of a distribution.  Skewness 
indicates the degree of asymmetry in a distribution.  Skewed 
distributions have more values to one side of the peak or most likely 
value — one tail is much longer than the other.  A skewness of 0 
indicates a symmetric distribution, while a negative skewness means 
the distribution is skewed to the left.  Positive skewness indicates a 
skew to the right. 
See kurtosis 

The standard deviation is a measure of how widely dispersed the 
values are in a distribution.  Equals the square root of the variance. 
See variance 

Stochastic is a synonym for uncertain, risky. 
See risk, deterministic 

Subjective risk or subjective probability is a probability value or 
distribution determined by an individual's best estimate based on 
personal knowledge, expertise, and experience.  New information 
often causes changes in such estimates.  Reasonable individuals may 
disagree on such estimates. 
See objective risk 

A Summary Graph is an output graphic in @RISK that presents 
simulation results for a range of cells in a Excel worksheet.  The 
Summary Graph takes the underlying distributions for each cell and 
summarizes them by showing the trend of the means and two 
measures on either side of the means.  These two measures default to 
the 10th and 90th percentile trends. 

Trial is another term for iteration. 
See iteration
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Simulation 
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Truncation is the process by which a user chooses a minimum-
maximum range for a random variable that differs from the range 
indicated by the distribution type of the variable.  A truncated 
distribution has a smaller range than the untruncated distribution 
because the truncation minimum is greater than the distribution 
minimum and/or the truncation maximum is less than the 
distribution maximum. 

See risk 

A variable is a basic model component that can take on more than one 
value.  If the value that actually will occur is not known with 
certainty, the variable is considered uncertain.  A variable, certain or 
uncertain, may be either dependent or independent. 
See dependent variable, independent variable 

The variance is a measure of how widely dispersed the values are in a 
distribution, and thus is an indication of the "risk" of the distribution.  
It is calculated as the average of the squared deviations about the 
mean.  The variance gives disproportionate weight to "outliers", 
values that are far away from the mean.  The variance is the square of 
the standard deviation. 

 

Truncation 

Uncertainty 

Variable 

Variance 
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Appendix D: Recommended 
Readings 

Readings by Category 
The @RISK User’s Guide has given you a start on understanding the 
concepts of Risk Analysis and simulation.  If you're interested in 
finding out more about the Risk Analysis technique and the theory 
behind it, here are some books and articles which examine various 
areas in the Risk Analysis field. 

Introduction to Risk Analysis 
If you are new to Risk Analysis or if you would just like some more 
background information on the technique, the following books and 
articles might be helpful: 

* Clemen, Robert T.  and Reilly, Terrence. Making Hard Decisions with 
DecisionTools: Duxbury Thomson Learning, 2000. 

Hertz, D.B. "Risk Analysis in Capital Investment": HBR Classic, Harvard 
Business Review, September/October 1979, pp. 169-182. 

Hertz, D.B. and Thomas, H. Risk Analysis and Its Applications: John Wiley 
and Sons, New York, NY, 1983. 

Megill, R.E. (Editor). Evaluating and Managing Risk: PennWell Books, Tulsa, 
OK, 1984. 

Megill, R.E. An Introduction to Risk Analysis, 2nd Ed.: PennWell Books, 
Tulsa, OK, 1985. 

Morgan, M. Granger and Henrion, Max, with a chapter by Mitchell Small. 
Uncertainty: Cambridge University Press, 1990. 

Newendorp, P.D. Decision Analysis for Petroleum Exploration: Petroleum 
Publishing Company, Tulsa, Okla., 1975. 

Raiffa, H. Decision Analysis: Addison-Wesley, Reading, Mass., 1968. 

*Winston, Wayne and Albright, Christian. Practical Management Science, 2nd 
Ed: Duxbury Thomson Learning, Pacific Grove, CA, 2000. 
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Distribution Fitting 
If you’re interested in finding out more about distribution fitting, 
consult any of these books: 

* Groebner, David F.  and Shannon, Patrick W.  Business Statistics: A 
Decision-Making Approach, 4th ed.: Macmillan Publishing Company, New 
York, NY, 1993. 

* Law, Averill M.  and Kelton, David.  Simulation Modeling and Analysis, 
2nd ed.: McGraw-Hill, New York, NY, 1991. 

* Walpole, Ronald E.  and Myers, Raymond H.  Probability and Statistics for 
Engineers and Scientists, 5th ed.: Macmillan Publishing Company, New York, 
NY, 1993. 

Distribution Functions 
To learn more about the distribution functions used by @RISK's 
BestFit distribution fitting software, refer to the following book: 

* Evans, Merran, Nicholas Hastings and Brian Peacock.  Statistical 
Distributions, 2nd ed:  John Wiley & Sons, Inc, New York, NY, 1993. 

Technical References to Simulation and Monte 
Carlo Techniques 
If you would like a more in depth examination of simulation, 
sampling techniques and statistical theory, the following books may 
be useful: 

Iman, R.L., Conover, W.J. "A Distribution-Free Approach To Inducing Rank 
Correlation Among Input Variables":  Commun. Statist.-Simula. 
Computa.(1982) 11(3), 311-334 

* Law, A.M. and Kelton, W.D. Simulation Modeling and Analysis: McGraw-
Hill, New York, NY, 1991,1982, 2000. 

*Oakshott, Les. Business Modeling and Simulation: Pitman Publishing, 
London, 1997. 

*Ragsdale, Cliff T. Spreadsheet Modeling and Decision Analysis: ITP 
Thomson Learning, 1998.   

Rubinstein, R.Y. Simulation and the Monte Carlo Method: John Wiley and 
Sons, New York, NY, 1981. 

*Vose, David. Quantitative Risk Analysis: John Wiley and Sons, New York, 
NY, 2000. 



Appendix D: Recommended Readings 491 

Technical References to Latin Hypercube 
Sampling Techniques 
If you are interested in the relatively new technique of Latin 
Hypercube sampling, the following sources might be helpful: 

Iman, R.L., Davenport, J.M., and Zeigler, D.K. "Latin Hypercube Sampling (A 
Program Users Guide)": Technical Report SAND79-1473, Sandia Laboratories, 
Albuquerque (1980). 

Iman, R.L. and Conover, W.J. "Risk Methodology for Geologic Displosal of 
Radioactive Waste: A Distribution - Free Approach to Inducing Correlations 
Among Input Variables for Simulation Studies": Technical Report NUREG CR 
0390, Sandia Laboratories, Albuquerque (1980). 

McKay, M.D, Conover, W.J., and Beckman, R.J. "A Comparison of Three 
Methods for Selecting Values of Input Variables in the Analysis of Output 
from a Computer Code": Technometrics (1979) 211, 239-245. 

Startzman, R.A. and Wattenbarger, R.A. "An Improved Computation 
Procedure for Risk Analysis Problems With Unusual Probability Functions": 
SPE Hydrocarbon Economics and Evaluation Symposium Proceedings, Dallas 
(1985). 

Examples and Case Studies Using Risk Analysis 
If you would like to examine case studies showing the use of Risk 
Analysis in real life situations, see the following: 

Hertz, D.B. and Thomas, H. Practical Risk Analysis - An Approach Through 
Case Histories: John Wiley and Sons, New York, NY, 1984. 

* Murtha, James A. Decisions Involving Uncertainty, An @RISK Tutorial for 
the Petroleum Industry: James A. Murtha, Houston, Texas, 1993. 

*Nersesian, Roy L. @RISK Bank Credit: Roy L. Nersesian, 1998. 

Newendorp, P.D. Decision Analysis for Petroleum Exploration: Petroleum 
Publishing Company, Tulsa, Okla., 1975. 

Pouliquen, L.Y. “Risk Analysis in Project Appraisal”: World Bank Staff 
Occasional Papers Number Eleven. John Hopkins Press, Baltimore, MD, 1970. 

* Trippi, Robert R. and Truban, Efraim. Neural Networks: In Finance and 
Investing: Probus Publishing Co., 1993. 

*Winston, Wayne. Financial Models Using Simulation and Optimization: 
Palisade Corporation, 1998. 

*Winston, Wayne and Albright, Christian. Practical Management Science: ITP 
Thomson Learning, 1997.  

*Winston, Wayne. Spreadsheet Modeling: ITP Thomson Learning, 1996. 
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* These titles can be purchased through Palisade Corporation.  Call 
(800-432-7475 or 607-277-8000), fax (607-277-8001), or write to order 
or request further information on these and other titles relevant to 
risk analysis.  The Palisade Technical Sales Department can also be 
reached by e-mail at sales@palisade.com or on the World Wide Web 
at http://www.palisade.com. 
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